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CHAPTER 1

Préambule

1.1 Avant-propos

Bienvenue dans notre cours! Nous allons vous montrer comment utiliser facilement et efficacement QGIS. Si vous
&tes nouveaux utilisateurs de SIG, nous vous dirons ce que vous avez besoin de savoir pour commencer. Si vous &tes
un utilisateur expérimenté, vous verrez combien QGIS remplit toutes les fonctions que vous attendez d’un programme
SIG, et plus encore!

1.1.1 Pourquoi QGIS?

L’information étant de plus en plus sensible a I'espace, les outils capables de remplir certaines ou toutes les fonctions
SIG couramment utilisées ne manquent pas. Pourquoi utiliser QGIS plutét qu'un autre logiciel SIG ?

Voici quelques unes des raisons :

* Rien ne vaut un repas gratuit. Installer et utiliser le programme QGIS ne vous cofite pas d’argent. Pas de frais
initiaux, pas de frais récurrents, rien.

e Ceest libre! Si vous avez besoin d’une fonctionnalité dans QGIS, vous pouvez faire plus que seulement
espérer que celle-ci soit incluse dans la prochaine version. Vous pouvez sponsoriser le développement d’une
fonctionnalité ou I'ajouter vous-méme si vous étes familier avec la programmation.

o C'est en développement constant. Parce que chacun peut ajouter de nouvelles fonctionnalités et améliorer les
existantes, QGIS ne stagne jamais. Le développement d’un nouvel outil peut se dérouler aussi rapidement que
nécessaire.

¢ Aide et documentation approfondies sont disponibles. Si vous €tes bloqués, vous pouvez vous tourner vers la
documentation approfondie, vos camarades utilisateurs QGIS, ou encore les développeurs.

¢ Cross-platform. QGIS can be installed on macOS, Windows and Linux.

Maintenant que vous savez pourquoi utiliser QGIS, les exercices suivants vous apprendront comment.
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1.1.2 Préparation

En 2008, nous avons lancé Une rapide introduction aux SIG, une ressource complétement libre et ouverte pour les
personnes désirant apprendre a utiliser des SIG sans étre surchargées par le jargon et la terminologie. Ce travail a été
sponsorisé par le gouvernement Sud-Africain et a ét€ un succes phénoménal car des personnes de toute la terre nous
ont écrit pour nous décrire comment elles avaient utilisé ce travail pour réaliser des formations universitaires, pour
apprendre les SIG par eux-mémes, etc. L’introduction rapide n’est pas un tutoriel de logiciel mais plutot un texte
générique (bien que des exemples sous QGIS soient montrés) permettant de comprendre les SIG. 11 existe également
le Manuel QGIS qui fournit un apercu détaillé des fonctionnalités de 'application QGIS. Néanmoins, il n’est pas
structuré sous forme de tutoriel mais plus comme un guide de référence. A Linfiniti Consulting CC., nous organisons
fréquement des formations et nous avons réalisé qu’il manquait une troisi€me ressource, une qui permettrait de guider
séquentiellement le lecteur a travers 'apprentissage des aspects clefs de QGIS sous forme d’'un échange formateur-
éleve. Nous avons alors produit ce document.

Ce manuel d’exercices est prévu pour permettre de conduire une formation de 5 jours sur QGIS, PostgreSQL et
PostGIS. La formation est structurée pour s’adapter aux utilisateurs novices, intermédiaires et avancés et elle dispose
de plusieurs exercices complets avec des réponses annotées tout au long du texte.

1.1.3 Licence

@00

Le manuel de formation QGIS est gratuit de Linfiniti Consulting CC. est basé sur une version antérieure de Linfiniti
et est sous licence Creative Commons Attribution 4.0 International. Des autorisations au-dela de la portée de cette
licence peuvent étre disponibles a I'adresse ci-dessous.

Nous avons publié ce manuel d’exercice QGIS sous une licence libre pour vous permettre de le copier, de le modifier
et de le redistribuer librement. Une copie complete de la licence est disponible a la fin de ce document. En termes
simples, les recommandations d’utilisation sont les suivantes:

* Vous ne pouvez pas déclarer que cette ceuvre est la votre ou supprimer le texte sur les auteurs de cette oeuvre.

* Vous ne pouvez pas redistribuer cette oeuvre sous des permissions plus restrictives que celles qui vous ont été
attribuées.

« Si vous ajoutez une portion significative a cette ceuvre et que vous livrez votre contribution en retour au projet
(au moins un module complet), vous pouvez ajouter votre nom a la fin de la liste des auteurs de ce document
(qui apparait en page de garde).

« Si vous avez effectué des changements mineurs ou des corrections, vous pouvez vous ajouter a la liste des
contributeurs ci-dessous.

* Si vous traduisez le document en entier, vous pouvez ajouter votre nom a la liste des auteurs sous la forme
« Translated by Joe Bloggs ».

* Si vous financez un module ou une legon, vous pouvez demander a I'auteur d’inclure une note au début de
chaque lecon financée, par exemple:

Note: Ce cours a été sponsorisé par MegaCorp.

« Si vous n’étes pas certain de ce que vous pouvez faire sous cette licence, merci de nous contacter a 'adresse
office@linfiniti.com et nous vous donnerons des conseils sur 'acceptabilité de vos intentions.

* Si vous souhaiter publier ce travail sous un site d’hébergement autonome comme https://www.lulu.com nous
demandons que vous transmettiez les profits au projet QGIS.

* Vous ne pouvez pas commercialiser cette ceuvre sans la permission expresse des auteurs. Pour €tre clair, par
commercialisation, nous entendons que vous ne pouvez pas la revendre pour le profit, pour créer un travail dérivé
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commercial (ex: vendre le contenu pour l'inclure dans des articles de magazines). L’exception a cette regle
consiste a reverser tous les profits au projet QGIS. Vous pouvez (et nous vous encourageons a le faire) utiliser
cette ceuvre comme un livre pour gérer votre formation méme si cette formation est de nature commerciale.
En d’autres termes, vous pouvez vous rémunérer en réalisant une formation basée sur cette ceuvre mais vous
ne pouvez pas réaliser de profits en vendant le livre en lui-méme, de tels profits devant étre reversés au projet
QGIS.

1.1.4 Sponsoriser des chapitres
Cette oeuvre ne prétend pas étre une référence complete de toutes les choses que vous pouvez accomplir avec QGIS
et nous vous encourageons a ajouter de nouveaux éléments pour combler les vides. Linfiniti Consulting CC. peut

également créer du contenu pour vous sur la base d’un service commercial avec le fait que tout le travail produit
devriendra partie de I'oeuvre et sera publié sous la méme licence.

1.1.5 Auteurs

* Riidiger Thiede - Rudi has written the QGIS instructional materials and parts of the PostGIS materials.

e Tim Sutton (tim@kartoza.com) - Tim has overseen and guided the project and co-authored the PostgreSQL
and PostGIS parts. Tim also authored the custom sphinx theme used for this manual.

* Horst Diister (horst.duester@kappasys.ch ) - Horst a co-produit les parties sur PostgreSQL et PostGIS.

* Marcelle Sutton - Marcelle provided proof-reading and editorial advice during the creation of this work.

1.1.6 Contributeurs individuels

Votre nom ici!

1.1.7 Sponsors

* Cape Peninsula University of Technology

1.1.8 Fichiers sources et signalement de bugs

La source de ce document est disponible sur GitHub, dans le dépot QGIS-Documentation. Consultez GitHub.com
pour les instructions d’utilisation du systeéme de contrdle de versionnement git.

Malgré nos efforts, vous pourriez trouver certaines erreurs ou informations manquantes en suivant ce manuel. Nous
vous remercions de bien vouloir les signaler a https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Derniére version

Vous pouvez toujours obtenir la derniere version de ce document en visitant la version en ligne qui fait partie du site
de documentation du QGIS (https://docs.qgis.org).

Note: Le site web de documentation contient des liens vers les versions en ligne et PDF du manuel de formation et
d’autres parties de la documentation QGIS.
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1.2 A propos des exercices

Maintenant que vous savez pourquoi utiliser QGIS, nous allons vous montrer comment le faire.

Avertissement: Ce manuel d’exercices, ce cours comprend des instructions sur I'ajout, la suppression et la
modification des jeux de données SIG. Nous avons fourni des ensembles de données de formation a cet effet. Avant
d'utiliser les techniques décrites ici sur vos propres données, assurez vous toujours de disposer des sauvegardes
appropriées !

1.2.1 Comment utiliser ce tutoriel ?

Le texte qui ressemble a ca se réfere a quelque chose que vous pouvez voir dans I'interface de QGIS.
Le texte qui ressemble » a » ¢a pointe sur un menu.

Ce type de texte se réfere a quelque chose que vous devez taper, comme une commande.
Ce/type/de.texte se réféere a un chemin ou un nom de fichier.

Ceci+Cela se réfere a un raccourci clavier composé de deux touches.

1.2.2 Objectifs du cours a plusieurs niveaux

Ce cours s’adresse a différents niveaux d’expérience des utilisateurs. En fonction de la catégorie dans laquelle vous
vous considérez, vous pouvez vous attendre a des résultats différents. Chaque catégorie contient des informations qui
sont essentielles pour la suivante, il est donc important de faire tous les exercices qui sont a votre niveau d’expérience
ou en dessous.

Basique
Dans cette catégorie, le cours suppose que vous avez peu ou pas d’expérience préalable en matiere de connaissances
théoriques sur les SIG ou de fonctionnement des logiciels SIG.

Une formation théorique limitée sera fournie pour expliquer le but d’une action que vous effectuerez dans le cadre du
programme, mais I'accent est mis sur I'apprentissage par la pratique.

A Tissue du cours, vous aurez une meilleure idée des possibilités des SIG et de la maniere d’exploiter leur puissance
via s QGIS.

Intermédiaire
Dans cette catégorie, il est supposé que vous avez une connaissance et une expérience pratique des utilisations
quotidiennes des logiciels SIG.

Les instructions pour le niveau débutant vous permettront de vous familiariser avec le terrain, et vous feront prendre
conscience des cas ot QGIS fait les choses un peu différemment des autres logiciels auxquels vous étes habitués. Vous
apprendrez également comment utiliser les fonctions d’analyse dans QGIS.

En suivant ce cours, vous aurez une bonne maitrise des fonctionnalités usuelles de QGIS.
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Avanceé

Dans cette catégorie, on suppose que vous avez une expérience des logiciels SIG, une connaissance et une expérience
des bases de données spatiales, de I'utilisation des données sur un serveur distant, peut-&tre de I’écriture de scripts a
des fins d’analyse, etc.

Les instructions des deux autres niveaux vous familiariseront avec I'approche suivie par l'interface QGIS et vous
permettront de savoir comment accéder aux fonctions de base dont vous avez besoin. On vous montrera également
comment utiliser le systeme de plugin QGIS, I'acces aux bases de données, etc.

A Tissue du cours, vous devriez étre bien familiarisé avec le fonctionnement quotidien du logiciel QGIS, ainsi qu’avec
ses fonctions plus avancées.

1.2.3 Données

Les données qui accompagnent ce manuel sont disponibles librement et proviennent des sources suivantes :
* Les données de rues et villes viennent d’OpenStreetMap (https://www.openstreetmap.org/)
 Les limites de parcelles (urbaines et rurales), les données sur ’eau viennent de NGI (https://ngi.dalrrd.gov.za/)
e Le MNT SRTM vient de CGIAR-CGI (http://srtm.csi.cgiar.org/)

Téléchargez I'ensemble de données préparé a partir du Training data repository et décompressez le fichier. Toutes
les données nécessaires sont fournies dans le dossier exercise_data.

Si vous &tes un instructeur et que vous souhaitez utiliser des données plus pertinentes, vous trouverez des instructions
pour créer des données locales dans I'annexe Préparation des données d'exercice.
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CHAPTER 2

Création et exploration d’'une carte de base

Dans ce module, vous allez créer une carte de base qui servira plus tard de support aux démonstrations des
fonctionnalités de QGIS.

2.1 Lesson: Un Apercu de I'Interface

Nous allons explorer l'interface utilisateur de QGIS afin que vous soyez familier avec les menus, les barres d’outils,
le canevas de carte et la liste des couches, ces €léments formant la structure de base de I'interface.

Le but de cette lecon: Comprendre les notions de base de I'interface de QGIS.
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2.1.1 Try Yourself: Les Notions de Base

*Basic Map - QGIS 0c62abed96 [tm]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

BRERR @epresn AABRE R e §-D-GME %I =0 9
~amazssn @ B

Layers

BNSDHS

o &

e@®
AR 3 e
v

Layers
S

ate (Ctrl+K] |1\egendenmemmoved Coordinate 20.3420.-33.9989 | % Scale 1:32869 |~ | @ Magnifier| 100% 3| Rotation |0.0°* % v Render @ EPSG:4326 @

Les éléments identifiés sur la figure ci-dessous sont:

1.

AN

Légende / Panneau Explorateur
Barres d’outils

Canevas de carte

Barre d’état

Barre d’outils latérale

Barre de localisation

La Liste de Couches

Dans la liste des couches, vous pouvez voir a tout moment toutes les couches qui sont disponibles dans le projet.

Dérouler les boutons a plusieurs options (en cliquant sur la petite fleche juste a c6té du bouton) vous donnera les
différentes fonctions de ses options.

En survolant la couche, vous obtiendrez quelques informations de base : nom de la couche, type de géométrie, systeme
de référence des coordonnées et le chemin complet de I'emplacement sur votre appareil.

Cliquer sur la couche avec le bouton droit affichera un menu avec plein d’options. Durant ce cours, vous en utiliserez
certaines, alors restez attentifs !

Note:

Une couche vecteur est un jeu de données, généralement d’un seul type d’objets, comme des routes, arbres,

etc. Une couche vectorielle peut contenir soit des points, soit des lignes ou des polygones.
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Le panneau de recherche

L’Explorateur de QGIS est un panneau qui permet de naviguer aisément dans votre base de données. Vous pouvez
accéder aux fichiers vectoriels courants (shapefiles ESRI, fichiers Maplnfo. . .), aux bases de données (PostGIS, Oracle,
SpatiaLite, GeoPackage, MS SQL Server...) et aux connections WMS/WFS. Vous pouvez aussi voir les données
GRASS.

Si vous avez enregistré un projet, le panneau du navigateur vous donnera également un acces rapide a toutes les
. A . N . . * .
couches stockées dans le méme chemin d’acces au fichier de projet dans le Project Home.

De plus, vous pouvez définir un ou plusieurs dossiers comme Favoris: recherchez sous votre chemin et une fois que
vous avez trouvé le dossier, faites un clic droit dessus et cliquez sur Ajouter comme favori. Vous devriez alors

pouvoir voir votre dossier dans les Favoris.

Astuce: Il peut arriver que les dossiers ajoutés a I'’élément favori aient un nom tres long: ne vous inquiétez pas, faites
un clic droit sur le chemin et choisissez Renommer favori ... pour définir un autre nom.

Barres d’Outils

Les groupes d’outils que vous utilisez le plus peuvent étre présents sous forme de barre d’outils pour un acces facilité.
Par exemple, la barre d’outils Projet vous permet de sauvegarder, charger, imprimer, et démarrer un nouveau projet.
Vous pouvez facilement personnaliser 'interface pour n’afficher que les outils que vous utilisez le plus, en ajoutant ou
retirant des barres d’outils via le menu Vue » Barres d outils.

Méme s’ils ne sont pas visibles dans les barres d’outils, tous vos outils sont accessibles via les menus. Par exemple, si
vous supprimez la barre d’outils Projet (qui contient le bouton Enregistrer le projet), vous pouvez toujours sauvegarder
votre carte en cliquant sur le menu Projet puis sur Enregistrer.

Le Canevas de Carte
C’est 1a que la carte elle-méme est affichée et ol les couches sont chargées. Dans le canevas de carte, vous pouvez

interagir avec les couches visibles: zoom avant / arriere, déplacer la carte, sélectionner des entités et de nombreuses
autres opérations que nous verrons dans les sections suivantes.

La Barre d’Etat

Affiche des informations sur la carte actuelle. Vous permet également d’ajuster 1'échelle de la carte, la rotation de la
carte et de voir les coordonnées du curseur de la souris sur la carte.

La barre d’outils latérale

Par défaut, la barre d’outils latérale contient les boutons pour charger les couches et tous les boutons pour créer une
nouvelle couche. Mais n’oubliez pas que vous pouvez déplacer toutes les barres d’outils 1a ou cela vous convient le
mieux.

2.1. Lesson: Un Apercu de I'Interface 11
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La barre de localisation

Dans cette barre, vous pouvez accéder a presque tous les objets de QGIS: couches, entités de couches, algorithmes,
signets spatiaux, etc. Vérifiez toutes les différentes options dans la section locator_options du manuel de l'utilisateur
de QGIS.

Astuce: Avec le raccourci Ctrl + K vous pouvez facilement accéder a la barre.

2.1.2 Try Yourself 1

Essayez d’identifier les quatre éléments listés ci-dessus sur votre écran, sans vous référer au diagramme ci-dessus.
Voyez si vous pouvez retrouver leurs noms et fonctions. Vous vous familiarisez avec ces éléments au fur et a mesure
que vous les utiliserez.

Réponse

En vous référant a I'image montrant la disposition de l'interface, vérifiez que vous vous souvenez du nom et de la
fonction des éléments de I'écran.

2.1.3 Try Yourself 2

Essayez de retrouver chacun de ces outils dans votre interface. A quoi servent-ils?

L
2 50
3. BN

4. BRendu

[—]

5., ™

Note: Siun de ces outils n’est pas visible a I'écran, essayez d’activer certaines barres d’outils qui sont actuellement
cachées. Gardez a I'esprit que s’il n’y a pas assez d’espace sur 'écran, une barre d’outils peut étre raccourcie, masquant
certains de ses outils. Vous pouvez voir les outils cachés en cliquant sur le bouton double fleche a droite de toute barre
d’outils repliée. Vous pouvez voir une info-bulle avec le nom de n’importe quel outil en maintenant votre souris sur
Poutil pendant un certain temps.

Réponse

1. Save as
Zoom to layer(s)
Invert selection

Rendering on/off

wooA »N

Measure line
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2.1.4 What’s Next?

Maintenant que vous étes familiarisé avec les bases de I'interface QGIS, nous verrons dans la prochaine lecon comment
charger certains types de données courants.

2.2 Lesson: Ajout de vos premieres couches

Nous allons lancer I'application, et créer une carte de base a utiliser pour les exemples et les exercices.

Objectif de cette lecon: Démarrer avec une carte d’exemple.

Note: Avant de commencer cet exercice, QGIS doit étre installé sur votre ordinateur. De plus, vous devriez avoir
téléchargé le jeu de données a utiliser.

Lancez QGIS a partir de son raccourci sur le bureau, depuis le menu, etc., selon la fagon dont vous avez configuré
son installation.

Note: Les captures d’écran de ce cours ont été prises dans QGIS 3.4 sous Linux. Selon votre configuration, les
écrans que vous rencontrerez peuvent sembler quelque peu différents. Cependant, tous les mémes boutons seront
toujours disponibles et les instructions fonctionneront sur n’importe quel systeme d’exploitation. Vous aurez besoin
de QGIS 3.4 (la derniere version au moment de la rédaction) pour utiliser ce cours.

Commencgons dés maintenant !

2.2.1 Follow Along: Préparer une carte

1. Ouvrez QGIS. Vous aurez une carte vierge.

untitled Project - QGIS [new] (>

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
DEBEREmREE O 2p "D c I
Lh VA

ez %% Recent Projects

LET*O
Favorites

[ Home

=y

@ GeoPackage

/ spatiaLite

@ postals

> MssQL

@ pB2

@ WMS/WMTS

@ XvZTiles

@ wes

@ WFs

© ows

& ArcGisMapServer

& ArcGisFeatureServer

% GeoNode

He
X
B

Layers 2®
< @ ® T |2 3=

Q Type to locate (Ctrl+K) Ready Coordinate ¥ scle 11 ~ | @ Magnifier| 100% | Rotation |0,0°* +| ¥/ Render @ gpsGia326 @
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2. Laboite de dialogue Gestionnaire de source de donnees vous permet de choisir les données a charger en fonction

du type de données. Nous allons l'utiliser pour charger notre jeu de données: cliquez sur le bouton ‘l
Open Data Source Manager

Si vous ne trouvez pas 'icone, vérifiez que la barre d’outils Gestionnaire des sources de données est activée dans
le menu Vue » Barres d outils.

Untitled Project - QGIS [new]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

SHSH: o D ~ —
DEBREEY UL p P (YL~ D ¥ 2 m-e 0
[R|& 5L # E ® 2
A ® :
Brows ©% Recent Projects
LReX*e
Favoyjtes
» @ Homé
» o/ .
@ GeoPackyge Data Source Manager | Browser
/ spatiaLite B
@ postals -
P MssqL Vo QRY®O
bB2 ‘. ~ - Favorites
@ WMS/WMTS r—— » [ /media/TRAVAIL/2019/Controle
» @ xvzTiles e » [a] Home
S wes 2% Mesh =
@ WFs . » @ GeoPackage
© ows o Delimited Text / spatiaLite
@ ArcGisMapServer @ Postals
@ ArcGisFeatureServer 4 Geopackage » mssQL
& GeoNode ) @ pB2
7, spatialite » @ WMS/WMTS
» @ XYZTiles
4 PostaresQL & wcs
@ ArcGisMapServer
@ ArcGisFeatureServer
Layers @ sk GeoNode
Y @wT R &=
& wmis/wmts
& wes
a WFS
#3 Arcais Map server
ArCGIS Feature
@4 server
4 GeoNode
Q Type to locate (Ctrl+k) Ready Coordinate ¥ sale| 11 ~ | @ Magnifier | 100% = Rotation [00° 3| V/Render @ EPsG4326 @

3. Chargez le fichier protected_areas. shp:

1. Cliquez sur 'onglet Vecteur.

2. Activez le type de source ® ! Fichier.
3. Appuyez sur le bouton ... a coté de Ensemble (s) de données vecteur.

4. Sélectionnez le fichier exercise_data/shapefile/protected_areas.shp dans votre
répertoire d’entralnement.

5. Cliquez sur Ouvrir. Vous verrez la boite de dialogue source, avec le chemin du fichier rempli.

14

Chapter 2. Création et exploration d’une carte de base



QGIS Training Manual

B Browser

Vector

Raster

Mesh

Delimited Text

GeoPackage
¢ Spatialite

PostgreSQL

MSSQL

DB2

| virtual Layer

WMS/WMTS
wCs

WFS

ArcGIS Map
server

- ArcGIS Feature

Server

Data Source Manager | Vector
Source Type
(@ File ( Directory (' Database (' Protocol: HTTP(S), cloud, etc.
Encoding

System -

Source

Vector Dataset(s) exercise_data/shapefile/protected_areas.shp

@Help < Add # Close

6. Cliquez sur Ajouter ici aussi. Les données que vous avez spécifiées vont maintenant se charger: vous
pouvez voir un élément protected_areas dans le panneau couches (en bas a gauche) avec ses entités
affichées dans le canevas de la carte principale.

*Untitled Project - QGIS [new]

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

DEBRRESYN O L2L PR RAAEHBIRS &6 -H-a5-5,BE¥ I = [0

LA AN A N

Browser @R
LeT®HO
Favorites
» [& Home
» [/
@ GeoPackage
/# Spatialite
@ Postais
» MssQL
& pB2
@ WMS/WMTS.
» @ xyZTiles

& ArcGismapserver
& ArcGisFeatureServer
¢ GeoNode

Layers (S]]
o« @ ® T &- A0
[l protected areas

Q Type to locate (Ctrl+K) Ready

= % & @~ ®

Coordinate|20.3631,33.8948 | ¥ Scale 1:76050 ~ | & Magnifier | 100% | Rotation |0,0° | |¥| Render & EPsc43ze @
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Félicitations ! Vous avez désormais une carte de base. Il est maintenant temps de sauver votre travail.

‘
1. Cliquez sur le bouton Sauvegarder sous : =14

2. Enregistrez la carte dans un dossier solution a coté de exercise_data et appelez-le basic_map.
ggz.

2.2.2 Try Yourself

Répétez les étapes ci-dessus pour ajouter les couches places.shp et rivers.shp du méme dossier
(exercise_data/shapefi) ala carte.

Réponse

Dans la partie principale de la fenétre, vous devriez voir plusieurs formes avec des couleurs différentes. Chaque
forme appartient a une couche que vous pouvez identifier par sa couleur dans le panneau de gauche (vos couleurs sont
peut-Etre différentes de celles de Fig. 2.1 ci-dessous) :

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
hEEBRBREmRE O 220 RDD L/ O @G- -RER-EE % 2 =~ [0
@@V A W 7 5 fi<s B g [ oy e @A ¥

Layers (2]
o [ ® T &6 °F L

v/ * places
v! [ ] protected_areas

Layers | Browser NN

L Type to locate (Ctrl+K) Coordinate |20.4061,-33.8952 | ¥ Scale 1:108708  ~ | (@ Magnifier 100% +| Rotation |0.0° </ |v|Render @ Epsciadze @

Figure2.1: Une carte basique

2.2.3 Follow Along: Chargement des données vecteur depuis une base
GeoPackage

Les bases de données vous permettent de stocker un grand volume de données combinées dans un seul fichier. Vous
étes peut-€tre déja familiarisé avec un systeme de gestion de base de données (SGBD) tel que Libreoffice Base ou
MS Access. Les applications SIG peuvent également utiliser des bases de données. Les SGBD spécifiques aux SIG
(tels que PostGIS) ont des fonctions supplémentaires, car ils doivent traiter des données spatiales.

Le format ouvert GeoPackage est un conteneur qui vous permet de stocker des données SIG (couches) dans un seul
fichier. Contrairement au format ESRI Shapefile (par exemple le jeu de données protected_areas.shp que
vous avez chargé précédemment), un seul fichier GeoPackage peut contenir diverses données (tant vectorielles que
matricielles) dans différents systemes de référence de coordonnées, ainsi que des tableaux sans information spatiale ;
toutes ces fonctionnalités vous permettent de partager facilement les données et d’éviter la duplication des fichiers.

Pour charger une couche a partir d'un GeoPackage, vous devez d’abord créer la connexion avec celui-ci :
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1 Cliquez sur le bouton ﬂ Gestionnaire des sources de données

2. Cliquez a gauche sur 'onglet @ GeoPackage.

3. Cliquez sur le bouton Nouveau et naviguez jusquau fichier training_data.gpkg dans le dossier
exercise_data que vous avez téléchargé précédemment.

4. Sélectionnez le fichier et appuyez sur Ouvrir. Le chemin du fichier est maintenant ajouté a la liste des connexions
Geopackage, et apparait dans le menu déroulant.

Vous étes maintenant prét a ajouter n’importe quelle couche de ce GeoPackage a QGIS.

1. Cliquez sur le bouton Connecter. Dans la partie centrale de la fenétre, vous devriez maintenant voir la liste de
toutes les couches contenues dans le fichier GeoPackage.

2. Sélectionnez la couche roads et cliquez sur le bouton ajouter.

Data Source Manager | GeoPackage

I srowser Connections
- g Vector training_data.gpkg@/media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg -
r Raster New Remove
Sl
=mil Table - Type Geomelkry column Sql
Delimited Text ~ /media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg
= buildings [ MultiPolygon geom
roads " LineString geom
¥ SpatiaLite
* PostgresQL
+ MSSQL
DE2 pB2
m Virtual Layer
tﬁ WMS/WMTS
-I@:; WCs
.y WFS [ »

*
Also list tables with no geometry

'+ ArcGIS Map Server

ArcGIS Feature Search options

Server
& GeoNode @Help setFilter || «/Add % Close

Une couche roads est ajoutée au panneau couches avec les entités affichées sur le canevas de la carte.
3. Cliquez sur Fermer.

Félicitations ! Vous avez chargé la premiere couche d’'un GeoPackage.

2.2.4 Follow Along: Chargement de données vecteur a partir d’'une base de
données SpatialLite avec le navigateur

QGIS donne acces a de nombreux autres formats de base de données. Comme GeoPackage, le format de base de
données SpatiaLite est une extension de la bibliotheque SQLite. Et 'ajout d’'une couche provenant d’un provider
SpatiaLite suit les mémes regles que celles décrites ci-dessus : Créer la connexion —> L’activer —> Ajouter la ou les
couches.

Bien que ce soit une fagcon d’ajouter des données SpatiaL.ite a votre carte, explorons une autre fagon puissante d’ajouter
des données : le Navigateur.

1. Cliquez sur I'icone ‘! pour ouvrir la fenétre gestionnaire sources de données.
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. Cliquez sur I'onglet T Navigateur.

. Dans cet onglet, vous pouvez voir tous les disques de stockage connectés a votre ordinateur ainsi que les entrées

pour la plupart des onglets a gauche. Ceux-ci permettent un acces rapide aux bases de données ou aux dossiers

connectés.

Par exemple, cliquez sur I'icone déroulante a coté de I'entrée 0 GeoPackage. Vous verrez le fichier
training-data.gpkg auquel nous nous sommes précédemment connectés (et ses couches, si elles sont

développées).

. Faites un clic droit sur I'entrée f SpatiaLite et sélectionnez Nouvelle Connexion....

. Naviguez vers le dossier exercise_data, sélectionnez le fichier Landuse . sqlite et cliquez sur Ouvrir.

Notez qu’une entrée g landuse.sqlite a été ajoutée sous celle de SpatiaLite.

. Développez 'entrée @ landuse.sqlite.

. Double-cliquez sur la couche -~ landuse ou sélectionnez-la et faites-la glisser sur le canevas de la carte. Une

nouvelle couche est ajoutée au panneau couches et ses entités sont affichées sur le canevas de la carte.

E Browser
+ Vector

S Raster
ff:_ Mesh

4 Delimited Text
"ﬁ GeoPackage
,_a: SpatiaLite

- PostgreSQL

* MSSQL
D82, DB2

m Virtual Layer

& wms/wmts
L5 wes

WFs

=~
¥ ArcGIS Map Server

ArcGIS Feature
#* Server

» GeoNode

Data Source Manager | Browser

Browser
O~&THHo
i Favorites
» [ Project Home
» [&] Home
» O/
~ @ GeoPackage
~ = training_data.gpkg
2 buildings
" roads
- i’ Spatialite
~ = landuse.sqlite
@ Postcis
P mssqL
[ pB2
@ WMS/WMTS
v @ XYZ Tiles
" OpenStreetMap
@ wcs
7 WFS
) ows
& ArcGisMapServer
&) ArcGisFeatureServer
st GeoNode

Astuce:

Activez le panneau navigateur dans le menu Vue » Panneaux » et utilisez-le pour ajouter vos données.

C’est un raccourci pratique pour l'onglet gestionnaire source de donnees » navigateur, avec la méme fonctionnalité.

Note: N’oubliez pas de sauvegarder votre projet fréquemment ! Le fichier de projet ne contient aucune donnée en

18
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soi, mais il se souvient des couches que vous avez chargées dans votre carte.

2.2.5 Try Yourself Charger plus de données vecteur
Chargez les ensembles de données suivants du dossier exercise_data dans votre carte en utilisant 'une des
méthodes expliquées ci-dessus :

* buildings

* water

Réponse
Votre carte devrait avoir sept couches :
e protected_areas
e places
* rivers
* roads
* landuse
* buildings (pris dans training_data.gpkg) et

e water (pris dans exercise_data/shapefile).

2.2.6 Follow Along: Réorganisation des calques

Les calques dans votre liste de calques sont dessinés sur la carte dans un certain ordre. Le calque en bas de la liste
est dessiné en premier, et le calque en haut est dessiné en dernier. En changeant leur ordre dans la liste, vous pouvez
changer 'ordre suivant lesquel ils sont dessinés.

Note: Vous pouvez modifier ce comportement en utilisant la case & cocher contréler l'ordre du rendu située sous le
panneau ordre couches. Nous ne discuterons cependant pas encore de cette fonctionnalité.

L’ordre dans lequel les couches ont été chargées dans la carte n’est probablement pas logique a ce stade. Il est possible
que la couche des routes soit completement cachée parce que les autres couches sont au-dessus d’elle.

Par exemple, cet ordre de couche...

Layers (=]ES)
<l .@ L =3 T & E/ O 0

v| [ water

v [ buildings

v| [l landuse

v| — roads

v| — rivers

v/ * places

v [] protected_areas

... aurait pour conséquence de cacher les routes et les endroits qui passent en dessous des polygones de la couche
d’occupation des sols.

2.2. Lesson: Ajout de vos premiéres couches 19



QGIS Training Manual

Pour résoudre le probleme :
1. Cliquez et glissez sur la couche dans la légende de la carte.

2. Réorganiser-les pour obtenir ¢a :

basic_map - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEEARREREY OLALLPHPPLAAGRDNS 6 N-N-5,HE T m- -
WPV A8 B sR-FE TG0 B =qEgEags ® &

Layers (S]]
« @ ® T g~
places
v/ — roads
v| — rivers
v! [ buildings
V! [ water
v| [ ] protected_areas
v/ [l landuse

Layers | Browser

e / / // / \
Q. Type to locate (Ctrl+K) Coordinate | 204981,33.9741 | Scale 156077~ | @ Magniﬁer Rotation | 0.0° 2| VIRender @ Epsc43ze @

Vous verrez que la carte a maintenant visuellement plus de sens, avec les routes et les batiments qui apparaissent
au-dessus des régions d’utilisation du sol.

2.2.7 In Conclusion

Maintenant, vous avez ajouté toutes les couches dont vous avez besoin a partir de plusieurs sources différentes et créé
une carte de base !

2.2.8 What’'s Next?

Vous connaissez maintenant la fonction de base du bouton ouvrir le gestionnaire de sources de donnees, mais qu’en
est-il de tous les autres ? Comment fonctionne cette interface ? Avant de continuer, jetons un coup d’ceil a quelques
interactions de base avec I'interface QGIS. C’est le sujet de la prochaine legon.

2.3 Lesson: Naviguer sur le canevas de carte

Cette section se concentrera sur les outils de navigation de base QGIS utilisés pour naviguer dans le canevas de la
carte. Ces outils vous permettront d’explorer visuellement les couches a différentes échelles.

Le but de cette lecon: Apprendre a utiliser les outils Panoramique et Zoom au sein de QGIS et se familiariser avec
I’échelle des cartes.
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2.3.1 Follow Along: Outils de navigation de base

Avant d’apprendre comment naviguer dans le canevas de carte, ajoutons des couches que nous explorerons au cours
de ce tutoriel.

1. Ouvrez un nouveau projet vierge et en utilisant les étapes apprises dans Creafe a Map, chargez les couches
protected_areas, roads etbuildings vues précédemment dans le projet. La vue du résultat devrait
ressembler a I'extrait dans Fig. 2.2 ci-dessous (les couleurs n’ont pas d’importance) :

Q@

O R O HPPD " Q LR &c--8-LEE-
neViaw@ 1/ =4 9= -R &
0 12 px

Browser @
QRTHO
[ VirtualBox
v+ [ wscode
+ [ 3D Objects
naconda3

Desktop
1 Documents
Downloads
1 Dropbox (BOSTOM UNIVERSITY)
v [ eclipse
b [ eclipse-workspace
Layers
- I@ Q.Y E.J'_"_TQ
v roads
| [l buildings
v! [l protected areas

(R

0

\ Type to locate (Ctrl+K) 1leg 4| 20.2255-34.0416 ¥ ¢ 1:119950 |~ | @ r|100% SERCLE 3| v/ Render @ ppsGi4326 @

Figure2.2: Protected areas, roads et buildings ajoutes

Commengons par apprendre a utiliser 'outil Pan.

1. Dans la barre d’outils de navigation cartographique, assurez-vous que le bouton ‘{rj Pan est activé.
2. Déplacez la souris au centre de la zone du canevas de carte.

3. Cliquez sur le bouton gauche et maintenez-le enfoncé, puis faites glisser la souris dans n’importe quelle direction
pour faire un panoramique de la carte.
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Ensuite, faisons un zoom avant et examinons de plus pres les couches que nous avons importées.

1. Dans la barre d’outils de navigation cartographique, cliquez sur le bouton &~ Z°omIn_

2. Déplacez votre souris a peu pres dans la partie supérieure gauche de la zone ou la densité des batiments et des
routes est la plus élevée.

3. Cliquez sur le bouton gauche et maintenez-le enfoncé.

4. Ensuite, faites glisser la souris, ce qui créera un rectangle, et couvrez la zone dense de batiments et de routes
(Fig. 2.3).

Figure2.3: Zoom in

5. Relachez le clic gauche. Cela permettra de zoomer pour inclure la zone que vous avez sélectionnée avec votre
rectangle.
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@ *Untitled Project - QGIS — O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DoBRRY OPPL,HAPPD " QL RBLORC &¢ -KN-8-GEE -~
WOVo A MB V)R R-ZT <o B =g = - @ & H
D } '[12 2] px - | 'T’ -

Browser (=]
QRETHO

b [ VirtualBox =
v [ wscode

b [ 3D Objects
+ [ Anaconda3
+ [ AppMods

v [ Autodesk
»

v

»

Y

»

»

[ Contacts
5 Desktop
[1 Documents 7
[ Downloads L= T
1 Dropbox (BOSTOMN UNIVERSITY) -
[ eclipse ]
|+ [ eclipse-workspace
Layers =] . X
i » T &8 7 O i
— roads : 7.6 -
M buildings ' - ol .-
[T protected areas ;

1]

| & Type tolocate (Ctri+K) | 1 204849,-33.9843 |¥ /132458 v | @ r[100% |5 3 [00°  [5][v/Render @ ePsciaize @

6. Pour effectuer un zoom arriere, sélectionnez le bouton }9 Zoom Out e effectuez la méme action que pour le
zoom avant.

Lorsque vous effectuez un panoramique, un zoom avant ou un zoom arriere, QGIS enregistre ces vues dans un

historique. Cela vous permet de revenir a une vue précédente.

1. Dans la barre d’outils de navigation cartographique, cliquez sur le bouton }a ZoomLast hoyr aller & votre vue
précédente.
2. Cliquez sur le bouton }a Zoom suivant oy continuer A avancer dans votre histoire.
Parfois, apres avoir exploré les données, nous devons remettre notre vue a I’échelle de toutes les couches. Au lieu
d’essayer d’utiliser plusieurs fois I'outil Zoom Out, QGIS nous fournit un bouton pour faire cette action a notre place.
1. Cliquez sur le bouton n Zoom etendue complete

En effectuant un zoom avant et arriere, vous remarquerez que la valeur de echelle dans la barre d’état change. La
valeur echelle représente I'échelle de la carte. En général, le chiffre & droite de : représente le nombre de fois que
l'objet que vous voyez dans le canevas de carte est plus petit que I'objet réel dans le monde réel.
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Coordinate  20.6324,-34.0757 - Scale 1:128472 ~ | & Magnifier 100% +| Rotation |0.0° 5| v/ Render X @

Vous pouvez également utiliser ce champ pour régler manuellement I’échelle de la carte.
1. Dans la barre d’état, cliquez sur le champ de texte echelle.

2. Tapez 50000 et appuyez sur entrer. Cela redessinera les éléments de la carte pour refléter 'échelle que
vous avez saisie.

3. Vous pouvez également cliquer sur la flieche d’options du champ échelle pour voir les échelles prédéfinies de la
carte.

A
1:1000000 =

1:500000
1:250000
1:100000
1:50000
1:25000 |
1:10000
1:5000
1:2500
1:1000 |~

$ Scale 1:50000 -

4. Sélectionnez 1:5000. Cela mettra également a jour I’échelle de la carte dans le canevas de carte.

Maintenant, vous connaissez les bases de la navigation sur le canevas de la carte. Consultez le manuel de l'utilisateur
sur Zooming and Panning pour connaitre les autres facons de naviguer sur la carte.

2.3.2 In Conclusion

Il est important de savoir comment naviguer sur le canevas de la carte, car cela permet d’explorer et d’inspecter
visuellement les couches. Cela peut étre fait pour 'exploration initiale des données, ou pour valider les résultats d’une
analyse spatiale.

2.4 Lesson: Symbologie

La symbologie d’'une couche correspond a son apparence visuelle sur la carte. La force de base des SIG par rapport
aux autres facons de représenter des données spatiales est qu’avec les SIG, il est possible d’avoir une représentation
visuelle des données avec lesquelles vous travaillez.

Ainsi, Papparence visuelle de la carte (qui dépend de la symbologie individuelle des couches) est trés importante.
Lutilisateur final des cartes que vous produisez a besoin d’étre capable de voir facilement ce que la carte représente.
Un aspect tout aussi important est le fait que vous devez &tre en mesure d’explorer les données avec lesquelles vous
travaillez, et une bonne symbologie aide beaucoup.

En d’autres mots, posséder sa propre symbologie n’est pas un luxe ou tout simplement quelque chose d’agréable a
avoir. En fait, c’est essentiel pour vous d’utiliser un SIG proprement et produire des cartes et informations que les
gens seront en mesure d’utiliser.
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Objectif de cette lecon : Etre capable de créer n’importe quelle symbologie souhaitée pour n’importe quelle couche
vectorielle.

2.41 Follow Along: Modification des couleurs

To change a layer’s symbology, open its Layer Properties. Let’s begin by changing the color of the 1anduse layer.
1. Right-click on the 1anduse layer in the layers list.

2. Sélectionnez I'élément Propriétés dans le menu qui apparait.

Note: Par défaut, vous pouvez aussi accéder aux propriétés de la couche en double-cliquant sur la couche dans
la 1égende.

Astuce: Le bouton d en haut du panneau couches ouvrira le panneau style couche. Vous pouvez utiliser
ce panneau pour modifier certaines propriétés de la couche : par défaut, les modifications seront appliquées
immédiatement !

3. Dans la fenétre proprietes couche, sélectionnez 'onglet d symbologie :

Layer Properties - landuse | Symbology

~ |

| 2 single symbol

@ information I ¢ |

. [ simple fill

A2 source

Unit | Millimeters -
, Opacity “[1000% |-
" Diagrams ~
Color | H
ug 3D View
E Fields
E Attributes Form | 2 Favorites -| e
Joins
ﬁ Auxiliary Storage -I -
@ Actions
o gradient gray 3 fill hashed black / hashed black\,  hashed black X outline blue outline green outline red
. plasma
- Display
) r
" Rendermg : - - -
i L
Variables
. outline xpattern pattern dot pattern zelda simple blue fill  simple greenfill  simple red fill
B Metadata black
"™ Dependencies |save Symbol... | Advanced - |
Legend » Layer Rendering
&8 qais server ~| @Help || style - | SApply | % cancel |’ oK ]

4. Cliquez sur le bouton de sélection de la couleur a c6té de I'étiquette couleur. Une boite de dialogue de couleur
standard apparaitra.

5. Choisissez une couleur grise et cliquez sur OK.

6. Cliquez encore sur OK dans la fenétre Propriétés de couche, et vous verrez le changement de couleur &tre
appliqué a la couche.
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2.4.2 Try Yourself

Change the color of the water layer to light blue. Try to use the Layer Styling panel instead of the Layer Properties
menu.

Solution

 Vérifiez que les couleurs changent bien comme vous le souhaitez.

« It is enough to select the water layer in the legend and then click on the ‘& Open the Layer Styling panel o
Change the color to one that fits the water layer.

symbology - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEBRRRY OUPALAHRPPLAALBORS 6 N-0-5FEHHE 2 =~ I

BEV. AW # /B2 2T %0 0 mafl%s s ® 4 B
Layers ® Layer Styling ®
o 0l e TE-F » (= water -
N & = Single symbol -
7] ] simple fill
v || water
[
v [[] landuse
& OaflY
unit | Millimeter x| =
OpaCity e—— | 100.0% |+
Color
g . Favorites a|-| i

b Layer Rendering

Layers | Browser oo V| Live update | « Apply

2 Type to locate (Ctri+K) Coordinate | 20.5265,-33.9850 |95 Scale  1:50008 - | @ Magnifier 100% ~| Rotation |0.0°

%[V Render & EPSG4326 @

Si vous voulez travailler sur une couche a la fois et vous ne voulez pas étre distrait par les autres couches, vous pouvez
cacher une couche en décochant la case a c6té de son nom dans la liste des couches. Si la case est décochée, la couche
est cachée.

2.4.3 Follow Along: Modification de la structure des symboles

Ce sont de bonnes choses jusqu’a présent, mais il y a plus que juste sa couleur dans la symbologie d’une couche. Par
la suite, nous €liminerons les lignes entre les différentes zones d’utilisation du sol afin de rendre la carte visuellement
moins encombrée.

1. Open the Layer Properties window for the 1anduse layer.
Sous 'onglet (\{ Symbologie, vous verrez le méme type de dialogue qu’auparavant. Cette fois, cependant,
vous faites plus que changer rapidement la couleur.

2. Dans Tlarbre des couches de symboles, développez le menu déroulant remplissage et sélectionnez 'option
remplissage simple.

3. Cliquez sur le menu déroulant style de ligne. Pour I'instant, il devrait afficher une ligne courte et les mots ligne
continue.

4. Changez cette option pour Pas de ligne.
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Layer Pro ies - landuse — Symbology
| single symbol - |
fi Information 3 ~ [ Fill | @ |
[ simple Fill
;-':‘- Source —
|Cd) | &)
Qf Symbology
€I Labels
BB Masks symbol layer type| Simple Fill - |
Sy 30 View Fill olor N | €,
'. Diagrams Fill style |- Solid = | =8
i oo stroke color N | =,
E Attributes Form stroke width |0'260000 = |'| |M|II|meter5 M | 1=
: Stroke style | Mo Line - | el
Joins
. Join style |a Bevel hd | L=l
£ ) Auxiliary Storage
x | 0,000000 | ——
&} Actions Offset |Mi|limeters - | L=l
y | 0,000000 |: -
- Display
¢_' Rendering V| Enable symbol layer €=, Draw effects
“ Temporal P Layer Rendering
Variables = | B Aide | | Style '| v Ok l |\/ﬁppliquer | | & Annuler |

5. Cliquez sur OK.

Now the 1anduse layer won't have any lines between areas.

2.4.4 Try Yourself

* Change the water layer’s symbology again so that it has a darker blue outline.
* Change the rivers layer’s symbology to a sensible representation of waterways.
Rappelez-vous : vous pouvez utiliser le bouton d ouvrir le panneau style couche ot yoir tous les changements

instantanément. Ce panneau vous permet également d’annuler des modifications individuelles tout en symbolisant
une couche.

Réponse

Votre carte devrait ressembler a ceci :

2.4. Lesson: Symbologie 27



QGIS Training Manual

symbology - QGIS 0

Project Edit View Layer Settings Plugins Vector Raster Database Web Help
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Q & O allw
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’ color | NN
Wwidth | 0.36000 ERES
<. Favorites a |- a
» Layer Rendering
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Si vous étes un utilisateur débutant, vous pouvez vous arréter ici.
« Utilisez la méthode ci-dessus pour changer les couleurs et les styles pour toutes les autres couches.

» Essayez d’utiliser des couleurs naturelles pour les objets. Par exemple, une route ne devrait pas étre rouge ou
bleue, mais peut étre grise ou noire.

* N’hésitez pas non plus a expérimenter avec des parametres différents de Fill style et de Stroke style pour les
polygones.

symbology - QGIS 0
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DoBRRRY O PLAHPPAALGRBRNRS @ H-N-LEE I & [0

¥ 7 B & = 7 ™ @ a abe| (abgl (abel (abe b
GV LR /BRZ-B2T=808 =4wH{ugag59 R4 B KK
Layers ax® : Layer Styling a®
< 0 e TE-F » 9 buildings -
v/ @ places = single symbol -
¥ — roads
v — rivers e AU
v [l buildings / - W simple il
! [] water ; : :
v/ [ protected_areas ) : vy ’l
v/ [ landuse 1 ¢
4 | EEhrnny
S s
3 unit  Millimeter M=
Opacity _11100.0 % ~
Color I
< Favorites a|-r| i
b Layer Rendering
Layers | Browser / b & V! Liveupdate | « Apply
Q Type to locate (Ctrl+K) Coordinate| 20.5355-33.9815 |§ Scale 1:53664 ~ | @ Magnifier 100% | Rotation |0.0° +| v Render & EPsG4326 @
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2.4.5 Follow Along: Visibilité dépendante de I'échelle

Parfois, vous trouverez que la couche ne fonctionne pas pour une échelle donnée. Par exemple, un jeu de données de
tous les continents peut avoir peu de détails, et ne pas €tre tres précis au niveau d’'une rue. Quand cela se passe, vous
voulez étre capable de cacher le jeu de données aux échelles inappropriées.

Dans notre cas, nous pouvons décider de cacher les batiments a la vue a petite échelle. Cette carte, par exemple. ..

symbology - QGIS o

Project Edit View Layer Settings Plugins WVector Raster Database Web Help

DEBREERE UPLPL A HNPPLALAGBRIRQ 6 N-N-FEEE & [0
REV.A® #/BRR-BT =0 B "4 HYEBEL R 2 « X

Layers @&
« il ® T &~ »
v| = places
V| — roads
V| — rivers
v! [[] buildings
v/ [ | water

I protected_areas

v landuse

Layers = Browser

Q Type to locate (Ctrl+K) sordinal| 20.7122,-33.9589 |¥ :al| 1:150104 ~| @ agnifil| 100% = | otatic | 0.0° | ¥ Render % EPSGi4326 @

... n'est pas tres utile. Les batiments sont difficiles a distinguer a cette échelle.
Pour autoriser le rendu selon I'échelle :

1. Open the Layer Properties dialog for the buildings layer.

2. Activez l'onglet f rendu.
3. Activez le rendu basé sur I'échelle en cliquant sur la case a cocher intitulée visibilité dépendante échelle :

4. Changez la valeur de Minimum 2 1:10000.
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Layer Properties - landuse — Rendering

w v Scale Dependent Visibility

fi esifEn Minimum (exclusive) Maximum (inclusive)
1:10000 - | | &R~ 0 ~ | |&R|-
;{s} Source ﬁ ﬁ)
-‘\. symbology v Simplify Geometry
a3 Label Mote: Feature simplification may speed up rendering but can result in rendering inconsistencies
abels

Simplification threshold (higher values result in more simplification) 1,00 2| pixels
€D masks - ) -

Simplification algorithm Distance -~
"I
N D View Simplify on provider side if possible {(Not supported)
Sl oy - - . - . . . -

1 Diagrams Maximum scale at which the layer should be simplified (1:1 always simplifies) | 1:1 -

E el b Fixed Reference Scale
E Attributes Form P Selections

Force layer to render as a raster (may result in smaller export file sizes)
Joins
Refresh layer at interval

-

Auxiliary Storage

1O,

Actions

Display

a- Temporal

VELEL

Refresh layer on notification Only if message | |

-

10 Elevation

i Aide Style - v Ok « Appliquer | | & Annuler

5. Cliquez sur OK.

Test the effects of this by zooming in and out in your map, noting when the buildings layer disappears and
reappears.

Note: Vous pouvez utiliser votre molette de souris pour zoomer par incrément. Une alternative est d’utiliser 'outil
de zoom pour zoomer sur une fenétre.

e

2.4.6 Follow Along: Ajout de couches de symbole
Maintenant que vous savez comment changer une simple symbologie pour des couches, la prochaine étape est de
créer des symbologies plus complexes. QGIS vous permet de faire cela en utilisant les couches de symboles.

1. Go back to the 1anduse layer’s symbol properties panel (by clicking Simple fill in the symbol layers tree).

Dans cet exemple, le symbole courant n’a pas de bordure (c’est-a-dire que le style de bordure Pas de crayon est
utilisé).
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Laye es - landuse — Symb

| Z single symbol

fi Information ~ [ Fill |@|
[ simple Fill
;.':‘- Source =
|Cd) | &)
d Symbology
€I Labels
D Mask symbol layer type| simple Fill - |
g 30 View Fll color S | €,
'. Diagrams Fill style |- Solid = | L=
i oo stroke color N | =,
E Attributes Form stroke width |0,260000 = |'| |M|II|meter5 M | 1=
: Stroke style | Mo Line - | el
Joins

. Join style |a Bevel hd | L=l

£ ) Auxiliary Storage
x | 0,000000 | ——

&} Actions Offset |Mi|limeters - | L=l
: y | 0,000000 o —
. Display
& ’ Rendering V| Enable symbol layer =] Draw effects
ﬁ Temporal P Layer Rendering

- | i Aide | | Style -| l v Ok l |\/ﬁppliquer | | & Annuler |

VELEL

2. Sélectionnez le niveau Remplissage dans I'arbre et cliquez sur le bouton Ifl-l:l-l:| Ajouter le symbole de couche T o dialogue
va changer pour ressembler a ceci, avec une nouvelle couche de symboles ajoutée :
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Layer Properties - landuse | Symbology .

= Single symbol =
G’ Information ~ H Fill
Simple Fill =l
33 source [X simple Fill .
' =E
& symbology
€@ Labels
symbol layer type Simple Fill -
D Masks 4 ver typ s
. i O
S Fill color [=h
Fill style I solid -
WF 3D View 2 &
stroke color | [ - <.
E Fields
Stroke width | 0,260000 @ |7 |Millimeters K =N
E Attributes Form —
Stroke style | ——Solid Line - | €
Joins Join style 1 Bevel K=
ﬁ Auxiliary Storage x | 0,000000 -
Offset Millimeters -
{;@ Actions y | 0,000000 =
® oisplay v| Enable symbol layer 4=, Draw effects
Qj;/ Rendering
» Layer Rendering
e dblee @Help Style -~ «/Apply || % cCancel / OK

-

11 peut sembler quelque peu différent en couleur, par exemple, mais vous allez quand méme le changer.

Désormais, vous avez deux couches de symbole. La nouvelle étant de remplissage continu, elle masquera
completement I'ancienne. De plus, elle posséde un style de bordure Ligne continue, que nous ne voulons pas.
Actuellement, ce type de symbole n’est clairement pas ce que I'on souhaite et doit étre changé.

Note: Un point tres important est de ne pas confondre une couche et une couche de symbole. Une couche est un
ensemble de vecteurs (ou une image raster) qui a été chargé dans la carte. Une couche de symbole est une partie
des symboles utilisés pour représentés la couche. Dans ce cours, nous ferons toujours la distinction et ce, pour éviter
toute confusion.

Avec la nouvelle couche de symbole Remplissage simple sélectionnée :
1. Mettez le style de bordure a Pas de crayon, comme avant.

2. Changez le style de remplissage avec quelque chose d’autre que Continu ou Pas de brosse. Par exemple :
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[T rties - landuse — Symbology v oA X
&[S singlesymbol =
(3 information ] - & Fin ||
I simple Fill =[v
S mple i (=) (V]
AW Source I simple Fill =
| (&)
d Symbology
€3 Labels
B Masks Symbol layer typel Simple Fill = |
N 30 View Fill color S - €
'I Diagrams Fill style H:Hi Cross - | S
g oo stroke color |
E ., — Stroke width 0,260000 a |,,| | Millimeters = | L =8
Stroke style | Mo Line - | L el
Joins
. Join style |“ Bevel = | el
£ ] Auxiliary Storage
x | 0,000000 [ —
B} Actions Offset |Mi|limeter5 - | el
y | 0,000000 s
- Display
V| Enable symbol layer =], Draw effects
4 Rendering
ﬁ Temporal b Layer Rendering
) = | B Aide | | Style '| v Ok l |\/ﬁppliquer | | © Annuler |

3. Cliquez sur OK.

Vous pouvez maintenant voir vos résultats et les modifier si nécessaire. Vous pouvez mé€me ajouter plusieurs couches
de symboles supplémentaires et créer ainsi une sorte de texture pour votre couche.

O |- |
4 simple Fill
IF simple Fill
] simple Fill

Joli ! Mais il y a trop de couleurs pour pouvoir 'utiliser dans une belle carte.
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2.4.7 Try Yourself

Remembering to zoom in if necessary, create a simple, but not distracting texture for the buildings layer using
the methods above.

Réponse

Customize your buildings layer as you like, but remember that it has to be easy to tell different layers apart on
the map.

Voici un exemple :

symbology - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Help

NEBERRY O o2 8PP, &6 -N-N-FEET -
BV, A W JBRR-Z O <8 B w6 B ey oumem > @A . »

Layers ()] w&“ %a %
¢ BT E-BAO R

v/ * places

v — roads

v — rivers

v [ buildings

v| [ ] water

v/ [ ] protected_areas
v landuse

Layers & Browser

Q Type to locate (Ctrl+K) 1| 20.45040-34.01345 9 | 1:5000 ~| @ r|[100% >l 1 |00° +| v/ Render % EpsG432e @

2.4.8 Follow Along: Classement des niveaux de symbole
Quand des couches de symboles sont dessinées, elles sont, tout comme des couches, dessinées dans un certain ordre.
Dans certains cas, des résultats inattendus peuvent apparaitre avec plusieurs couches de symboles.
1. Give the roads layer an extra symbol layer (using the method for adding symbol layers demonstrated above).
2. Donnez a la ligne une Largeur de trait de 1 . 5 et une couleur noire.
3. Donnez a la nouvelle couche supérieure une épaisseur de « 0,8 » et une couleur blanche.

Ce qui devrait donner cela :
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)

BN\

Eh bien, les routes ont maintenant une symbologie de type rue, mais vous voyez que les lignes se chevauchent a chaque
croisement. Ce n’est pas du tout ce que nous voulons !

Pour éviter que cela advienne, vous pouvez trier les niveaux de symboles et ainsi choisir dans quel ordre les couches
de symboles se dessinent.

Pour changer 'ordre des couches de symboles :
1. Sélectionnez la couche supérieure Ligne dans I'arbre des couches de symboles.

2. Cliquez sur avance » niveaux de symbole... dans le coin inférieur droit de la fenétre.

Layer Properties - training_data — roads — Symbology

= single symbol -
q Information ¥ = Line o
Simple Line
q\:\} Source = Simple Line
&¢ symbology
Labc WIELT
€D Masks color | (| -
“‘ 3D View Bhaniy 100,0 % €
: Width | 1,50000 2| | Millimeters MEKES
Diagrams
E Fields O, Favorites a|~| 8t
Attributes Form Default
Joins
------------------------ =
ﬁ Auxiliary Storage
r.@ Actions dash black dash blue dash green dash red effect emboss —

@ oisplay = =

¢/ Rendering

p Layer Rendering
0 Temporal —| BlAide Style ~
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Cela permettra d’ouvrir un dialogue comme celui-ci :

symbol Levels S

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

@Help oK

-

* Cancel &

=

3. Check o Activer les niveaux de symboles. Vous pouvez ensuite définir I'ordre des couches de chaque symbole
en entrant le numéro du niveau correspondant. 0 est la couche inférieure.

Dans notre cas, nous voulons juste activer I'option, comme ceci :

symbol Levels 0

v| Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

Layer O Layer 1

—_ = ) 1

@Help % Cancel

7
-
(o
-~

Cela rendra la ligne blanche au-dessus des limites de la ligne noire épaisse :
4. Cliquez deux fois sur OK pour retourner a la carte.

La carte doit maintenant ressembler a cela :
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Lorsque vous avez terminé, n’oubliez pas de sauvegarder le symbole lui-méme afin de ne pas perdre votre travail si
vous changez a nouveau le symbole a I'avenir. Vous pouvez sauvegarder votre style de symbole actuel en cliquant sur
le bouton Sauvegarder style ... en bas de la boite de dialogue Proprietes couche. Nous utiliserons le format fichier
QGIS QML Style.

Enregistrez votre style dans le dossier solution/styles/better_roads.gml. Vous pouvez a tout moment
charger un style précédemment sauvegardé en cliquant sur le bouton Charger style.... Avant de modifier un style,
gardez a I'esprit que tout style non sauvegardé que vous remplacez sera perdu.

249 Try Yourself

Change the appearance of the roads layer again.

Les routes doivent étre étroites et jaunes, avec un fin contour gris pale et une fine ligne noire au milieu. N’oubliez pas
que vous devrez peut-étre modifier I'ordre de rendu des couches via le dialogue Avance » Niveaux de symboles....

Réponse

Pour créer le symbole voulu, vous avez besoin de trois couches de symboles :
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Layer Properties - roads (triple_levels) | Symbology

| & single symbol -
@ information gd _—tLine |
— Simple line
A% source simple line
= Simple line
& symbology
€2 Labels —
| | ollallv
— e
. Diagrams
~ Unit  Millimeter -
Ny 3D View Opacity 1/100.0% |+
E SourceFields eyl ]
Attributes <
Form width | 2.10000 2 a
Joins
. Auxiliary | @ Favorites a -8
&1 storage -
@ Actions
N - e e eeeeee oy ——
. Display
‘ Rendering dash black dash blue dash green dash red effect emboss effect neon
Variables [l |save Ssymbol| | Advanced ~|
ah Metadata
P Layer Rendering
& Dependencies .| @Help || style - | «/Apply || %cancel |’ oK ]

La couche de symbole la plus basse est une ligne grise, large et pleine. Par-dessus se trouve une ligne jaune plus fine
et pleine ; finalement, on ajoute une ligne noire pleine encore plus fine.

Si vos couches de symboles ressemblent a ci-dessus mais vous n’obtenez pas le résultat voulu :

1. Vérifiez que vos niveaux de symboles sont définis comme ceci :

Symbol Levels

v Enable symbol levels

Define the order in which the symbol layers are
rendered. The numbers in the cells define in which
rendering pass the layer will be drawn.

Layer 0 Layer 1 Layer
= =0 1 —2
[] >
| @Help | | % cancel |[ « OK ]

2. A présent, votre carte devrait ressembler a ceci :
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2.410 Try Yourself

Les niveaux de symboles fonctionnent également pour les couches classées (c’est-a-dire les couches ayant plusieurs
symboles). Comme nous n’avons pas encore abordé la classification, vous travaillerez avec quelques données
rudimentaires pré-classifiées.

1. Create a new project and add only the roads dataset.

2. Appliquez a la couche le fichier de style advanced_levels_demo.qgml disponible dans le dossier
exercise_data/styles. Cette opération peut s’effectuer via le menu déroulant Style » Charger Style...
en bas de la fenétre des Propriétés de la Couche.

3. Zoomez sur la zone Swellendam.

4. Grace aux couches de symboles, créez une carte ou les intersections des routes semblent connectées les unes
avec les autres comme dans I'image suivante :
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Réponse

1. Ajustez les niveaux de symbole avec ces valeurs :

Symbol Levels B

¥| Enable symbol levels

Define the order in which the symbol layers are
rendered. The numbers in the cells define in which
rendering pass the layer will be drawn.

Layer 0 Layer 1
T Trunk | 3
—|Tertiary LI 2
= Unclassified == 0 1

@Help % cancel

1. Essayez des valeurs différentes pour obtenir des résultats différents.

2. Réouvrez votre carte d’origine avant de continuer avec I'exercice suivant.
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2.4.11 Follow Along: Types de couches de symbole

En plus de définir les couleurs de remplissage et d’utiliser des motifs prédéfinis, vous pouvez utiliser différents types
de couches de symboles. Le seul type que nous utilisions jusqu’a présent était le type Remplissage simple. Les types
de couches de symboles plus avancés vous permettent de personnaliser encore plus vos symboles.

Chaque type de vecteur (point, ligne et polygone) a son propre set de types de couche de symbole. Premierement,
nous allons voir les différents types possibles pour les points.

Types de couches de symbole de point

1. Uncheck all the layers except for places.

2. Change the symbol properties for the places layer:

Layer Properties - places | Symbology
| = single symbol ]

'rf Information

@ Simple marker

;.'@ Source

Q’ Symbology

€2 Labels

€D Masks Unit | Millimeters -
Opacity 111000% <
Size  |2,00000 EK=E
B rietos Rotation |0,00° BE=E

E Attributes Form | . Favorites al-| 8

. Diagrams

Color |

Wg 3D View

Joins

ﬁ Augxiliary Storage ® O @ O O *

@ Actions

: had
- Display shadow

dot black dot white dot blue dot green dok red effect drop

4 Rendering B @ ®

Variables

. shield disability topo hospital  topo pop capital
a Metadata

|save Symbol... | |Advanced - |

M Dependencies |_| =

» Layer Rendering
[ @relp |[ syie - _Jaoply || ®cancel |[ ok

3. Vous pouvez accéder aux différents types de couches de symboles en sélectionnant la couche Marqueur simple
dans l'arbre des couches de symboles, puis cliquez sur le menu déroulant Type de couche de symbole :
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Layer Properties - places | Symbology

Q = Single symbol -

Ellipse marker

fi Information

Filled marker

15
W Source Font marker

(0t}

& symbology Geometry generator
a3 Label Mask

Labels
Raster image marker —

O Masks symbol layer type[STiTE El TN

- : . SVG marker
. [MELEINE Size .
Vector field marker
Np 3D View Fill color N | S
E Fields stroke color | (I - <.
E Attributes Form Stroke style | —— Solid Line ~| &
. Stroke width | Hairline || Millimeters ~| &
Joins
. Join style 5 Bevel ~| S
ﬂ Augxiliary Storage
Rotation 0,00° = EL
o actions 0,000000 =
) X0, -
® Display Offset Millimeters ~| &
y | 0,000000 =
rd .
4  Rendering VCenter MRS
Anchor point
VELELIES . HCenter -~ &
[ Metadata
& OCO0AAKXT@++X 1| > D
ﬁ Dependencies £ a O O |_| I\ /] “ a -

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Ftudiez les différentes options qui s'offrent & vous, et choisissez un symbole avec un style que vous pensez
approprié.

5. En cas de doute, utilisez un marqueur rond Simple avec un bord blanc et un remplissage vert pale, avec un taille
de 3.00 et une largeur de trait de 0. 5.

Types de couches de symbole de ligne

Pour voir les différentes options disponibles pour les données lignes :

1. Change the Symbol layer type for the roads layer’s topmost symbol layer to Marker line:
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Layer Properties - roads | Symbology
| = single symbol

G‘ Information ~ — Line | g |

3 | Simpleline
"W Source e -
Q’ Symbology Geometry generator
Hashed line
€3 Labels .
Marker line &
O Masks symbol layer type Simple line
- . -
b Color | | <.
N7 3D View Stroke width | 0,260000 a [3||Milimeters -~ | &,
E Fields Offset 10,000000 2| | millimeters  ~ | &
E P — stroke style | ——Solid Line K=
: Join style | B Bevel -~ &
Joins
Cap style | I square = | <

=8 Augxiliary Storage
':" Use custom dash pattern

@ Actions

Display

| Millimeters - &

" Rendering
Variables
{ Metadata
v| Enable symbol layer 4=, Draw effects

Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

2. Sélectionnez la couche Marqueur simple dans I'arbre des couches de symboles. Modifiez les propriétés du
symbole pour qu'elles correspondent a ce dialogue :
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Layer Properties - roads | Symbology
| = single symbol

"i Information ~ -+ Line |E|
* . - Marker line

;{s} Source v - Marker

Q/ Symbology

""""" jla

€3 Labels
EED Masks symbol layer type Simple marker - 1=
: Diagrams Size 0,500000 |$| | Millimeters ~| &
.." 3D View Fill color | E| (=8
B s stroke color | MM | <,
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
& actions 10,000000 [ P
- x y -
- Offset | Millimeters - &
O oisplay y |0,000000 B
& Rendering \VCenter - &
Variables Anchor point 'HCenter aK=E
| Metadat:
AT D000AAK T @++X | > b
"™ Dependencies Dd aoif hA M a -
P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Sélectionnez la couche marqueur ligne et changez I'intervalle en 1. 00 :
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Layer Properties - roads | Symbology x

Q = Single symbol -

fi Information v = Line g

3

"W Source + - Marker =
simple marker L2

@' Symbology

€3 Labels

B Masks symbol layer type| Marker line -

: Diagrams Marker placement =,

N7 3D View ® withinterval | [0 2| Millimeters  ~ | &

E Fields (! on every vertex

() on last vertex only

E Attributes Form ) )
! on first vertex only

Joins (! on central poink
ﬁ Auxiliary Storage ("' on central point of segments
; () on every curve point
{;@ Actions
. Offset along line 0,000000 %! Millimeters ~| &
- Display
) ¥ Rotate marker to Follow line direction
4 Renderin u || TS
J Average angle over | 4,000000 < | Millimeters ~| &
R Line offset 0,000000 +| | Millimeters  ~ €L
E Metadata
- v
ﬁ R Enable symbol layer 4=, Draw effects
L]

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Assurez-vous que les niveaux de symboles sont corrects (via la boite de dialogue menuselection:Avancé —>
Niveaux de symboles, étudiée auparavant) avant d’appliquer le style.

Une fois appliqué, visualisez le résultat sur la carte. Comme vous pouvez 'observer, ces symboles suivent les directions
des routes mais ne les suivent pas parfaitement partout. Cet aspect peut étre utile dans certains cas, dans d’autres pas
du tout. Si vous préfériez le style précédent, vous pouvez lui affecter de nouveau son style d’origine.

Types de couches de symbole de polygone

Pour voir les différentes options possibles pour les données polygones :
1. Change the Symbol layer type for the water layer, as before for the other layers.
2. Etudiez ce que les différentes options de la liste peuvent faire.
3. Choisissez 'une d’entre elles que vous trouvez adéquate.

4. Si vous doutez, utilisez le Motif de point avec les options suivantes :
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Layer Properties - water | Symbology
& [Ssinglesymbol

"i Information - Fill |E|
~ °  Point pattern fill
v © Marker

° Q]3]

- |

-?& Source

Q’ Symbology

€3 Labels
EED Masks symbol layer type Simple marker - 1=
: Diagrams Size 2,000000 |$||Millimeter5 ~| &
.r' 3D View Fill color | E| (=8
B s stroke color | (N | =,
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
& actions 10,000000 [ P
- x y -
- Offset | Millimeters - &
O oisplay y |0,000000 B
4" Rendering \VCenter K=
Variables Anchor point 'HCenter aK=E
 srctad
B mecadoro OCO00CAANXTO@F+F X | DD
"™ Dependencies Dd aoif hA M a -
P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |
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Layer Properties - water | Symbology
& [Ssinglesymbol

%) Information ~ . . Fill | |

a cooo Point pattern Fill
"W Source o000 v © Marker — =
o000 © simple marker |E| |Q|
Q’ Symbology o000
€3 Labels
B Masks symbol layer type Point pattern fill - |
: Diagrams Distance
Horizontal |4,000000 <| | Millimeters K =R
N7 3D View [ | <] |
Vertical | 4,000000 2| Millimeters  ~| &
E Fields .
Displacement
B8 Attributes Form Horizontal | 0,000000 4| Mmillimeters  ~| &
Joins Vertical | 0,000000 4| Mmillimeters  ~ | &
L Offset
5" Augxiliary Storage
Horizontal | 0,000000 2| Millimeters  ~| &
@ Actions - —
Vertical | 0,000000 2| Millimeters  ~| &
- Display
g. Rendering
Variables
E Metadata
v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

5. Ajoutez une nouvelle couche de symbole avec un Remplissage simple normal.
6. Mettez-lui le méme bleu clair avec une bordure bleu foncé.

7. Déplacez-la sous la couche de symbole en motif de points a I'aide du bouton Descendre.
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Layer Properties - water | Symbology X

Q = Single symbol -

fi Information ~ | Fill o
2 simple Fill = @

"% Source » . . Point pattern Fill Olla
& symbology -
€3 Labels
B Masks symbol layer type Simple Fill -
-

, Diagrams Fllcolor | M - (=,
N7 3D View Fill style I solid -la
E Fields stroke color | (I - =
E P — Stroke width | 0,260000 = | Millimeters ~| &

. Stroke style |—— Solid Line K=k
Joins
. Join style 5 Bevel ~| S
E_" Augxiliary Storage -
X | 0,000000 -
@ Actions Offset Millimeters -
. y | 0,000000 =
- Display
/ .
4 Rendering
Variables

E Metadata

ﬁ Dependencies v| Enable symbol layer <=, Draw effects
P Layer Rendering
@Help Style - «/ Apply || % Cancel o OK

Par conséquent, vous avez un symbole texturé pour la couche de I'eau, avec le bénéfice supplémentaire que vous
pouvez changer la taille, la forme et la distance des pointillés individuels qui composent la texture.

2412 Try Yourself

Apply a green transparent fill color to the protected_areas layer, and change the outline to look like this:
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Réponse

Voici un exemple de la structure du symbole :

Layer Properties - protected_areas | Symbology
| = single symbol -

"rf Information ~ . Fill

Marker line Nhkddk
;-'o_';_\ Source ~ 4 Marker : :
+ Simple marker ) >
w' symbology simple Fill ayvvvy
€2 Labels — — — — —
1®||=|8laallY]
. Diagrams
symbol layer type| Outline: Marker line v| =
u# 3D View
Marker placement <,
E Source Fields ® with | | I la
®) with interval |3.000000 = Millimeter -
Attributes
Form ) on every vertex
Joins ) on last vertex only
&% Auxiliary ) on first vertex only
L Storage )
: _! on central point
& Actions ]
- ! on every curve point
Display y | PP
Offset along line | 0.000000 || Millimeter -~ &
& Rendering ¥| Rotate marker
Variables Line offset |0.000000 /| Millimeter K=
!h Metadata T I
P Layer Rendering
™ Dependencies _| @Help | stle -| | «/Apply || ®cancel |’ «/ OK ]
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Layer Properties - protected_areas | Symbology

| 2 single symbol -

- LI
(3" information ¥ .7 Fill

¥ i 4 Marker line ey
;{g\ Source * 4+ Marker - -
: 1 1
& symbology simple Fill avrvyy
€3 Labels — S
- [&)[=][a)[E)[al[
d Diagrams
Symbol layer type| Simple marker v| =
W 3D View
Size |2.200000 2| | Millimeter -~ e
E Source Fields .

: i ]
Attributes il | l;| &
— Stroke color | H (=R
Joins -

o stroke style | ——Solid Line aK=E
=~ Auxiliary
& B storage Stroke width | 0.200000 @ ||| Millimeter K =N
@ Actions Join style | B Bevel - a
. Display Rotation |0.00° |:| (=
e = x | 0.000000 ]
& Rendering Offset | | Millimeter aK=E
Variables y |0.000000 |'|
| vcenter K =

ah Metadata

P Layer Rendering

™ Dependencies _| @Help | style -| | «/Apply || %cancel |’ «/ OK ]

2.4.13 Follow Along: Symbologie du générateur de géométrie
Vous pouvez utiliser la symbologie du générateur de géométrie avec tous les types de couches (points, lignes et
polygones). Le symbole résultant dépend directement du type de couche.

Tres brievement, la symbologie du générateur de géométrie vous permet d’effectuer quelques opérations spatiales au
sein de la symbologie elle-méme. Par exemple, vous pouvez exécuter une opération spatiale de centroide réel sur une
couche de polygones sans créer de couche de points.

De plus, vous disposez de toutes les options de style pour modifier 'apparence du symbole résultant.
Essayons !
1. Select the water layer.

2. Cliquez sur Remplissage simple et changez le type de couches de symbole en Générateur de géométrie.
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(] Centroid Fill
| Z single symbol

G‘ Information

Geometry ge'?eratcr
Gradient fill

Line pattern Fill
Point pattern Fill
Random marker Fill 3

-?& Source

Q’ Symbology

Raster image Fill
€3 Labels SVG Fill
Shapeburst Fill

B Masks symbol layer typ
simple Fill
-
, Diagrams Fill color | Outline: Arrow
.r' 3D View Fill style | Outline: Hashed line
- | Outline: Marker line
i Stroke color
E Fields Outline: simple line
E Attributes Form Stroke width | 0,260000 @ [7[|Millimeters ~ T &
. Stroke style | ——Solid Line -~ &
Joins
. Joinstyle | T Bevel -~ &
E" Augxiliary Storage -
x |0,000000 S —
1B Actions Offset - | Millimeters ~|
y | 0,000000 2] R
Display
" Rendering
Variables
{ Metadata
v| Enable symbol layer 4=, Draw effects

Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Avant de commencer a écrire la requéte spatiale, nous devons choisir le type de géométrie en sortie. Dans cet
exemple, nous allons créer des centroides pour chaque élément, donc changez le type de géométrie en Point /
Multipoint.

4. Maintenant, écrivons la requéte dans le panneau de requéte:

{centroid($geometry) ]
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Layer Properties - water | Symbology
& [Ssinglesymbol

"i Information ~ @ Fill |E|

an
W Source ~ @ Marker e
® simple marker |E| |ﬂ|

Q’ Symbology
€3 Labels
B Masks Symbol layer type| Geometry generator v|
: Diagrams Geometry type | " Point / MultiPaint - |
ﬁ 3D View centroid{$geometry) |E|
E Fields
E Attributes Form

Joins
ﬁ Augxiliary Storage
@ Actions
- Display
&  Rendering

Variables
E Metadata 4 L

v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

5. When you click on OK you will see that the water layer is rendered as a point layer! We have just run a
spatial operation within the layer symbology itself, isn’t that amazing?
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a *chapter_3 - QGIS [tm] - 8 ox
Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
BEBRR O:FEL2HPP R4 LR e S-E-LEE¥Is-9 0.
/ = 3 Qae ~9- B A " W
Layers EE]
- .
o @ ® TV &AL
e
v L]
°
P
®
water
1]
.
° °
° .
. °
. .
°
° °
°
. °
°
°
°
° e
.
°
Layers | Browser
Type to locate (Ctrl+K Coordinate| 20.4963.-33.9835 |® Scale|1:34265 |~ @ Magnifier| 100% 2| Rotation |0.0° %V Render @ EPSG:4326 @

Avec la symbologie du générateur de géométrie, vous pouvez vraiment dépasser les limites de la symbologie normale.

Try Yourself

Les générateurs de géométrie ne sont qu’'un autre niveau de symbole. Essayez d’ajouter un autre Remplissage simple
sous celui du Générateur de géométrie.

Modifier également I'apparence du marqueur simple de la symbologie du générateur de géométrie.

Le résultat final devrait ressembler a ceci :
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Réponse

1. Cliquez sur le bouton ':II-I:II-:I pour ajouter un niveau de symbole.

v

2. Déplacez le nouveau symbole en bas de la liste en cliquant sur le bouton .
3. Choisissez une couleur appropriée pour remplir les polygones d’eau.

4. Cliquez sur le Marker de la symbologie de générateur de géométrie et remplacez le cercle par une autre forme
de votre choix.

5. Expérimentez d’autres options pour obtenir plus de résultats utiles.
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2.4.14 Follow Along: Créer un remplissage SVG personnalisé

Note: Pour faire cet exercice, vous aurez besoin d’installer le logiciel gratuit d’édition vectorielle Inkscape.

1. Lancez le programme Inkscape. Vous verrez l'interface suivante :

000 \ New document 1 - Inkscape
File Edit View Layer Object Path Text Filters Extensions Help

LBEéa Bk DD Q@@ TEaE <& PTeBE *B@

B & a px G || affect [E_.Hﬁ‘@l"z‘
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i
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0
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i

:

(= =1
N HE B U INN EEEENS | | | L | | N
<€ > G
Me  wa o & @ [-tayer1 2 | No objects selected. Click, Shift-+lick, or drag around objects to select X i 2% 3

Vous pouvez la trouver familiére si vous avez utilisé d’autres programmes d’édition d’'image vectorielle, comme
Corel.

Premierement, nous allons changer le canevas a une taille appropriée pour une petite texture.

2. Cliquez sur I'élément du menu Fichier » Propriétés du document. Cela vous ouvrira la boite de dialogue
Propriétés du document .

Changez les Unités en px.
Changez largeur et la hauteur en 100.
Fermez la boite de dialogue quand c’est fait.

Cliquez sur I'élément du menu Vue » Zoom » Page pour voir la page sur laquelle vous &tes en train de travailler.

N AW

Sélectionnez 'outil Cercle.

2.4. Lesson: Symbologie 55


https://inkscape.org/

QGIS Training Manual

0060 '\ New document 1 - Inkscape
File Edit View Layer Object Path Text Filters Extensions Help
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8. Cliquez et faites glisser sur la page pour dessiner une ellipse. Pour que I'ellipse devienne un cercle, tenez appuyé
le bouton ctrl pendant que vous dessinez.

9. Faites un clic droit sur le cercle que vous venez de créer et ouvrez Remplissage et Contour Vous pouvez modifier
son apparence, comme par exemple:

1. Changez la couleur de Remplissage pour obtenir un bleu clair,

2. Choisissez une couleur plus sombre pour le contour dans I'onglet Stroke paint,

3. Etréduisez I'épaisseur de la bordure dans I'onglet Stroke style
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8.6.8 [x] New document 1 - Inkscape

Elle Edit View Layer Object Path Text Filters Extensions Help
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\ e B BB B B B R TR B BB e @ [RF and Stroke (ShiftFCtr4+-F) ® &
e Fill|[stroke paint |=*stroke style o
[ 2 - i
. xOOOoBEO?

— % Flat color
|g| j RGB |HSL CMYK |Wheel | cMs

@ - .
©- - M ¢ -

o - : DG - | (7
&7 » COOODDDDNNNNNN - .|

: .

© - M

b ;
i? ¥ RGBA, [00065eff E;

iy Blur
v - . il
N E_ Opacity, % 2
o o [T
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10. Dessinez une ligne en utilisant 'outil Crayon:

1. Cliquez une fois pour commencer la ligne. Maintenez la touche Ctr1 enfoncée pour I'incrémenter de
15 degrés.

Déplacez le pointeur horizontalement et placez le point avec un simple clic.
Cliquez et accrochez-vous au sommet de la ligne et tracez une ligne verticale, terminée par un clic simple.

Maintenant, rassemblez les deux sommets terminaux.

A

Modifiez la couleur et la largeur du symbdle de triangle pour correspondre au trait du cercle et déplacez-le
autour de maniere a obtenir un symbole qui ressemble au suivant:
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11. If the symbol you get satisfies you, then save it as landuse_symbol under the directory that the course is
in, under exercise_data/symbols, as SVG file.

Dans QGIS :
1. Open the Layer Properties for the 1anduse layer.
2. Inthe (}{ Symbology tab, change the symbol structure by changing the Symbol Layer Type to SVG Fill shown
below.
3. Cliquez sur le bouton ... et ensuite sur Selection fichier... pour sélectionner votre image SVG.

11 a été ajouté a I'arbre des symboles et vous pouvez maintenant personnaliser ses différentes caractéristiques
(couleurs, angle, effets, unités...).
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Layer Properties - landuse | Symbology

| = single symbol

%) Information ~ [ Fill | |
— 4 SVG fill
-?& Source = :J:i v — Line o
7\ r‘ — simple line |E| |Q|
Q’ Symbology E —
€3 Labels
B Masks symbol layer type SVG fill -
: Diagrams Texture width | 10,000000 |:| | Millimeters - &
.r' 3D View Fill color (=8
E Fields Stroke color =8
BB Attributes Form Stroke width | || Millimeters  ~| &
: Rotation 0,00° i &
Joins
SVG Groups SVG symbols
E" Auxiliary Storage ~ [ App Symbols - - . . 252 =
& _ [ accommodation - ..
g Actions ] amenity oy e
: [ arrows i S|e &y x
- Display L

[J backgrounds
[ components

&  Rendering

[ crosses o :
Variables [] emergency |0 ' _ '||
[ entertainment we llwe I
{ Metadata [ food h &
a [ gpsicons X : S Y o | ﬂ%
ﬁ Dependencies [ health
[J landmark = A\ O ‘#’ ’(:}‘ [E— m A =
"~ Legend A
s *nts/GIS/QGIS/TrainingManual/exercise_data/symbols/landuse_symbol.svg & ||_|t| =i
& qais server
v| Enable symbol layer <, Draw effects

ﬂ Digitizing

» Layer Rendering
| @Help || style -  Japply | %cancel |[ ok |

Once you validate the dialog, features in 1anduse layer should now be covered by a set of symbols, showing a
texture like the one on the following map. If textures are not visible, you may need to zoom in the map canvas or set
in the layer properties a bigger Texture width.
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symbology - QGIS 8

Project Edit Wiew Layer Settings Plugins Vector Raster Database Web Help

NEERREY Q@ LLpHPPRAANRS &G E-N-EET -
BV AR V/BRR-ZT >0 B =qEHuemgn R 4

Layers (=)
o @ ® T g~ »

Layers = Browser

Q, Type to locate (Ctrl+K) di| 20.4301,-33.8939 |9 /11109148 |~ | @ n|100% >3 |00 | v/ Render % EpsGi4326 @

2.4.15 In Conclusion

Changer la symbologie des différentes couches a transformé un empilement de vecteurs en une belle carte lisible.

2.4.16 Further Reading

Exemples de belles cartes

2.4.17 What's Next?

Changer la symbologie pour une couche entiere est utile, mais I'information contenue dans chaque couche n’est pas
disponible pour quelqu’un qui lit la carte. Comment se nomment les rues ? A quelles régions ces zones appartiennent
? Quelles sont les surfaces des exploitations agricoles ? Toutes ces informations sont encore invisibles. La prochaine
lecon expliquera comment représenter ces données sur une carte.

Note: Avez-vous pensé a sauvegarder votre carte récemment ?
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CHAPTER 3

Module: Classer des données vectorielles

La classification des données vectorielles vous permet d’attribuer différents symboles aux entités (différents objets dans
la mé&me couche), dépendamment de leurs attributs. Cela permet a quelquun qui utilise la carte de voir facilement
les attributs des différentes entités.

3.1 Lesson: Attributs de données vectorielles

Les données vecteur sont sans doute le type de données le plus courant dans l'utilisation quotidienne des SIG. Le
modele vecteur représente 'emplacement et la forme d’entités géographiques a I'aide de points, de lignes et de
polygones (et pour les données 3D, également des surfaces et des volumes), tandis que leurs autres propriétés sont
incluses en tant qu’attributs (souvent présentés sous forme de tableau dans QGIS).

Jusqu’a maintenant, aucune des modifications que nous avons apportées a la carte ont été influencées par les objets
qui sont représentés. En d’autres termes, toutes les zones d’occupation du sol se ressemblent, et toutes les routes
également. En regardant la carte, les observateurs ne savent rien a propos des routes qu’ils regardent ; seulement qu’il
y a une route d’une certaine forme a un certain endroit.

Mais toute la force des SIG est que tous ces objets visibles sur la carte ont également des attributs. Des cartes dans
un SIG ne sont pas uniquement des images. Elles ne représentent pas seulement des objets dans des endroits, mais
également des informations sur ces objets.

L’objectif de cette lecon : Etudier la structure de données vectorielles et explorer les données attributaires d’un objet

3.1.1 Follow Along: Visualisation des attributs d’'une couche
Il est important de comprendre que les données avec lesquelles vous étes en train de travailler ne montrent pas
seulement ol ces objets se trouvent dans I’espace, mais aussi vous informent sur ce que sont ces objets.

Drapres I'exercice précédent, vous devriez avoir la couche « protected_areas » chargée dans votre carte. Si elle n’est
pas chargée, alors vous pouvez trouver le jeu de données au format protected_areas . shp ESRI Shapefile dans
le répertoire exercise_data/shapefile.

Les polygones représentant les zones protégées constituent les données spatiales, mais nous pouvons en apprendre
davantage sur les zones protégées en explorant la table d’attributs.

1. Dans le panneau couches, cliquez sur la couche protected_areas pour la sélectionner.
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2. Dans le menu Couche, cliquez sur le bouton == Ouvrirla Table Atributaire 5yq5j accessible depuis la barre d’outils
en haut). Cela ouvrira une nouvelle fenétre montrant la table d’attributs de la couche protected_areas.

r ] & 5 T & o 0] 2 E = & &

full_id osm_id osm_type boundary is_in leisure name type wikidata wil
1/ 12855697 2855697 relation protected_a... Western Ca... nature_reser... Bontebok N... boundary Q892884 en:B¢
2/ w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Nat... NULL NULL

4 3

T show All Features _

Une ligne est appelée un enregistrement et est associée a une entité dans la carte sur le canevas, comme
un polygone. Une colonne est appelée champ (ou attribut), et porte un nom qui aide a la décrire, comme
name ou id. Les valeurs dans les cellules sont connues sous le nom de valeur d’attribut. Ces définitions sont
couramment utilisées dans les SIG, il est donc bon de se familiariser avec elles.

Dans la couche protected_areas, il y a deux entités, qui sont représentées par les deux polygones que
nous voyons sur la carte.

Note: Afin de comprendre ce que représentent les champs et les valeurs d’attribut, il peut étre nécessaire
de trouver de la documentation (ou des métadonnées) décrivant la signification des valeurs d’attribut. Cette
documentation est généralement disponible aupres du créateur du jeu de données.

Ensuite, voyons comment un enregistrement dans la table d’attributs est 1ié & une entité de polygone que nous voyons
sur la carte.

1. Retournez a la fenétre principale QGIS.

2. In the Edit —> Select menu, click on the 253 Select Feature(s) button.
3. Assurez-vous que la couche protected_areas est toujours sélectionnée dans le panneau Couches.

4. Move your mouse to the Map Canvas and left click on the smaller of the two polygons. The polygon will turn
yellow indicating it is selected.
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@ basic_map - QGIS — O %

Project Ed Layer Settings
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Browser =
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v [[" Spatial Bookmarks
[ Project Home
¢ [él Home
v Gy
v @ GeoPackage
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& PostGIS
P MssaL
@ Oracle
¥ pB2
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» & XYZ Tiles =
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5. Go back to the Artribute Table window, and you should see a record (row) highlighted. These are the attribute
values of the selected polygon.

Q protected_areas ©: Features Total: 2, Filtered: 2, Selected: 1 - [l *
/ (] 2 € A T ESD PE =8 &
full id osm id 0sm type boundary is in leisure name tvpe wikidata Wi

) r2855697 elatic protected_a... |Western Ca... |nature_reser... |Bontebok M... |boundary (892884
2/w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL NULJ
L) L3

| 7 show All Features _ = |_-|
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Vous pouvez également sélectionner une entité a I'aide de la table d’attributs.

1. Dans la fenétre rable attributs, a gauche, cliquez sur le numéro de ligne de I'enregistrement qui n’est actuellement
pas sélectionné.

(R protected_areas : Features Total: 2, Filtered: 2, Selected: 1 - O X
> ® 0§ e E¥e PE = 56
full id osm id osm tvpe boundary is in leisure name tvpe wikidata wi

() r2855697 protected_a... |Western Ca... |nature_reser... |Bontebok M...
187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL MNULI

14 »
T show All Features _ = (EE

2. Retournez a la fenétre principale de QGIS et regardez le canevas cartographique. Vous devriez voir le plus
grand des deux polygones colorés en jaune.

s

3. Pour désélectionner lentité, allez dans la fenétre Table dattributs et cliquez sur
Désélectionner toutes les entités de la couche

Parfois, de nombreuses entités sont affichées sur la carte et il peut étre difficile de voir quelle entité est sélectionnée
dans la table d’attributs. Une autre facon d’identifier I'emplacement d’un élément est d’utiliser I'outil Faire clignoter
lentité.

1. Dans la table attributs, faites un clic droit sur toute cellule de la ligne qui a la valeur d’attribut r2855697 pour
le champ full_id.

2. Dans le menu contextuel, cliquez sur Flash Feature et regardez le canevas de carte.

= |
() protected_areas : Features Total: 2, Filte
/ [+ B &
~ full id osm id osm tvpe
1- Select All
2|w1870559

Copy Cell Content
Zoom to Feature
Pan to Feature

Flash Feature

Open Form

Vous devriez voir le polygone clignoter en rouge plusieurs fois. Si vous 'avez manqué, essayez-le a nouveau.
Un autre outil utile est l'outil zoomer a lentité, qui indique a QGIS de zoomer sur I'élément qui I'intéresse.

1. Dans la table attributs, faites un clic droit sur toute cellule de la ligne qui a la valeur d’attribut r2855697 pour
le champ full_id.
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2. Dans le menu contextuel, cliquez sur zoomer a lentité.

- protected_areas :: Features Total: 2, Fi

]
I R 5]

3 E]

full id osm id osm ty]

JOCCoOT

i r2855697 -
f Select All

2 w1870559
Copy Cell Content

Zoom to Feature

Pan to Feature

Flash Feature

Open Form

Regardez le canevas de la carte. Le polygone devrait maintenant occuper I'étendue de la zone.

Vous pouvez maintenant fermer la table d’attributs.

3.1.2 Try Yourself explorer les attributs des donnees vecteur

1. Combien de champs sont disponibles dans la couche rivers ?
2. Parlez-nous un peu des endroits town de votre jeu de données.

3. Ouvrez la table des attributs de la couche places. Quel champ serait le plus utile a représenter sous forme
d’étiquette, et pourquoi ?

Réponse
¢ Il devrait y avoir 9 champs dans la couche rivers :
1. Sélectionnez la couche dans le panneau Couches.
2. Right-click and choose Open Attribute Table, or press the button on the Astributes Toolbar (it can be
enabled from View » Toolbars menu).
3. Comptez le nombre de colonnes.

A quicker approach could be to double-click the rivers layer, open the Layer properties » Fields tab, where you
will find a numbered list of the table’s fields.

* Information about towns is available in the places layer. Open its attribute table as you did with the rivers layer:
there are two features whose place attribute is set to town: Swellendam and Buffeljagsrivier. You can add
comment on other fields from these two records, if you like.

¢ The name field is the most useful to show as labels. This is because all its values are unique for every object
and are very unlikely to contain NULL values. If your data contains some NULL values, do not worry as long
as most of your places have names.
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3.1.3 In Conclusion

Vous savez maintenant comment utiliser la table d’attributs pour étudier les données que vous utilisez. Les jeux
de données seront seulement intéressants lorsqu’ils comporteront des attributs qui vous concerne. Si vous savez de
quels attributs vous avez besoin, vous pouvez savoir rapidement si vous serez capable d’utiliser un jeu de données
spécifiques ou si vous avez besoin d’un autre qui dispose des données nécessaires.

3.1.4 What’s Next?

Des différents attributs sont utiles a différentes fins. Certains d’entre eux peuvent étre représentés directement sous
forme de texte dans la carte que voit l'utilisateur. Vous apprendrez comment faire cela dans la prochaine lecon.

3.2 Lesson: Etiquettes

Des étiquettes peuvent étre ajoutées a une carte pour afficher de I'information sur un objet. N'importe quelle couche
vecteur peut avoir des étiquettes qui lui sont associées. Le contenu de ces étiquettes repose sur les données attributaires
de la couche.

Le but de ce cours: Appliquer des étiquettes utiles, jolies et lisibles a une couche.

3.2.1 Follow Along: Utilisation d’étiquettes

Premierement, assurez-vous que le bouton ‘“atz] est visible dans I'interface graphique :
1. Aller a I'’élément du menu Vue » Barres d outils

2. Assurez-vous que I'élément Barre d outils Etiquettes est coché. Si ce n’est pas le cas, cliquez sur 'élément Barre
d’outils Etiquettes pour l'activer.

3. Cliquez sur la couche places dans le panneau Couches pour qu’il soit mis en évidence
4. Cliquez sur le bouton “=t=| de la barre d’outils pour ouvrir I'onglet Efiguettes du panneau Style de couche
5. Passez de Pas d étiquettes & "2t=! Etiquettes simples.

Vous devrez choisir le champ des attributs qui sera utilisé pour les étiquettes. Dans la lecon précédente, vous
avez décidé que le champ name était le plus approprié a cette fin.

6. Select name from the Value list :
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Layer Styling )
o places -

=1 Single Labels - | |4
- Value |abc name -~ || &

abe i abe abc . J

-

Text

Font | MS ShellDig 2 | S

Style Regular = @
UE[sE BE I€&

Size | 10.0000 | &
Paints | S

coor | (GGG - <.

Dpaﬂt? __l IDD.D E‘ru -

Tl Favorites v | 8
= Save Settings...

| e v Live update apply

7. Cliquez sur Appliquer

La carte devrait maintenant afficher des étiquettes comme ceci:
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() WFS / OGC AP| - Feature
@ ows

& ArcGisMapServer

=y -

I 5

-

Layers

[« = 7 &8

®

»

v| @ places

v roads

v rivers

v| M buitdings

v . ‘water

v . protected_areas
v landuse

() *basic_map - QGIS 3efaefidf1 - [m] x
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Progessing Help
DR QL 2L, RAPPRPFRALRBLONOR (e -E--E-R-EE% I s~ T~
R\ AW B S ¥ e e YRR L]
Browser =165 Layer Styling @
QRTHO | = places &
- ¢ Favorites < Bl =5ro- Lo -] (%]
= - b
¥ 3 QGIS-Training-Data'e S
~ [ QGIS-Training-Data\s ___value | abc name M| \£|
b [ styles - =
» @ basic.map oo [ o (@ O
v IV Spatial Bookmarks -
v [% Project Home Text
v (& Home Font  |Ms Shel Dig 2 MK =S
e
3 @ GeoPackage Style |Regu|ar ~ ‘ El,
v/ Spatislite - —
@ postals uw&ls € B8/&|1&
P mssoL — —
082 Size | 10.0000 BESE
B WS WMTS ;
Points -
ﬂ Wector Tiles | = ‘ E"
v XMZTiles coor | (S - <.
B wcs a

Opacity == || 100,0 % =] El,

avorites :i
| O Faverite: al-| 2

|‘ E ‘Sava Semngs...|
(o][e] v lveupdate | apply |

| @ Type to locate (Cirl+K)

Coordinate| 20.5409,-33.3522 | W Scale umes10 v | (@ Magnifier| 100% |2] Rotaton [0.0° 2| W/Render @ EpsGiazes @

3.2.2 Follow Along: Modification des Options d’Etiquetage

Selon les styles que vous avez choisis pour votre carte dans les lecons précédentes, vous pourriez trouver que les
étiquettes ne sont pas formatées correctement et soit se chevauchent, soit sont trop éloignées de leurs marqueurs de

points.

Note: Ci-dessus, vous avez utilisé le bouton dans la barre d’outils Etiguettes pour ouvrir le panneau Style de
couches. Comme pour Symbologie, les mémes options d’étiquetage sont disponibles dans le panneau Style de couches
que dans la fenétre Propriétés de la couche. Ici, vous utiliserez la boite de dialogue Propriétés de la couche.

1. Ouvrez le dialogue Propriétés de la couche en double-cliquant sur la couche places.

2. Sélectionnez 'onglet ‘2kz| Etiguettes

3. Assurez-vous que Texte est sélectionné dans la liste d’options a gauche, puis mettez a jour les options de
formatage de texte pour les faire correspondre a celles montrées ci-dessous:
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@ Layer Properties - places | Labels

Information

Source

Symbology

Masks
Diagrams
Fields
Attributes Form
Joins
liary Storage

Actions

Display
Rendering
Variables
Metadata
Dependencies
Legend

QGls

Digitizing

=1 Single Labels

Value | abc name - &
w Text Sample
Lorem Ipsum
Lorem Ipsum | 1:59610 B |- v
abe Text Text
i Formatting Font |Ari3| M | L =8
8Be [uffer
abe Mask Style Regular - @.
. Background u Ev 5 Ev B Ev I Ev
Shadow
:,,f Size | 13.0000 A ER
/ Callouts
1-:0 Placement Points i E,
4 Renderin
“ P oo | | =L
Opacity 1| 100.0 % 3| €
L Favorites >~ | 8%

Cancel

Save Settings...

Help

. Cliquez sur Appliquer

Cette police est peut-étre plus grande et plus familiere aux utilisateurs, mais sa lisibilité dépend toujours des
couches qui sont rendues en dessous. Pour résoudre ce probléme, regardons I'option Tampon.

. Sélectionnez Tampon dans la liste d’options de gauche

. Sélectionnez la case a cocher a coté de Afficher un tampon, puis choisissez les options qui correspondent aux

suivantes:

3.2. Lesson: Etiquettes
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@ Layer Properties - places | Labels

*
Q =1 Single Labels = | |E|
= Value |ib< name - | |E|
w Text Sample
Lorem Ipsum
{@be| Labels _— B— !
|Loren1 Ipsum |3| |1;59510 - | |m|v| | |v|
b .l W S
e abe Text Buffer
e Formatting v | Draw text buffer @,
= = Size | 1.0000 2 €
= abe’ Mask
-0 @ Background | Millmeters ~| S
=0 _
J Shadow Color | ==t
abe =
/ Callouts
Y V| Color buffer's fill
#y¥ Placement
7 Rendering Oparity 1] 100.0 % | &
) Pen join style | B Bevel = | =l
Blend mode |Normal - | @
Draw effects
L%
%}
= | style - | oK | | cancel || Apply [ Help |

7. Cliquez sur Appliquer

Vous constaterez que cela ajoute une bordure ou un tampon coloré autour des étiquettes des places, les rendant

plus faciles a repérer sur la carte:
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(@ *basic_map - QGIS 3e6aef5df1 - m] X
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Progessing Help

DoAY Uer,prRPPRPra i BL0OR I -K-B-H-BEERXT=-0 W~

RV AWM B 1 - =4 = ngse% & |
Browser B

DT HO

= ' Favorites =l

3 QGIS-Training-Data'
~ [ QGIS-Training-Data\s
b [ styles

v @ basic_map
Lm Spatial Bookmarks
Project Home
[¢] Home
[ ca
" GeoPackage
f Spatialite
@ postGls
P mssaL
& pe2
B wms wmTS
H Wector Tiles
bOEEE XVZ Tiles
B wcs
) WFS / OGC AP| - Feature |
) ows

& ArcGisMapServer I
- -

v vy owow

%

< [ D

Layers (=15
o 1@ :QT EYR G T

@ places

roads

E ~ rivers

B buitdings

. water

. protected_areas
landuse

| Q Type to locate (cul+k) Coordinate | 20.4841,-33.3781 | % Scale 142259 v | (@ Magrifier | 100% |+] Rrotaton [0.0° 2| ViRendsr @epsciazs @

Maintenant, nous pouvons aborder le positionnement des étiquettes par rapport a leurs points de reperes.
8. Sélectionnez Placement dans la liste d’options de gauche

9. Sélectionnez Autour du point et changez la valeur de Distance a 2 . 0 millimetres :
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@ Layer Properties - places | Labels
=1 Single Labels

q Information Value | abs name - || &

w Text Sample
J{:\‘- Source

"“' Symbology Lorem |pGLIITI
Labels b
Lorem Ipsum | (142258 |- | |BF|~ v
D Masks pro— Placement
‘I Diagrams .2 Formatting
8Be [uffer
E Fields abe! pask Cartographic  ®) Around paint Offset from point
Back d
E Attributes Form . ackgroun
- Shadow
. abe
Joins Callouts
. Distance | 2,0000

1-:0 Placement

& @

ﬂ Auxiliary Storage

/' Rendering Millimeters M
{;!_('3 Actions Quadrant E.
- Display

Q‘_f Rendering

__ v Geometry generator
Variables

E Metadata
ﬁ’ Dependencies

Point / MultiPoint
Legend

— w Data defined
QGIS Server

“ L Coordinate X E, ¥ E,
Digitizing -

Style * 0K, Cancel Apply Help
W ne —

10. Cliquez sur Appliquer

Vous verrez que les étiquettes ne chevauchent plus désormais les points.

3.2.3 Follow Along: Utiliser des étiquettes a la place de symboles de couche

Dans de nombreux cas, 'emplacement d’un point n’a pas besoin d’étre tres précis. Par exemple, la plupart des points
de la couche « places » se réferent a des villes ou des banlieues entieres, et le point spécifique associé a de telles entités
n’est pas si spécifique a grande échelle. En fait, donner un point trop spécifique est souvent déroutant pour quelqu’un
qui lit une carte.

Par exemple: sur une carte du monde, le point indiquant 'Union Européenne peut étre quelque part en Pologne, par
exemple. Pour quelqu’un qui lit la carte, voir un point marqué Union Européenne en Pologne peut sembler vouloir
dire que la capitale de I'Union Européenne est donc en Pologne.

Aussi, pour prévenir ce genre d’incompréhension, il est souvent utile de désactiver les symboles de points et les
remplacer completement par les étiquettes.

Dans QGIS, vous pouvez faire ¢a en positionnant I'étiquette directement a la place du point auquel elle se réfere.
1. Ouvrez I'onglet etiquettes du dialogue proprietes couches pour la couche places.

2. Sélectionnez l'option Placement dans la liste des options
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3. Cliquez sur le bouton décalage du point

Ceci va révéler les options Quadrant que vous pourrez utiliser pour définir la position de I'étiquette par rapport
au marqueur de point. Dans le cas-ci, nous souhaitons centrer I'étiquette sur le point donc choisissez le centre

du quadrant:
@ Layer Properties - places | Labels X
Q =4 Single Labels = | |E|
= Value |ib€ name - | |E|
w Text Sample
Lorem Ipsum
{abe| Labels _— i b
|Loren1 Ipsum |2| |1:42259 - | |@g_|’| | |:|
abc -
abe Text Placement
2% Formatting =
— abe Buffer
= abe! pashk () Cartographic | Around point (@) Offset from point
=] . Background
us - Shadow
./” Callouts g || —
& Quadrant | [ gl || | &
‘.’ Placement ——————
‘,‘ Rendering ||||||
) | | @ | |
OffsetX,Y | 0.0000 |2 0.0000 2 &
|Millimeters 5 | @,
Rotation |0.00* B
= v Geometry generator
] 5
[ Point / MultiPoint v
L w Data defined 3
- | Style * | | OF, | | Cancel | | Apply | | Help |

4. Cachez les symboles de points en éditant la couche symbologie comme d’habitude, et en fixant la taille du
Markera 0.0 :
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@ Layer Properties - places | Symbology

Q

E Single symbal

- Marker

¥ Symbology

Simple marker

abe
abs Unit | Milimeters - |
Opacity | 00.0% <l
Color | I'l
= Sze | p.00000 BEEE
B Rotation | 0,00 ° B ="
. Favorites a |~ | 8
B ° ® O e ® ¥
dot black dot white dot blue dot green dot red effect drop
shadow
& ® ©
shield disability topo hospital topo pop capital
i/ |:| E Save Symbol . | | Advanced ~ |
v b Layer Rendering
= | style - | oK | | cancel || Apply [ Help |
5. Cliquez sur Appliquer et vous verrez ce résultat :
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(2 *basic_map - QGIS 3e6aebidf1 - O X
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Progessing Help

DeERRX OrrrAEPPrQLARLRNOR & -H-B-G-BEHS =0 M-

m@Vi A wm B s = im e qEm g gge e ]
Browser
T TO

~ 5 Favorites [«
v 5 QGIS-Training-Data\e
~ [ QGI5-Training-Data\s
b [ styles
3 Q basic_map
(" Spatial Bookmarks
(% Project Home
[&] Home
[(mE=Y
e GeoPackage
# Spatialite
@ rostcls
P wmssaL
2 pe2
@B WMSWMTS
ﬂ Vector Tiles
R XYZ Tiles
& wes
7 WFS/ OGC API - Feature,
ows
)] ArcGisMapServer

| L

e
3 D

Layers
o« @ e T EG-F »

</

places
roads

rivers

i
water . -
raal Rest/Cai
. protected_areas / ‘U&m
landuse

buildings

| Q Type o locate (Ctrl+Q) Coordinate | 20.4857,-33.9804 | Scale | 1:42256 "| & Wagrifier | 100% |2] Rotation (0.0° [2] [V Render @ Epsciazzs @

Si vous effectuez un zoom arriere sur la carte, vous verrez que certaines des étiquettes disparaissent a des échelles plus
grandes pour éviter les chevauchements. C’est parfois ce que vous souhaitez lorsque vous traitez des ensembles de
données qui comportent de nombreux points, mais a d’autres moments, vous perdrez des informations utiles de cette
maniere. Il existe une autre possibilité pour traiter ce genre de cas, que nous aborderons dans un exercice ultérieur

: . N . {ake] S .
de cette lecon. Pour l'instant, faites un zoom arriere et cliquez sur le bouton dans la barre d’outils et voyez ce qui
se passe.

3.2.4 Try Yourself Personnaliser les étiquettes

¢ Réinitialisez les parameétres des étiquettes et des symboles pour avoir un marqueur de points et un décalage
d’étiquettes de 2, O millimetres.

Réponse

Your map should now show the marker points and the labels should be offset by 2mm. The style of the markers and
labels should allow both to be clearly visible on the map:
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(2 *basic_map - QGIS 3e6aebidf1
Project Edit View Layer Settings Plugins Vector Raster Database

DeBRRY UL RPRPIFRALGBLEIOR O

Mesh  Progessing  Help

TE-E-R-EES S0 0

‘R@V. A w B

Browser

LETTO

~ 5 Favorites 1=
v 5 QGIS-Training-Data\
~ [ QGI5-Training-Data\s
b [ styles
b G basic map
(" Spatial Bookmarks
Project Home
[&] Home
e
e GeoPackage
# Spatialite
@ rostcls
P mssaL
2 pe2
@B WMSWMTS
ﬂ Vector Tiles
R XYZ Tiles
& wes
7 WFS/ OGC API - Feature,
) ows
)] ArcGisMapServer —

-

A
4 B —
Layers
L 4 1@ . ? VRGN

® places

roads

— rivers

B buitdings

. water

. protected_areas

landuse

&/ -

R R IEE R LN

%

‘ Q, Type to locate (Ctrl+)

Coordinate | 20.5535,34.0117 | % scale [1:42253  ~ | (@ Magnifier | 100%

[2] [V Render @ Epsciazzs @

2| Rotation 0.0°

* Mettez la carte a I'échelle 1: 100000. Vous pouvez le faire en la tapant dans la case Echelle dans la barre
statut. Modifiez vos étiquettes pour qu’elles puissent étre visualisées a cette échelle.

Réponse

One possible solution has this final product:
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() “basic_map - QGIS 3e6aebidf1 — [m] x
Project Edit View Layer Seftings Plugine Vector Raster Dstabase Mesh Progessing Help

 mERRE (DL RPRP I AL REINOR 60 -H-B-R-BE# =~ 0

LA -4 - w0, g W my g gy a |
Browser Layer Styling
QQTEI‘O ‘.‘bplaues 'l
- 7 Favorites E &1 single Labels -] [

v 5 QGIS-Training-Data\e _‘ | f—

~ 5 QGIS-Training-Data\s = value [abe name M| ‘£|

b [ styles
3 Q basic_map
" Spatial Bookmarks
(% Project Home
[&] Home
[(mE=Y
e GeoPackage
# Spatialite
@ rostcls
P wmssaL
2 pe2
@ WMSWMTS
ﬂ Vector Tiles
55 XVZ Tiles
& wes
7 WFS [ OGC API - Feature
) ows
)] ArcGisMapServer
AR A e,

1 »
Layers
‘ill@ l? 814'13 »
V| @ places
v roads
v rivers
v| B buitdings
v . water
v . protected_areas
v landuse

-

| Q4 Type to locate {Ctrl+)

Coordinatz | 20.5946,-34.0152 %8  Scale | 1:100000

| Mo change

Formatted numbers a

Decimal places | 3 =

Show plus sign

‘El ‘El V| Live update |

- | ﬁ Magnlﬁer\lUU%

|2] Rotation (0.0°

[2] v Render @ epsciazs @

:_ ] |- ase | ») '}°|<‘»|

Apply

R ="
eter o000 2] &
word | 0,0000 B =8

| Enable kerning
Text orientation | Horizontal - G
Blend mode |Nwma| b ‘ @
Apply label text substitutes
Multiple lines
Wrap on character | ‘ @

Wrap lines to | No automatic wrapping = \ @

| Maximum line length -
Line height [ 1.00line DR =R
Alignment |Fo||ow Label Placement  ~ ‘ @

-

To arrive at this result:

e Use a font size of 10

* Use an around point placement distance of 1.5 mm

¢ Use a marker size of 3.0

mm

* In addition, this example uses the Wrap on character option:
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Layer Styling £
o places -

- =1 Single Labels - | [
= Value | abc name > || &

-

abc _.E abe abc . J
Formatting

Type case Mo change -

Ll

A@ @@ @

Spadng letter | 0.0000

word | 0.0000
¥ | Enable kerning
Text orientation | Horizontal -

Blend mode Mormal -

Apply [abel text substitutes

Multiple lines
Wrap on character @,
Wrap lines to Mo automatic wrapping = @,
Maximum line length -

Line height 1.00 line +| €

Alignment Follow Label Placement = ‘@,

Formatted numbers @,

Decimal places | 3 = -
Show plus sign L

b e ¥ Live update Apply

* Enter a space in this field and click Apply to achieve the same effect. In our case, some of the place names
are very long, resulting in names with multiple lines which is not very user friendly. You might find this setting
to be more appropriate for your map.
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3.2.5 Follow Along: Etiquetage de Lignes

Maintenant que vous comprenez le fonctionnement de I'étiquetage, il y a un nouveau probleme. Points et polygones
sont faciles a étiqueter, mais qu’en est-il des lignes? Si vous les étiquetez de la méme maniere que les points, vos
résultats devraient ressembler a quelque chose comme ceci:

() *basic_map - QGIS 3ebaeh3df — O X
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Progessing Help

DEBRRY M*LLPHAPPF ALoRBLNOR o -H-6-G-BE#I =~ 0

Mm@V AmIB sy = iame e qegqaqg ;i 4l
Browser

GRTTO

~ ¢ Favorites [=]

» 5 QGIS-Training-Data\e
~ [ OGIS-Training-Datals
b [ styles
b (2 basic. map
u:', Spatial Bookmarks
Project Home
[&] Home
(=)
e GeoPackage
#° Spatialite
@ postals
P mssaL

B vector Tiles
b EIE XVZ Tiles

@ wes i

7 WFS/ OGC API - Feature, |

& ows

& ArcGisMapServer

P

1] [ [»
Layers
« @l ® T &6 »

[ ] ® places

roads

~— rivers

B buitdings

. water

. protected_areas

landuse

-

| Q Type to locate (Cr-+) | Coordinate| 20.5190,-33.984 | % Scale 135434~ | (@ Wagnifier | 100% 2| Rotation 0.0° |2] ¥ Render @ Ersciazs @

Nous allons maintenant reformater les étiquettes de la couche roads afin qu’elles soient faciles a comprendre.
1. Cachez la couche « places » pour qu’elle ne vous distraie pas
2. Activez etiquette simple pour la couche roads comme vous I'avez fait ci-dessus pour places.
3. Définissez la police faille* a 10 pour que vous puissiez voir plus d’étiquettes
4. Zoom sur la zone Swellendam de la ville

5. Dans l'onglet efiguettes de I'onglet Placement, choisissez les parametres suivants :
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@ Layer Properties - roads | Labels x
Q =1 Single Labels = | |E|
3 Value |ib< name - | |E|

w Text Sample

Lorem Ipsum
{@be| Labels _— B— b
|Lorem Ipsum | 4 | | 1:8880 - | |&;|’| | |+
abc -
abe Text Placement
a
2% Farmatting
- 8Be [uffer
= abc) Mask (®) Parallel () Curved () Horizontal
=0 . Background
=0
- Shadow
abe
Callouts
/* Allowed positions Above line || On line Below line @
#y¥ Placement
‘( Rendering Line orientation dependent position
(v} Distance | 0.0000 s €&
Millimeters hd L
Repeat | No repeat |:| @.
| Points - &
Qverrun feature |No OWErrun |:| E.
|Mil|imeters - |
v Geometry generator
L%
:‘J

- | style - | oK || cancel || Apply [ Help |

Vous constaterez probablement que le style du texte a utilisé des valeurs par défaut et que les étiquettes sont
par conséquent tres difficiles a lire. Mettez a jour le 7exte pour utiliser une Couleur gris foncé ou noire et le
Tampon pour utiliser une Couleur jaune clair.

Selon I'échelle, la carte devrait ressembler a peu pres a ceci:
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Vous verrez que certains noms de voies apparaissent plus d’une fois sans que ce ne soit toujours nécessaire.
Pour empécher cela:

6. Dans l'onglet efiguettes du dialogue proprietes couche, choisissez 1'option rendu et sélectionnez Fusionner les
lignes connectées pour éviter les doublons comme indiqué :
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@ Layer Properties - roads | Labels

Information

Source

Symbology

Labels

€ED Masks

9.

Diagrams
Fields
Attributes Form
Joins

liary Storage
Actions
Display
Rendering
Variables
Metadata
Dependencies
Legend
QGls

Digitizing

=1 Single Labels

Value | abc name

w Text Sample

Lorem Ipsum

Larem Ipsum

abe Text
Formatting
abe Byffer

abc! Mask

. Background

- Shadow
abe
/ Callouts

1-:0 Placement
/ Rendering

Rendering

o

Pixel size-based visibility (Jabels in map units)

Minimum 3 px

Maximurn 10000 px

e

1:8860

-

Label z-index |0.00

Show all labels for this layer (induding colliding labels)

Data defined

Show label @

Always show @.

Show upside-down labels

8| never

w Feature options

when rotation defined

Label every part of multi-part features

always

v Merge connected lines to avoid duplicate labels

Limit number of features to be labeled to

2000

Suppress labeling of features smaller than

5.00 mm

OK

Cancel

Apply

L1

Cliquez sur OK.

Une autre fonction utile permet d’empécher I'affichage des entités trop courtes pour &tre indiquées.

Dans le méme panneau Rendu, définissez la valeur de Supprimer ['étiquetage des entités plus petites que a 5. 00
mm et notez les résultats lorsque vous cliquez sur Appliquer.

Essayez également différents réglages de Position. Comme nous I'avons vu précédemment, 'option Horizontal
n’est pas une bonne idée dans ce cas, alors essayons plutdt I'option Incurvé.

Sélectionnez 'option Incurvé dans le panneau Placement de I'onglet Etiquettes

Voici le résultat:

82

Chapter 3. Module: Classer des données vectorielles



QGIS Training Manual

() “basic_map - QGIS 3e6aebidf1 — [m] x
Project Edit View Layer Seftings Plugins Vector Raster Database Mesh Progessing Help

 mERR (*ALPEPP/ RAGBLEOR o
"GV 2w @S o =
Browser @ &= /-n ‘—'}\I\EZ' ' =]
nevte § o
a X LR
~ 0 Favorites = \Q&.Q%J

» 5 QGIS-Training-Datale

= [ QGIS-Training-Data\s
b [ styles
3 G basic_map

Y Spatial Bookmarks

(% Project Home

[&] Home

[(mE=Y

‘5 GeoPackage

# Spatialite

@ rostcls

P wmssaL

2 pe2
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& ows
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®
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D protected_areas
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Comme vous pouvez le voir, cela cache certaines étiquettes qui étaient auparavant visibles, en raison de la difficulté
de faire suivre a certaines d’entre elles des lignes de rue sinueuses tout en étant lisibles. Cela rend d’autres étiquettes
beaucoup plus utiles, car elles suivent les routes plutot que de flotter dans I'espace entre elles. Vous pouvez décider
laquelle de ces options utiliser, en fonction de ce qui vous semble le plus utile ou le plus esthétique.

3.2.6 Follow Along: Valeurs définies par des données

1. Désactiver I'étiquetage pour la couche roads

2. Réactiver I'étiquetage pour la couche places

3. Ouvrez la table d’attributs pour les places via le bouton

Il y a un champ qui nous intéresse maintenant : place qui définit le type de zone urbaine pour chaque
enregistrement. Nous pouvons utiliser ces données pour influencer les styles d’étiquettes.

4. Naviguez vers le sous-panneau 7exte de 'onglet Etiquettes de la couche places.

5. Cliquez sur le bouton € a coté du bouton de texte en italique sous Style et sélectionnez Editer... pour ouvrir
le Constructeur d’expression :
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@ Expression String Builder
Expression Function Editor
= L+ - Ay i
Expected format: bool [1=True|0=False]
Feature < Mational Park Reception & Shop | ~ [ 3
Preview:

&, Search...

T T T T T YT YT T YTTYTTTTTTYTTTTTE

symbol_color
value
Aggregates
Arrays

Color
Conditionals
Conversions
Date and Time
Fields and Values
Files and Paths
Fuzzy Matching
General
Geometry

Map Layers
Maps

Math

Operators
Rasters

Record and Attributes
String

User expressions
Variables

Recent (generic)

Show Help

Ok Cancel Help

6. Sous Champs et valeurs, double-cliquez sur place puis cliquez sur Tous. Cela permettra de lister toutes les
valeurs uniques du champ place de cette couche. Ajoutez un = dans I'éditeur de texte, puis double-cliquez

sur town.

Vous pouvez aussi taper : "place" = "town" directement dans I'éditeur de texte.

7. Cliquez deux fois sur OK :

Q Expression String Builder
P 9

Expression Function Editor

B _L X Q, search... Show Values group field
:| "town' symbeol_color ® | Double-click to add field name to expression
value string.
b Aggregates Right-Click on field name to open context
b Arrays menu sample value loading options.
¥ Color R
» Conditionals o
» Conversions Loading field values from WF5 layers isn't
¥ Date and Time supported, before the layer is actually
= Fields and Values inserted, ie. when building queries,
abe full_id
abc gsm_id -
abe gsm_type Values | 4 Search. .
abe is_in All Unique 10 Samples
abc name ham
abc place am.et
. locality
abe sagns_id suburb
abc wikidata town
abe wikipedia
» Files and Paths
= + | - / = L~ lpnl ) | w b Fuzzy Matching
» General
Expected format: bool [1=True|0=False] b Geometry
) ) b Map Layers
Feature |<National Park Reception & Shop | ~ 3 b Maps
Preview: 0 P Math %
Ok Cancel Help
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Notez que les étiquettes de tous les lieux dont le champ place correspond a t own sont affichées en italique.

(2} *basic_map - OGIS 3e6aebidf1 — O x
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Processing Help

NEBRRE ML LPHPRL  ALBLEOR QG- N -6-G-ME#I s~ 0~

EE‘G"’E.’D*E’L 8 MR~ i (WG e qegRgg ;i a
Browser
oeT®o

3

~ ¢ Favorites [

+ [ QGIS-Training-Data\e

~ [ QGIs-Training-Data\s

b [ styles
b (2 basic.map

%) Spatial Bookmarks

[% Project Home

[c] Home

e

@ GeoPackage

,’ Spatialite

W@ postals

P mssaL

2 ps2

G WMSWMTS

ﬂ Vector Tiles

bR MVE Tiles
& wes ;
(7) WFS/ OGC AP - Festure,
@ ows
& ArcGisMapServer =

1]

I

Layers
o 1@ =, ? gE-H® »
@ places I
roads
~ rivers
B buildings
. water
[ protected_areas
landuse

| Q Type to locate (Cirl+K) | Coordinate | 20.5470,34.0360 | Scale [1:35428  ~ | (@ Magnifier 100% 2| Rotation | 0.0° |2 ¥ mender @ Epsciazs @

3.2.7 Try Yourself Utiliser les Valeurs définies par des données

Note: Nous allons aller un peu plus loin ici pour vous présenter quelques parametres avancés d’étiquetage. A ce
niveau avancé, nous assumons que vous avez suffisamment de connaissances sur le sujet pour comprendre ce qui va
suivre. Si ce n’est pas le cas, quittez cette section et revenez plus tard lorsque vous aurez étudiez les pré-requis.

1. Ouvrez la table des attributs pour les « places ».
2. Entrez en mode édition en cliquant sur le bouton y .

=
3. Ajouter une nouvelle colonne avec le bouton EI=*

4. Configurez-le comme ceci:
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() Add Field

MName FONT_SIZE

Comment

Type
Provider type double
Length 3

Precision 1

Ok

Decimal number (real)

Cancel

Ll

qk

5. Utilisez cette fonction pour définir des tailles de police personnalisées pour chaque type de lieu (chaque clé

dans le champ place)

Réponse

1. Still in edit mode, set the FONT__SIZE values to whatever you prefer. The example uses 1 6 for towns, 14 for

suburbs, 12 for localities, and 10 for hamlets.

2. Remember to save changes and exit edit mode

3. Return to the Text formatting options for the places layer and select FONT_SIZE in the Autribute field of

the font size = data defined override dropdown:

Q basic_map - QGIS 3e6aedidf1

() Layer Properties - places | Labels
Q = Single Labels
@ oiion value | abc name

¥ Text Sample

I :{4:\\ Source

Lorem Ipsum
Lorem Ipsum | |35z |~ | Ky |~
abe Text Text
y Diagrams % Formatting  Font  |Arial -
886 Buffer
E Fields abs Mask Style | Regular -
Backi d
B8l attributes Form @ sackgroen Ul€E (s & Bl € |
) Shadow
abo Size 13,0000 =
Joins Y7 Callouts
3 % Placement Points =
2 i s [RSA
coor | N -
B acions
- Opacity I 100.0% =
, Display
" Q. Favorites @ |~
4 Rendering
Variables
E Metadata
ﬁ Dependencies
Legend
& asis server
“ [ i | = Save Settings...
-~ — Style  ~ oK | Cancel Apply Help

Q, Type to locate (Ctrl+<)

Description...

Store Data in the Project
Attribute Field

d typ doub
Expression
Variable
Edit...
Paste

Toggles the editing st Coordinate | 20.4195,-34.0233 | Scale | 135423 |~

& Magnifier | 100%

Your results, if using the above values, should be this:

= | Rotation |0.0°

2| ¥/ Render

v
v
%
agsrivier
L
.
fullid (string)

osm_id  (string)
, osm_type  (string)
is.in (string)
name  (string)
place (string)
sagns_id  (string)
wikidata (string)
wikipedia  (string)
FONT_SIZE

(double}

S epsciazze @
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R XYZ Tiles
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o D
Layers 4
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# places
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3.2.8 Possibilités Avancées de I'étiquetage

Nous ne pouvons pas couvrir toutes les options dans ce cours, mais sachez que 'onglet efiguette a de nombreuses
autres fonctions utiles. Vous pouvez définir un rendu basé sur ’échelle, modifier la priorité de rendu des étiquettes
dans une couche, et définir chaque option d’étiquette a I'aide des attributs de la couche. Vous pouvez méme définir la
rotation, la position XY et d’autres propriétés d’'un label (si des champs d’attributs ont été attribués a cet effet), puis
modifier ces propriétés a I'aide des outils adjacents au bouton principal options étiquetage des couches :

o R R R

(Ces outils seront actifs tant que les champs requis existent dans la table d’attributs et que vous &tes en mode édition.)

N’hésitez pas a explorer les diverses possibilités offertes par le systeme d’étiquetage.
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3.2.9 In Conclusion

Vous avez appris comment utiliser les attributs d’'une couche pour créer des étiquettes dynamiques. Cela peut rendre
votre carte plus informative et plus élégante.

3.2.10 What’s Next?

Maintenant que vous savez comment les attributs peuvent apporter une différence visuelle a votre carte, que diriez-
vous de les utiliser pour changer la symbologie des objets eux-mémes ? C’est I'objet de la legon suivante!

3.3 Lesson: Classification

Les étiquettes sont un bon moyen de communiquer des informations telles que les noms de lieux individuels, mais elles
ne peuvent pas étre utilisées pour tout. Par exemple, disons que quelqu’un veut savoir a quoi sert chaque landuse.
En utilisant des étiquettes, vous obtiendriez ceci :

ik
ntial IJ'J ’\

eemetery |
\

{
S

Cela rend les étiquettes de la carte difficiles a lire car trop nombreuses si vous avez de nombreuses utilisation du
territoires différentes a afficher.

Objectif de cette lecon : Apprendre comment classifier des données vectorielles efficacement.

3.3.1 Follow Along: Classification de données nominales

1. Ouvrez le dialogue Propriétés de la couche pour la couche landuse.
2. Aller a 'onglet Symbologie

3. Cliquez sur le menu déroulant qui indique Symbole unique et changez-le en Categorisé:
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Layer Properties - landuse | Symbology

| = Categorized

"i Information Value |
-?&. Source Symbol ||
Color ramp |

Random colors

& symbology

symbol = Value

Legend

€€ Labels

B Masks

- .
. [MELEINE

N7 3D View

E Fields

Attributes
Form

Joins

% Auxiliary
< B storage

@ Actions
- Display

P Layer Rendering
@Help || style -

- |

| Classify | |E| |E| | Delete All |

|Advanced ~ |

| /Apply || % cancel |[ & OK ]

4. Dans le nouveau panneau, changez la Valeur en 1anduse et la Palette de couleur en Couleurs aléatoires.

5. Cliquez sur le bouton intitulé Classer.

Layer Properties - landuse | Symbology

| = Categorized

Value a6 [anduse -le|
symbol || 'E|
Color ramp | Random colors H
Symbol = Value Legend

Labels v/ [l cemetery cemetery
v [l conservation conservation

Masks vl farmland farmland
v [l forest fForest

Diagrams vl grass grass
v Il industrial industrial

3D View vl orchard orchard
v [l reservoir reservoir

Fields v [l residential residential

Attributes v [l v!llage_green v!llage_green

— v [l vineyard vineyard
v [ all other values

Joins

L Auxiliary
Storage

@ Actions

' Display

» Layer Rendering
| @rep || syle -

6. Cliquez sur OK

Vous verrez quelque chose comme ¢a :

| Classify | |£| |E| | Delete All |

|Advanced ~ |

 /Apply || %cancel || JoK |

3.3. Lesson: Classification
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7. Cliquez sur la fleche (ou le signe plus) a c6té de 1anduse dans le panneau Couches, vous verrez les catégories
expliquées :
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Layers (&) )
o [ ® T &~5 & [

» v o places -
v| ] buildings
v — roads
water |
rivers

.~ landuse

I cemetery

. conservation

B farmland

. Forest

I grass
B industrial

I orchard
. reservoir

B residential

I village_green
"] vineyard

-

v
v

e e e e e L

Maintenant, nos polygones d’utilisation des terres sont colorés et sont classés de maniere a ce que les zones
ayant la méme utilisation des terres soient de la méme couleur.

8. Si vous le souhaitez, vous pouvez changer le symbole de chaque zone d’utilisation des terres en double-cliquant
sur le bloc de couleur correspondant dans le panneau Couches ou dans la boite de dialogue Propriete couche :
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Symbol Selector

(%]
Unit | Millimeters - |
Opacity ~1/100,0 % |:_|
Color | H
| ©. Favorites a@|v| &
| Z/ BN

gradient gray 3 fill hashed black/  hashed black,

plasma
|| B |save Symbol... | | Advanced ~|
| @Help | | % cancel H « oK ]

Notez qu’il y a une catégorie qui est vide :
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Layer Properties - landuse | Symbology B

= Categorized -
q Information Value abe landuse || €
;';‘:\,._ Source Symbol I i
Color ramp Random colors =
& symbology
symbol = Value Legend
€3 Labels v [ cemetery cemetery
v/ [l conservation conservation
EED Masks v/ [l farmland farmland
- v/ [l forest forest
, Diagrams v/ [ grass grass
v Il industrial industrial
\*’ 3D View v [l orchard orchard
v [ reservoir reservoir
E Fields v/ [l residential residential
Attributes v/ [l village _green village green
Form v [ vineyard vineyard

Joins

L Auxiliary
< B storage

{;'.-® Actions
@ Display —| @Help Style - « Apply || % cancel

Classify | = | = | Delete All Advanced ~
P Layer Rendering

Cette catégorie vide est utilisée pour colorier tous les objets qui n’ont pas de valeur d’utilisation du sol définie ou qui
ont une valeur NULL. 1l peut étre utile de conserver cette catégorie vide afin que les zones ayant une valeur NULL
soient toujours représentées sur la carte. Vous pouvez changer la couleur pour représenter plus clairement une valeur
vide ou NULL.

Pensez a sauvegarder votre carte maintenant afin de ne pas perdre toutes vos modifications « durement » effectuées !

3.3.2 Try Yourself Plus de classification

Utilisez les connaissances acquises ci-dessus pour classer la couche buildings. Définissez la catégorisation par
rapport au champ building et utilisez la palette de couleurs Spectrale.

Note: Rappelez-vous de zoomer sur une zone urbaine pour voir les résultats.

3.3.3 Follow Along: Classification de ratio

Il y a quatre types de classification : nominale, ordinale, d’intervalle et de ratio.

Dans la classification nominale, les catégories dans lesquelles les objets sont classés sont basées sur le nom ; elles
n'ont pas d’ordre. Par exemple : noms des villes, codes des districts, etc. Les symboles utilisés pour les données
nominales n'impliquent aucun ordre ni aucune grandeur.

* Pour les points, on peut utiliser des symboles de forme différente.

* Pour les polygones, on peut utiliser différents types de hachures ou différentes couleurs (éviter de mélanger les
couleurs claires et foncées).

* Pour les lignes, nous pouvons utiliser différents motifs de tirets, différentes couleurs (évitez de mélanger les
couleurs claires et foncées) et différents symboles le long des lignes.
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Dans la classification ordinale, les catégories sont classées dans un certain ordre. Par exemple, les villes du monde
sont classées en fonction de leur importance pour le commerce mondial, les voyages, la culture, etc. Les symboles
utilisés pour les données ordinales doivent impliquer un ordre, mais pas une magnitude.

* Pour les points, nous pouvons utiliser des symboles de couleurs claires a foncées.
* Pour les polygones, on peut utiliser des couleurs graduées (de claire a foncée).
* Pour les lignes, nous pouvons utiliser des couleurs graduées (de claire a foncée).

Dans la classification a intervalle, les chiffres sont sur une échelle avec des valeurs positives, négatives et zéro. Par
exemple : hauteur au-dessus/au-dessous du niveau de la mer, température en degrés Celsius. Les symboles utilisés
pour les données d’intervalle doivent indiquer I'ordre et la magnitude.

* Pour les points, on peut utiliser des symboles de taille variable (de petit a grand).

* Pour les polygones, on peut utiliser des couleurs graduées (de claire a foncée) ou ajouter des diagrammes a
taille variable.

* Pour les lignes, on peut utiliser 'épaisseur (de fine a épaisse).

Dans la classification ratio, les chiffres sont sur une échelle avec seulement des valeurs positives et z€ro. Par exemple
: la température au-dessus du zéro absolu (0 degré Kelvin), la distance par rapport a un point, le volume moyen de
trafic dans une rue donnée par mois, etc. Les symboles utilisés pour les données de ratios doivent impliquer I'ordre
et 'ampleur.

* Pour les points, on peut utiliser des symboles de taille variable (de petit a grand).

 Pour les polygones, on peut utiliser des couleurs graduées (de claire a foncée) ou ajouter des diagrammes a
taille variable.

* Pour les lignes, on peut utiliser 'épaisseur (de fine a épaisse).

Dans I'exemple ci-dessus, nous avons utilisé la classification nominale pour colorer chaque enregistrement de la couche
landuse en fonction de son attribut 1anduse. Nous allons maintenant utiliser la classification par ratio pour
classer les enregistrements par zone.

Nous allons reclassifier la couche, de sorte que les classes existantes seront perdues si elles ne sont pas sauvegardées.
Pour stocker la classification actuelle :

p—

. Ouvrez le dialogue des propriétés de la couche

[\

. Cliquez sur le bouton sauvegarder style ... dans le menu déroulant Style.
3. Sélectionnez renommer courant..., entrez 1and usage et appuyez sur OK.

Les catégories et leurs symboles sont maintenant enregistrés dans les propriétés de la couche.

N

. Cliquez maintenant sur I'entrée ajouter... du menu déroulant Style et créez un nouveau style nommé ratio.
Ceci enregistrera la nouvelle classification.

5. Fermez la boite de dialogue proprietes couche

Nous voulons classer les zones d’utilisation des terres par taille, mais il y a un probleéme : elles n’ont pas de champ de
taille, donc nous devrons en faire un.

1. Ouvrez la table d’attributs pour la couche 1anduse.
2. Entrez en mode édition en cliquant sur le bouton basculer mode edition

3. Ajoutez une nouvelle colonne de type décimal, appelée AREA, en utilisant le bouton Nouveau champ .
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Add Field )

Name

Comment

Type

AREA

Decimal number (double) -

Provider type FLOAT

4. Cliquez sur OK

# Cancel «/ OK

Le nouveau champ sera ajouté (a 'extréme droite du tableau ; vous devrez peut-étre faire défiler le tableau
horizontalement pour le voir). Cependant, pour le moment, il n’est pas rempli, il y a juste beaucoup de valeurs

NULL.

Pour résoudre ce probléme, nous devrons calculer les superficies.

1. Ouvrez la calculatrice de champ avec le bouton .

Vous obtiendrez ce dialogue :

() landuse — Field Calculator X
Only update 0 selected features
v | Create a new field Update existing field
Create virtual field
Qutput field name
Qutput field type | Binary object (BLOB) -
Cutput field length | 0 Precision
Expression Function Editor
|| ek L Se.. Show Help
row_number
» Aggregates
» Arrays
+ Color
b Conditionals
+  Conversions
b Date and Time
b Fields and Values
»  Files and Paths
¥ Fuzzy Matching
b General
b Geometry
» Map Layers
b Maps
k Math
b Operators
- +  Rasters
= Jl+J- I/ I CJ) [ ¥ Record and Attribu...
b String
T - b ¥ User expressions
Preview: » Variables
0K Cancel Help
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2. Cochez la case g Mettre a jour les champs existants

3. Sélectionnez AREA dans le menu déroulant des champs

Field Calculator O

Create a new field v| Update existing Field

1.2 AREA -

4. Sous l'onglet Expression, développez le groupe de fonctions Geometry dans la liste et trouvez $area.

5. Double-cliquez dessus pour qu’il apparaisse dans le champ Expression

landuse — Field Calculator 0

Create a new Field V| Update existing Field
1.2 AREA -

Expression | Function Editor

8 oLl Q search... function $area
$area : ke . = Returns the area of the current feature. The
Date and Time ) )
» Fields and Values area calculatedlbytlhls f.uncpon relspects both
» Files and Paths the current project's ellipsoid setting and area
» Fuzzy Matching unit settings. For example, if an ellipsoid has
» General been set for the project then the calculated
~ Geometry area will be ellipsoidal, and if no ellipsoid is
dnale at_vertex set then the calculated area will be
planimetric.
area
azimuth Syntax
boundary $'
bounds area
= L+ LA LA L) e bounds_height
bounds_width Examples
Feature |1 - B buffer
Preview: 1312821.1395745648 buffer_by_m = " sarea 42

@Help % cancel < oK

6. Cliquez sur OK

7. Faites défiler le champ AREA dans la table attributaires et vous remarquerez qu’il est rempli de valeurs
(vous devrez peut-€tre cliquer sur 'en-téte de la colonne pour actualiser les données).

Note: Ces zones respectent les parametres des unités de surface du projet, elles peuvent donc étre en metres
carrés ou en degrés carrés.

5. Appuyez sur & pour enregistrer les modifications et quittez le mode d’édition avec /  basculer en mode édition,
6. Fermer la table d’attributs

Maintenant que nous avons les données, utilisons-les pour rendre la couche 1anduse.
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1. Ouvrez l'onglet proprietes couche du dialogue Symbologie pour la couche 1anduse.
2. Changer le style de classification de Categorise a Gradue.
3. Changer la Valeur & AREA.

4. Sous plage couleurs, choisissez I'option créer une nouvelle plage de couleurs ... :

(2} Layer Properties - landuse | Symbology P4
| :-Graduated - |
value |‘1-2 AREA T | |E|
Symbaol | |'|
Legend format |%1 - %2 | precision 4 || V| Trim
" Symbology -
Colorramp | ~ I
€ Labels | Classes | i Invert Color Ramp
Al Random Color Ramp
D Masks Symbol ~ |V
- I Blues
b .
1 Diagrams I Greens
E Fields M Greys
. Magma
E Attributes Form I |Rde
I Reds
Joins
I |Spectra|
E - iary Storage . Viridis
All Color Ramps b
,.Q Actions
' Display Edit Color Ramp...
’ —— Save Color Ramp..,
4 Rendering Mode |HEHEqU'ﬂm:; T Classes | 5 =
Q oo | Cassify || % ||=|| Deetel | [Advanced_~]

V| Link class boundaries

Variables

P Layer Rendering

-

Metadata

[ s - o | conel || sy || b |

5. Choisissez degrade (si ce n’est pas déja sélectionné) et cliquez sur OK. Vous verrez ceci :
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() Select Color Ramp >

Color 1 | (N |~ color 2 | IR |~/ Type | Continuous B

] ]
w Gradient Stop -
Relative position | 0.0 %G Delete Stop
5 *
e Z « R o :
Sancrd ol "l Os I - |-
- U :
= I -
R | Opadty A oo -
® | = HTML notation | 0000fFF
Current *
w Plot
Information oK Cancel Help

Vous utiliserez ceci pour désigner la zone, avec des petites zones comme Couleur 1 et des grandes zones comme
Couleur 2.

6. Choisissez les couleurs appropriées

Dans cet exemple, le résultat doit ressembler a cela :
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(&) Select Color Ramp >

""| Type |Canﬁnuous h |

|| color 2 | GG

Color 1 |

w Gradient Stop |~

Relative position | 0.0 % = | Delete Stop
s = | Os I —

Fe
=
I\!}I W
I

v||

T e
oLy

_~| | opaaty METTE
|@"E| HTML notation | £b2dfea 7 |
Curent : I I T e
w Plot
-
Information oK ] | Cancel | | Help

7. Cliquez sur OK

8. Vous pouvez enregistrer la plage de couleur en sélectionnant sauvegarder la plage couleurs... sous 'onglet plage
de couleurs. Choisissez un nom approprié pour la plage de couleurs et cliquez sur sauvegarder. Vous pourrez
maintenant sélectionner la méme plage de couleurs facilement sous foutes les plages de couleurs.

9. Sous Mode choisissez H_H Nombre égal (Quantile)

10. Cliquez sur Classer.

Maintenant, vous aurez quelque chose comme ¢a :
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@ Layer Properties - landuse | Symbelogy x
Q = Graduated - |
= value 12 anea - [g]
Symboal | |:|

Legend format | %1 - %2 | | Precision 0 |$| V! Trim

‘ Symbology -
Colorramp | . S——

abe -

| Classes | Histogram

e Symbol ™ Values Legend
¥ 131.30 - 10512.65 131-10313
¥ . 10512.65 - 35728.06 10513 - 35728
= v . 35728.06 - 132271.73 35728 - 132272
= ¥ . 132271.73 - 362220.57 132272 - 362221
- ¥ . 362220.57 - 112894046.06 362221 - 112894046
=0
Mode | H:EHEquaI Count (Quantile) ~ | Classes | 5 3|
| Classify | |¥| |;| | Delete Al | | Advanced '|
V| Link class boundaries
O

B Layer Rendering

| stye - ok || cancel || Appy || hHep |

Laissez tout le reste tel quel.

11. Cliquez sur OK :

Bontebok &ishop}
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3.3.4 Try Yourself Affiner la Classification

* Modifiez les valeurs Mode et Classes jusqu’a obtention d’une classification qui ait du sens.

Réponse

The settings you used might not be the same, but with the values Classes = 6 and Mode = Natural Breaks (Jenks) (and
using the same colors, of course), the map will look like this:

“Boniebok National|Rark[Recepion/& Shoplt

3.3.5 Follow Along: Classification basée sur des régles
1l est souvent utile de combiner plusieurs critéres pour une classification, mais une classification normale ne prend
malheureusement d’un seul attribut en compte. C’est la que la classification basée sur de régles est trés pratique.

Dans cette lecon, nous allons représenter la couche 1anduse de maniere a identifier facilement la ville principale
de l'autre zone résidentielle et des autres types d’utilisation du sol (en fonction de leur supetficie).

1. Ouvrez le dialogue Propriétés de la couche pour la couche landuse.
2. Passez a I'onglet Symbologie
3. Changez le style de classification en basé sur des régles.

QGIS affichera automatiquement les régles qui représentent la classification actuelle mise en ceuvre pour cette
couche. Par exemple, apres avoir terminé I'exercice ci-dessus, vous pouvez voir quelque chose comme ceci :
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@ Layer Properties - landuse | Symbelo 4
y p Y gy
- [= Rule-based -
q Information Label Rule Min, scale Max.
v 131 - 101924 "AREA" »= 131.299349 AND "AREA" <= 101924.499748
;{:\a_ TrnmEz v 101924 - 300418 "AREA" » 101924.495748 AND "AREA" <= 309417.846808
: v 300418 - 839955 "AREA" » 309417.846808 AND "AREA" <= 839954.777508
v . 839955 - 1578789 "AREA" » 839954,777508 AND "AREA" <= 1578788.863263
v . 1578789 - 34452227 "AREA" » 1578788.863263 AND "AREA" <= 34452226.958486
€8 Labels v . 34452227 - 112884046 "AREA" » 34452226,958486 AND "AREA" <= 112894046.060455
D Masks
- . _
. Diagrams 7 5
E Fields g I = Symbel Levels...
: Refine Selected Rules
E Attributes Form

p Layer Rendering

Joins Style - oK Cancel Apply Help

4. Cliquez et glissez pour sélectionner toutes les regles

5. Utilisez le bouton "= Supprimer régles sélectionnées o supprimer toutes les régles existantes

Ajoutons maintenant nos régles coutumieres.

1. Cliquez sur le bouton '37':'-!] ajouter regle
2. Le dialogue modifier regle apparait alors

3. Entrez Swellendam city sous la forme etiquette

4. Cliquez sur le bouton e a coté de la zone de texte Filtre pour ouvrir le construire une expression.

5. Entrez le critere "name" = "Swellendam" et validez

Expression String Builder x

Expression | Function Editor

)8 L L Q. search... group field ]
-~ 'Swellendam' i =
veLendan ’ Condlthnals Double-click to add field name to expression string.
» Conversions . .
» Custom Right-Click on field name to open context menu sample value
» Date and Time loading options.
~ Fields and Values Notes
NULL oles L
123 ogc_Ffid
abe full_id Values | C. Search...
abc psm_id
s osm_type All Unique 10 Samples
< landuse Fynbos Heights E
Gaikou Lodge
ahe bype Koloniesbos
— ane wikipedia Koornland
= A AU D) avc boundary Marloth Nature Reserve
ab< s in Railton
Feature 1 - > avc [eisure swellendam
Preview: 0 abc pame:de - |Wamakersbos -
@Help * cancel

6. Back to the Edit rule dialog, assign it a darker grey-blue color in order to indicate the town’s importance in the
region and remove the border
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Label swellendam city =
e Filter "name" = 'Swellendam’ b Test
Else Catch-all For other Features
Description
Scale range
v Symbol
=
M simple Fill
Unit Millimekers -
Opacity _11100.0 % -
Color v

-

@Help ¥ cancel

7. Cliquez sur OK
8. Répétez les étapes ci-dessus pour ajouter les regles suivantes :

1. Other residential label with the criterion "landuse" = 'residential' AND "name" <>
'Swellendam'. Choose a pale blue-grey Fill color

2. etiquette Big non residential areas avec le critere "landuse" <> ‘'residential' and
"AREA" >= 605000. Choisissez une couleur verte moyenne.

Layer Properties — landuse (basic) — Symbology 0

2 Rule-based

fi Information Label Rule Min. Scale Max. Scale  Count Duplicate Count
v| [l swellendam city "name" = 'Swellendam’
:{_‘\\ Source v Other residenttial "landuse" = 'residential' AND "name" <> 'Swellendam’

v| [l Big non residential areas "landuse" <> 'residential' AND "AREA" >= 605000
& symbology

WF 3D View

Diagrams

-
'
o Z[|Z symbol Levels...

E Fields

E Attributes Form e Redering

Joins - | @Help Style - «/ Apply || % cancel

Ces filtres sont exclusifs, en ce sens qu’ils excluent des zones sur la carte (les zones non résidentielles
inférieures a 605 000 (metres carrés) ne sont incluses dans aucune des regles).

3. Nous allons capturer les entités restantes en utilisant une nouvelle regle intitulée Small non residential

areas. Au lieu d’'une expression de filtre, vérifiez le e Else. Donnez a cette catégorie une couleur vert
pale appropriée.
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Label small non residential areas

Filter
® Else Catch-all for other features
Description

Scale range

v| Symbol

o
simple Fill

Unit Millimeters -
Opacity _11100.0 % -

Color v

-

©@Help % Cancel

Vos regles devraient maintenant ressembler a ceci :

Layer Properties — landuse (basic) — Symbology B

2 Rule-based -

@) information * |Label Rule Min. Scale Max. Scale  Count Duplicate Count
v| [l swellendam city "name" = 'Swellendam’
:{_‘\\ Source v Other residenttial "landuse" = 'residential' AND "name" <> 'Swellendam'
v/ [l Big non residential areas "landuse” <> 'residential’ AND "AREA" >= 605000
‘ Ssymbology v small non residential areas ELSE
€= Labels
€0 Masks
W 3D View
. Diagrams
s Z[| 2 symbol Levels...

E Fields

E Attributes Form

Joins - | @Help Style ~ «/Apply | % cCancel

b Layer Rendering

9. Appliquer cette symbologie

Votre carte ressemblera a quelque chose comme ¢a :
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Bontebok National Rerk Reception's| Shop !

Maintenant que vous avez une carte avec Swellendam, le quartier résidentiel le plus important et d’autres quartiers
non résidentiels colorés en fonction de leur taille.

3.3.6 In Conclusion

La symbologie nous permet de représenter les attributs d’'une couche d’une fagon facile a lire. Cela nous permet aussi
bien qu’au lecteur de carte de comprendre la signification de caractéristiques, en utilisant tout attribut pertinent que
nous choisissons. En fonction des problemes auxquels vous faites face, vous appliquerez différentes techniques de
classification pour les résoudre.

3.3.7 What’s Next?

Nous avons maintenant une carte de belle apparence, mais comment allons-nous sortir de QGIS dans un format que
nous pouvons imprimer, ou en faire une image ou un PDF ? C’est le sujet de la prochaine legon !
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Module: Mise en place des cartes

Dans ce module, vous apprendrez a utiliser la mise en page de QGIS pour produire des cartes de qualité avec tous les
composants de carte nécessaires.

4.1 Lesson: Utilisation de mise en page

Maintenant que vous avez une carte, vous devez pouvoir I'imprimer ou I'exporter vers un document. La raison en
est qu’un fichier de carte SIG n’est pas une image. Il enregistre plutdt I'état du programme SIG, avec des références
a toutes les couches, leurs étiquettes, leurs couleurs, etc. Ainsi, pour quelqu’un qui ne dispose pas des données ou
du méme programme SIG (comme QGIS), le fichier de carte sera inutile. Heureusement, QGIS peut exporter son
fichier de carte dans un format que n‘importe quel ordinateur peut lire, ainsi qu'imprimer la carte si vous avez une
imprimante connectée. L’exportation et I'impression sont toutes deux gérées par la fonction Mise en page.

L’objectif de cette lecon: Utiliser Mise en page QGIS pour créer une carte avec tous les parametres requis.

4.1.1 Follow Along: Le gestionnaire de mise en page
QGIS vous permet de créer plusieurs cartes en utilisant le méme fichier cartographique. Pour cette raison, il dispose
d’un outil appelé Gestionnaire mise en page.

1. Cliquez sur I'entrée de menu Projet » Gestionnaire de msie en page... pour ouvrir cet outil. Vous verrez
apparaitre un dialogue Gestionnaire de mise en page vide.
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Layout Manager

w New from Template

Empty layout -

Open template directory User

@Help % Close

2. Sous Un nouveau depuis le modéle, sélectionnez Mise en page vide et appuyez sur le bouton Créer....
3. Donnez a la nouvelle mise en page le nom de Swellendam et cliquez sur OK.

4. Vous verrez maintenant la fenétre Mise en page :

*Swellendam

Layout Edit View Items AddItem Atlas Settings

REE [ & By b Y | | &
AL PHY BRI QO A
P LR P | ems | undo wistory
[ Items (=)
® @ Item

| |
toa bl v b

50

Layout | Item Properties | Guides
Layout [E5]

w General Settings

100

Reference map =

¥ Guides and Grid

150

Grid spacing
10,00 - || mm -

Grid offset

200

x: 0,00
mm -

ovar el FHANERWBHEZTSE

y: 0,00

Snap tolerance

«
o
4

g
1 |

x: 238 mm y: 0 mm page: 1 35.6% |9

Vous pouvez également créer cette nouvelle mise en page via le menu Projet » Nouvelle mise en page....

Quel que soit le chemin que vous empruntez, la nouvelle mise en page est désormais accessible depuis le menu Projet
» Mise en page », comme dans 'image ci-dessous.
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Edit View Layer Settings Plugins Vector Raster Databa

" New Ctrl+N ;] g_j g__) &q

New from Template ’
Qpen... ctrl+o
Open From b
Open Recent »
Close
= save ctrl+s
| Save As... Ctrl+Shift+s
save To »
Revert...
Properties... Ctrli+Shift+P
Snapping Options...
Import/Export »
i New Print Layout... ctrl+P

i) New Report...

% Layout Manager...

Swellendam
Exit QGIS crl+Q

4.1.2 Follow Along: Composition d’une carte de base

Dans cet exemple, la composition était déja telle que nous la voulions. Assurez-vous de faire de méme.

1. Faites un clic droit sur la feuille dans la partie centrale de la fenétre de mise en page et choisissez Propriétés de
page... dans le menu contextuel.

2. Vérifiez que les valeurs dans I'onglet Propriétés élément sont définies comme suit :
* taille: A4.
e Orientation : Paysage.

Vous avez maintenant la mise en page que vous souhaitez, mais cette page est encore vierge. Il manque
clairement une carte. Ajoutons cela !

3. Cliquez sur le bouton | &y Ajouter e carte
Avec cet outil activé, vous pourrez placer une carte sur la page.

4. Cliquez et faites glisser un bloc sur la page blanche :
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*Swellendam

Layout Edit View [tems AddItem Atlas Settings

BRLURORE B @ikt e | | BE H- @

|o |50 |1on |150 |2ﬂn |250 | ‘300 ltems E®
v bbb b bvraoa b bvooo v bvvoar b bl vrah g —
@ 3 = & Item
el
ﬁ 3
5 EE Layout = Item Properties = Guides
!f;’ = Item Properties =]
8| :
L2
]
) .
E_
. |23
=._n ]
= ]
he <
3
width: 289.104 mm height: 202.495 mm X:292.763 mm y: 206.154 mm page: 1 43.4% v [

La carte apparaitra sur la page.

5. Déplacez la carte en cliquant et en vous déplagant autour:

*Swellendam

Layout Edit View [tems AddItem Atlas Settings

BRUREE & ®Riplkho | | BE L @

300 Jtems

|0 |50 |100 ||150 |200 |250
s oo b b oo b b oo boode b rcoac oo b ocoa v boroa vl

@ = ltem

Layout | Item Properties | Guides

3l &7 =
I T T

I’\%’ Item Properties
8 Map 1
O ER ERIMNE =
¥ Main Properties [
Scale 38108 | &
R- -
i-'u =5 Map rotation 0,00 ° |v| LET
== - CRS | Use Project CRS - | |§|
A} —: v Draw map canvas items
U - v Lavers E
1 item selected X: 140.892 mm y: 101.247 mm page: 1 |43.4% v | ———e

6. Redimensionnez-le en cliquant et en faisant glisser sur les bords :
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Layout Edit View [tems AddItem Atlas Settings

BRURORE B @ik o BE - m

|n ] |50 |1nn |150 |2nn |250 ‘300 ltems E®
oo bevac bbb b bovvoe b boror b bvern vl —

@ - Item

| | | Map 1

I
i

50

Layout | Item Properties | Guides

16

153

R = Item Properties (G]E)
—| = Map 1

| = CEHRER LB =

IQ 22 | A
q B ¥ Main Properties

E Scale 38108 a

i 2c Map rotation 0,00 ° =RE"

= = CRS Use Project CRS - [@

A = O v Draw map canvas items

200

w Lavers e’
width: 270.196 mm height: 187.247 mm X: 25.0069 mm y: 20.7374 mm page: 1 43.4% v [k

Note: Votre carte peut étre tres différente, bien stir ! Cela dépend de comment est configuré votre propre
projet. Mais pas de panique ! Ces instructions sont générales, donc elles fonctionneront de la méme maniere,
peu importe a quoi ressemble la carte.

7. N’oubliez pas de laisser des marges sur les bords, et un espace sur le dessus pour le titre.

8. Zoomez et dézoomez sur la page (mais pas sur la carte !) en utilisant ces boutons :

Hep

9. Zoomez et faites un panoramique de la carte dans la fenétre principale de QGIS. Vous pouvez également
effectuer un panoramique de la carte en utilisant I'outil LB aephcer e contemu e Ielement
La vue de la carte s’actualise au fur et 2 mesure que vous faites un zoom avant ou arriere.
10. Si, pour une raison quelconque, la vue de la carte ne se rafraichit pas correctement, vous pouvez forcer la carte

| -
a se rafraichir en cliquant sur le bouton M/ Rafraichirla vue

N’oubliez pas que la taille et la position que vous avez indiquées sur la carte n’ont pas besoin d’étre définitives.
Vous pouvez toujours revenir et la modifier plus tard si vous n’étes pas satisfait. Pour I'instant, vous devez vous
assurer que vous avez bien enregistré votre travail sur cette carte. Etant donné qu'une mise en page dans QGIS
fait partie du fichier principal de la carte, vous devez enregistrer votre projet.

=]
11. Allez a la page mise en page » sauvegarder projet. C’est un raccourci pratique vers celui du dialogue
principal.
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4.1.3 Follow Along: Ajout d’un Titre

Votre carte a maintenant fiere allure sur la page, mais vos lecteurs/utilisateurs ne sont pas encore informés de ce qui se
passe. Ils ont besoin d’un contexte, et c’est ce que vous leur fournirez en ajoutant des éléments de carte. Commengons
par ajouter un titre.

. T| . A
Cliquez sur le bouton ajouter etiquette

1.
2. Cliquez sur la page, au-dessus de la carte, acceptez les valeurs suggérées dans le dialogue nouvelles proprietes
element, et une étiquette apparaitra en haut de la carte.
3. Redimensionnez-la et place-la en haut au centre de la page. Elle peut étre redimensionnée et déplacée de la
méme fagcon que lorsque vous avez redimensionné et déplacé la carte.
Lorsque vous déplacez le titre, vous remarquerez que des lignes directrices apparaissent pour vous aider a
positionner le titre au centre de la page.
Cependant, il existe également un outil dans la barre d’outils des actions pour aider a positionner le titre par
rapport a la carte (et non a la page) :
|I:l
4. Cliquez sur la carte pour la sélectionner
5. Maintenez Shift sur votre clavier et cliquez sur I'étiquette de sorte que la carte et I'étiquette soient toutes
deux sélectionnées.
2 i s céments sélectonneés  gauch , o ,
6. Cherchez le bouton igner fes elements selectionnes @ gauche et cliquez sur la liste déroulante a coté pour faire
apparaitre les options de positionnement et cliquez sur il aligner centré :
.
9 S b M 2
- - - - -
| 300 |tem Align Left
11 —
=
| Align Right
v
Align Top
= Align Center Vertical
Layi - Align Bottom
Maintenant, le cadre de I'étiquette est centré sur la carte, mais pas le contenu. Pour centrer le contenu de
I'étiquette :
1. Sélectionnez I'étiquette en cliquant dessus.
2. Cliquez sur 'onglet proprietes element dans le panneau latéral de la fenétre de mise en page.
3. Changez le texte de I'étiquette en « Swellendam » :
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Layout | Item Properties | Guides

Itemn Properties @
Label

¥ Main Properties

Sswellendam

Render as HTML

Insert an Expression...

v Appearance

Font r
Font color I (-
Horizontal margin | 0.00 mm =
Vertical margin 0.00 mm =

Horizontal alignment

Left Center Right (e Justify
Vertical alignment
e Top Middle Bottom

Position and Size

>

P Rotation

3 Frame

3 Background
P Item ID

4. Utilisez cette interface pour définir les options de police et d’alignement sous la section Apparence :

1. Choisissez une police large mais raisonnable ('exemple utilisera la police par défaut avec une taille
de 36)

2. Définissez le Alignement horizontal a Centrer.

Vous pouvez également changer la couleur de la police de caractere, mais il est probablement préférable
de la laisser en noir, comme par défaut.

5. La configuration par défaut n’ajoute pas de cadre autour de la boite de texte du titre. Cependant, si vous
le souhaitez, vous pouvez le faire :

1. Dans l'onglet Propriétés de l'objet, faites défiler vers le bas jusqu’a ce que vous voyiez 'option Cadre.

2. Cochez la case Cadre pour activer le cadre. Vous pouvez également changer la couleur et 'épaisseur
du cadre.

Dans cet exemple, nous n’activerons pas le cadre, ainsi voici notre page telle qu’actuellement :

Lesson: Utilisation de mise en page 113



QGIS Training Manual

*Swellendam
Layout Edit View [tems AddItem Atlas Settings

BRLRDR B ®kimlke BB Q9 &E A - L -

|n |50 |1nn |150 | |2nn |250 ‘300 ltems E®
v dvven bbb boraoa b bvoaoalbcooao brvoaborooboror ol —
@ |3 @ - Item
) [ | | Swellendam
| - Swellendam v 0] Map 1
ﬁ 3
I

2- Layout | Item Properties | Guides
R = Item Properties =]
|
IS
]
B
5 7=
== E
Ao g

X:173.218 mm y: -4.26947 mm page: 1 43.4% > | F

Pour vous assurer que vous ne déplacez pas accidentellement ces éléments maintenant que vous les avez alignés,
vous pouvez les verrouiller :

1. Sélectionnez a la fois I'étiquette et les éléments de la carte

T
2. Cliquez sur le bouton % Bloguer éléments sélectionnés qang |a barre d’outils Actions.

Note: Cliquez sur le bouton [el Déverrouiller tous les éléments qang Ja barre d’outils Actions pour pouvoir
modifier a nouveau les éléments.

4.1.4 Follow Along: Ajout d’'une Légende

Le lecteur de carte doit également étre capable de voir ce que signifient réellement les différents éléments de la carte.
Dans certains cas, comme les noms de lieux, cela est assez évident. Dans d’autres cas, c’est plus difficile a deviner,
comme les couleurs des foréts. Ajoutons une nouvelle légende.

. CN .
1. Cliquez sur le bouton 8- Ajouter légende |

2. Cliquez sur la page pour placer la 1égende, acceptez les valeurs suggérées dans le dialogue Nouvelle propriété
de élément,

3. Une légende est ajoutée a la page de mise en page, montrant la symbologie des couches telle qu’elle est définie
dans le dialogue principal.

4. Comme d’habitude, vous pouvez cliquer et déplacer I'objet 1a ol vous le souhaitez :
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4.1.5 Follow Along: Personnaliser les éléments de lIégende

Pas tout dans la 1égende n’est nécessaire, alors enlevons quelques éléments non souhaités.

1. Dans l'onglet Propriétés de l'élément, vous trouverez le groupe Eléments légende.

2. Décochez la case O Mise a jour automatique, vous permettant de modifier directement les éléments de la
légende

3. Sélectionnez I'entrée avec buildings.

4. Supprimez-le de la légende en cliquant sur le bouton =

Vous pouvez aussi renommer les éléments.

1. Sélectionnez une couche dans la méme liste.
2 CliqueZ sur le bouton @ Editer les propriétés de I'’élément sélectionné

3. Renommez les couches en Places, Roads and Streets, Surface Water etRivers.

Vous pouvez également les commander a nouveau :
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Comme la légende sera probablement €largie avec les nouveaux noms des couches, vous pouvez déplacer et
redimensionner la 1égende et/ou la carte. Voici le résultat :
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4.1.6 Follow Along: Exporter votre carte

Note:

Avez-vous pensé a souvent sauvegarder votre travail ?

La carte est enfin préte pour I'exportation ! Vous verrez les boutons d’exportation dans le coin supérieur gauche de la
fenétre de mise en page :

B0 tmprimer . interface avec une imprimante. Comme les options d’impression different selon le modele

d’'imprimante avec lequel vous travaillez, il est probablement préférable de consulter le manuel de 'imprimante
ou un guide général d’'impression pour plus d’informations sur ce sujet.

Les autres boutons vous permettent d’exporter la page de la carte vers un fichier.

B Exporter comme image + yous donne une sélection de divers formats d’'images courants parmi lesquels vous
pouvez choisir. C’est probablement I'option la plus simple, mais I'image qu’elle crée est « figée » et difficile a
modifier.

Exporterauformat SVG . G yous envisagez d’envoyer la carte a un cartographe (qui peut vouloir 'éditer pour la
publier), il est préférable de I'exporter en SVG. SVG signifie « Scalable Vector Graphic », et peut étre importé
dans des programmes comme Inkscape ou d’autres logiciels d’édition d’images vecteur.

"L' Exporterau format PDF . G yous devez envoyer la carte a un client, il est plus courant d’utiliser un PDF, car il
est plus facile de configurer les options d’impression pour un PDF. Certains cartographes peuvent également
préférer le format PDF, s’ils disposent d’un programme qui leur permet d’'importer et de modifier ce format.

Pour nos fins, nous allons utiliser un PDF.

1.
2.

. >
Cllquez sur le bouton Exporter au format PDF

Choisissez un emplacement de sauvegarde et un nom de fichier comme d’habitude. La boite de dialogue
suivante s’affiche.
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PDF Export Options 0

lw| Export Options

Always export as vectors
v Append georeference information

v Export RDF metadata (title, author, etc.)

Text export | Always Export Text as Paths (Recommended) -

v Advanced Options

Disable tiled raster layer exports

v Simplify geometries to reduce output File size

@Help % cancel | Psave |

Vous pouvez maintenant utiliser en toute sécurité les valeurs par défaut et cliquer sur Sauvegarder.

QGIS procédera a I'exportation de la carte et ajoutera un message au dialogue de mise en page deés qu’il sera
terminé.

Cliquez sur I'hyperlien dans le message pour ouvrir le dossier dans lequel le PDF a été enregistré dans le
gestionnaire de fichiers de votre systéme

Ouvrez-le et voyez a quoi ressemble votre mise en page.
Tout va bien ? Félicitations pour votre premier projet de carte QGIS achevé !

Quelque chose d’insatisfaisant ? Retournez a la fenétre QGIS, faites les modifications appropriées et exportez
a nouveau.

. N’oubliez pas de sauvegarder votre fichier de projet.
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4.1.7 In Conclusion

Vous savez maintenant comment créer une carte statique de base. Nous pouvons aller plus loin et créer une mise en
page de carte qui s’adapte dynamiquement, avec plus d’éléments de mise en page.

4.2 Lesson: Créer une mise en page dynamique

Maintenant que vous avez appris a créer une mise en page de base, nous allons un peu plus loin et créons une mise en
page qui s’adapte dynamiquement a I’étendue de notre carte et aux propriétés de la page, par exemple lorsque vous
changez la taille de la page. De méme, la date de création s’adaptera de maniere dynamique.

4.2.1 Follow Along: Création du canevas de carte dynamique

. Chargez les jeux de données au format ESRI Shapefile protected_areas.shp, places.shp,
rivers.shpetwater. shp dansle canevas de carte et modifiez leurs propriétés a votre propre convenance.

. Une fois que tout est rendu et symbolisé 4 votre convenance, cliquez sur ") Nouvelle mise en page d'impression qapg 15

barre d’outils Projet ou choisissez Projet » "~ Nouvelle mise en page d’impression. Vous serez invité a choisir
un titre pour la nouvelle mise en page.

. Nous voulons créer une mise en page cartographique composée d’un en-téte et d’une carte de la région pres de
Swellendam, en Afrique du Sud. La mise en page doit avoir une marge de 7,5 mm et I’en-téte doit avoir une
hauteur de 36 mm.

. Créez un élément de carte appelé carte principale sur le canevas et allez dans le panneau mise en
page. Descendez jusqu’a la section Variables et trouvez la partie mise en page. Ici, nous définissons quelques
variables que vous pouvez utiliser dans toute la mise en page dynamique. Allez dans le panneau mise en page

et descendez jusqu’a la section Variables. La premicre variable définira la marge. Appuyez sur le bouton E'E-llj

et tapez le nom sw_layout_margin. Définissez la valeur a 7. 5. Appuyez a nouveau sur le bouton I:II-I:I-I:I et
tapez le nom w_layout_height_header. Mettez la valeur a 36.

. Vous €tes maintenant prét a créer automatiquement la position et la taille du canevas de la carte au moyen des
variables. Assurez-vous que votre élément de carte est sélectionné, allez dans le panneau proprietes element,

faites défiler vers le bas et ouvrez la section Position et taille. Cliquez sur I'expression 4E] passer outre les donnees
pour X et a partir de 'entrée Variables, choisissez @sw_layout_margin.

'ﬂF, passer outre les données définies

. Cliquez sur I'expression pour Y, choisissez editer... et tapez la formule: :

[to_real(@sw_layout_margin) + to_real (@sw_layout_height_header)

)

7. Vous pouvez créer la taille de I'’élément de carte en utilisant les variables largeur et hauteur. Cliquez sur

I’expression & passer outre les donnees definies pour largeur et choisissez Edit ... A nouveau. Remplissez la formule: :

[@layout_pagewidth - @sw_layout_margin * 2

)

-!JF, passer outre les donnees definies

Cliquez sur I'expression pour hauteur et choisissez Edit .... Remplissez ici la
formule: :
[@layout _pageheight - (@sw_layout_height_header - (@sw_layout_margin * 2

8. Nous allons également créer une grille contenant les coordonnées de I'étendue du canevas de la carte principale.
Allez a nouveau sur proprietes element et choisissez la section grille. Insérez une grille en cliquant sur le bouton

L-II:I-IIJ. Cliquez sur modifier grille ... et définissez I'intervalle Intervalle pour X, Y et Offset selon I'échelle de la
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carte que vous avez choisie dans le canevas principal du QGIS. Le T'ype de grille Cross est tres bien adapté a
nos besoins.

4.2.2 Follow Along: Création de I'’en-téte dynamique

1. Insérez un rectangle qui contiendra len-téte avec le bouton =i Aloweruneforme — Dyang Je panneau:
guilabel:Eléments, entrez le nom header.

2. Encore une fois, allez dans la section proprietes element et ouvrez la section position et taille. En utilisant €
passer outre les donnees definies - ¢hojsissez la variable sw_layout_margin pour X ainsi que pour Y. largeur sera
définie par I'expression: :

[@layout _pagewidth - @sw_layout_margin * 2

et hauteur par la variable sw_layout_height_header.
3. Nous allons insérer une ligne horizontale et deux lignes verticales pour diviser I'en-téte en différentes sections

al'aide de la fonction IE ajouter element noeud - Créez une ligne horizontale et deux lignes verticales et nommez-les
Ligne horizontale,Ligne verticale 1,Ligne verticale 2.

1. Pour la ligne horizontale
1. Mettez X a la variable sw_layout_margin.

2. Définissez I'expression pour Y a: :

[@sw_layout_margin + 8

3. Définissez I'expression pour largeur a: :

[@layout_pagewidth - (@sw_layout_margin * 3 - 53.5

2. Pour la premiere ligne verticale :

1. Définissez I'expression pour X a: :

[@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. Mettez Y ala variable sw_layout_margin.

3. La hauteur doit étre la méme que celle de I'en-té€te que nous avons créé, donc mettez hauteur a la
variable sw_layout_height_header.

3. La deuxieme ligne verticale est placée a gauche de la premiere

1. Définissez I'expression pour X a: :

[@layout_pagewidth - @sw_layout_margin * 2 - 83.5 }

2. Mettez Y ala variable sw_layout_margin.

3. La hauteur doit étre la méme que celle de l'autre ligne verticale, donc mettez hauteur a la variable
sw_layout_height_header.

La figure ci-dessous montre la structure de notre mise en page dynamique. Nous allons remplir les zones créées
par les lignes avec quelques éléments.
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Layout Edit View Items AddIitem Atlas Settings

BRLEE (2 ®Blulhe

LPLRLRRC BE G & O bbHE]
Rannnnn Racnanna Bannann e nannaatnsna] et aonlanninn ks

F

:& ;

TR cal e

&

o

&2

¥
t
[eamannarRlannnn

20

&

4

204 204 20.5 205 206 20.6

339 4 -+ + + —+ +

140‘ 120‘
Vi

1 item selected

-33.9

-34.0

-34.0

Items | Undo History

Items
@

v
v

v
v

JRRIRIR R RIRIQE

Item

™ logo organisation

{7 vertical line 2

{7 vertical line 1

map description

== scale

= north arrow

[T] project title (Variable)
[T] organisation information (Variables)
" horizontal line

1 _hearder

Layout | Item Properties | Guides | Atlas

Item Properties

< | Map Grid Properties

w Appearance

2®

¥ (][] [O0] [ ¢

<

4.2.3 Follow Along: Création d’étiquettes pour I'en-téte dynamique

Grid type Cross
CRs EPSG:4326
Interval units Map unit
X 0,050000000000
Interval
'Y 0,050000000000 a
X 0,050000000000
Offset
'Y 0,000000000000
Cross width 3,00 mm
Line style
» Blend mode Normal
x:124.577 mm y: 92.8866 mm page: 1 96.8% MLE

1. Le titre de votre projet QGIS peut étre inclus automatiquement. Le titre est défini dans les proprietes projet.

Insérez un label avec le bouton Iﬂ ajouter etiquette ot entrez le nom project title (variable). Dans
le panneau Main Properties du panneau proprietes element, entrez I'expression: :

[[%@project_title%]

Définissez la position de I’étiquette.

1. Pour X, utilisez I'expression: :

[@sw_layout_margin + 3

2. Pour Y, utilisez I'expression: :

[@sw_layout_margin + 0.25

3. Pour largeur, utilisez I'expression: :

[@layout _pagewidth - @sw_layout_margin *2 - 90

4. Entrez 11, 25 pour hauteur.

Sous Apparence, définissez la taille de la police & 16 pt.

2. La deuxieme étiquette comprendra une description de la carte que vous avez créée. La encore, insérez une
étiquette et nommez-la description de la carte. Dans le champ Propriétés principales, entrez le
texte description de la carte. Nous inclurons également

[printed on: [%format_date(now (), 'dd.MM.yyyy') %]

Nous avons utilisé ici deux fonctions Date et Heure (now et format_date).

Définissez la position de I'étiquette.

1. Pour X, utilisez I'expression: :

4.2. Lesson: Créer une mise en page dynamique

121



QGIS Training Manual

[@sw_layout_margin + 3 J

2. Pour Y, utilisez 'expression: :

[@sw_layout_margin + 11.5 J

3. Latroisieme étiquette comprendra des informations sur votre organisation. Nous allons d’abord créer quelques
variables dans le menu Variables des Propriétés de ['élément. Allez dans le menu Mise en page, cliquez sur

le bouton Ifl'l:ll-:| a chaque fois et entrez les noms o_department, o_name, o_adress et o_postcode.
Dans la deuxieme ligne, entrez les informations concernant votre organisation. Nous utiliserons ces variables
dans la section Propriétés principales.

Dans Propriétés principales, entrez

o

@o_name %]
@o_department %]
Qo_adress %]
@o_postcode %]

o° o o oP

Définissez la position de Iétiquette.

1. Pour X, utilisez I'expression: :

[@1ayout_pagewidth - @sw_layout_margin - 49.5 }

2. Pour Y, utilisez 'expression: :

[@sw_layout_margin = 15,95 }

3. Pour largeur, utilisez 49 . 00.

4. Pour hauteur, utilisez 'expression: :

[@sw_layout_height_header = 15,5 J
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Layout @ Item Properties = Guides = Atlas

Item Properties
Label

¥ Main Properties

[% @o_name%]

[% @0 department]
[% @o_adress%]

Pﬁ @o_postcode%|

Render as HTML

Insert an EKPFEESiGI"I...

(& (=)

4.2.4 Follow Along: Ajout d'images dans I'en-téte dynamique

1. Utilisez le bouton ““ ¥owerimage pour placer une image au-dessus de votre étiquette information
d'organisation. Apres avoir saisi le nom logo de 1'organisation, définissez la position et

la taille du logo :

1. Pour X, utilisez 'expression: :

[@layout_pagewidth - @sw_layout_margin - 49.5

2. Pour Y, utilisez 'expression: :

[@sw_layout_margin + 3.5

3. Pour largeur, utilisez 39.292

4. Pour hauteur, utilisez 9.583

Pour inclure un logo de votre organisation, vous devez enregistrer votre logo sous votre répertoire d’origine et

entrer le chemin sous Propriétés principales w» Source de l'image.

2. Notre tracé a encore besoin d’une fleche nord. Celle-ci sera également insérée en utilisant ﬁb Ajouter flzche du nord |

Nous utiliserons la fleche nord par défaut. Définissez la position :

1. Pour X, utilisez I'expression: :

[@layout_pagewidth - @sw_layout_margin * 2 - 78

2. Pour Y, utilisez I'expression: :

4.2. Lesson: Créer une mise en page dynamique
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[@ sw_layout_margin + 9

3. Pour Largeur, utilisez 21 .027

4. Pour Hauteur, utilisez 21 .157.

4.2.5 Follow Along: Création de la barre d’échelle de I'en-téte dynamique

1. Pour insérer une barre d’échelle dans I'en-téte, cliquez sur £z Alouter barre déchelle ot places ]a dans le rectangle
au-dessus de la fleche nord. Dans Carte sous Propriétés principales choisissez votre carte principale
(Carte 1). Cela signifie que I'échelle change automatiquement selon I'étendue que vous choisissez dans le
canevas principal de QGIS. Choisissez le Style Numérigue. Cela signifie que nous insérons une échelle simple
sans barre d’échelle. L’échelle a encore besoin d’une position et d’une taille.

1. Pour X, utilisez I'expression: :

[@layout_pagewidth - @sw_layout_margin * 2 - 78 ]

2. Pour Y, utilisez I'expression: :

[@ sw_layout_margin + 1 ]

3. Pour Largeur, utilisez 25.
4. Pour Hauteur, utilisez 8.
5. Placezle Point de référence au centre.

Félicitations ! Vous avez créé votre premiere mise en page de carte dynamique. Jetez un coup d’ceil a la mise en
page et vérifiez si tout est comme vous le souhaitez ! La mise en page de la carte dynamique réagit automatiquement
lorsque vous modifiez les propriétés de la Page. Par exemple, si vous changez la taille de la page de DIN A4 a DIN

| L
A3, cliquez sur le bouton e Rafraichirlavue of 15 conception de la page est adaptée.
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4.2.6 What’s Next?

Sur la page suivante, vous aurez un devoir a compléter. Cela vous permettra de pratiquer les techniques que vous
avez apprises jusqu’a présent.

4.3 Tache 1

Ouvrez votre projet de carte existant et révisez le completement. Si vous observez de petites erreurs ou des éléments
que vous vouliez réparer auparavant, faites-le maintenant.

Lors de la personnalisation de votre carte, posez-vous continuellement des questions. La carte est-elle facile a lire et
a comprendre pour quelqu’un qui n’est pas familier avec les données ? Si je voyais cette carte sur Internet, ou sur une
affiche ou dans un magazine, serait-elle capable de capturer mon attention ? Est-ce que je serais intéressé a lire cette
carte si elle n’était pas la mienne ?

Si vous suivez ce cours a un niveau Basique ou Intermédiaire, étudiez aussi les techniques dans les sections plus

avancées. Si vous voyez quelque chose que vous aimeriez faire dans votre carte, pourquoi ne pas essayer de I'appliquer
9

Si vous suivez ce cours avec l'aide de quelqu’un, cette personne peut vous demander de soumettre une version finale
de votre carte, exportée au format PDF, pour I'évaluation. Si vous suivez ce cours en auto-apprentissage, il est
recommandé que vous évaluiez votre propre carte en utilisant les mémes criteres de sélection. Votre carte sera évaluée
sur I'apparence générale et la symbologie de la carte elle-méme, aussi bien que sur 'apparence et la disposition de la
page et des éléments de la carte. Rappelez-vous que ’élément clé pour évaluer 'apparence des cartes sera toujours
la facilité d'utilisation. Une carte est faite pour &tre regardée et plus il est facile de la comprendre d’'un simple coup
d’ceil, mieux c’est.

Joyeuse personnalisation!

4.3.1 In Conclusion

Les quatre premiers modules vous ont appris a créer et mettre en forme une carte vecteur. Dans les quatre prochains
modules, vous apprendrez a utiliser QGIS pour une compléete analyse en SIG. 1l s’agira notamment de créer et éditer
des données vectorielles ; analyser des données vectorielles ; utiliser et analyser des données raster ; et utiliser le SIG
pour résoudre un probleme de bout en bout, a I'aide de données raster et vecteur.
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CHAPTER D

Module: Créer des données vectorielles

Créer des cartes a partir de données existantes n’est qu'un début. Dans ce module, vous apprendrez a modifier des
données vectorielles existantes et créer entierement de nouveaux jeux de données.

5.1 Lesson: Création d’un Nouveau Jeu de Données Vectorielles

Les données que vous utilisez doivent venir de quelque part. Pour la plupart des applications, les données existent
déja ; mais plus le projet est particulier et spécifique, moins il est probable que les données soient déja disponibles.
Dans ce cas, vous devez créer vos propres données.

Objectif de cette lecon : Créer un nouveau jeu de données vectorielles.

5.1.1 Follow Along: La boite de dialogue de création de couche

Avant que vous puissiez créer de nouvelles données vectorielles, vous avez besoin d’un jeu de données vectorielles
auquel les ajouter. Dans notre cas, vous commencerez par créer enticrement des nouvelles données, plutot que de
modifier un jeu de données existant. Par conséquent, vous devrez définir votre propre nouvel ensemble de données
en premier.

1. Ouvrez QGIS et créez un nouveau projet vierge.

2. Naviguez et cliquez sur I'entrée de menu Couche » Créer une couche w Nouvelle couche de fichier de forme.
Le dialogue nouvelle couche Shapefile s’affiche, vous permettant de définir une nouvelle couche .
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.
File name
File encoding UTF-8 >
Geometry type Point v
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WG5S B4 v ||

New Field

Name

Type | abc Text data v

Length |80 Precision

Add to Fields List

Fields List

MName Type Length Precision

id Integer 10

Remowve Field

OK Cancel Help

Cliquez sur ... pour le champ Nom fichier. Un dialogue de sauvegarde apparaitra.
Naviguez vers le répertoire exercise_data.
Enregistrez votre nouvelle couche sous le nom de school_property. shp.

C’est important de décider quelle sorte de jeu de données vous voulez a ce stade. Chaque différent type de
couche vectorielle est « construit différemment » dans le fond, alors une fois que vous avez créé la couche, vous
ne pouvez changer son type.

Pour le prochain exercice, nous allons créer de nouvelles entités qui décrivent des zones. Pour ces éléments,
vous devrez créer un ensemble de données polygone .

Pour type geometrie, sélectionnez Polygone dans le menu déroulant :

Geometry type ~ Polygon -

128

Chapter 5. Module: Créer des données vectorielles



QGIS Training Manual

Cela n’a pas d'impact sur le reste de la boite de dialogue, mais cela produira le bon type de géométrie a utiliser
quand le jeu de données vectorielles sera créé.

Le champ suivant vous permet de spécifier le systeme de référence des coordonnées, ou CRS. Le CRS est
une méthode permettant d’associer des coordonnées numériques a une position a la surface de la Terre. Voir
Utiliser les projections dans le manuel d’utilisation pour en savoir plus.

Pour cet exemple, nous utiliserons le CRS par défaut associé a ce projet, qui est WGS84.

EP5G:4326 - WG5S 84 Mk -

Ensuite, il y a une collection de champs regroupés sous nouvel attribut. Par défaut, une nouvelle couche n’a qu'un
seul attribut, le champ « id » (que vous devriez voir dans la liste des champs champs) ci-dessous. Cependant,
pour que les données que vous créez soient utiles, vous devez en fait dire quelque chose sur les entités que vous
allez créer dans cette nouvelle couche. Pour nos besoins actuels, il suffira d’ajouter un champ appelé « nom »
qui contiendra des « données textuelles » et sera limité a une longueur de texte de 80 caracteres.

7. Reproduisez la configuration ci-dessous, puis cliquez sur le bouton Reproduisez la configuration ci-dessous, puis
cliquez sur le bouton :guilabel: ajouter attribut a la liste

New Field

Name | name
Type | abcText data >
Length 80 Precision

Add to Fields List

8. Vérifiez que votre fenétre ressemble maintenant a ceci:
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.
File name aining-Data-2.0\exercise_data\school_property.shp
File encoding UTF-8 >
Geometry type ~ Polygon -
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WG5S B4 v ||

New Field

Name

Type | abc Text data v

Length |80 Precision

Add to Fields List

Fields List

MName Type Length Precision

id Integer 10

name String a0

Remowve Field

OK Cancel Help

9. Cliquez sur OK

La nouvelle couche devrait apparaitre dans votre panneau Légende de carte.

5.1.2 Follow Along: Sources de Données

Quand vous créez de nouvelles données, cela doit évidemment étre sur des objets qui existent réellement sur le terrain.
Par conséquent, vous devrez obtenir vos informations a quelque part.

Il y a plusieurs facons différentes d’obtenir des données sur des objets. Par exemple, vous pouvez utiliser un GPS
pour prendre des points dans le monde réel, puis importer les données dans QGIS par la suite. Ou vous pouvez lever
des points a I'aide d’'un théodolite, et entrer manuellement les coordonnées pour créer de nouvelles fonctionnalités.
Ou vous pouvez utiliser le processus de numérisation pour localiser des objets a partir de données de télédétection,
telles que I'imagerie par satellite ou la photographie aérienne.

Pour notre exemple, vous utiliserez 'approche de numérisation. Des échantillons de jeu de données raster sont fournis,
ainsi vous pourrez les importer si nécessaire.
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1 Cliquez sur le bouton g gestionnaire source de donnees

. Sélectionnez :'- Raster sur le coté gauche.

. Dans le panneau Source, cliquez sur le bouton ... :

2

3

4. Naviguez vers exercise_data/raster/.

5. Sélectionnez le fichier 3420C_2010_327_RGB_LATLNG.tif.
6

. Cliquez sur Open pour fermer la fenétre de dialogue.

Source type
(®) Fle () Protocol: HTTP(S), cloud, etc.

Source

Raster Dataset(s) lercise_data\raster\3420C_2010_327_RGB_LATLNG.tf &

- Oracle
D2, DB2

m Virtual Layer

&3 wums/wimTs
£ wes

< ""_ WFS

"i?‘_ ArcGIS Map Server
b ArcGIS Feature Server

» GeoMNode

Close Add Help

7. Cliquez sur ajouter et fermer. Une image se chargera dans votre carte.

5.1. Lesson: Création d’'un Nouveau Jeu de Données Vectorielles 131



QGIS Training Manual

@ *Untitled Project - QGIS - [} X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEEREX Lo PPRABLNR @6 -5 55 83 =90
®R@V.awm @ o - =y @ : ® 2
Layers (E2]E3)

o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.5018,34.0192 |% Scale 1:27241 |~ | @ Mognifier 100%  |*| Rotation [0.0° %/ [v/Render @ EPsGia3zs @

8. Si vous ne voyez pas apparaitre une image aérienne, sélectionnez la nouvelle couche, faites un clic droit et
choisissez zoom sur la couche dans le menu contextuel.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Datab:

DEBRRY QPRI PR
B@V.Aam @ /7 :

Layers &
v [l ® T - O

3420C ?2n1n 227 par 1LATING |
sl '® Zoom to Layer

o2 Show in Overview

Copy Layer
Rename Layer
1 Zoom to Native Resolution (100%)
Stretch Using Current Extent
L] Duplicate Layer
[l Remove Layer...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

9. Cliquez sur le bouton ;: ZoomIn et 700mez sur la zone surlignée en bleu ci-dessous :
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(@ *Untitled Project - QGIS - O x

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

NEBRRE N@LRIPPRALBLNR e -K-6-5 &= 9[-
: | ® o

L LY AN
Layers (E2]E3)
o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.4529,-34.0291 |¥ Scale 1:27241 |~ @ Magnifier 100%  |%| Rotation [0.0° *|v/Render @ epsGi36 @

Vous étes maintenant prét a numériser ces trois champs :
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Avant de commencer a numériser, déplagons la couche school_property au-dessus de I'image aérienne.

1. Sélectionnez la couche school_property dans le panneau couches et faites-la glisser vers le haut.

Layers e
o [l ® T &§~3 F 4

v [ school property
v 2 3420C 2010 327 RGB LATLNG

Afin de commencer la numérisation, vous devez entrer en mode d’édition. Les logiciels SIG nécessitent souvent cela
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pour vous empécher de modifier ou de supprimer accidentellement des données importantes. Le mode d’édition est
activé ou désactivé pour chaque couche individuellement.

Pour entrer en mode édition pour la couche school_property :

1. Cliquez sur la couche school_property dans le panneau couches pour la sélectionner.

F,
¥ .
2. Cliquez sur le bouton ¢/ baseuer en ediion

Si vous ne trouvez pas ce bouton, vérifiez que la barre d’outil Numérisation est activée. 1l devrait y avoir une
coche a coté de I'entrée du menu Vue » Barre d’outils » Numérisation.

Des que vous étes en mode édition, vous verrez que certains outils de numérisation sont devenus actifs :

. ] Capture Polygone.

o / outil noeud

D’autres boutons pertinents sont toujours inactifs, mais deviendront actifs lorsque nous commencerons a
interagir avec nos nouvelles données.

Notez que la couche school_property dans le panneau couches a maintenant I'icone du crayon, indiquant
quelle est en mode édition.

[} Capture Polygone

3. Cliquez sur le bouton pour commencer a numériser nos champs d’école.

Vous remarquerez que le curseur de votre souris est devenu un réticule. Cela vous permet de placer plus
précisément les points que vous allez numériser. N’oubliez pas que méme lorsque vous utilisez I'outil de
numérisation, vous pouvez faire un zoom avant et arriere sur votre carte en faisant tourner la molette de la
souris, et vous pouvez faire un panoramique en maintenant la molette de la souris enfoncée et en faisant glisser
la carte.

La premiere entité que vous allez numériser est le athletics field :

4. Commencez a numériser en cliquant sur un point n’‘importe ot le long du bord du champ.

5. Placez plus de points en cliquant davantage le long du bord, jusqu’a ce que la forme que vous dessinez recouvre
completement le champ.
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@ +Untitled Project - QGIS - O >

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

hEERRY 0LL2LHEPPH L BEMNS &-N-8-FEE -~
B2 B 4/ B®R%- b we E . R A

Layers " |
e T&E-FEFDO

v! [ school property

v/ I 3420C_2010_327_RGB_LATLNG

| Q Type to locate (Ctri+K) | i 20.444140,-34.024140 | ¢[1:1308 <| @rfwowe |33 00° |2 VIRender @ epsGiaszs @

6. Apres avoir placé votre dernier point, cliquez avec le bouton droit de la souris pour terminer le dessin du
polygone. Cela finalisera I'élément et vous montrera le dialogue Attributs.

7. Entrer les valeurs comme ci-dessous :

school_property - Feature Attributes

d 1 a |
name | Athletics Field a |
OK || Cancel |
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8. Cliquez sur OK, et vous avez créé une nouvelle entité !

Q@ +untitled Project - QGIS - O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

e 0SP2PLPHPD A LEBEORC @@ -N-8-5,8E -~
B@V.Z2m B 4/ BR%- o e = - @A

Layers
o il » T &~ & O

v [# school property

V| " 3420C_2010_327_RGB_LATLNG

| Q. Type to locate (Ctri+K) | i) 20.447232,-34.023345 | ¥ ¢ 1:1308 v @rlwoe 3]s looe  [f| VIRender @ epsci43s @

9. Dans le panneau couches, sélectionnez la couche school_property.

10. Faites un clic droit et choisissez ouvrir table d'attributs dans le menu contextuel.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Ras

NEERREY U 2K
RSV Z @B 47

Layers e b
[l ® T § -3 & L
7 school prisa l

v ¥ 3420C 2( 2 Zoom to Layer
Zoom to Selection

“2 Show in Overview
Show Feature Count
Copy Layer
Rename Layer

L Duplicate Layer

[4 Remove Layer...

8 Open Attribute Table

# Current Edits
Filter...

Toggle Editing

Change Data Source...

Set Layer Scale Visibility...
Set CRS

Export
Styles

Properties...

Dans la table, vous verrez 'élément que vous venez d’ajouter. En mode édition, vous pouvez mettre a jour les
données des attributs en double-cliquant sur la cellule que vous souhaitez mettre a jour.
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id name
1 1| Athletics Field

T show Al Features _

e

s VTESD ERZE »

Update All || Update Selected

11. Fermez la table d’attribut.

12. Pour enregistrer la nouvelle entité que nous venons de créer, cliquez sur

' Bouton Enregistrer les modifications

Souvenez-vous, si vous avez fait une faute pendant la numérisation d’une entité, vous pouvez toujours la modifier
apres que vous l'ayez créée. Si vous avez fait une faute, continuez & numériser jusqu’a ce que vous ayez créé I'entité

comme au-dessus. Puis :

1. Cliquez sur le bouton /E;{ outil de noeud

2. Passez la souris sur un sommet que vous souhaitez déplacer et cliquez sur le sommet avec le bouton gauche de

la souris.

3. Déplacez la souris a 'emplacement correct du sommet, puis cliquez sur le bouton gauche. Le sommet sera

alors déplacé vers le nouvel emplacement.
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La méme procédure peut étre utilisée pour déplacer un segment de ligne, mais vous devrez survoler le point
médian du segment de ligne.

Si vous voulez annuler un changement, vous pouvez appuyer sur le bouton " Amnuler oy Ctr1+7.
. . . ]
4. Noubliez pas de sauvegarder vos modifications en cliquant sur le bouton &4 Sauvegarder

5. Une fois I’édition terminée, cliquez sur le bouton y Basculer en mode Edition r5 sortir du mode d’édition.
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5.1.3 Try Yourself Numérisation des polygones

Numérisez ’école elle-mé&me et le champ du haut. Utilisez cette image pour vous guider :

N’oubliez pas que chaque nouvelle entité doit avoir une valeur d’id unique !

Note: Quand vous avez fini d’ajouter des entités a une couche, rappelez-vous de sauvegarder vos modifications et
ensuite de quitter le mode d’édition.

Note:  Vous pouvez styliser le remplissage, le contour et I'emplacement des étiquettes et le formatage de la
school_property en utilisant les techniques apprises dans les lecons précédentes.
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5.1.4 Follow Along: Utiliser la table de I'éditeur de noeud
Une autre fagon d’éditer une entité est d’entrer manuellement les valeurs des coordonnées réelles pour chaque sommet
en utilisant la table Editeur de noeuds.

1. Assurez-vous que vous €tes en mode édition sur la couche school_property.

2. Si ce n'est pas déja fait, cliquez sur le bouton /ﬂ;‘ outil noeud

3. Déplacez la souris sur une des entités polygone que vous avez créé dans la couche school _property et
cliquez dessus avec le bouton droit de la souris. Cela sélectionnera I'entité et un panneau editeur de noeud

apparaitra.
Vertex Editor & %)
X Y r

(0 20.4456 -34.0226 |
oo oo —
2 20.4457 -34.,0251

3 20.4453 -34.0247

4/ 20,4450 -34.0250

5 20.444 -34.0241

f 20.4456 -34.0226

Note: Ce tableau contient les coordonnées des sommets de I'entité. Notez qu’il y a sept sommets pour cet
élément, mais que seuls six sont identifiés visuellement dans la zone de la carte. En y regardant de plus pres,
on remarque que les lignes O et 6 ont des coordonnées identiques. Il s’agit des sommets de début et de fin de la
géométrie de I'entité, et ils sont nécessaires pour créer une entité polygone fermée.

4. Cliquez et faites glisser une case sur un ou plusieurs sommets de I'entité sélectionnée.
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)

Les sommets sélectionnés prendront une couleur bleue et la table editeur de noeuds aura les lignes
correspondantes en surbrillance, qui contiennent les coordonnées des sommets.
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Q@ “basic_map - QGIS - O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DB @@w@y@ﬂy PPQJ UE!;UE
L AAN N AN #men [

Browser (=]
ST®HO
<+ Favorites =

» IV Spatial Bookmarks
’ Project Home
+ [a] Home
v OC\
+ @ GeoPackace
Layers (=]
o @l®To-#FTDL

roads

[#] school_property

¥ 3420C 2010 327 RGB LATLNG

[

Vertex Editor 3]
X ' r

0 20.4456 34,0226

1 20.4469 -34.0238

2 20,4457 -34.0251

-34.0247

-34.0250

-34.0241

| @ Type tolocate (Crrl+k) | valid: rdi| 20.447353,-34.025117 | ¢ 1:1521

5. Pour mettre & jour une coordonnée, double-cliquez a gauche sur la cellule du tableau que vous souhaitez modifier
et saisissez la valeur mise a jour. Dans cet exemple, la coordonnée x de la ligne 4 est mise a jourde 20.4450
a20.4444.
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Vertex Editor () ()
X v r
0 20.4456 -34.0226
1| 20,4469 -34.0238
2 20.4457 -34.0251
3 20.4453 -34.0247
120.4444 ‘m-
5| 20,4441 -34.0241
f 20.4456 -34.0226
Q. Type to locate (Ctri+K) validi rdil| 20.4441

6. Apres avoir saisi la valeur actualisée, appuyez sur la touche « Entrée » pour appliquer la modification. Vous
verrez le sommet se déplacer vers le nouvel emplacement dans la fenétre de la carte.

7. Une fois I'édition terminée, cliquez sur le bouton ' Basculerenmode Edition noyr sortir du mode d’édition et
enregistrer vos modifications.

5.1.5 Try Yourself Numérisation des lignes

Nous allons numériser deux itinéraires qui ne sont pas déja marqués sur la couche des routes ; I'un est un chemin,
l'autre est une piste. Notre chemin longe la bordure sud de la banlieue de Railton, commengant et se terminant a des
routes marquées :

5.1. Lesson: Création d’un Nouveau Jeu de Données Vectorielles 147



QGIS Training Manual

Notre piste est un peu plus loin au sud :
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. Puisque vous travaillez avec une entité linéaire, cliquez sur le bouton

. Sila couche « roads » n’est pas dans votre carte, ajoutez-la a partir du fichier GeoPackage t raining-data.
gpkg inclus dans le dossier exercise_data des données d’entrainement que vous avez téléchargées. Voir
PI2I?] Pas & pas : Charger des données vectorielles depuis une base de données GeoPackage pour rappel de la
démarche.

. Créez un nouveau jeu de données ESRI Shapefile appelé routes.shp’ “dans le dossier

:file: exercise_data’, avec les attributs " idettype (utilisez 'approche ci-dessus
pour vous guider).

. Activez le mode édition de la couche guilabel:routes.

“[ Aldouterligne hour Jancer le mode de

numeérisation.

. Un a la fois, numérisez le chemin et la piste sur la couche « routes ». Essayez de suivre les itinéraires aussi

précisément que possible, en ajoutant des points supplémentaires le long des virages ou des tournants.

. Définissez la valeur de l'attribut t ype a path ou track.

. Utilisez la boite de dialogue proprietes couche pour ajouter du style a vos itinéraires. N’hésitez pas a utiliser
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des styles différents pour les chemins et les pistes.

4 s
8. Enregistrez vos modifications et quittez le mode d’édition en appuyant sur le bouton f/ basculer mode édition

Réponse

La symbologie n’a que peu d’'importance, mais les résultats devraient ressembler plus ou moins a ceci :

QGIS 2.0.1-Dufour - basic_may
SRPLHPAPLLR/AMR & @ B hEBE =0 50 /1 B
s [og 2

X e

I 3420C._2010_327_AGB_LATLNG
» ™ O landuse

. Borlebok National Park Enirance Gate

............

[P Browser

Toggles the editing state of the current layer

lugin available [Q§] Coordinate: '20.44958,-34.04065 Scale [1:9566 ~ ) [&/] & Render EPSG:4326 (@] y

5.1.6 In Conclusion

Vous savez maintenant comment créer des entités ! Ce cours ne couvre pas I'ajout d’entités ponctuelles, car ce n’est
pas vraiment nécessaire une fois que vous avez travaillé avec des entités plus compliquées (lignes et polygones). Cela
fonctionne exactement de la méme maniere, hormis le fait que vous cliquez seulement une fois ot vous voulez que le
point soit, lui donnez des attributs comme d’habitude, et ensuite I'entité est créée.

Savoir comment numériser est important car c’est une activité treés courante dans les programmes SIG.

5.1.7 What’s Next?

Les éléments d’une couche SIG ne sont pas seulement des images, mais des objets dans I'espace. Par exemple, les
polygones adjacents savent ou ils se trouvent les uns par rapport aux autres. C’est ce qu'on appelle la topologie. Dans
la prochaine legon, vous verrez un exemple de I'utilité de cette méthode.
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5.2 Lesson: Topologie des données

La topologie est un aspect utile des couches de données vectorielles, car il minimise les erreurs telles que les
chevauchements ou les lacunes.

Par exemple : si deux entités partagent une bordure, et que vous modifiez la bordure avec la topologie, alors vous
n’aurez pas besoin de modifier d’abord une entité, puis 'autre, et soigneusement aligner les bordures afin qu’elles
correspondent I'une avec l'autre. Vous pouvez plutdt modifier leur bordure commune et les deux entités changeront
en méme temps.

Objectif de cette lecon: Comprendre la topologie par les exemples.

5.2.1 Follow Along: Accrochage
Le snapping facilite I'édition topologique. Le curseur de votre souris peut ainsi se fixer sur d’autres objets pendant
que vous numérisez. Pour définir les options d’accrochage :

1. Rendez-vous dans le menu Projet » Options d’accrochage....

2. Configurez votre dialogue options Snapping (accrochage) pour activer la couche Landuse avec Type vertex et
tolérance 12 pixels :

Project Snapping Settings s

« | ‘% Advanced Configuration_ | © Topological Editing Snapping on Intersection

Layer Type Tolerance units Avoid overlap
® places
[ buildings
— roads
water
rivers
v landuse vertex 12 pixels v
[Tl protected_areas

Q, Filter layers...

3. Assurez-vous que la case dans la colonne eviter les chevauchements est cochée.

4. Quittez le dialogue.

5. Sélectionnez la couche landuse et entrez en mode d’édition (¥ )
6. Vérifiez (sous Vue » barre d'outils) que la barre d’outils numerisation avancee est activée.

7. Zoomez jusqu’a cette zone (activez des couches et des étiquettes si nécessaire) :
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*example - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEERRY OAPLHPRFALEEDR

LAVAEL S S RE RERFE G- QR B-G PR K-
6e-M-8-LbEEH#IZ=m-7 LB BIRRRARPS HRP > R
Layers @@
@ vanva-arn
v| ® places =
! [ buildings
v| — roads
v| [ water
v rivers
| M Bl landuse |
Browser @®
LET®O

» ¢ Favorites
» " spatial Bookmarks
» [¥ Project Home

» [&] Home

» [0/
»
»
13

-

4

@ GeoPackage
# spatiaLite
@ Postals

4

SEDHAABANLEMS

i
a
o
B

&

@ WMS/WMTS
@ XYZ Tiles
& wes

7 WFS / OGC API - Features
) ows

@ ArcGismapServer

& ArcGisFeatureServer

¢ GeoNode

v vy wvow

| @ Type to locate (Ctrl+k) Coordinate| 20.48982-34.00907 |9 Scale|1:14392 = | @ Magnifier 100% | Rotation |0,0° %[V Render 4 gPsGi4326 @

8. Digitize this new (fictional) area shown in red:
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9. Lorsque vous y étes invité, donnez-lui un OGC_FID de 999, mais n’hésitez pas a laisser les autres valeurs

152 Chapter 5. Module: Créer des données vectorielles



QGIS Training Manual

inchangées.

Si vous faites attention lors de la numérisation, et que vous laissez le curseur se positionner sur les sommets des
zones adjacentes, vous remarquerez qu’il n’y aura pas d’écart entre votre nouvelle zone et les zones adjacentes
existantes.

10. Notez les outils !3 undo (ED redo dans la barre d’outils numérisation avancée.

5.2.2 Follow Along: Corriger les caractéristiques topologiques

La topologie des entités peut parfois devoir étre mise a jour. Dans notre zone d’étude, une zone a été transformée en
forét, donc la couche 1anduse a besoin d’'une mise a jour. Nous allons donc étendre et faire se rejoindre certaines
entités de la forét dans cette zone :

*example - QGIS B
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Au lieu de créer de nouveaux polygones pour rejoindre les zones forestieres, nous allons utiliser 'outil outil noeud
pour modifier et rejoindre les polygones existants.

1. Entrez en mode édition (s’il n’est pas déja actif)

2. Sélectionnez l'outil /ﬂ;{ outil noeud |

3. Choisissez une zone de forét, sélectionnez un sommet et déplacez-le vers un sommet voisin afin que les deux
entités de la forét se rencontrent :

5.2. Lesson: Topologie des données 153



QGIS Training Manual

*example - QGIS
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DEERRY OAPLHPRFALEEDR

21718 %2 [&F 09 QRS YERYE G- QB G B
06 H- S GEEFIST LB BOARTIRPS F Y

Layers @@ ‘.‘-\ - = ]
@ vawmvaranrn | ")

v| ® places = .
Vé ! [ buildings b
' v| — roads
] v| [ water
Eg v rivers
I landuse IS
% It g
f Browser @® |
S navre J

» ¢ Favorites |
'uv » [[* spatial Bookmarks |
» [¥ Project Home
» |zl Home
@ | ol
» @ GeoPackage
» /# SpatiaLite
+ @ postGls

EE'; » @ WMS/WMTS
» B XYZ Tiles
» @ wes
/) WFS / OGC API - Features
» ) OWS
@ ArcGismapServer
& ArcGisFeatureServer
¢ GeoNode

. Y

; A Y /
| @ Type to locate (Ctrl+k) | Coordinate| 20.51955-34.01389 |9 Scale 1:6588 ~| & magnifier| 100% | Rotation |0,0° %[V Render 4 gPsGi4326 @

4. Cliquez sur les autres sommets et enclenchez-les en place.

Les bordures topologiquement correctes ressemblent a cela :

*example - QGIS
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Allez-y et rejoignez quelques autres domaines en utilisant I'outil outil de noeud.

Vous pouvez également utiliser I'outil ~ £ aiovter entité polyzone o1 combler I'espace entre les deux polygones de
la forét. Si vous avez activé 'option éviter les chevauchements, vous n’avez pas besoin d’ajouter chaque sommet
- ils seront ajoutés automatiquement si votre nouveau polygone chevauche les existants.

Si vous utilisez nos données d’exemple, vous devriez avoir une zone forestiere ressemblant a celle-ci :

*example - QGIS B
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Ne vous inquiétez pas si vous avez regroupé plus, moins ou différentes zones de forét.

5.2.3 Follow Along: Outil: Simplifier I'Entité

En continuant sur la méme couche, nous allons tester I'outil % Simplifier Pentité
1. Cliquez dessus pour l'activer.

2. Cliquez sur I'une des zones que vous avez jointes a I'aide de l'outil outil de noeud ou ajouter une entité. Vous
verrez ce dialogue :
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|J¢§ancel|l «/ OK ]

- |

Method | simplify by distance

Tolerance ’ oloooo00
1 feature(s): 17 to 17 vertices (100%)

:] Layer units

3. Modifiez le Tolérance et regardez ce qui se passe :

|X§ancel|[ «/ OK ]

- |

Method | Simplify by distance

A
“ | Tolerance ’

1 feature(s): 17 to 5 vertices (29%)

|:] | Layer units

Cela vous permet de réduire le nombre de sommets.

4. Cliquez sur OK
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L’avantage de cet outil est qu’il vous offre une interface simple et intuitive pour la généralisation. Mais remarquez que
I'outil enleéve de la topologie. Le polygone simplifié ne partage plus les limites avec ses polygones adjacents, comme

il le devrait. Cet outil est donc mieux adapté aux entités autonomes.

Avant de continuer, remettez le polygone dans son état d’origine en annulant le dernier changement.

5.2.4 Try Yourself Outil: Ajouter un anneau

@)

Loutil Ajouter anneau vy permet d’ajouter un anneau intérieur a un élément de polygone (couper un trou dans
le polygone), a condition que le trou soit complétement contenu dans le polygone (toucher la limite est OK). Par
exemple, si vous avez numérisé les limites extérieures de I’Afrique du Sud et que vous devez ajouter un trou pour le

Lesotho, vous utiliserez cet outil.

Si vous expérimentez avec cet outil, vous remarquerez peut-&tre que les options d’accrochage peuvent vous empécher
de créer un anneau a I'intérieur d’un polygone. Il vous est donc conseillé de désactiver I'option d’accrochage avant de

découper un trou.

1. Désactivez I'accrochage pour la couche landuse en utilisant le bouton @ activer accrochage (o ytilisez le

raccourci s).

@y

2. Utilisez 'outil

et

&

Dessinez un polygone sur I'entité cible, comme si vous utilisiez I'outil

Lorsque vous cliquez avec le bouton droit de la souris, le trou est visible.

ajouter anneau por créer un trou au milieu d’'une géométrie de polygone.

Ajouter un polygone

5. Remove the hole you just created using the

[ Delete Ring ] - Click inside the hole to delete it.

Réponse

The exact shape doesn’t matter, but you should be getting a hole in the middle of your feature, like this one:
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* Undo your edit before continuing with the exercise for the next tool.

5.2.5 Try Yourself Outil: Ajouter une partie

Loutil gb._j Ajouter une partie youg permet d’ajouter une nouvelle partie 2 une entité, qui n’est pas en contact direct avec
la géométrie existante de I'entité. Par exemple, si vous avez numérisé les limites de I’Afrique du Sud continentale,
mais que vous n’avez pas encore ajouté les iles du Prince-Edouard, vous utiliserez cet outil pour les créer.

1
1. Sélectionnez le polygone auquel vous souhaitez ajouter la partie en utilisant Toutil Eg%
Sélectionner les entités par zone ou par clic simple

2. Utilisez l'outil ajouter partie pour ajouter une zone périphérique.

3. Supprimez la partie que vous venez de créer a I'aide de I'outil % supprimer la partie

Note: Cliquez a I'intérieur de la partie pour la supprimer.

Réponse

1. First select the Bontebok National Park:

[sXsX¢) QGIS 2.0.1-Dufour - basic_map
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2. Now add your new part:
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0606 QGIS 2.0.1-Dufour - basic_map.
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3. Undo your edit before continuing with the exercise for the next tool.

5.2.6 Follow Along: Outil: Remodeler les Entités

Loutil ﬁ Remodeler les entités et ytilisé pour étendre un élément de polygone ou en couper une partie (le long de la

limite).

Extension :

1. Sélectionnez le polygone a 'aide de I'outil %

sélectionner les entités par surface ou par simple click

2. Cliquez avec le bouton gauche de la souris a I'intérieur du polygone pour commencer a dessiner.

3. Dessinez une forme a I'extérieur du polygone. Le dernier sommet doit se trouver a I'intérieur du polygone.

4. Cliquez sur le bouton droit pour terminer la forme :
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Coupez une partie :

.
1. Sélectionnez le polygone 3 Taide de Ioutil % sélectionner les entités par surface ou par simple click.

2. Cliquez a I'extérieur du polygone.

3. Dessinez une forme a I'intérieur du polygone. Le dernier sommet doit se trouver a I'extérieur du polygone.
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4. Cliquez avec le bouton droit de la souris a I'extérieur du polygone :
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Le résultat de ce qui précede :
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5.2.7 Try Yourself Outil: Séparer les entités

dp . G:J -
Loutil g Couperlesentiés eqt similaire a 'outil U™ Remodelerlesentités "qayf quil ne supprime aucune des deux parties.

Au lieu de cela, il les conserve toutes les deux.

Nous utiliserons cet outil pour séparer un coin d’un polygone.

1. Tout d’abord, sélectionnez la couche « landuse » et réactivez la fonction d’accrochage pour celle-ci.

dp iy
2. Sélectionnez I'outil g% OUPer NS et cliquez sur un sommet pour commencer 2 tracer une ligne.

3. Tracez la ligne de démarcation.

4. Cliquez sur un sommet du c6té « opposé » du polygone que vous souhaitez diviser et faites un clic droit pour

compléter la ligne :
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5. A ce stade, il peut sembler que rien ne s’est passé. Mais n’oubliez pas que la couche 1anduse est rendue sans
ligne de démarcation, de sorte que la nouvelle ligne de démarcation ne sera pas affichée.

6. Utilisez Pouti] 3 Sélectionner les entités par surface ou par simple clic pour sélectionner la partie que vous venez de découper

; la nouvelle entité sera alors mise en évidence :
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5.2.8 Try Yourself Outil: Fusionner les Entités

Nous allons maintenant réintégrer I'élément que vous venez de séparer dans la partie restante du polygone :

%E Fusionner les entités sélectionnées ¢ === Fusionner les attributs des entités sélectionnées

1. Testez donc les outils et ==

2. Remarquez les différences.

Réponse
* Use the Merge Selected Features tool, making sure to first select both of the polygons you wish to merge.

* Use the feature with the OGC_FID of 1 as the source of your attributes (click on its entry in the dialog, then
click the Take attributes from selected feature button):

If you're using a different dataset, it is highly likely that your original polygon’s OGC_FID will not be 1. Just choose
the feature which has an OGC_FID.
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8086 Merge feature attributes
OGC_FID | GEOMETRY | osmid | asm_way_id | name | type | aeoway | amenty | adminleve | barrier [
Id Skip attribute _:I Feature 1 _H Feature 1 _ﬂ Feature 1 _:I Feature 1 _H Feature 1 _ﬂ Feature 1 _:I Feature 1 _H Feature 1 _ﬂ Feature 1 _:I Fei
|1 H1 HNULL Hzasﬁag? ” NULL ”Bomebok National Park Hboundary ”NULL HNULL HNULL ”NULL ‘ atior
14 NULL 2855697 NULL Bontebok National Park boundary NULL NULL NULL NULL atior
Morge  Skipped 2855607 Bontebok National Park boundary natic

| ] | Take atiributes from selected feature

| & | Remove feature from selection

| Cancel | OK

Using the Merge Attributes of Selected Features tool will keep the geometries distinct, but give them the same attributes.

5.2.9 In Conclusion

L’édition topologique est un outil puissant qui vous permet de créer et de modifier des objets rapidement et facilement,
tout en veillant a ce qu’ils restent topologiquement corrects.

5.2.10 What’s Next?

Vous savez maintenant comment numériser facilement la forme des objets, mais I'ajout d’attributs reste un peu un
casse-téte | Nous vous montrerons ensuite comment utiliser les formes, en rendant la modification des attributs plus
simple et plus efficace.

5.3 Lesson: Formulaires

Quand vous ajoutez de nouvelles données via la numérisation, une boite de dialogue vous est présentée pour
vous permettre de remplir les attributs pour cette fonction. Cependant, cette boite de dialogue n’est, par défaut,
visuellement pas tres agréable. Cela peut causer un probleme d’utilisation, en particulier si vous avez de grands jeux
de données a créer, ou si vous voulez que d’autres personnes vous aident a numériser et qu’elles trouvent les formulaires
par défaut source de confusion.

Heureusement, QGIS vous laisse créer vos propres boites de dialogue personnalisées pour une couche. Cette legcon
vous montre comment.

Objectifs de cette lecon : Créer un formulaire pour une couche.
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5.3.1 Follow Along: Utilisation de la Conception de Formulaires avec QGIS

1. Sélectionnez la couche roads dans le panneau Couches.

2. Entrez comme avant en Mode d’édition.

3. Ouvrez la table attributaire de la couche roads.

4. Faites un clic-droit sur une cellule dans la table. Un petit menu apparaitra, avec 'entrée Ouvrir formulaire.
5. Cliquez dessus pour voir le formulaire que QGIS génere pour cette couche.

Evidemment, il serait bien de pouvoir faire cela tout en regardant la carte, plutdt que d’avoir besoin de chercher une
rue spécifique dans la table d’attribut tout le temps.

1. Sélectionnez la couche roads dans le panneau Couches.

P
2. En utilisant Poutil QR Identifier cliquez sur une rue dans la carte.

3. Le panneau Résultats identifiés s’ouvre et affiche une arborescence montrant les valeurs des champs et d’autres

informations générales sur l'entité cliquée.
4. At the top of the panel, check the Auto open form for single feature results checkbox in the “ Identify Settings
menu.

5. Cliquez maintenant sur une des rues de la carte. A coté du dialogue Résultats Identité vous verrez la forme
maintenant familiere :

8086 Attributes - roads
osm_id  |47587910) a
name NULL
highway unclassified a

waterway  NULL

aerialway  |NULL

barrier NULL

man_made |NULL

other_tags  "lanes"=>"2" a

(w06

6. Chaque fois que vous cliquez sur un élément avec I'outil Identifier, sa forme apparait tant que la case Formulaire
d’ouverture automatique est activée
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5.3.2 Try Yourself Utilisation du formulaire pour modifier des valeurs

Si vous €tes en mode d’édition, vous pouvez utiliser ce formulaire pour modifier les entités des attributs.

1. Activez le mode d’édition (si ce n’est déja fait).

2. En utilisant 'outil Q& identifier des entités ' cliquez sur la rue principale qui traverse Swellendam :

x X
X
x X
sy -
X
X
o Q - s
» w0 Ml 2 osm_id |2s8808188 2|
x ><r?<x x name |Voorlrek Street ‘
.

highway [ tertiary |

waterway | NULL ‘

aerialway  |NULL |

barrier [nuLe |

man_made |NULL |

other_tags |"Ianm"=>"2“

|Canee | (0K

=, 200 Pt

3. Modifier sa valeur highway pour qu’elle soit secondary.

4. Quitter le mode édition et enregistrer vos modifications

5. Ouvrez la Table attributaire et notez que la valeur a ét€ mise a jour dans la table des attributs et donc dans les
données sources

5.3.3 Follow Along: Configuration des types de champs du formulaire

C’est bien de modifier les choses en utilisant un formulaire, mais vous devez encore tout entrer a la main.
Heureusement, les formulaires ont différentes sortes de soi-disant outils qui vous permettent de modifier les données
de différentes maniéres.

1. Ouvrez les Propriétés... de la couche roads

2. Basculez sur I'onglet Champs. Vous verrez ceci :
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'ri Information

8 source

% symbology
€2 Labels
€ED Masks

d Diagrams

N# 3D View

E g Fields

Attributes
Form

Joins

L Auxiliary
Storage

{;,I_GI Actions

Layer Properties - roads | Fields

(/] (8]

id -~ Name Alias Type Typename Length Precision Comment WMS WFS *
122 0 [fid glonglong Integer64 0 0 v v
abe 1 Full_id Qstring  String 255 0 v v
abc 2 osm_id Qstring  String 255 0 v v
abc 3 osm_type QString String 255 0 v v
N S P O N N
ac 5 lanes Qstring  String 0 v v
ac §  maxspeed Qstring  String 255 0 v v
abc 7 oneway QString  String 255 0 v v
abc 8 | ref QString String 255 0 v v
abc 9 | surface Qstring  String 255 0 v v
ac 10 | name Qstring  String 255 0 v v
abc 11 embankment Qstring  String 255 0 v v
abc 12 | maxweight Qstring String 255 0 v v -

[ @ve | syle -

| «/Apply || % cancel H &/ OK ]

3. Passez a l'onglet Formulaire d attributs. Vous verrez ceci :

fi Information
':-‘\S_\ Source
%~ symbology
€3 Labels

€O Masks

Diagrams

-
]

Wg 2D View

E Fields
Attributes Form

Joins

." Auxiliary
Storage

(;‘.-GI Actions

Layer Properties - roads | Attributes Form

Autogenerate

- | |E\ | Show form on add feature (global settings) ~ |

“ |Available widgets =

Fields

osm_type

highway

lanes

maxspeed

oneway

ref

surface

name

embankment
maxweight
destination:back...
destination:Forward
destination:ref:ba...
destination:symb. ..
cutting

access

~| @Help || sile -

- </Apply || % cancel H oK ]

4. Cliquez sur la ligne oneway et choisissez Case a cocher comme Type de widget dans la liste des options :
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Layer Properties - roads | Attributes Form X

Autogenerate ~ || ® || show form on add feature (global settings) ~

“ Available widgets = v General ]

~ Fields
Fid
full_id
osm_id Comment
osm_type
highway
lanes ~c

maxspeed

surface Classification
name
embankment Color
maxweight :
destination:backw... Date/Time
destination:forward
destinat!on:ref:ba... Attachment
destination:symbo... i
cutting Hidden
access

hgv

foot

sac_scale
name:af
lanes:backward
lanes:Forward Text Edit
reg_ref
bicycle
cycleway ¥ Uuid Generator
sidewalk
service
bridge Value Relation
layer = =

@Help Style -~ </ Apply || % cancel <« OK

Alias

v| Editable Label on top

fif -8 B &« 4 @

Relation Reference

Unigue Values

Value Map

5. Cliquez sur OK

6. Entrez en mode édition (si la couche roads n’est pas déja en mode édition)

7. Cli quez sur Poutil Q% Identifier des entités
8. Cliquez sur la méme route principale que vous avez choisie précédemment

Vous verrez maintenant que l'attribut oneway a une case a cocher a c6té de lui indiquant t rue (coché) ou false
(non coché).

5.3.4 Try Yourself

Définissez un outil de formulaire plus approprié pour le champ highway.

Réponse

For the TYPE, there is obviously a limited amount of types that a road can be, and if you check the attribute table for
this layer, you’ll see that they are predefined.

1. Set the widget to Value Map and click Load Data from Layer.

2. Select roads in the Label dropdown and highway for both the Value and Description options:
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s |2 |hgway |QSting | Sting L | | Unique values edtabie | ¥
L S S [ams [a [ =
sPEMs] Attribute Edit Dialog "highway" !—‘l o ¢
b o~ 4

msj Line edit [g' Editable

Classification [ | Label on top -—
ata 33”99 I Select data from attributes in selected layer.

nigue values " o . . !
" Combo box with predefined items. Value is stored in the attribute
sg:) name shown in the combo box. Layer [ foads
ue map

Enumeraton Load Data from layer | [ Load Data from GSV file Value ighway ) e

Hidden . —_—— [T

Checkbox Valie Dosarition Description highway o

Text edit

Calendar 1 | | Value Description

Value relation

UUID generator footway footway

Photo

Webview path path

Color

primary primary

residential residential

service service

tertiary tertiary

| Remove Selected ' [ Cancel | [ OK )

3. Cliquez sur OK trois fois.

4. If you use the Identify tool on a street now while edit mode is active, the dialog you get should look like this:

806 " ~ Attributes - roads
osm_id 238808188
name |‘ubnrtrek Street |
highway [ secondary #]

waterway | MULL |

aerialway  NULL |

barrier | NULL |
man_made | |
other_tags | "lanes"=>"2" |

Cancel ] E_DK_}
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5.3.5 Try Yourself Création d’un test de données

Vous pouvez également concevoir votre propre formulaire personnalisé en partant de zéro.
1. Créez une simple couche de points appelé « test-data » avec deux attributs :
¢ name (text)

* age (entier)

New GeoPackage Layer X

Database training_data.gpkg

Table name test-data

Geometry type Point >
Include Z dimension Include M values

EPSG:4326 - WGS 84 v | |
New Field
Name
Type 123 \Whole Number (integer) -

Maximum length

Fields List
Name Type Length
name text 80
age integer

w Advanced Options

Layer identifier  test-data
Layer description

Feature id column | fid
Geometry column |geometry

¥ Create a spatial index

©Help Ocancel QoK

2. Capturez quelques points sur votre nouvelle couche en utilisant les outils de numérisation afin que vous ayez
un peu de données pour jouer avec. Il se peut qu’on vous présente le formulaire de capture d’attribut généré
par défaut par QGIS chaque fois que vous capturez un nouveau point.

Note: Vous pouvez devoir désactiver I’ Accrochage s’il est encore activé des taches précédentes.
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test-data - Feature Attributes X

fid Autogenerate a| v
name richard a
age 23 @ 3

cancel QoK

5.3.6 Follow Along: Création d’'un Nouveau Formulaire

Nous voulons maintenant créer notre propre formulaire personnalisé pour la phase de saisie des données attributaire.
Pour ce faire, vous devez avoir installé QT Designer (nécessaire uniquement pour la personne qui crée les formulaires).

1. Démarrer QT Designer.
2. Dans la boite de dialogue qui apparait, créez une nouvelle boite de dialogue :

000

New Form

templates/forms
Dialog with Buttons Bottom
Dialog with Buttons Right
Dialog without Buttons
Main Window
Widget

Widgets

Cancel 0K
Embedded Design
Device: None
Screen Size: [ Default size B

(¥ Show this Dialog on Startup

| Open.. | | Recentw |

[ Close | [ Graate]

. Cherchez 1”Outil boite sur le coté gauche de votre écran (par défaut). Il contient un élément appelé Edition de
ligne.

. Cliquez sur cet élément et faites-le glisser dans votre formulaire. Cela crée une nouvelle Edition de ligne dans
le formulaire.

Avec le nouvel élément d’édition de ligne sélectionné, vous verrez ses propriétés le long du c6té de votre écran
(par défaut sur la droite) :
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10.
11.
12.

13.
14.

0060 Property Editor

[Filter | + -

lineEdit : QLineEdit

Praperty Value
"
| objectName [T [«]
"

enabled ™

» geometry [(80, 40), 113 x 21]

» sizePolicy [Expanding, Fixed, 0, 0]

»  minimumSize 0x0

» maximumSize 16777215 x 16777215

» sizelncrement 0x0

» baseSize 0ox0
palette Inherited

» font A [Lucida Grande Ul, 13]
cursor | I1Beam
mouseTracking ™
focusPolicy StrongFocus
contextMenuPolicy | DefaultContextMenu
acceptDrops ™

» toolTip

b statusTip

» whatsThis

» accessibleMame

» accessibleDescrip...
layoutDirection LeftToRight
autoFillBackground | |
styleSheet

¢ locale English, SouthAfrica

p inputMethodHints ImhNone

» inputMask
b text
maxLength 32767
frame E
echoMode Normal
cursorPosition 0
» alignment AlignLeft, AlignVCenter
dragEnabled ]
readOnly ]
p placeholderText
curanridoveShila | nnicalMovaShila

Appelez-le name
En utilisant la méme approche, créez une nouvelle spinbox et donnez-lui le nom age.

Ajoutez une Efiquette intitulée Ajouter une nouvelle personne en caracteres gras (regardez dans
les propriétés de T'objet pour savoir comment la définir). Vous pouvez également définir le titre du dialogue
lui-méme (plutdt que d’ajouter un label).

Ajoutez un Label a chacun de vos widgets Line Edit et Spin Box.
Organisez les éléments comme bon vous semble.
Cliquez n’importe ou dans votre boite de dialogue.

Trouvez le bouton Mettre en page dans un layout de formulaire (dans une barre d’outils le long du bord supérieur
de I’écran, par défaut). Votre dialogue s’affichera alors automatiquement.

Définissez la taille maximale du dialogue (dans ses propriétés) a 200 (largeur) par 150 (hauteur).

Votre formulaire devrait maintenant ressembler a ¢a:
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8 -add_people.ui* |- [X

15. Enregistrez votre nouveau formulaire sous le nom de exercise_d

ata/forms/add_people.ui

16. Lorsque I'enregistrement est terminé, vous pouvez fermer Qt Designer.

5.3.7 Follow Along: Associer un Formulaire a une Couche

1. Retour & QGIS

2. Double-cliquez sur la couche fest-data dans la liste des couches pour

accéder a ses propriétés.

3. Cliquez sur I'onglet Formulaire d attributs dans la fenétre Propriétés de la couche.

4. Dans la liste déroulante Mise en page de l'éditeur d attribut, sélectionnez Fournir un fichier-ui.

5. Cliquez sur le bouton avec les trois points et choisissez le fichier add_people.ui que vous venez de créer :

Layer Properties - test-data | Attributes Form 8

-

Provide ui-file

= Edit Ul |/home/qgis-user/forms/add_people.ui

G’ Information
Available widgets
D v General
W Source ~ Fields
fid .
T All
& symbology name ias
___age | Comment
X Labels Relations .
- Other Widgets v/ Editable | | Labelon top
@B masks QML Widget
HTML Widget v Widget Type
. Diagrams
Text Edit
Wg 3D View
Multiline
E Fields
e .
|=1| Attributes Form
Joins w Constraints
L Auxiliary
0 storage Mot null
(;‘.G) Actions Unique
- Display Expression
, Expression description
& Rendering
Enforce expression constraint
Variables
_ v Defaults
H Metadata
Default value
ﬁ Dependencies Prene
Legend Apply default value on update
QGIS Server
elp e ~
@Hel Skyl

-

6. Cliquez sur OK dans la boite de dialogue Propriétés de la couche

7. Passer en mode édition et capturer un nouveau point

# || show fForm on add Feature (global settings) ~

=

# Cancel

« Apply

8. Lorsque vous faites cela, on vous présentera votre boite de dialogue personnalisée (a la place de la boite de

dialogue générique que QGIS crée habituellement).
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9. Si vous cliquez sur un de vos points en utilisant I'outil Ejk Identifier les entités o5 pouvez maintenant faire
apparaitre le formulaire en faisant un clic droit dans la fenétre des résultats d’identification et en choisissant
Voir le formulaire des entités dans le menu.

10. Si vous étes en mode édition pour cette couche, ce menu contextuel affichera plutdt modifier le formulaire
d’attribut, et vous pourrez alors ajuster les attributs dans la nouvelle forme méme apres la capture initiale.

5.3.8 In Conclusion

En utilisant des formulaires, vous vous facilitez la vie lorsque vous modifiez ou créez des données. En modifiant
des types d’outil ou en créant entierement un nouveau formulaire a partir de rien, vous pouvez contrdler I'expérience
de quelqu'un qui numérise des nouvelles données pour cette couche, en minimisant les malentendus et les erreurs
inutiles.

5.3.9 Further Reading

Si vous avez complété la section avancée ci-dessus et avez des connaissances en Python, vous voudrez peut-étre
consulter cette entrée de blog sur la création de formulaires d’entités personnalisées avec la logique Python, qui
permet des fonctions avancées, notamment la validation des données, 'autocomplétion, etc.

5.3.10 What’s Next?

L’ouverture d’'un formulaire pour lidentification d’une entité est une des actions standards que QGIS effectue.
Cependant, vous pouvez également le diriger pour effectuer des actions personnalisées que vous définissez. Clest
le sujet de la prochaine lecon.

5.4 Lesson: Actions

Maintenant que vous avez vu une action par défaut dans la lecon précédente, il est temps de définir vos propres actions.

Une action est une chose qui se produit lorsque vous cliquez sur une entit€. FElle peut ajouter beaucoup de
fonctionnalités supplémentaires a votre carte, vous permettant de récupérer des informations supplémentaires sur
un objet, par exemple. Lattribution d’actions peut ajouter une toute nouvelle dimension a votre carte !

Objectif de cette lecon : Apprendre a ajouter des actions personnalisées.

Dans cette lecon, vous utiliserez la couche school_property que vous avez créé précédemment. Les exemples de
données comprennent des photos de chacune des trois propriétés que vous avez numérisées. Ce que nous allons faire,
c’est associer chaque propriété a son image. Ensuite, nous allons créer une action qui ouvrira 'image d’une propriété
en cliquant sur celle-ci.

5.4.1 Follow Along: Ajouter un champ pour images
La couche school_property n’a pas encore la possibilité d’associer une image a une propriété. Nous allons
d’abord créer un champ a cet effet.

1. Ouvrez la fenétre Propriétés de la couche.

2. Cliquez sur I'onglet Champs.

3. Basculez en mode édition :
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Layer Properties - school_property | Fields

NE
d - 1Toggle editing mode t'pe Type name  Length Precision = Comment

1230 |id glonglong | Integer64 10 0 v

‘:{:\? Source

%" symbology

abc | name Qstring  String 80 0 v
€3 Labels

B Masks

- .
. [MELEIN S

W7 3D View
E 5 Fields

E Aktributes Form

1 4

Joins
s Auxiliary . @telp || style -  Japply | ®cancel || Jok |

4. Ajoutez une nouvelle colonne :

Layer Properties - school_property | Fields

? LAl
fi [EEEETEE e + |New field jme Alias Type Type name Length Precision Comment

1230 |id glonglong | Integer64 10 0 v

‘:{:\\ Source . :
; ac 1 pame Qstring | String 80 0 Y

%~ symbology

€3 Labels

€D Masks

- .
. Diagrams

W7 3D View

5. Entrez les valeurs ci-dessous :
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Add Field

Name

Comment

Type
Provider type string
Length

|image|

Text (string)

255

il
-

% cancel | o OK

6. Une fois le champ créé, allez dans l'onglet formulaire d’attribut et sélectionnez le champ image.

7. Définissez type wiget a piéce jointe :

Layer Properties - school_property | Attributes Form x

.

G Information

‘:{:\} Source

% symbology

> .
" Diagrams

W# 3D View
ﬁ Fields

::E: Attributes For

Joins

L Auxiliary
&M Storage

{;@ Actions
- Display
Qj./ Rendering

Variables

m Metadata

ﬁ Dependencies|
Legend

& qais server

Autogenerate

Awvailable Widgets
~ Fields

id

name

image

Relations
~ Other Widgets
QML Widget
HTML Widget

@Help Style

- ||

v General

Alias
Comment

v| Editable Label on top

v Widget Type
Attachment

Path

Default path |/home/tveite/Downloads/QGIS/QGIS-Trainin...

Relative paths

Storage Mode

® File paths
Directory paths

v Display Resource Path
v Display button to open File dialog

Filter

Use a hyperlink For document path (read-only)

«/ Apply

8. Cliquez sur OK dans la boite de dialogue proprietes couche.

Show Form on add feature (global settings) ~

-

-
-

#® Cancel

9. Utilisez I'outil Identifier pour cliquer sur une des trois entités dans la couche school_property.

Puisque vous étes toujours en mode édition, le dialogue devrait étre actif et ressembler a ceci :
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school_property - Feature Attributes

Actions

id |2 |

name school campus

image

% cancel | &/ OK |

10. Cliquez sur le bouton parcourir (le ... a c6té du champ image).

11. Sélectionnez le chemin d’accés de votre image. Les images se trouvent dans exercise_data/
school_property_photos/ et portent le méme nom que les entités auxquelles elles doivent €tre
associées.

12. Cliquez OK.
13. Associez toutes les images avec les bonnes entités en utilisant cette méthode :

14. Sauvegardez vos modifications et sortez du mode d’édition.

5.4.2 Follow Along: Création d’'une Action

1. Ouvrez l'onglet Actions pour la couche school_property, et cliquez sur le bouton 5k Ajouter nowele action

Layer Properties - school_property | Actions B

¥ Action List

Description Short Title Action  Capture Action Scopes On Notification Only when editable

€3 Labels
abc VFT

Diagrams

W# 3D View

E Fields

E Attributes Form

Joins
] »

ﬂ Auxiliary Storage ik Create Default Actions

Actions Add a new action

» Show in Attribute Table

2. Dans le dialogue Ajouter une nouvelle action, entrez les mots Show Image dans le champ Description :
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Add New Action -~

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 3
| E Insert
Execute if notification matches

Enable only when editable

@Hel ¥ cancel
p L

Ce qui faut ensuite faire varie selon votre systeme d’exploitation, ainsi choisissez la ligne de conduite appropriée
a suivre :

¢ Windows
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Cliquez sur le menu déroulant T’ype et choisissez Ouvrir.
e Ubuntu Linux

Sous Action, écrivez eog pour le Gnome Image Viewer, ou écrivez display pour utiliser ImageMagick.
N’oubliez pas de mettre un espace apres la commande !

* macOS
1. Cliquez sur le menu déroulant T'ype et choisissez Mac.
2. Sous Action, écrivez open. N’oubliez pas de mettre un espace apres la commande !
Vous pouvez maintenant continuer a écrire la commande.

Vous souhaitez ouvrir I'image, et QGIS connait sont emplacement. Il ne reste plus qu’a renseigner le Action ou
I'image est.

3. Sélectionnez image dans la liste :
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Add New Action i3

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 eoq- [%imageS]

4 b
123 id

abc name

@Help % Cancel

4. Cliquez sur le bouton Insérer un champ. QGIS ajoutera la phrase [$ "image" %] dans le champ Action
Text.

5. Cliquez sur le bouton OK pour fermer le dialogue Ajouter une nouvelle action.
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6.

Cliquez sur OK pour fermer la boite de dialogue Proprietes couche

Il est maintenant temps de tester la nouvelle action :

1.

2.
3.

.' -_--I :’ :
&Q {Q\"}Q"i--.h:' 5~ @) :

Cliquez sur la couche school_property dans le panneau couches afin qu’elle soit mise en évidence.

i o .
Trouvez le bouton 9\% Exécuter action d'entité ({ang |a barre d’outils Asributs).

Cliquez sur la fleche vers le bas a droite de ce bouton. Une seule action a été définie pour cette couche jusqu’a
présent, celle que vous venez de créer.

%}EE'G T~

O vovimage os I

4.
5.

Cliquez sur le bouton pour activer I'outil.
En utilisant cet outil, cliquez sur une des trois propriétés de 1’école.

L’image de cette propriété doit s’ouvrir.

5.4.3 Follow Along: Recherche sur Internet

Disons que nous regardons la carte et que nous voulons en savoir plus sur la région ou se trouve une ferme. Supposons
que vous ne connaissez rien de la zone en question et que vous vouliez trouver des informations générales a son sujet.
Votre premiere action, si'on considere que vous utilisez un ordinateur en ce moment, serait probablement de chercher
sur Google le nom de la zone. Alors disons a2 QGIS de le faire automatiquement pour nous !

1.

A I

Ouvrez la table d’attribut pour la couche landuse.

Nous utiliserons le champ name pour chacune de nos zones d’utilisation des terres pour effectuer des recherches
sur Google.

Fermez la table d’attribut.

Retournez a Actions dans Propriétés des couches.

Cliquez sur le bouton créer l'action par défaut pour ajouter un certain nombre d’actions prédéfinies.
Supprimez toutes les actions sauf I'action ouvrir 'URL avec le nom court Search Web en utilisant le bouton
ci-dessous. " supprimez action sélectionnée

Double-cliquez sur I'action restante pour la modifier

Remplacez le champ Description par Google Search, et supprimez le contenu du champ nom court.
Assurez-vous que le Canevas figure parmi les champs d’action de Action.

Ce qui faut ensuite faire varie selon votre systeme d’exploitation, ainsi choisissez la ligne de conduite appropriée
a suivre :

¢ Windows

Sous T'ype, choisissez Ouvrir. Cela va dire a Windows d’ouvrir une adresse internet dans votre navigateur
par défaut, tel qu'Internet Explorer.

¢ Ubuntu Linux

Sous Action, écrivez xdg—open. Cela indiquera a Ubuntu d’ouvrir une adresse Internet dans votre
navigateur par défaut, tel que Chrome ou Firefox.

¢ macOS

Under Action, write open. This will tell macOS to open an Internet address in your default browser,
such as Safari.
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Vous pouvez maintenant continuer a rédiger la commande

Quelle que soit la commande que vous avez utilisée en-dessus, vous devez dire quelle adresse internet ouvrir
apres. Vous voulez visiter Google, et rechercher automatiquement une phrase.

En général, lorsque vous utilisez Google, vous entrez votre phrase de recherche dans la barre de recherche
Google. Mais dans ce cas, vous voulez que votre ordinateur le fasse pour vous. La facon dont vous dites a
Google de rechercher quelque chose (si vous ne voulez pas utiliser directement sa barre de recherche) est de
donner a votre navigateur Internet I'adresse « https://www.google.com/search?q=SEARCH_PHRASE », ol
« SEARCH_PHRASE » est ce que vous voulez rechercher. Comme nous ne savons pas encore quelle phrase
rechercher, nous ne saisirons que la premiere partie (sans la phrase de recherche).

Dans le champ Action, écrivez https://www.google.com/search?g=. Noubliez pas d’ajouter un
espace apres votre commande initiale avant d’écrire ceci !

Maintenant, vous voulez que QGIS dise au navigateur d’indiquer a Google de rechercher la valeur de name
pour toute entité sur laquelle vous pourriez cliquer.

10. Sélectionnez le champ name.

11.

Cliquez sur le bouton Insérer :
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Edit Action -~

Type Generic - Capture output

Description |Google Search
Short Mame |Leave empty to use only icon

lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 xdg-open-http://www.google.com/search?q=[%name%]

1 b

| E Insert

Execute if notification matches || l

Enable only when editable
@Help % Cancel

Cela signifie que QGIS va ouvrir le navigateur et 'envoyer a I'adresse https://www.google.com/search?q=[%

«name » %]". L’adresse [$ "name" %] indique a QGIS d'utiliser le contenu du champ name comme
expression a rechercher.
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Ainsi, si, par exemple, la zone d’utilisation des terres sur laquelle vous cliquez est appelée Réserve
naturelle de Marloth, QGIS vaenvoyer le navigateur a https://www.google.com/search?
g=Marloth%20Nature%20Reserve, ce qui amenera votre navigateur a visiter Google, qui a son tour
cherchera « Réserve naturelle de Marloth ».

12. Si vous ne I'avez pas encore fait, mettez tout en place comme expliqué ci-dessus.
13. Cliquez sur le bouton OK pour fermer le dialogue Ajouter une nouvelle action.
14. Cliquez sur OK pour fermer la boite de dialogue Proprietes couche
Il est maintenant temps de tester la nouvelle action.
1. Avec la couche landuse active dans le panneau Couches, cliquez sur la fleche vers le bas a droite du bouton =%
Exécuter action entité ot g&lectionnez la seule action (Google Search) définie pour cette couche.

2. Cliquez sur n’importe quelle zone d’utilisation des terres que vous pouvez voir sur la carte. Votre navigateur
s’ouvre alors et lance une recherche sur Google pour trouver le lieu qui est enregistré comme la valeur name
de cette zone.

Note: Si votre action ne fonctionne pas, vérifiez que tout a été correctement entré ; les fautes de frappe sont
communes avec ce genre de travail !

5.4.4 Follow Along: Ouvrir une page web directement dans QGIS

Ci-dessus, vous avez vu comment ouvrir une page web dans un navigateur externe. Cette approche présente quelques
inconvénients en ce sens qu'elle ajoute une dépendance inconnaissable : I'utilisateur final disposera-t-il du logiciel
nécessaire pour exécuter ’action sur son systeme ? Comme vous I'avez vu, ils n’ont pas nécessairement le méme type
de commande de base pour le méme type d’action, si vous ne savez pas quel systeme d’exploitation ils utiliseront.
Avec certaines versions de systemes d’exploitation, les commandes ci-dessus pour ouvrir le navigateur peuvent ne pas
fonctionner du tout. Cela peut étre un probléme insurmontable.

Cependant, QGIS se trouve au-dessus de la bibliotheque Qt, incroyablement puissante et polyvalente. De plus, les
actions de QGIS peuvent étre arbitraires, tokenisées (c’est-a-dire utilisant des informations variables basées sur le
contenu d’un attribut de champ), des commandes Python !

Vous allez maintenant voir comment utiliser une action python pour afficher une page web. C’est la méme idée
générale que I'ouverture d’un site dans un navigateur externe, mais elle ne nécessite pas de navigateur sur le systeme
de l'utilisateur puisqu’elle utilise la classe Qt QWebView (qui est un widget html basé sur un webkit) pour afficher le
contenu dans une fenétre pop-up.

Cette fois, utilisons Wikipédia. L'URL que vous demandez ressemblera donc a ceci :
https://wikipedia.org/wiki/SEARCH_PHRASE
Créer I'action associée a la couche:
1. Ouvrez la boite de dialogue Propriétés de la couche et rendez-vous sur 'onglet Actions.
2. Paramétrez une nouvelle action en utilisant les propriétés suivantes:
e Type: Python
* Description: Wikipedia
* Scope: Feature, Canvas

o Action Text:

from ggis.PyQt.QtCore import QUrl
from gqgis.PyQt.QtWebKitWidgets import OQOWebView

myWV = QWebView (None)
(suite sur la page suivante)
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(suite de la page précédente)

myWV.load (QUrl ('https://wikipedia.org/wiki/ [%$name%] "))
myWV . show ()

Type

Edit Action b

Python - Capture output

Description |Wikipedia

Short Name |Leave empty to use only icon

Icon

Action Scopes

Layer

v Feature

v Canvas

Field

Form

Action Text

The action text defines what happens if the action is triggered.

The content depends on the type.

For the type Python the content should be Python code, if the action is triggered from a button
widget embedded in a drag and drop designer Form, the Form instance is exposed to Python as
the formvariable.

For other types it should be a file or application with optional parameters.

1

WM

=l o un

L)

123

from-qgis.PyQt.QtCore import . QuUrl
from -qgis.PyQt.QtWebKitWidgets  -import -QWebView

myW\V - = QWebView(None)

myWV . Lload (QUrL( "https://wikipedia.org/wiki/[%name%] "))
myWV . show( )

*

> |E Insert

Execute if notification matches

Enable only when editable

© Help

Ocancel || @0k |

1l y a quelques choses qui se passent par ici :

e [$nname%] sera remplacé par la valeur réelle de lattribut lorsque l'action est invoquée (comme
précédemment).

* Le code crée simplement une nouvelle instance de QWebView, définit son URL, puis appelle show ()
sur celle-ci pour la rendre visible comme une fenétre sur le bureau de 'utilisateur.

Vous pouvez également utiliser cette approche pour afficher une image sans exiger que les utilisateurs disposent
d’un visualiseur d’images particulier sur leur systeme.

3. Essayez d’utiliser les méthodes décrites ci-dessus pour charger une page Wikipédia en utilisant 'action
Wikipédia que vous venez de créer.
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5.4.5 In Conclusion
Les actions vous permettent de donner a votre carte des fonctionnalités supplémentaires, utiles a I'utilisateur final qui

visualise la méme carte dans le QGIS. Etant donné que vous pouvez utiliser des commandes shell pour n’importe quel
systeéme d’exploitation, ainsi que pour Python, les fonctions que vous pourriez incorporer sont illimitées !

5.4.6 What’s Next?

Maintenant que vous avez créé toutes sortes de données vecteur, vous allez apprendre a analyser les données pour
résoudre les problemes. C’est le sujet du prochain module.
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Module: Analyse vectorielle

Maintenant que vous avez modifié¢ quelques entités, vous souhaitez slirement savoir ce que I'on peut faire d’autre avec
elles. Avoir des entités avec des attributs, c’est bien, mais une fois finie, la carte ne vous apprendra rien de plus qu’une
carte non-SIG.

Le principal avantage d’un SIG est qu'un SIG peut répondre a des questions.

Pour les trois prochains modules, nous nous efforcerons de répondre a une question de recherche en utilisant des
fonctions SIG. Par exemple, vous étes un agent immobilier recherchant une propriété résidentielle dans Swellendam
pour des clients ayant comme criteres :

1. La propriété doit étre dans Swellendam.

2. Elle doit étre a une distance correcte en voiture (disons 1km) d’une école.
3. Sa taille doit étre supérieure a 100 m>.

4. Etre située 2 moins de 50 m de la route principale.

5. Etre située 2 moins de 500 m d’un restaurant.

Dans les prochains modules, nous allons exploiter la puissance des outils d’analyses SIG pour localiser les terrains
adaptés pour ce nouveau quartier résidentiel.

6.1 Lesson: Reprojeter et transformer des données

Parlons a nouveau des systemes de référence de coordonnés (CRS). Nous en avons déja parlé brievement, mais nous
n’avons pas discuté de ce que cela signifie concretement.

Le but de cette lecon : Reprojeter et transformer des jeux des données.
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6.1.1 Follow Along: Projections

Le CRS dans lequel se trouvent actuellement toutes les données, ainsi que la carte elle-méme, s’appelle WGS84. 11
s’agit d’un systeéme de coordonnées géographiques (GCS) trés courant pour représenter les données. Mais il y a un
probleme, comme nous allons le voir.

1. Enregistrez votre carte actuelle

2. Ensuite, ouvrez la carte du monde que vous trouverez sous exercise_data/world/world.qgs
3. Zoomez sur I’Afrique du Sud a I'aide de I'outil Zoom +
4

. Essayez de définir une échelle dans le champ echelle, qui se trouve dans la barre de statut en bas de I'écran.
Lors de votre passage en Afrique du Sud, réglez cette valeur sur « 1:5 000 000 » (un a cinq millions).

5. Parcourez la carte tout en gardant un ceil sur le champ échelle

Vous avez remarqué que I'échelle change ? C’est parce que vous vous éloignez du point sur lequel vous avez zoomé
a « 1:5 000 000 », qui était au centre de votre écran. Tout autour de ce point, I'échelle est différente.

Pour comprendre pourquoi, pensez au globe terrestre. Il y a des lignes imaginaires s’étendant du Nord au Sud. Ce
sont les lignes de longitude qui sont éloignées a I'équateur, mais qui se rejoignent aux poles.

Dans un GCS, vous travaillez sur cette sphere, mais votre écran est plat. Lorsque vous essayez de représenter la
sphere sur une surface plane, il se produit une distorsion, semblable a ce qui se produirait si vous coupiez une balle de
tennis et essayiez de I'aplatir. Cela signifie que sur une carte, les lignes de longitude restent a égale distance les unes
des autres, méme aux poles (ou elles sont censées se rencontrer). Cela signifie qu’a mesure que vous vous éloignez
de I’équateur sur votre carte, I'’échelle des objets que vous voyez devient de plus en plus grande. Ce que cela signifie
pour nous, en pratique, c’est qu'il n’y a pas d’échelle constante sur notre carte !

Pour résoudre ce probleme, utilisons a la place un Systeéme de Coordonnées Projeté (SCP). Un SCP « projette » ou
convertit la donnée de maniere a prendre en compte les changements d’échelle et de les corriger. Par conséquent,
pour garder une échelle constante, nous devrons reprojeter nos données et utiliser un SCP.

6.1.2 Follow Along: La reprojection “a la volée”

Par défaut, QGIS reprojete les données « a la volée ». Cela signifie que méme si les données elles-mémes se trouvent
dans un autre CRS, QGIS peut les projeter comme si elles se trouvaient dans un CRS de votre choix.

Vous pouvez changer le CRS du projet en cliquant sur le bouton =" Projection courante qang Je coin inférieur droit de
QGIS.

1. Dans la boite de dialogue qui apparait, tapez le mot « global » dans le champ Filtre. Quelques CRS devraient
apparaitre dans le champ Systémes de référence prédéfinis ci-dessous.

2. Sélectionnez 'entrée WGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 en cliquant dessus, puis cliquez sur
OK.

Remarquez comment la forme de I’Afrique du Sud change. Toutes les projections fonctionnent en modifiant
la forme apparente des objets sur Terre.

3. Zoomez a nouveau a I'échelle 1:5 000 000, comme précédemment.
4. Déplacez vous sur la carte.
Notez que I'échelle reste fixe !

£,

La reprojection “a la volée” est également utilisée pour visualiser des jeux de données ayant des SCR différents.

1. Ajoutez une autre couche vecteur a votre carte qui contient les données pour I'Afrique du Sud uniquement.
Vous la trouverez sous la forme exercise_data/world/RSA. shp.

2. Chargez-le. Un moyen rapide de voir son CRS est de passer la souris sur la couche de la 1égende. 11 s’agit de
« EPSG:3410 ».

Que remarquez-vous ?
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La couche est visible méme si elle a un CRS différent de celui de continents.

6.1.3 Follow Along: Enregistrer un jeu de données dans un autre SCR

Parfois, vous devez exporter un ensemble de données existant avec un autre CRS. Comme nous le verrons dans la
prochaine lecon, si vous devez faire des calculs de distance sur une couche, il est toujours préférable d’avoir la couche
dans un systeme de coordonnées projetées.

Sachez que la reprojection « a la volée » est liée au projet et non a des couches individuelles. Cela signifie qu'une
couche peut avoir un CRS différent du projet méme si vous le voyez dans la position correcte.

Vous pouvez facilement exporter la couche avec un autre CRS.

1.
2.
3.

Ajoutez le jeu de données buildings a partirde training_data.gpkg
Cliquez avec le bouton droit sur la couche buildings dans le panneau Couches

Sélectionnez Exporter » Sauvegarder les entités sous ... dans le menu qui apparait. La boite de dialogue
Enregistrer la couche vecteur sous ... s’affiche.

Cliquez sur le bouton Parcourir a cdté du champ Nom de fichier

Naviguez vers exercise_data/ et spécifiez le nom de la nouvelle couche comme
buildings_reprojected.shp.

Changez la valeur du CRS. Seuls les CRS récents utilisés seront affichés dans le menu déroulant. Cliquez sur le

i
TT N
=

bouton i Sélectionner la projection 3 ¢4t& du menu déroulant.

Le dialogue Sélecteur de systéme de référence de coordonnées apparaitra. Dans son champ filtre, recherchez
348S.

Sélectionnez WGS 84 / UTM zone 34S | EPSG:32734 dans la liste
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Coordinate Reference System Selector

Select the coordinate reference system for the vector file. The data points will be transformed fraom the layer
coordinate reference system.

Filter | ©. 345

@ |
Recently used coordinate reference systems
Coordinate Reference System Authority 1D
WGS 84/ UTM zone 345 EPSG:32734

1

[»

Coordinate reference systems of the world Hide deprecated CRSs
wordinate Reference System Authority ID [
RGRDC 2005 / UTM zone 345 EPSG:4062
WGS 72 [ UTM zone 345 EP5G:32334
WGS 72BE / UTM zone 345 EP5G:32534
WGS 84 f UTM zone 345 EP5G:32734
4] >
Selected CRS |WGS 84 / UTM zone 345
N ™ W g u
Extent: 18.00, -80.00, 24.00, 0.00 \ o N
Projd: +proj=utm +zone=34 +south .’I . .
+datum=WGS84 +units=m +no_defs - g
| [@lHelp | | @cancel || Fok |

9. Laissez les autres options inchangées. La boite de dialogue Enregistrer la couche vecteur sous ... ressemble
maintenant a ceci :
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Save Vector Layer as...

Format ESRI Shapefile

File name |ome/matteo/exercise_data/exercise_data/buildings_reprojected.shp &

Layer name
CRS EPSG:32734 - WGS 84 7 UTM zone 345 - | |
Encoding UTF-8 -

v | Add saved file to map

b Select fields to export and their export options
v Geometry

Geometry type Automatic =

» Extent (current: layer)
P Layer Options

P Custom Options

Help @ Cancel oK

10. Cliquer OK

Vous pouvez maintenant comparer les anciennes et les nouvelles projections de la couche et voir qu’elles sont dans
deux CRS différents mais qu’elles se chevauchent toujours.
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6.1.4 Follow Along: Créez votre propre projection
Il existe beaucoup plus de projections que celles incluses dans QGIS par défaut. Vous pouvez également créer vos
propres projections.

1. Commencer une nouvelle carte

2. Chargez le fichier world/oceans. shp

3. Allez & Parametres » Projection personnalisee... et vous verrez ce dialogue.

Custom Coordinate Reference System Definition x

v Define

You can define your own custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string Format for specifying a CRS.

Name Parameters dha
=
Name
Format WKT (Recommended) -
Validate
Parameters
v Test

Use the text boxes below to test the CRS definition you are creating. Enter a coordinate where both the lat/long and the transformed result are known (for example by
reading off a map). Then press the calculate button to see if the CRS definition you are creating is accurate.

Geographic / WGS84 Destination CRS

Calculate

@Help Ocancel QoK

4. Cliquez sur le bouton G aouter nowveau R pour créer une nouvelle projection
5. Une projection intéressante a utiliser s’appelle Van der Grinten I.Entrez sonnom dansle champ Nom.

Cette projection représente la Terre dans un champ circulaire plutdt que rectangulaire, comme la plupart des
autres projections.

6. Dans Format, sélectionnez WKT (Recommandé)

7. Ajoutez la chalne suivante dans le champ Paramétres

(PROJCRS["unknown",
BASEGEOGCRS [ "unknown",
DATUM["unknown",
ELLIPSOID["unknown", 6371000,0,
LENGTHUNIT ["metre", 1,
ID["EPSG",9001]111,
PRIMEM|["Greenwich", O,
ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",8901]11,
CONVERSION ["unknown",
METHOD ["Van Der Grinten"],
PARAMETER|["Longitude of natural origin", 0,

(suite sur la page suivante)
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ID["EPSG", 880211,
PARAMETER["False easting", 0,
LENGTHUNIT ["metre",1],
ID["EPSG", 880611,
PARAMETER["False northing", 0,
LENGTHUNIT ["metre",1],
ID["EPSG",8807111,
CS[Cartesian, 2],
AXIS[" (E)",east,
ORDER[17],
LENGTHUNIT["metre", 1,
ID["EPSG", 9001111,
AXIS[" (N)",north,
ORDER[2],
LENGTHUNIT ["metre", 1,
ID["EPSG", 90011111

ANGLEUNIT["degree",0.0174532925199433],

(suite de la page précédente)

Custom Coordinate Reference System Definition X

v Define

You can define your ewn custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string Fermat for specifying a CRS.

Name Parameters o
Van der Grinten | PROJCRS["unknown", BASEGEOGCRS["unknown", DATUM["unknown" ELLIPSOID["unknown",6371000,0,LENGTHUNIT["metre”,1,ID[... -
Name Van der Grinten |
Format WKT (Recommended) v
PROJCRS["unknown", = Vvalidate

BASEGEOGCRS["unknown",
DATUM["unknown",
ELLIPSOID["unknown",6371000,0,
LENGTHUNIT["metre",1,
Parameters ID["EPSG",9001]]]],
PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8901]]],
CONVERSION["unknown",
METHOD["Van Der Grinten"],

P Test
@Help

8. Cliquer OK
&

Ocancel QoK

9. Cliquez sur le bouton " CRS courant 3 qrojite de la barre d’état pour modifier le CRS du projet

10. Choisissez votre projection nouvellement définie (recherchez son nom dans le champ Filtre)

11. En appliquant la projection, voici ce a quoi doit ressembler la carte :
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 DERBREY Qe rRPPRLALRBIER e K-U-EE#I=-0 0
P /BRAR-Fox0Doe "qEH%ES92 QAR a90- B "« L
Layers
« BT E&-HAL

@
v oceans

I3
L]

Browser ‘ Layers |

| @ Type to locate (ctr+k) 1 legend entries removed Coortinate | 2652139.4502093) | scale | 1218427020 ‘-| & Magnifier | 100% 2] Rotation [0.0°

[3][v] Render @ userao0o2s @

6.1.5 In Conclusion

Différentes projections sont utiles a différentes fins. En choisissant une projection correcte, vous vous assurez que les
entités de votre carte seront représentées de maniere précise.

6.1.6 Further Reading

Le matériel de la section Avancé de cette lecon est tiré de cet article <https://anitagraser.com/2012/03/18/beautiful-
global-projections-adding-custom-projections-to-qgis/> _ .

Pour plus d’informations, lire Systéme de Coordonnées de Référence.

6.1.7 What’s Next?

Dans la prochaine lecon, vous apprendrez comment analyser des données vecteur en utilisant les différents outils
d’analyse vecteur de QGIS.

6.2 Lesson: Analyse Vectorielle

Les données vecteur peuvent également étre analysées pour révéler comment différentes entités interagissent les unes
avec les autres dans I'espace. 1l existe de nombreuses fonctions différentes liées a I’analyse, nous ne les passerons donc
pas toutes en revue. Nous allons plutdt poser une question et essayer de la résoudre a I'aide des outils que fournit le
QGIS.

Objectif de cette lecon : Poser une question et la résoudre en utilisant les outils d’analyse.
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6.2.1 Le processus SIG
Avant de commencer, il serait utile de donner un bref apercu d’un processus qui peut étre utilisé pour résoudre un
probléme. La marche a suivre est la suivante :

1. Enoncer le probleme

2. Obtenir les données

3. Analyser le probleme

4. Présenter les résultats

6.2.2 Le probleme

Nous allons commencer le processus en décidant d'un probleme a résoudre. Par exemple, vous &tes un agent
immobilier et vous recherchez une propriété résidentielle 8 Swellendam pour des clients dont les criteres sont les
suivants:

—

. Il doit étre dans Swellendam

2. Elle doit se trouver a une distance raisonnable d’une école (disons 1 km)
3. Il doit avoir une taille supérieure a 100 metres carrés

4. A moins de 50m d’une route principale
5

. A moins de 500m d’un restaurant

6.2.3 Les données

Pour répondre a ces questions, nous allons avoir besoin des données suivantes :
1. Les propriétés résidentielles (batiments) dans la région
2. Les routes dans et autour de la ville
3. L’emplacement des écoles et des restaurants
4. La taille des batiments

Ces données sont disponibles par le biais ’OSM, et vous devriez constater que I'ensemble de données que vous avez
utilisé tout au long de ce manuel peut également étre utilisé pour cette lecon.

Si vous souhaitez télécharger des données a partir d’'une autre zone, passez au Introduction Chapter pour lire comment
le faire.

Note: Bien que les données OSM en téléchargement ont des champs cohérentes, la couverture et le détail varie. Si
vous trouvez que votre région choisie ne contient pas d’informations sur les restaurants, par exemple, vous devriez
peut-étre choisir une région différente.
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6.2.4 Follow Along: Démarrer un projet et obtenir les données

Nous devons d’abord charger les données pour travailler.

1. Démarrer un nouveau projet QGIS

2. Si vous le souhaitez, vous pouvez ajouter un fond de carte. Ouvrez le Navigateur et chargez le fond de carte
OSM dans le menu tuiles XYZ.

*Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEERRE UL, H PRPRA - LBEOC

=3 9 »
= WY = [T - @
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« @ ® T .3 e p

- |v| ¥ OpenStreetMap
s A
[} \ C
&
%

e
/ SIS
Swellendam &’%

@ Browser (]E3] s
®.5CTT0 \ =" :

» @ PostGIS = L R
@~ » mssaL T3 [ \
= = pB2 s L e \ C
S @ wMS/WMTS | 7 7 = \
&) v |~ @ xvZTiles I # 4 \

= OpenStreetMap y AN —

Vo' @ wes 1 N A T / ~

» ) WFS / OGC API - Features i ! T - N\

L0y @ ows | f
@ ArcGisMapServer |

&) ArcGisFeatureServer ] )«' e ~
sf¢ GeoNode ! J iy %
=l ._r
1 » /i
1 Type to locate (Ctri+K) i| 2271701,-4029807 |9 = 1:53229 ~| & r|100% >3 |o0° =| ¥/ Render & EpsGi3gsT @

3. Dans la base de données training_data.gpkg Geopackage, vous trouverez la plupart des jeux de
données que nous utiliserons dans ce chapitre :

1. buildings
2. roads
3. restaurants
4. schools
Chargez-les, et aussi landuse.sglite.
4. Zoomer sur 'étendue de la couche pour voir Swellendam, South Africa

Avant de poursuivre, nous allons filtrer la couche roads, afin de n’avoir que quelques types de routes spécifiques
avec lesquelles travailler.

Certaines routes dans les ensembles de données OSM sont répertoriées comme unclassified, tracks,
path” et ' footway. Nous voulons les exclure de notre ensemble de données et nous concentrer sur les

autres types de routes, plus appropriés pour cet exercice.

De plus, les données OSM pourraient ne pas €tre mises a jour partout, et nous exclurons également les valeurs
NULL.

5. Faites un clic droit sur la couche roads et choisissez Filtre....

6. Dans le dialogue qui s’affiche, nous filtrons ces entités avec I'expression suivante: :
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"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS.
—NOT NULL

La concaténation des deux opérateurs NOT et IN exclut toutes les entités qui ont ces valeurs d’attribut dans le
champ highway.

IS NOT NULL combiné avec I'opérateur AND exclut les routes sans valeur dans le champ highway.
Notez I'icone E a coté de la couche roads. Elle vous aide a vous rappeler que cette couche a un filtre activé,
de sorte que certaines entités peuvent ne pas étre disponibles dans le projet.

La carte avec toutes les données doit ressembler a la suivante :

tm_ch72 - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEERRE UL, HAPP "R RGO

,i abe| ‘ @ 0 »
Qo -K-8-EE%¥ I =0 - &
Layers @
@ lvawnvre -#an
~ V| [l training_data
vs v| [ training_data schoo|
= v| [] training_data restau
[+} v| — training_data roa"’
g] v| [ training_data buildi | <
5]
¥ ] landuse .
’Q ~ [|  OpenStreetMap . N
K;’ . |
I v . \
. . -
M Browser B AN )
Q. BT i /) / :
] ~
» # Spatialite E I
@' » @ postals ——
% P MssoL T
W & pB2 ~—
&~ » @ wms/wmTs
~ @ XYZ Tiles
\f; b = OpenStreetMap
» @& wes
S0 |y & WFS/OGC API - Features
» ) ows
& ArcGisMapServer
& ArcGisFeatureserver
s} GeoNode -
[ »
Q Type to locate (Ctrl+k) i| 2275926,-4028540 |9 2| 1:53229 ~| @ r|100% 2la |oo® 2| [v|Render 4 epscizasT @

6.2.5 Try Yourself Convertir le SCR des couches

Comme nous allons mesurer des distances a I'intérieur de nos couches, nous devons changer le CRS des couches.
Pour ce faire, nous devons sélectionner chaque couche a tour de role, enregistrer la couche dans une nouvelle couche
avec notre nouvelle projection, puis importer cette nouvelle couche dans notre carte.

Vous disposez de nombreuses options différentes, par exemple vous pouvez exporter chaque couche comme un jeu
de données au format ESRI Shapefile, vous pouvez ajouter les couches a un fichier GeoPackage existant, ou vous
pouvez créer un autre fichier GeoPackage et le remplir avec les nouvelles couches reprojetées. Nous allons montrer la
derniere option, de sorte que le fichier training_data.gpkg restera propre. N’hésitez pas a choisir le meilleur
flux de travail pour vous-méme.

Note: Dans cet exemple, nous utilisons le CRS WGS 84 / UTM zone 34S, mais vous devriez utiliser un CRS UTM
qui est plus approprié pour votre région.

1. Cliquez avec le bouton droit sur la couche roads dans le panneau couches

2. Cliquez sur Exporter —> Sauvegarder les entités sous...
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. Dans le dialogue sauvegarder les couches sous, choisissez GeoPackage comme Format.

. Cliquez sur ... pour le Nom du fichier, et nommez le nouveau GeoPackage vector_analysis.

3
4
5. Changer le Nom de la couche en roads_34S.
6. Remplacer le CRS par WGS 84 / UTM zone 34S
7

. Cliquez sur OK :
Save Vector Layer as... X
Format GeoPackage -

File name ning-Data-release 3.10/exercise_data/vector analysis.gpkg

Layer name roads 345

CRS EPSG:32734 - WGS 84 f UTM zone 345 - | | &

Encoding

[#| Select Fields to export and their export options
v Geomekry

Geometry type Automatic -

F Extent (current: layer)
b Layer Options

P Custom Options

@Help v| Add saved fileto map | ¥ Cancel « OK

Cela va créer la nouvelle base de données GeoPackage et ajouter la couche roads_34S.

8. Repeat this process for each layer, creating a new layer in the vector_analysis.gpkg GeoPackage file
with _34S appended to the original name.

On macOS, press the Replace button in the dialog that pops up to allow QGIS to overwrite the existing
GeoPackage.
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Note: When you choose to save a layer to an existing GeoPackage, QGIS will add that layer next to the
existing layers in the GeoPackage, if no layer of the same name already exists.

9. Remove each of the old layers from the project

10. Une fois que vous avez terminé le processus pour toutes les couches, faites un clic droit sur n'importe quelle
couche et cliquez sur zoomer jusqu'a l'étendue de la couche pour centrer la carte sur la zone d’intérét.

Maintenant que nous avons converti les données OSM en une projection UTM, nous pouvons commencer nos calculs.

6.2.6 Follow Along: Analyse du probléeme : Distances des écoles aux routes

QGIS vous permet de calculer les distances entre n’importe quel objet vecteur.

1. Assurez-vous que seules les couches routes_34S et buildings_34S sont visibles (pour simplifier la
carte pendant que vous travaillez)

2. Cliquez sur le lien traitement » boite outils pour ouvrir le ceeur analytique de QGIS. Fondamentalement, tous
les algorithmes (pour I'analyse vecteur et raster) sont disponibles dans cette boite a outils.

3. Nous commengons par calculer la zone autour de roads_34S en utilisant I'algorithme fampon. Vous pouvez
le trouver dans le groupe Géomeétrie vecteur.
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Processing Toolbox

"ne0 A

Q

1 b . . . . A

() Recently used
(2 Cartography

(2} Database

() File tools

(2 Graphics

(2} Interpolation

(2} Layer tools

()} Network analysis
()} Raster analysis
() Raster terrain analysis
() Raster tools

() Vector analysis
(2} Vector creation
() Vector general
() Vector geometry

me Add geometry attributes
4% Aggregate

4% Boundary

4% Bounding boxes

= Centroids

+ Check validity

&% Collect geometries

# Concave hull (alpha shapes)

¥ Concave hull (k-nearest neighbaor)

4% Convert geometry type
& convex hull

4% Create layer from extent
4% Create wedge buffers

@ Delaunay triangulation
¥ Delete holes

4% Densify by count

4% Densify by interval

P Dissolve

4% Drape (set z-value from raster)
4# Drop M/Z values

¥ Eliminate selected polygons
4% Explode lines

4 Extend lines

¥ Extract specific vertices
"'* Extract vertices

4% Filter vertices by m value
4% Filter vertices by z value
4F Fix geometries

4% Geometry by expression
4 Interpolate point on line

i vrnn M hisensck ek

-

You can add more algorithms to the toolbox,
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Vous pouvez également taper t ampon dans le menu de recherche situé dans la partie supérieure de la boite a
outils :

Strumenti di Processing () ]
e OB Y
<. buffer] & |
= () Geometria vettore =
Buffer multi-anello (distanza costante)
Buffer su singolo lato
Create wedge buffers
Tapered buffers
Variable width buffer (by m-value)

- = GDAL
* Geoprocessing di Vettori
= Buffer su singalo lato
e Vettori buffer
~ & GRASS
* Raster (r.#)
@ r.buffer
@ r.bufferlowmem
* Vettore (v.®)
@ v.buffer
- & SAGA
~ Raster tools
& Raster buffer
& Raster proximity buffer
& Threshold raster buffer

= Wrartor eneeoesd

4. Double-cliquez dessus pour ouvrir le dialogue de I'algorithme

5. Sélectionnez roads_34S comme couche entrée, mettez Distance” a 50 et utilisez les valeurs par défaut pour
le reste des parametres.
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Parameters | Log Buffer
Input layer . .
P y This algorithm computes a buffer area for all the
W/ roads_34S [EPSG:32734] v ||...|| @ features in an input layer, using a fixed or dynamic
distance.

Dist. The segments parameter controls the number of

Istance line segments to use to approximate a quarter circle
50,000000 @ % |meters K =N when creating rounded offsets.

Segments The end cap style parameter controls how line

s — endings are handled in the buffer.

d l The join style parameter specifies whether round,
End cap style miter or beveled joins should be used when

Round - offsetting corners in a line.

Join style The miter limit parameter is only applicable for
miter join styles, and conkrols the maximum

Round h distance from the offset curve to use when creating

Miter limit a mitered join.

2,000000 -

Dissolve result
Buffered

[Create temporary layer]

¥| Open output file after running algorithm

| 0%

@Help Run as Batch Process... # Close

6. La valeur par défaut de Distance est en metres car notre jeu de données d’entrée est dans un systeme de
coordonnées projetées qui utilise le metre comme unité de mesure de base. Vous pouvez utiliser la boite
combinée pour choisir d’autres unités de projection comme les kilometres, les yards, etc.

Note: Si vous essayez de créer un tampon sur une couche avec un systeme de coordonnées géographiques,
Processing vous avertira et vous proposera de reprojeter la couche dans un systeme de coordonnées métriques.

7. Par défaut, traitement crée des couches temporaires et les ajoute au panneau Couches. Vous pouvez également
ajouter le résultat a la base de données GeoPackage en

1. Cliquant sur le bouton ... et choisir sauvegarder GeoPackage....
2. Nommer la nouvelle couche « roads_buffer 50m ».

3. Enregistrez-le dans le fichier vector_analysis.gpkg
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Parameters ‘ Log

Input layer

/" roads_34s [EPSG:32734]

-|[..][2]

Distance

'50,000000 @ 3| |meters

MR =2

Segments

'5

rF
-

End cap style

'Round

Join style

'Round

Miter limit

12,000000

Fe
-

Dissolve result
Buffered

okg' table="roads_buffer_50m" (geom) |:|

¥| Open output file after running algorithm

Buffer

This algorithm computes a buffer area for all the
features in an input layer, using a fixed or dynamic
distance.

The segments parameter controls the number of
line segments ko use to approximate a quarter circle
when creating rounded offsets.

The end cap style parameter controls how line
endings are handled in the buffer.

The join style parameter specifies whether round,
miter or beveled joins should be used when
offsetting corners in a line.

The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
distance from the offset curve to use when creating
a mitered join.

0%

| @Help || RunasBatch Process... |

| %Close |l «/Run ]

8. Cliquez sur Exécuter, puis fermez le dialogue tampon.

Maintenant, votre carte devrait ressembler a peu pres a ceci:
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*tm_ch72 - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

NEERERS O L BPR Q0L LM

/ T . Q¥ e T
@ M-o-EEK =0 . R
Layers =)

« @ ® T &vE AL
v| — roads_34S

V; v| [l schools_34s
-] V! [[] restaurants_34S

2 roads_buffer 5om |
ﬁg ! [] buildings_34s

v [ landuse_34s

,n v [| ® openstreetMap
fa
Fﬁ- Browser B&

e}
Q- & B T 1l‘ ]
» 7 |Favorites
@v » " spatial Bookmarks
» [¥ Project Home
% » [l Home

@[ g
» @ GeoPackage
\Gv » # spatiaLite
» @ postais
&Ez » MssQL
DB2
b B WMS/WMTS
b B XYZ Tiles

L & arc -

4 »
| @ Type to locate (ctrl+k) Coordinate| 2271541,4028794 |9 Scale|1:51359 |~ | @@ Magnifier 100% \:| Rotation |0,0° |2V Render @ Epsc3ss7 @

Si votre nouvelle couche se trouve en haut de la liste couches, elle obscurcira probablement une grande partie de votre
carte, mais cela vous donne toutes les zones de votre région qui se trouvent a moins de S0m d’une route.

Remarquez qu’il existe des zones distinctes dans votre zone tampon, qui correspondent a chaque route individuelle.
Pour vous débarrasser de ce probleme :

1. Décochez la couche roads_buffer_50m et recréez le tampon avec dissoudre résultat activé.
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Parameters ‘ Log

Input layer
"/ roads_34S [EPSG:32734] <~ | .| @]

Distance

150,000000 @ || |meters ~| €&

Segments

E <]
End cap style

'Round -
Join style

'Round -
Miter limit

'2,000000 2]

issolve result

By Dissolve result

ok{python identifier: ‘DISSOLVE lgeom) | ... |

¥| Open output file after running algorithm

Buffer

This algorithm computes a buffer area for all the
features in an input layer, using a fixed or dynamic
distance.

The segments parameter controls the number of
line segments ko use to approximate a quarter circle
when creating rounded offsets.

The end cap style parameter controls how line
endings are handled in the buffer.

The join style parameter specifies whether round,
miter or beveled joins should be used when
offsetting corners in a line.

The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
distance from the offset curve to use when creating
a mitered join.

| 0%

| @Help || RunasBatch Process... |

| %Close |l «/Run ]

2. Enregistrez la sortie sous le nom de roads_buffer_50m_dissolved.

3. Cliquez sur executer et fermez le dialogue tampon.

Une fois que vous avez ajouté la couche au panneau couches, il ressemblera a ceci :
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*tm_ch72 - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DeEREY O, RPPRH Q0 &I

/ = - . AT
@ M-e-L,EE% S =)0 . R
Layers (@S]

-} o« @l ® T &vF AL

roads_buffer 5om |
\/: v — roads_34S
= v [l schools_34s

] v [[] restaurants_34s
Eg W roads_buffer_s0m

¥ [ buildings_34s

,n v [l landuse_34s
f - ¥ OpenStreetMap

(+]

l" Browser @®
LeT®o

» 7 Favorites

@' » " spatial Bookmarks
» [¥ Project Home

% » |4 Home

@- r O/
» @ GeoPackage
\,/:v » / SpatiaLite
+ @ postGls
€ P MssQL
DB2
b B WMS/WMTS

b & XYZ Tiles

a5 e .
4 ]
| A Type to locate (Ctrl+K) Coordinate| 2271575030207 |9 Scale 151359~ | @@ Magnifier| 100% 2] Rotation [0.0° |2V Render @ Epsc3ss7 @

Il n’y a maintenant plus de subdivisions inutiles.

Note: La bréve aide sur le c6té droit du dialogue explique comment I'algorithme fonctionne. Si vous avez besoin
de plus d’informations, il vous suffit de cliquer sur le bouton aide dans la partie inférieure pour ouvrir un guide plus
détaillé de I'algorithme.

6.2.7 Try Yourself Distance depuis les écoles

Utilisez la méme approche qu’en haut et créez un tampon pour vos écoles.

It shall be 1 km in radius. Save the new layer in the vector_analysis.gpkg file as
schools_buffer_lkm_dissolved.

Réponse

* Your buffer dialog should look like this:
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Buffer
Parameters Log ¢ Buffer
Input layer - This algorithm computes a buffer area
|C:jschco|5_34s [EPSG:32734] - | | .. ||®@]|| [forallthe features in an input layer,
o using a fixed or dynamic distance.
) The segments parameter controls the
Distance number of line segments to use to
- . . approximate a quarter circle when
|1.000000 a@ |'| kilometers ~ | 5, creating rounded offsets.
Segments The end cap style parameter controls
[s |:| how line endings are handled in the
buffer.
End cap style o N
The join style parameter specifies
| Round hd | whether round, miter or beveled joins
) should be used when offsetting corners
Join style in a line.
Round - T .
| oun | The miter limit parameter is only
Miter limit applicable for miter join styles, and
= controls the maximum distance from the
| 2.000000 |- offset curve to use when creating a
. mitered join.
v Dissolve result
Buffered
|ﬂgr:dbname='fhomejmattec.f\.rectcr_anaIysis.gpkg' table='sch00|s_buffer_lkm_d| | |
v Open output file after running algorithm
| 0% |
| [&Help | | Run as Batch Process... # Close | l &Run ]

The Buffer distance is 1 kilometer.

» The Segments to approximate value is set to 20. This is optional, but it’s recommended, because it makes the
output buffers look smoother. Compare this:
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To this:
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The first image shows the buffer with the Segments to approximate value set to 5 and the second shows the value set
to 20. In our example, the difference is subtle, but you can see that the buffer’s edges are smoother with the higher
value.

6.2.8 Follow Along: Chevauchement des zones

Nous avons maintenant identifié les zones ou la route est 8 moins de 50 metres et les zones ot il y a une école dans un
rayon de 1 km (ligne directe, pas de route). Mais évidemment, nous ne voulons que les zones ol ces deux criteres sont
satisfaits. Pour ce faire, nous devrons utiliser I'outil Intersection. Vous pouvez le trouver dans le groupe superposition
vecteur dans la boite a outils traitement.

1. Utilisez les deux couches tampons comme Couche dentrée et Couche de recouvrement, choisissez
analyse_vectorielle.gpkg GeoPackage dans Intersection avec Nom de la couche
road_school_buffers_intersect. Laissez le reste comme suggéré (par défaut).
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Intersection B

3 .
Parameters = Log Intersection
Input layer

This algorithm extracts the

-~ schools_buffer 1km [EPSG:32734] ||...|| @ overlapping portions of features
in the Input and Overlay layers.
Features in the output

Overlay layer Intersection layer are assigned
the attributes of the overlapping
~'roads_buffer_50m [EPSG:32734] = || .- [|®]| |Features from both the Input and

Overlay layers.

Input fields to keep (leave empty to keep all fields) [optional]
Overlay fields to keep (leave empty to keep all fields) [optional]

v Advanced parameters

Overlay fields prefix [optional]

Intersection

lysis.gpkg' table="road_school buffers_intersect" (geom)

¥| Open output file after running algorithm

@Help Run as Batch Process... # Close

o Pl e M e ma

2. Cliquez sur Exécuter.

Dans I'image ci-dessous, les zones bleues correspondent aux endroits ou les deux criteres de distance sont
satisfaits.
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o *chapter_7 - QGIS 9e45223d42 [tm] o x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
BRDR% @* 2L HPPAABBER @ §-D-GEE#C =P M-
4 7 @ < “qQlHuwee9 QQae ~9- B % X
Layers L]
$ Y@wTE-BAD
\} v [l road school_buffers_intersect
roads buffer 5om disssolved
7z p—
" ]
v [l schools_buffer_1km_dissolved
]
-]
=
|
~Or
Browser | Layers
X Type to locate (Ctri+K) Llegend sties remved Coortinate 2265496403585 | scale 132255 |~ | (@ Magnier| 100 2| Rotaton [00- 2| Vet @ mseamT @

3. Vous pouvez enlever les deux couches de tampon et garder seulement celle qui montre ou elles se croisent,
étant donné que c’est ce que nous voulons vraiment savoir en premier lieu :

o *chapter_7 - QGIS 9e45223d42 [tm] o x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
BREBRX Qe L L oPP AL B R S--LEE%IsS-9 M-
J 7 @ ¢ “4BlBuwee9e QAR 49~ & K
Layers L]
: sawYE-BAD0
v v [l road school buffers intersect
L VI roads_3as
VA v [ schools_34s
w v/ restaurants 345
V! [] buildings_3as
v [l 1anduse _34s
~OF
4
= *
)
-
Browser | Layers
Coortinta [2265730,4033115 | 9§ Scae 152255 |~ | @ Magnier | 100% 2| Rotaton (00" 2|Vl Render @ EsoaeT @

X Type to locate (CtrI+K) Llagend enties removed.
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6.2.9 Follow Along: Extraire les batiments

Maintenant, vous avez la zone ou les batiments doivent se chevaucher. Ensuite, vous voulez extraire les batiments
dans cette zone.

1. Cherchez I'entrée de menu Sélection de vecteurs » Extraction par emplacement dans la Boite a outils traitement

2. Sélectionnez buildings_34S dans Extrayez les entités de’. Vérifiez intersection dans Ot les éléments
(prédicat géométrique), sélectionnez la couche d’intersection tampon dans En comparant avec les éléments de .
Enregistrez dans le fichier :file: vector_analysis.gpkg, et nommez la couche well_located_houses.

Extract by Location £

Parameters | Log " Extract by location

Extract features from . .
This algorithm creates a new

.~ buildings_34s [EP5G:32734] .|| ... vector layer that only contains
matching features from an input

Where the features (geometric predicate) layer. The criteria for adding

v intersect touch Features to the resulting layer is
defined based on the spatial
contain overlap relationship between each
disioi oy fFeature and the Featuresin an
isjoint are within

additional layer.
equal Cross

By comparing to the features from

' road_school_buffers_interse: > | | ... || @

Extracted (location)

.g' table="well located houses" (geom)

¥ Open output file after running algorithm

| 0%

@Help Run as Batch Process... # Close

3. Cliquez sur Executer et fermez le dialogue

4. Vous constaterez probablement que peu de choses semblent avoir changé. Si c’est le cas, déplacez la couche
well_located_houses en haut de la liste des couches, puis zoomez.
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0 *chapter_7 - QGIS 9e45223d42 [tm]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessin

BERR: O AL sHPPA TR S -G EE# = D

Les batiments en rouge sont ceux qui correspondent a nos criteres, tandis que les batiments en vert sont ceux
qui n’y correspondent pas.

5. Vous avez maintenant deux couches séparées et vous pouvez supprimer buildings_34S de la liste des
couches.

6.2.10 Try Yourself Filtrer davantage nos batiments
Nous avons maintenant une couche qui nous montre tous les batiments a 1km d’une école et 2 50m d’une route. Nous
devons maintenant réduire la sélection pour ne montrer que les batiments qui sont 8 500m d’un restaurant.

En utilisant les processus décrits ci-dessus, créez une nouvelle couche appelée houses_restaurants_500m qui filtre
davantage votre couche well_located_houses pour ne montrer que celles qui sont 8 moins de 500m d’un restaurant.

Réponse
To create the new houses_restaurants_500m layer, we go through a two step process:

1. First, create a buffer of 500m around the restaurants and add the layer to the map:
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Buffer

Parameters | Log | Buffer
Input layer

This algorithm computes a buffer area

[~ restaurants_345 [EP5G:32734] - || .. ? for all the features in an input layer,
l = ‘ l_J u using a fixed or dynamic distance.

[ se t nly
. : The segments parameter controls the
Distance number of line segments to use to
- . approximate a quarter circle when
| 500.000000 a |" [meters ‘ \=4 creating rounded offsets.
Segments The end cap style parameter controls
|5 |¢I how line endings are handled in the
buffer.
End cap style o .
The join style parameter specifies
| Round b | ¢ | whether round, miter or beveled joins
) " | should be used when offsetting corners
Join style in a line.
Round - . :
l I The miter limit parameter is only
Miter limit applicable for miter join styles, and
= controls the maximum distance from the
| 2.000000 |v‘ offset curve to use when creating a
mitered join.
Dissolve result )
Buffered

hejm atteo/vector_analysis.gpkg' table="houses_restaurants_500m" (geom) sql= | .

Open output file after running algorithm

[ 0% /|

[ [&|Help I [ Run as Batch Process... ¥ Close ‘ l Run ]

L *chapter_7 - QGIS 9e45223d42 [tm] - a x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

DeBRRRY QL s HPPRAARBRER @G K-N-LBEXI=-9 0

P /BYGNR- PG00 be “qaAY“E9949% QAR 40- B ¥

Rl

Browser | Layers

[[QType to locate (ctri+k) 2legend enres removed. Coortnte| 2757254029383 | scole 122008 |~ | @ Magnier| 100% 2] Rotsten [00- [2] V] Rercer @ epsczes @

2. Next, extract buildings within that buffer area:
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Extract by Location

Parameters | Log | Extract by location

el T This algorithm creates a new vector

layer that only contains matching
features from an input layer. The criteria
for adding features to the resulting layer
is defined based on the spatial
relationship between each feature and

| 2 well_located_houses [EPS5G:32734] - | |:|

Where the features (geometric predicate)

intersect | | touch

| | contain | | overlap the features in an additional layer.
| disjoint | | are within
| | equal || cross

By comparing to the features from

| (2 restaurants_buffer_500m [EPSG:32734] - |[..][®]
[ Selected features only

Extracted (location)

|1attec{vectcr_analysis.gpkg' table="restaurants_buffer_500m" {geom) 5q|=| |_|

Open output file after running algorithm

[ 0% | |

| [@Help || Run as Batch Process... | | # Close |[ «Run ]

Your map should now show only those buildings which are within 50m of a road, 1km of a school and 500m of a
restaurant:

[} *chapter_7 - QGIS 9e45223d42 [tm] - B x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

Y PBBRRX Q*rLr s NPPRALARBRER 6 K-O-GEE#Z=-9 M-

P /BARAR-FTx0B6e “"qQE%999% QQR 49- 0B s

<l

IRREY

houses _restaurants_500m
vell located hou
restaurant_buffer_500m
roads_34s
restaurants_34s

e (B

Conranae| 2004001515 |95 scne[13m2 |+ | @ Mot 1005 2] oaton 00

[2] v Rerser @ Eseze @

| Q Type to locate (Ctri+K) 1 legend entries removed.
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6.2.11 Follow Along: Sélection des batiments de la bonne taille

Pour savoir quels batiments sont de la bonne taille (plus de 100 metres carrés), nous devons calculer leurs dimensions.
1. Sélectionnez la couche houses_restaurants_500m et ouvrez la Calculatrice de champs en cliquant sur le bouton
5] Ouvir caulatrice champs g T barre d'outils principale ou dans la fenétre de la table d’attributs

2. Sélectionnez créer un nouveau champs, mettez le nom de champ de sortie a AREA, choisissez nombre decimal
(real) as type de champ sortie, et choisissez Sarea dans le groupe Geometry.

Field Calculator x|

¥ Create a new Field Update existing Field

Create virtual field
Output field name |AREA
Qutput field type | Decimal number (real) -

Output field length Precision

Expression | Function Editor

=D W D)8 Q Searc... function $area =
$area d . = Returns the area of the current
» Date and Time
» |Eieldsand valles fegture. The area calculated by
» Files and Paths this function respects both the
} Fuzzy Matching current project’s ellipsoid setting
» General and area unit settings. For
~ Geometry example, if an ellipsoid has been
anile at_vertex set for the project then the
calculated area will be ellipsoidal,
Output preview: 1501.0355253089597 area ~| | and if no ellipsoid is set then the |~
o You are editing information on this layer but the layer is currently not in edit mode. If you click

OK, edit mode will automatically be turned on.
@Help % Cancel « OK

Le nouveau champ AREA contiendra la superficie de chaque batiment en metres carrés.

3. Cliquez sur OK. Le champ AREA a été ajouté a la fin de la table d’attributs.

4 Cliquez sur le bouton 'g'“ basculer en mode edition

vous y &tes invité.

pour terminer I’édition, et enregistrez vos modifications lorsque

5. Dans l'onglet Source des propriétés de la couche, réglez le filtre Provider Feature Filter a "AREA >= 100.
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Query Builder X

Set provider filter on houses_restaurants_500m
Fields Values

old_name = Q search...
addr:erf

internet_access

level

sport

man_made

layer Sample All

height
= Use unfiltered layer

v Operators
= < = LIKE % IM MNOT IN

<= = 1= ILIKE AND OR NOT

Provider specific Filter expression

== 100

1 b

©@Help Test Clear * cancel

6. Cliquez sur OK.

Votre carte ne doit maintenant vous montrer que les batiments qui correspondent a nos critéres de départ et qui ont
une superficie de plus de 100 metres carrés.

6.2.12 Try Yourself

Sauvegardez votre solution comme une nouvelle couche, en utilisant pour ce faire I'approche que vous avez apprise
ci-dessus. Le fichier doit étre enregistré dans la méme base de données GeoPackage, sous le nom de solution.

6.2. Lesson: Analyse Vectorielle 217



QGIS Training Manual

6.2.13 In Conclusion

En utilisant 'approche de résolution de problemes des SIG avec les outils d’analyse vecteur de QGIS, vous avez pu
résoudre un probleme a criteres multiples rapidement et facilement.

6.2.14 What's Next?

Dans la prochaine lecon, nous verrons comment calculer la distance la plus courte le long des routes d’'un point a un
autre.

6.3 Lesson: Analyse de réseau

La recherche de la plus petite distance entre deux points est une des utilisations récurrente d’'un SIG. Les outils pour
réaliser cette tache se trouvent dans la Boite a outils de Traitements.

Objectif de cette lecon: apprendre a utiliser I'algorithme Network analysis.

6.3.1 Follow Along: Les outils et les données

Vous pouvez trouver tous les algorithmes d’analyse de réseau dans le menu traitement » analyse reseau. Vous pouvez
constater que de nombreux outils sont disponibles :

Processing Toolbox B
e 0O TN

A Search.

=

(U Recently used
@ Cartography

@ Database

@ File tools

» @ GPS

@ Interpolation

=

=

=

=

=

@ Layer tools
@ Mesh
~ @ Network analysis
.. Service area (from layer)
. Service area (from point)
. Shortest path (layer to point)
. Shortest path (point to layer)
. Shortest path (point to point)
@ Plots
@ Raster analysis

=

=

=

=

¥ Raster creation

=

@ Raster terrain analysis

=

@ Raster tools

=

@ Vector analysis

=

@ Vector creation

=

@ Vector general
@ Vector geometry
@ Vector overlay

=

=

=

@ Vector selection
@ Vector table

@ Vector tiles

» i GDAL

» @ GRASS

=

=
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Ouvrez le fichier de projet exercise_data/network_analysis/network.ggz. Il contient deux couches

* network_points
e network_lines

La couche network_lines a déja un style qui aide a comprendre le réseau routier.

Les outils de calcul du chemin le plus court permettent de calculer le chemin le plus court ou le plus rapide entre deux
points d’un réseau donné :

* points de départ et d’arrivée sélectionnés sur la carte
* point de départ sélectionné sur la carte et points d’arrivée pris dans une couche de points
* points de départ pris a partir d’'une couche de points et point final sélectionné sur la carte

Commengons.

6.3.2 Calculer le chemin le plus court (de point a point)
Analyse réseau w Chemin le plus court (point a point) vous permet de calculer la plus courte distance entre deux points
sélectionnés manuellement sur la carte.
Dans cet exemple, nous allons calculer le plus court chemin (et non le plus rapide) entre deux points.
1. Ouvrez l'algorithme Le plus court chemin (point a point).
2. Sélectionnez network_lines pour Couche vecteur représentant le réseau.
3. Utilisez le plus court pour Type de chemin pour calculer.

Utilisez ces deux points comme points de départ et d’arrivée pour I'analyse :
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Starting Point

-

Ending Peint

4. Click on the ... button next to Start point (x, y) and choose the location tagged with Starting Point inthe
picture. Enable the snapping options for an accurate selection. The coordinates of the clicked point are added.

5. Faites la méme chose, mais en choisissant 'emplacement marqué avec point final pour End point (x, y).

6. Cliquez sur le bouton executer :

Shortest Path (Point to

Parameters | Log Shortest path (point to
Vector layer representing network point)
'/ network_lines [EPSG:32734] | &3 QR || | This algorithm computes optimal

(shortest or fastest) route between
given start and end points.

ed feature
Path type to calculate
Shortest -
Start point
-337683.461296,14891793.324881 [EPSG:32734]
End point
-338394.378190,14891385.941820 [EPSG:32734]

p Advanced Parameters
Shortest path

[Create temporary layer]

V| Open output file after running algorithm

0% Cancel

i Aide Advanced - Run as Batch Process... ~ Run & Fermer

7. Une nouvelle couche de lignes est créée, représentant le chemin le plus court entre les points choisis. Décochez
la couche network_1lines pour mieux voir le résultat :
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*network - QGIS 9e45223d42 [tm]

Project Edit View

BRR

Layers
“HeYs-BAO

Shortest path

BENSBHS

]
» G onass
» & saca

8. Ouvrez la table des attributs de la couche de sortie. Elle contient trois champs, représentant les coordonnées
des points de départ et d’arrivée et le coiit.

Nous avons choisi 1e plus court comme Type de chemin a calculer, donc le coiit représente la distance,
en unités de couche, entre les deux endroits.

Dans notre cas, la distance la plus courte entre les points choisis est d’environ « 1000™ metres :

Shortest path — Features Total: 1, Filtered: 1, Selected: 0

7 & LT E S O ¥ E = 8 &
start = end cost
11-337683.461296, 14891793.3249 -338394.37819, 148913859418 906,4072543701861

- Show All Features _ B

Maintenant que vous savez comment utiliser 'outil, n’hésitez pas a tester d’autres lieux.

6.3.3 Try Yourself Chemin le plus rapide

Avec les mémes données de I'exercice précédent, essayez de calculer le chemin le plus rapide entre les deux points.

De combien de temps avez-vous besoin pour passer du début a la fin ?

Answer

1. Open Network Analysis » Shortest Path (Point to Point) and fill the dialog as:
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Shortest Path (Point to Point)

Parameters | Log Shortest path (point to
Vector layer representing network pOInt)
/" network _lines [EPSG:32734] v @gj] Q% = This algorithm computes optimal

Gy (shortest or fastest) route between
ad feature

given start and end points.
Path type to calculate

Fastest =
Start point
-337683.461296,14891793.324881 [EP5G:32734]
End point
-338394.378190,14891385.941820 [EP5G:32734]

p Advanced Parameters
Shortest path

[Create temporary layer]

V| Open output file after running algorithm

| 0% Cancel

B Aide Advanced - Run as Batch Process... v Run | @ Fermer

2. Make sure that the Path type to calculate is Fastest.
3. Cliquez sur Exécuter et fermez le dialogue.

4. Open now the attribute table of the output layer. The cost field contains the travel time between the two points
(as fraction of hours):

Shortest path — Features Total: 1, Filtered: 1, Selected: 0

/ g BT ESD 2 E = @&
start end cost

1]|-337683.461296, 14891793.3249 -338394.37819, 14891385.9418 0,018128145087403721

| Show All Features _

6.3.4 Follow Along: Options avancées
Let us explore some more options of the Network Analysis tools. In the previous exercise we calculated the fastest
route between two points. As you can imagine, the time depends on the travel speed.
Nous utiliserons les mémes couches et points de départ et d’arrivée des exercices précédents.
1. Ouvrez l'algorithme Le plus court chemin (point a point).

2. Remplissez les parametres Couche en entrée, Point de départ (x, y) et Point d’arrivée (x, y) comme nous I'avons
fait auparavant
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3. Choisissez 1e plus rapide comme Type de chemin a calculer
4. Ouvrez le menu Paramétres avancés.

5. Changez la Vitesse par défaut (km/h) de la valeur par défaut 50 a 4.
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Shortest Path (Point to Point)

Parameters | Log

Shortest path (point to

Vector layer representing network

| /" network_lines [EPSG:32734]

Path type to calculate

point)

This algerithm computes optimal
(shortest or fastest) route between
given start and end points.

| Fastest

Start point

|-337683.46 1296,14891793,324881 [EP5G:32734]

End point

|-338394.3?81 90,14891385.241820 [EP5G:32734]

w Advanced Parameters

Direction field [optional]

Walue for forward direction [optional]

WValue for backward direction [optional]

Walue for both directions [optional]

Default direction

| Both directions

Speed field [optional]

Default speed (km/h)

4,000000

Topology tolerance

0,000000 | |meters  + |
Shortest path
|[C reate temporary layer] | |:
v | Open output file after running algorithm
‘ 0% | Cancel
| i aide | | Advanced '| | Run as Batch Process... ~ Run | | & Fermer |

6. Cliquez sur executer.

7. Une fois I'algorithme terminé, fermez le dialogue et ouvrez la table d’attributs de la couche de sortie.
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Le champ coiit contient la valeur en fonction du parametre de vitesse que vous avez choisi. Nous pouvons
convertir le champ coiit des heures avec fractions en valeurs minutes plus lisibles.

8. Open the field calculator by clicking on the icon

9. Add a new field to store the path cost in minutes.

Shortest path — Field Calculator

v Create a new field Update existing field
Create virtual field

Output field name |minutes

Output field type 1.2 Decimal Number (real) -

Output field length | 10 > | Precision 3

Expression Function Editor

= L e Q searc... | |Show Vi group field =
"cost” * 60 + Date and Time “ | Double-click to add field name to expression
~ Fields and values string. —
feature
geometry Values | O, Search...
id
NULL All Unigue 10 Samples
=t - LA | A | Y R ) ||\ abc start
abc pnd
Feature 51296, 14891793.3249  ~
1.2 cost
Preview: 13,596108815552794 b Files and Paths -

H aide " Ok |®ﬂnnuler

That’s it! Now you know how many minutes it will take to get from one point to the other one if the whole network
speedisat 4 km/h.

6.3.5 Le plus court chemin avec limitation de vitesse

La boite a outils d’analyse du réseau propose d’autres options intéressantes. Regardez la carte suivante :
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nous aimerions connaitre I'itinéraire le plus rapide compte tenu des limites de vitesse de chaque route (les étiquettes
représentent les limites de vitesse en km/h). Le chemin le plus court sans tenir compte des limitations de vitesse serait
bien siir le chemin violet. Mais sur cette route, la limite de vitesse est de 20 km/h, alors que sur la route verte, vous
pouvez aller a 100 km/h !

Comme nous I’avons fait dans le premier exercice, nous utiliserons le Analyse de réseau » Chemin le plus court (point
a point) et nous choisirons manuellement les points de départ et d’arrivée.

1. Ouvrez l'algorithme Analyse du réseau w» Chemin le plus court (point a point).
. Sélectionnez network_lines pour le parametre Couche vecteur représentant le réseau.
. Choisissez 1e plus rapide comme Type de chemin a calculer

2
3
4. Select the Start point (x, y) and End point (x, y) as we did before
5. Ouvrez le menu Paramétres avancés.

6

. Choisissez le champ vifesse comme parametre Champ de vitesse. Avec cette option, I'algorithme prendra en
compte les limites de vitesse pour chaque route.
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Shortest Path (Point to Point)

Parameters | Log

Vector layer representing network

|/ network_lines [EPSG:32734]

d featur

L
m

ect

o
b

s only

Path type to calculate

Shortest path (point to
point)

This algorithm computes optimal
(shortest or fastest) route between
given start and end points.

| Fastest

Start point

|—337683.461 2096,14891793.324881 [EPSG:32734]

End point

|—33 8394.378190,14891385.941820 [EP5G:32734]

w Advanced Parameters

Direction field [optional]

Value for forward direction [optional]

Value for backward direction [optional]

Value for both directions [optional]

Default direction

| Both directions

Speed field [optional]

|l-2 spead

Default speed (km/h)

50,000000

Topology tolerance

0,000000 2| [meters  ~ |
Shortest path
|[C reate temporary layer] | |:
v| Open output file after running algorithm
‘ 0% | Cancel
| H pide | | Advanced - | | Run as Batch Process... +" Run | | & Fermer |

7. Cliquez sur le bouton Exécuter.

8. Désactivez la couche network_1lines pour mieux voir le résultat
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L} *network - QGIS 9e45223d42 [tm] - a x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
BRRRY VPP IHNPPAR TR e YT E
/ @ 4@z aee QQR ~2o9- B * %
Layers @®
3O T &E-FADL
0

SNSSHS

Typet X e — Conrtnate| 2300203 100010068 | scole 11138 |+ | @ Mg 1005 2] Rotaton (00" 5| henter @ osca @

Browser | Layers

Comme vous pouvez le constater, l'itinéraire le plus rapide ne correspond pas au plus court.

6.3.6 Zone de service (a partir de la couche)

Lalgorithme analyse reseau w zone service (depuis la couche) peut répondre a la question : étant donné une couche
de points, quelles sont toutes les zones atteignables en fonction d’une distance ou d’une valeur temporelle ?

Note: Le analyse reseau » zone service (depuis point) est le méme algorithme, mais il vous permet de choisir
manuellement le point sur la carte.

Etant donné une distance de 250 metres, nous voulons savoir jusqu’'oll nous pouvons aller sur le réseau a partir de
chaque point de la couche network_points.

1. Décochez toutes les couches sauf network_points.

Ouvrez l'algorithme analyse reseau » zone service (depuis couche).
Choisissez network_1ines pour Couche vecteur représentant le réseau.
Choisissez network_points pour Couche vecteur avec points de départ.
Choisissez le plus court dans Type de chemin a calculer.

Entrez 250 pour le parametre Coiit du voyage

T B

Cliquez sur executer et fermez le dialogue

228 Chapter 6. Module: Analyse vectorielle



QGIS Training Manual

vice Area (From Layer)

3
Parameters \ — Service area (from layer)
Vector layer representing network This algorithm creates a new vector with all
| /" network_lines [EPSG:32734] - | tn ‘5}'\5 | . the edges or parts of edges of a network line
— layer that can be reached within a distance
Selected features only or a time, starting from features of a point

layer. The distance and the time (both

Path e to calculate .
yp referred to as "travel cost”) must be specified

| Shortest - | respectively in the network layer units or in
: . hours.
Vector layer with start points
- netwark_points [EPSG:32734] - 3 Xy ..
Selected features only

Travel cost (distance for 'Shortest’, time for ‘Fastest')

250,000000 ‘: |

p Advanced Parameters

Service area (lines) [optional]

[Create temporary layer] | | e

v Open output file after running algerithm

Service area (boundary nodes) [optional]

[Skip output] | |:
Open output file after running algorithm
| 0% | Cancel
| i Aide | | Advanced -~ | Run as Batch Process... ~ Run | | @ Fermer |

La couche de sortie représente le chemin maximum que vous pouvez atteindre a partir des caractéristiques du
point étant donné une distance de 250 metres :
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o *network - QGIS 9e45223d42 [tm]

C’est cool, n’est-ce pas ?

6.3.7 In Conclusion

Vous savez maintenant comment utiliser I'algorithme analyse reseau pour résoudre les problemes de chemin le plus
court et le plus rapide.

Nous sommes maintenant préts a effectuer des statistiques spatiales sur les données de la couche vectorielle. Allons-y
!

6.3.8 What’s Next?

Vous verrez ensuite comment exécuter des algorithmes de statistiques spatiales sur des jeux de données vectorielles.

6.4 Lesson: Statistiques Spatiales

Note: Lecon développée par Linfiniti et S Motala (Cape Peninsula University of Technology)

Les statistiques spatiales vous permettent d’analyser et de comprendre ce qui se passe dans un ensemble de données
vecteur donné. QGIS comprend de nombreux outils utiles pour I'analyse statistique.

Le but de cette lecon: Savoir comment utiliser les outils de statistiques spatiales de QGIS dans la boite a outils
traitement.
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6.4.1 Follow Along: Créer un jeu de données test

Nous allons créer un ensemble de points aléatoires, pour obtenir un ensemble de données avec lesquelles travailler.

Pour ce faire, vous aurez besoin d’un ensemble de données polygonales pour définir la zone dans laquelle vous
souhaitez créer les points.

Nous utiliserons la zone couverte par les rues.
1. Démarrer un nouveau projet

2. Ajoutez votre jeu de données roads, ainsi que srtm_41_19 (données d’élévation) qui se trouve dans le
fichier exercise_data/raster/SRTM/.

Note: Vous constaterez peut-étre que la couche SRTM DEM a un CRS différent de celui de la couche des
routes. QGIS reprojette les deux couches dans un seul CRS. Pour les exercices suivants, cette différence n’a
pas d’importance, mais n’hésitez pas a faire des reprojections (comme indiqué plus haut dans ce module).

3. Ouvrir la boite d’outils Traitement

4. Utilisez loutil Géométrie vecteur » Etendue minimum de la géométrie pour générer une zone englobant toutes
les routes en sélectionnant Convex Hull comme Type de géométrie :

Minimum Bounding Geometry 0

>

Parameters | Log Minimum bounding
Input layer geo metry
/" roads [EPSG:4326] v ||...|| @

This algorithm creates geometries which
enclose the features from an input layer.

Field (optional, set if Features should be grouped by class) [optional] | Mumerous enclosing geometry types are
supported, including bounding boxes
(envelopes), oriented rectangles, circles

-

Geometry type and convex hulls.

Convex Hull - Optionally, the features can be grouped by
) a Field. If set, this causes the output layer

Bounding geometry to contain one feature per grouped value

with a minimal geometry covering just the

[Create temporary layer
—— - ylayer] features with matching values.

¥| Open output file after running algorithm

@Help Run as Batch Process... % Close 7 Run

Comme vous le savez, si vous ne spécifiez pas la sortie, Traitement crée des couches temporaires. C’est a vous
de sauvegarder les couches immédiatement ou a un stade ultérieur.
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Création de points aléatoires

* Créez 100 points aléatoires dans cette zone en utilisant I'outil Création de vecteur » Points aléatoires dans les
limites de la couche, avec une distance minimale de 0.0 :

Random Points in Layer Bounds *

Parameters | Log ' Random 3
Input layer points in
2 Bounding geometry [EPSG:4326] ~ | ... | |2 layer bounds

This algorithm
creates a new point
layer with a given
[100| :l number of random
points, all of them
within the extent of

Number of points

Minimum distance between points

0,000000 | degrees A\ | agivenlayer. A
. distance fFactor can
Random points be specified, to

avoid points being

[Create temporary layer]
too close to each

v Open output file after running algorithm other. -
| 0%
@Help Run as Batch Process... # Close

Note: Le panneau d’avertissement jaune vous indique que ce parametre concerne les distances. La couche
Emprise de la géométrie se trouve dans un systéme de coordonnées géographiques et I'algorithme ne fait que
vous le rappeler. Pour cet exemple, nous n’utiliserons pas ce parametre, vous pouvez donc l'ignorer.

Si nécessaire, déplacez le point aléatoire généré vers le haut de la légende pour mieux les voir :
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*Untitled Project - QGIS 2

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

O

Y4

- BACENS @ 5

By O RPPr g LR
Eﬁvvl:ldﬁ} 2 vy mv
Layers @
« [l ® T | =
v ® Random points (=] =
v|[] Bounding geometry (=]
— roads
- B crbm A1 19 b
Browser (]3]
ORTTO

4 Favorites
» " spatial Bookmarks
» [¢] Home

=Y,

» @ GeoPackage

» # spatialite

-
L

Q Type to locate (Ctrl+K)

Echantillonage des données

-

rdil| 20.083,-34.046 %’ & 1:324314

-

@ n|100%

»

9

a
-

ps

3 [00°

L

.| 1,00000

-

~| v Render

& EPSG:4326

x

Pour créer un échantillon de données a partir du raster, vous devez utiliser ’algorithme Analyse raster » Exemple
de valeur raster. Cet outil échantillonne le raster a 'emplacement des points et ajoute les valeurs du raster dans de
nouveaux champs en fonction du nombre de bandes du raster.

1. Ouvrez la boite de dialogue de 'algorithme Exemple de valeurs raster

2. Sélectionnez Points_aléatoires comme couche contenant les points d’échantillonnage, et la trame
SRTM comme bande a partir de laquelle obtenir les valeurs. Le nom par défaut du nouveau champ est
rvalue_N, ol N est le numéro de la bande du raster. Vous pouvez changer le nom du préfixe si vous le

souhaitez.
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Sample Raster Values *

4

parameters | Log Sample raster
Input Point Layer values
©" Random points [EPSG:4326] - 2 This algorithm creates
a new vector layer
with the same
Raster Layer to sample attributes of the input
" srtm_41_19 [EPSG:32733] w||...|| |layerandthe raster
values corresponding
|w| Advanced parameters on the point location.
Output column prefix If the raster layer has
more than one band,
rvalue all the band values are
sampled.

sampled Points

[Create temporary layer]

v Open output file after running algorithm

| 0%

@Help Run as Batch Process... # Close

3. Appuyez sur Run

Vous pouvez maintenant vérifier les données échantillonnées du fichier raster dans la table des attributs de la couche
Points échantillonnés. Elles se trouveront dans un nouveau champ avec le nom que vous avez choisi.

Voici un exemple de représentation de la couche:
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Les points d’échantillonnage sont classés a I'aide du champ « rvalue_1 », de sorte que les points rouges se trouvent a
une altitude plus élevée.

Vous utiliserez cette couche d’échantillonnage pour le reste des exercices statistiques.

6.4.2 Follow Along: Statistiques Basiques
Maintenant, récupérez les statistiques basiques de cette couche.

1. Cliquez sur l'icone E voir le résumé statistique. qang 1a harre d'outils attribut. Un nouveau panneau apparaitra.
2. Dans la boite de dialogue qui apparait, spécifiez la couche « Points échantillonnés » comme source.

3. Sélectionnez le champ rvalue_1 dans la liste déroulante des champs. C’est le champ pour lequel vous allez
calculer les statistiques.

4. Le panneau Statistiques sera automatiquement mis a jour avec les statistiques calculées:
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Statistics & ]
. sampled Points v |
Va 1.2 rvalue_1 ~|| €|
* Statistic Value
',3 Count 100
BB sum 14148
9, |Mean 141.48
ﬁ: Median 122.5
Fﬁ_ st dev (pop) 89.4792
'u' St dev (sample) 89.93
@ Minimum 18
-
% Maximum 737
@ RE!I"IQE 719
w
Minority 18
+
Majorikty 120
&
Variety 78
Q1 97
Q3 163.5
IQR 66.5

Missing (null) values 0

|

Selected featuresonly 7 &2

W g

| Statistics | Layers  Browser

| Q Type to locate (Ctrl+K) |
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Note: Vous pouvez copier les valeurs en cliquant sur le bouton

résultats dans une feuille de calcul.

copier les statistiques dans le presse papier et coller les

5. Fermez le panneau statistiques quand vous aurez terminé

De nombreuses statistiques différentes sont disponibles :

Compte
Le nombre d’échantillons/valeurs.

Somme
Les valeurs ajoutées ensemble.

Moyenne

La valeur moyenne est simplement la somme des valeurs divisée par le nombre de valeurs.

Médiane

Si vous rangez toutes les valeurs de la plus petite a la plus grande, la valeur moyenne (ou la moyenne des deux
valeurs moyennes, si N est un nombre pair) est la médiane des valeurs.

St Dev (pop)

La déviation standard. Donne une indication sur la maniere dont les valeurs sont regroupées autour de la
moyenne. Plus la déviation est faible, plus les valeurs tendent a se situer a la moyenne.

Minimum
La valeur minimale.

Maximum
La valeur maximale.

Portée

La différence entre les valeurs minimale et maximale.

Q1

Premier quartile des données.

Q3

Troisieme quartile des données.

Valeurs (nulles) manquantes
Le nombre de valeurs manquantes.

6.4.3 Follow Along: Calculer des statistiques sur les distances entre points

1. Créer une nouvelle couche de points temporaire.

2. Entrez en mode édition, et numérisez trois points parmi les autres points.

Alternativement, utilisez 1a méme méthode de génération de points aléatoires que précédemment, mais spécifiez

seulement trois points.

3. Enregistrez votre nouvelle couche sous distance_points dans le format que vous préférez.

Pour générer des statistiques sur les distances entre les points dans les deux couches:

1. Ouvrez l'outil Analyse vecteur » Matrice de distance.

2. Sélectionnez la couche distance_points comme couche d’entrée, et la couche Sampled Points

comme couche cible.

3. Définissez-le comme ceci:
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Distance Matrix

Parameters | Log Distance matrix

T s o0 This algorithm creates a table

Distance Points [EPSG:4326] || . ||D containing a distance matrix, with
distances between all the pointsin a
points layer.

Input unigue 1D field
123 id -
Target point layer
Sampled Points [EP5G:4326] (.|| D

Target unique ID field

123 id -
Output matrix type

Summary distance matrix {mean, std. dev., min, max) -
Use only the nearest (k) target points
[2] =

Distance matrix

[Create temporary layer]

v Open output file after running algorithm

| 0%

&2 he un as Batc rocess... ase un
@|Help R Batch P % Cl @R

4. Si vous le souhaitez, vous pouvez enregistrer la couche de sortie sous forme de fichier ou simplement exécuter
I'algorithme et enregistrer la couche de sortie temporaire plus tard.

5. Cliquez sur Exécuter pour générer la couche de matrice de distance.

6. Ouvrez la table attributaire de la couche générée: les valeurs font référence aux distances entre les entités
distance_points et leurs deux points les plus proches dans la couche Sampled Points:

] Distance matrix :: Features Total: 3, Filtered: 3, Selected: 0 . o x
y ~ T =€ & h T E & D B @ e
InputiD MEAN STDDEVW MIN MaX
1 1 401.87013 235.74757 166.12256 637.61770
2 2 653.19728 229.72430 423.47299 882.92158
3 0 1005.87036 296.03133 709.83903 1301.90169

T Show All Features _ = |

Avec ces parametres, 1'outil Matrice de distance calcule les statistiques de distance pour chaque point de la couche
d’entrée par rapport aux points les plus proches de la couche cible. Les champs de la couche de sortie contiennent la
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moyenne, I'écart-type, le minimum et le maximum des distances par rapport aux voisins les plus proches des points
de la couche d’entrée.

6.4.4 Follow Along: Analyse du plus proche voisin (dans la couche)

Pour effectuer une analyse du voisin le plus proche d’une couche de points:
1. Choisissez Analyse vecteur » Analyse du plus proche voisin.
2. Dans la boite de dialogue qui apparait, sélectionnez la couche Points aléatoires et cliquez sur Exécuter.

3. Les résultats apparaitront dans le panneau Processing Visualiseur de résultats.

Processing Toolbox E3]
*?r (R !1- --:“;I = W -.:k}

'}
L

» (1) Recently used =
» (2 Cartography
b () Database

b (3 File Fnnls b

Results Viewer E3

" Mearest neighbour [04:51:51]

Algorithm: Nearest neighbour =
File path: /tmp/processing MXcuYE/
6aa2320aecdf41d4adbesed45440fF23
be/OUTPUT HTML FILE.html -

4. Cliquez sur le lien bleu pour ouvrir la page html avec les résultats:
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Mozilla Firefox

Jtmp/processing MXcuYE/« X

G | @ Ffile:///tmp/processing MXcu' s | X
Observed mean distance: 1408.03338044153
Expected mean distance: 0.01577808561
Nearest neighbour index: 89239.81118148957
Number of points: 100
Z-Score: 1707201.00974689284

6.4.5 Follow Along: Coordonnées Moyennes

Pour obtenir les coordonnées moyennes d’un jeu de données:
1. Démarrez Analyse vecteur » Coordonnée(s) moyenne(s)

2. Dans le dialogue qui apparait, spécifiez Random points comme couche entree, et laissez les choix optionnels
inchangés.

3. Cliquez sur Exécuter.
Comparons cela a la coordonnée centrale du polygone qui a été utilisée pour créer I'échantillon aléatoire.
1. Démarrer Géométrie vecteur » Centroides
2. Dans la boite de dialogue qui apparatit, sélectionnez 1a géométrie limite comme couche d’entrée.

Comme vous pouvez le voir, les coordonnées moyennes (point rose) et le centre de la zone d’étude (en vert) ne
coincident pas nécessairement.

Le centroide est le barycentre de la couche (le barycentre d’un carré est le centre du carré) tandis que les coordonnées
moyennes représentent la moyenne de toutes les coordonnées des nceuds.
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*Untitled Project - QGIS 0

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

0 BEX U2 HPPD P Q0L GO [ ¥ " 1000 Sldegrees -y > M~

J ae| * q »
@, H-B-,EE &% I =m0 - R
Layers (=]
© vasmva-sa0
» Sampled Points (=]
VS ® Random points (=]
v e Centroids =]
&l Mean coordinates [3]]
gg v [_] Bounding geometry =)
— roads
Yo | = [ W srtm_a1_19
Al ™
[+] 1548
M — vector_analysis roads_34S
@, -
&~
AVARS
&
¥ Layers | Browser
Coordinate| 20.1914,33.9933 | Scale 1:159115 = | @ Magnifier| 100% - Rotation 00° < V| Render ¢ gpsGa3ze @

Q Type to locate (Cerl+K)

6.4.6 Follow Along: Histogrammes d’image

L’histogramme d’un jeu de données montre la distribution de ses valeurs. Le moyen le plus simple de le démontrer
dans QGIS est via I'histogramme d’image, disponible dans la boite de dialogue Propriétés de la couche de n’importe

quelle couche d’image (jeu de données raster).

1. Dans votre panneau couches, faites un clic droit sur la couche srtm_41_19

2. Sélectionnez Propriétés

3. Choisissez I'onglet Histogramme. Vous devrez peut-€tre cliquer sur le bouton Calculer U'histogramme pour
générer le graphique. Vous verrez un graphique qui montre la distribution des fréquences pour les valeurs de

raster.
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Layer Properties - srtm_41_19 | Histogram

3 i i
£ Information Raster Histogram
¥ Source 6000 7
& symbology 5000 ]
!J'_i Transparency ]
. 4000 -
{*~ Histogram = ]
> ]
U ]
& Rendering € 3000 4
c -
1] i
@R Pyramids i .
. 2000 -
a Metadata ]
Legend 1000 -
QGIS Server 1
n _' _J_,...--—-—w-..,_“_ . _ L

0 200 400 600 800 1000 1200 1400

Pixel Value
® Band 1
& PrefsfActions. [ |
Set min/max style For Band 1 -
Min 0 EW
Max 1548 EW
©Help Style - « Apply || % Cancel  OK

=] . .
4. Le graphique peut étre exporté comme image a I'aide du bouton Enregistrer le graphique

5. Vous pouvez voir des informations plus détaillées sur la couche dans I'onglet Information (les valeurs moyennes
et maximales sont estimées, et peuvent ne pas étre exactes).

La valeur moyenne est de 332, 8 (estimée a 324,3), et la valeur maximale est de 1699 (estimée a 1548) ! Vous
pouvez zoomer dans I'histogramme. Comme il y a beaucoup de pixels de valeur 0, 'histogramme semble compressé
verticalement. En zoomant pour couvrir tout sauf le pic a 0, vous verrez plus de détails :
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Layer Properties - srtm_41_19 | Histogram x

[
=

- : .
2 Information Raster Histogram

A% source .

% symbology 150 -

I8 Transparency i

{*~. Histogram i

=%

=]

[=]
|

F4 .
4 Rendering

Frequency

B8 Pyramids

m Metadata

Legend

QGIS Server

200 400 600 800 1000 1200 1400

Pixel Value
® Band 1
@ prefs/Actions., H
Set min/max style for Band 1 -
Min 1 &
Max 1548 EW
©@Help Style ~ « Apply | % Cancel & OK

Note: Si les valeurs moyennes et maximales ne sont pas les mémes que celles indiquées ci-dessus, cela peut €tre dii
au calcul de la valeur min/max. Ouvrez 'onglet Symbologie et développez le menu Paramétres des valeurs Min / Max.

Choisissez - ®' Min /max et cliquez sur Appliquer.

N’oubliez pas qu’un histogramme vous montre la distribution des valeurs, et que toutes les valeurs ne sont pas
nécessairement visibles sur le graphique.
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6.4.7 Follow Along: Interpolation Spatiale

Supposons que vous ayez une collection d’exemples de points a partir desquels vous souhaitez extrapoler des données.
Par exemple, vous pourriez avoir acces au jeu de données Sampled points que nous avons créé plus tot, et vous
souhaitez avoir une idée de I'apparence du terrain.

1. Pour commencer, lancez I'outil GDAL » Analyse raster » Grid (IDW avec recherche du plus proche voisin)
dans la Boite a outils Traitement.

Pour Couche de points, sélectionnez Points échantillonnés.
Réglez Pouvoir de pondération sur 5 . 0.

Dans Parameétres avancés, mettez Valeur Z depuis le champ a rvalue_1

A

Enfin, cliquez sur Exécuter et attendez la fin du traitement
6. Fermez la boite de dialogue

Voici une comparaison entre I'ensemble de données original (a gauche) et celui construit a partir de nos points
d’échantillonnage (a droite). Les votres peuvent sembler différentes en raison de la nature aléatoire de I'emplacement
des points d’échantillonnage.

Comme vous pouvez le voir, 100 points d’échantillonnage ne sont pas vraiment suffisants pour obtenir une impression
détaillée du terrain. Cela donne une idée tres générale, mais elle peut aussi étre trompeuse.

6.4.8 Try Yourself Difféerentes méthodes d’interpolation

1. Utilisez les processus indiqués ci-dessus pour créer un ensemble de 10 000 points aléatoires

Note: Sile nombre de points est vraiment important, le temps de traitement peut étre long.

2. Utilisez ces points pour échantillonner le DEM original
3. Utilisez loutil Grid (IDW avec recherche du plus proche voisin) sur cet ensemble de données.
4. Réglez Power et Smoothing sur 5.0 et 2 . 0, respectivement.

Les résultats (dépendamment de la position de vos points aléatoires) ressembleront plus ou moins a cela :
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C’est une meilleure représentation du terrain, en raison de la plus grande densité des points d’échantillonnage.
N’oubliez pas que des échantillons plus grands donnent de meilleurs résultats.

6.4.9 In Conclusion

QGIS dispose d’un certain nombre d’outils pour analyser les propriétés statistiques spatiales des ensembles de données.

6.4.10 What's Next?

Maintenant que nous avons couvert I’analyse des vecteurs, pourquoi ne pas voir ce que I'on peut faire avec les rasters
? C’est ce que nous ferons dans le prochain module !
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Module: Rasters

Nous avons précédemment utilisé des rasters pour la digitalisation, mais les données raster peuvent aussi €tre utilisées
directement. Dans ce module, vous verrez comme cela est fait dans QGIS.

7.1 Lesson: Les données raster

Les données raster sont tres différentes des données vecteur. Les données vecteur ont des caractéristiques discretes
avec des géométries construites a partir de sommets, et peut-&tre reliées a des lignes et/ou des zones. Les données
raster, cependant, sont comme n’importe quelle image. Bien qu’elles puissent représenter diverses propriétés des
objets dans le monde réel, ces objets n’existent pas en tant qu’objets séparés. Ils sont plutot représentés a I'aide de
pixels de valeurs différentes.

Au cours de ce module, vous allez utiliser des données raster pour compléter votre analyse SIG existante.

Le but de cette lecon: Apprendre a travailler avec des données raster dans QGIS.

7.1.1 Follow Along: Chargement de Données Raster
Les données raster peuvent étre chargées avec les mémes méthodes que celles que nous avons utilisées pour les
données vecteur. Cependant, nous suggérons d’utiliser le panneau navigateur.
1. Ouvrez le panneau Navigateur et développez le dossier exercise_data/raster.
2. Chargez toutes les données dans ce dossier :
¢ 3320C_2010_314_RGB_LATLNG.tif
e 3320D_2010_315_RGB_LATLNG.tif
e 3420B_2010_328_RGB_LATLNG.tif
¢ 3420C_2010_327_RGB_LATLNG.tif

Vous devriez voir la carte suivante :
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*Untitled Project - QGIS X

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DNEBREY Q2RI DB Q kR 9 ¥ . [1m00 : g
&g »
L7 N Ca % T = [T » @
Layers @6 =
@ vasv - -#3a0
. 3320C_2010 314 RGB LATLNGI

V{; v| I 3320D_2010_315_RGB_LATLNG
o v| ¥ 3420B_2010_328_RGB_LATLNG

] v| I 3420C_2010_327_RGB_LATLNG
&

%
£

¥ Layers = Browser

Q. Type to locate (Ctrl+K) 1 203412340054 |9 = 1:98281 ~| @ r|100% 23 |0p° - v Render & EPsGi4326 @

Nous l'avons ici - quatre images aériennes couvrant notre zone d’étude.

7.1.2 Follow Along: Créer un Raster Virtuel

Comme vous pouvez le voir, votre couche de solution se trouve sur les quatre images. Cela signifie que vous allez
devoir travailler avec quatre raster tout le temps. Ce n’est pas I'idéal. Il serait préférable d’avoir un seul fichier pour
travailler.

Heureusement, QGIS vous permet de faire exactement cela, et sans avoir besoin de créer un nouveau fichier raster.
Vous pouvez créer un Raster virtuel. On I'appelle aussi souvent Catalogue, ce qui explique sa fonction. Ce n’est pas
vraiment un nouveau raster. C’est plutdt un moyen d’organiser vos rasters existants en un seul catalogue : un seul

fichier pour un acces facile.
Pour faire un catalogue, nous utiliserons traitement w boite a outils.

1. Ouvrez l'algorithme construire raster virtuel du menu GDAL w Raster miscellaneous ;

A

2. Dans la boite de dialogue qui apparait, cliquez sur le bouton ... a c6té du parametre couche en entree et vérifiez
toutes les couches ou utilisez le bouton sélectionner tous |

3. Uncheck Place each input file into a separate band. Notice the code that is generated at the bottom of the
dialog under GDAL/OGR console call. This is the command that will be executed when you click Run. The
text updates as you change different options in the dialog.

Note: N’oubliez pas que vous pouvez copier et coller le texte dans le « OSGeo Shell » (utilisateur Windows)
ou le « Terminal » (utilisateurs Linux et OSX) pour exécuter la commande. Vous pouvez également créer un
script pour chaque commande GDAL. C’est tres pratique lorsque la procédure prend beaucoup de temps ou
lorsque vous souhaitez programmer des tiches spécifiques. Utilisez le bouton Help pour obtenir plus d’aide sur

la syntaxe de la commande.

4. Pour finir, cliquez sur Exécuter

Note: As you know from the previous modules, Processing creates temporary layers by default. To save the file,
click on the ... button under Virtual.
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Build Virtual Raster X

Parameters | Log

Input layers E

Resolution
Average
v Place each input file into a separate band

Allow projection difference

v Advanced parameters

Add alpha mask band to VRT when source raster has none

Override projection for the output file [optional]

Resampling algorithm
Nearest Neighbour -

Nodata value(s) For input bands (space separated) [optional]

Additional command-line parameters [optional]

Virtual
[Save to temporary File]
v Open output file after running algorithm

GDAL/OGR console call

gdalbuildvrt -resolution average -separate -r nearest -input_File_list /tmp/
processing_waXvap/9e7966068f424564a9ca71decadc15F9/buildvrtinputFiles.txt /
tmp/processing waXvap/219f32d6606644108251F5ad770a7945/0OUTPUT.vrt -

| 0%

@Help Run as Batch Process... % Close «/ Run

Vous pouvez maintenant supprimer les quatre raster originaux du panneau couches et ne laisser que le raster du
catalogue virtuel de sortie.
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7.1.3 Transformation de données Raster

Les méthodes ci-dessus vous permettent de fusionner les jeux de données en utilisant un catalogue, et de les reprojeter
«alavolée ». Cependant, si vous configurez les données que vous allez utiliser pendant un certain temps, il peut étre
plus efficace de créer de nouveaux rasters qui sont déja fusionnés et reprojetés. Cela améliore les performances tout
en utilisant les rasters dans une carte, mais cela peut prendre un certain temps a d’abord mettre en place.

Reprojection de rasters

Ouvrez Warp (reproject) du menu GDAL » Projection raster.

Vous pouvez également reprojeter des rasters virtuels (catalogues), activer le traitement multithreading, etc.
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Warp (Reproject) o

Parameters Log

Input layer
" Virtual [EPSG:4326] -
Source CRS [optional]

Target CRS [optional]
Project CRS: EPSG:4326 - WGS 84 v ||
Resampling method to use

Nearest Neighbour -
Nodata value for output bands [optional]

Mot set

Output file resolution in target georeferenced units [optional]
Mokt set

P Advanced parameters
Reprojected

[Save to temporary file]
¥ Open output File after running algorithm
GDAL/OGR console call

gdalwarp -t_srs EPSG:4326 -r near -of GTiff /tmp/
processing E3t0r2/4d43521175294d8a8F7935de8c0d5¢ca3/OUTPUT.vrt /tmp/
processing_E3t0r2/cf35Ff6625870499798aa2930475ab4b1/OUTPUT.LIF

| 0%
©@Help Run as Batch Process... % Close «' Run

Fusion de rasters

Si vous avez besoin de créer une nouvelle couche raster et de la sauvegarder sur le disque, vous pouvez utiliser
'algorithme de fusion.

Note: Selon le nombre de fichiers raster que vous fusionnez et leur résolution, le nouveau fichier raster créé peut
&tre tres volumineux. Pensez plutdt a créer un catalogue raster comme décrit dans la section Create a Virtual Raster.

1. Cliquez sur I'algorithme fusionner du menu GDAL w Raster miscellaneous.
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2. Comme nous 'avons fait pour la commande Create a Virtual raster, utilisez le bouton ... pour choisir les couches
que vous voulez fusionner.

Vous pouvez également spécifier un raster virtuel comme entrée, puis tous les raster qui la composent seront
traitées.

3. Si vous connaissez la bibliotheque GDAL, vous pouvez également ajouter vos propres options en ouvrant le
menu Advanced parameters.

Parameters Log

Input layers

Grab pseudocolor table from First layer
Place each input file into a separate band
Output data type
Float32 -

b Advanced parameters
Merged

[Save to temporary file]
v Open output file after running algorithm
GDAL/OGR console call

gdal _merge.py -ot Float32 -of GTiff -o /tmp/

processing E3t0r2/517F150854b344bc9f4588a6e9884e32/OUTPUT.LIf --optfile
Jemp/processing E3t0r2/44e87c4b7bdf44533a9552e0d6695F3b/
mergelnputFiles.txt

| 0%

©@Help Run as Batch Process... # Close «/ Run
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7.1.4 In Conclusion

Dans QGIS, il est facile d’inclure des données raster dans vos projets existants.

7.1.5 What’s Next?

Ensuite, nous utiliserons les données raster qui ne sont pas de I'imagerie aérienne, et verrons comment la symbolisation
est ainsi utile dans le cas des rasters.

7.2 Lesson: Modification de la symbologie des Raster

Toutes les données raster ne sont pas des photos aériennes. Il existe de nombreuses autres formes de données raster
et, dans beaucoup de cas, il est essentiel de les symboliser pour qu’elles soient bien visibles et utiles.

Objectif de cette lecon : Changer la symbologie d’une couche raster.

7.2.1 Try Yourself

1. Utilisez le panneau navigateur pour charger srtm_41_ 19.tif, qui se trouve sous exercise_data/
raster/SRTM/

2. Zoomez sur I'étendue de cette couche en faisant un clic droit dessus dans le panneau couches et en sélectionnant
Zoomer sur couche.

Cet ensemble de données est un Modéle numérique délévation (MNE). 11 s’agit d’'une carte d’altitude du terrain, qui
nous permet de voir ol se trouvent les montagnes et les vallées, par exemple.

Alors que chaque pixel de I'ensemble de données de la section précédente contenait des informations sur les couleurs,
dans un DEM, chaque pixel contient des valeurs d’élévation.

Une fois que le DEM est chargé, vous remarquerez qu’il s’agit d’une représentation en niveaux de gris :
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QGIS a automatiquement appliqué un étirement aux valeurs des pixels de I'image a des fins de visualisation, et nous
en apprendrons davantage sur la facon dont cela fonctionne au fur et a mesure.

7.2.2 Follow Along: Modification du style d’'une couche Raster

Vous avez deux options différentes pour changer la symbologie raster :
1. Dans la boite de dialogue proprietes couche, en faisant un clic droit sur la couche dans I'arbre des couches et
en sélectionnant I'option proprietes. Ensuite, passez a 'onglet Symbologie.
&
2. En cliquant sur le bouton ouvrir le panneau de style de la couche jy;qte au-dessus du panneau couches (raccourci F7).
r
Cela ouvrira le panneau style couche, ol vous pourrez passer a 'onglet 0/ Symbologie

Choisissez la méthode avec laquelle vous préférez travailler.
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7.2.3 Follow Along: Bande grise unique

Lorsque vous chargez un fichier raster, s’il ne s’agit pas d’'une image photo comme celles de la section précédente, le
style par défaut est défini sur un dégradé de gris.

Examinons quelques-unes des caractéristiques de ce moteur de rendu.

Layer Properties - sttm_41_19 | Symbology

w Band Rendering

"i’ Information

Render type | Singleband gray -
-;}:._ Source Gray band Band 1 (Gray) -
& symbology Color gradient | Black to white -
l_g Transparency Min |0 Max 1548
B Histogram E:R;:ici}ment Stretch to MinMax -

.}/ Rendering ¥ Min / Max Value Settings

User defined
B Pyramids -
Cumulative

m Metadata countcut |20 =/ - (980 |~[%

Legend ® Min / max

Mean +/-
QGIS Server standard deviation =

Statistics extent whole raster -

Accuracy Estimate (Faster) -

v Color Rendering
Blending mode | Mormal - # Reset
Brightness e— | 0 = [Cnntrast e— } 0 =

Saturation — | 0 = [Grayscale OfF -

Hue Colorize Strength il

¥ Resampling

LI

Zoomed: in | Nearest neighbour ~ | out | Nearest neighbour - | Oversampling | 2,00

Thumbnail Legend Palette

@Help Style - # cancel o OK

La valeur par défaut de Color gradient est fixée a noir vers blanc, ce qui signifie que les valeurs de pixels
faibles sont noires et que les valeurs élevées sont blanches. Essayez d’inverser ce parametre en Blanc vers noir
et voyez le résultat.
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Le parametre amelioration contraste est trés important : par défaut, il est réglé sur etirer jusqu'au MinMax,
ce qui signifie que les valeurs des pixels sont étirées aux valeurs minimales et maximales.

Regardez la différence avec I'amélioration (a gauche) et sans (2 droite) :

Mais quelles sont les valeurs minimales et maximales qui doivent étre utilisées pour le trongon ? Celles qui se trouvent
actuellement sous paramétre valeur Min / Max. 1l existe de nombreuses fagons de calculer les valeurs minimales et
maximales et de les utiliser pour étirer :

1. défini par utilisateur : vous entrez les valeurs Min et Max manuellement

2. Coupure du comptage cumulatif : c’est utile lorsque vous avez des valeurs extrémement basses ou élevées.
1l coupe 2% (ou la valeur que vous choisissez) de ces valeurs

3. Min / max : les valeurs minimales et maximales réelles ou estimées du raster

4. Moyenne +/- écart-type : les valeurs seront calculées en fonction de la valeur moyenne et de I’écart-type

7.2.4 Follow Along: pseudocouleur - bande unique
Les niveaux de gris ne sont pas toujours de bons styles pour les couches rasters. Essayons de rendre le DEM plus
coloré.

» Changez le type de rendu en pseudocouleur bande unique. Si vous n’aimez pas les couleurs chargées par défaut,
s€lectionnez une autre rampe couleurs.

¢ Cliquez sur le bouton classer pour générer une nouvelle classification des couleurs

« Sielle n’est pas générée automatiquement, cliquez sur le bouton OK pour appliquer cette classification au DEM
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Layer Properties - srtm_41_19 | Symbology

o :
@ Information Render type |Singleband pseudocolor v|

bl ;
‘& Source Band |Band 1 (Gray) -

& symbology Min 0 | Max 1548 |
P Min / Max Value Settings

!g Transparency

(et Interpolation ' Linear - |
. Color ramp | [ - H
4 Rendering =
Label unit | |
B Pyramids sufFix
, value Color  Label
! Metadata
Legend
387 387
E QGIS Server
774 774
1161 1161
1548 . 1548
Mode  Continuous  ~ | Classes | |

Clip out of range values

v Color Rendering -

. @Help || style - | JApply | %cancel || JOK |

Vous verrez le raster qui ressemble a ceci :
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C’est une facon intéressante d’envisager le DEM. Vous verrez maintenant que les valeurs du raster sont a nouveau
correctement affichées, passant du bleu pour les zones inférieures au rouge pour les zones supérieures.

7.2.5 Follow Along: Changer la transparence

Parfois, changer la transparence de toute la couche raster peut vous aider a voir les autres couches couvertes par le
raster lui-méme et a mieux comprendre la zone d’étude.

Pour modifier la transparence de I'ensemble du raster passez a I'onglet Transparence et utilisez le curseur de I'onglet
Opacite globale pour réduire 'opacité :
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Il est
nous
allez dans Options de transparence personnalisées dans 'onglet Transparence.

Layer Properties - srtm_41_19 | Transparency
w Global Opacity

Information _F 55.6 % =
Source w No Data Value

Symbology

Additional no data value

. Transparency
: w Custom Transparency Options
Histogram
Transparency band | None -
Rendering o
Transparent pixel list
Pyramids From To Percent Transparent &
Metadata [
=
QGIS Server
5]

[B|Help Style - W Apply @ cancel

plus intéressant de modifier la transparence pour certaines valeurs de pixels. Par exemple, dans le raster que
avons utilisé, vous pouvez voir une couleur homogene aux coins. Pour définir ces pixels comme transparents,

En cliquant sur le bouton 1 sjouter valeur manuellement y,o;5 pouvez ajouter une gamme de valeurs et définir leur
pourcentage de transparence

Pour les valeurs uniques, le bouton |.‘ ajouter des valeurs a partir affichage

L&

est plus utile

Cliquez sur le bouton " iouter des valeurs depuis Taffichage 1 5 hofte de dialogue disparait et vous pouvez interagir

avec la carte.
Cliquez sur la couleur homogene dans un coin du DEM

Vous verrez que le tableau de transparence sera rempli avec les valeurs cliquées :
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Layer Properties - srtm_41_19 | Transparency

v Globalopacy
() Information 1[100,0% |

:t"- Source v No Data Value

% symbology

Additional no data value | |

Lr Transparency

Histogram [»| Custom Transparency Options
Rendering Transparency band |None - |
Transparent pixel list
B Pyramids P P -
From To Percent Transparent |$|
B Metadata 1/o 0 100 ]
Legend |§|
58 Qais server (=]
=]
=]
| @Help || style -] | Japply || %cancel || oK |

* Cliquez sur OK pour fermer le dialogue et voir les changements.

Vous voyez ? Les coins sont maintenant 100% transparents.
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7.2.6 In Conclusion

Voici quelques-unes des fonctions de base pour vous permettre de vous familiariser avec la symbologie raster. QGIS
vous offre également de nombreuses autres options, telles que la symbolisation d’'une couche a I'aide de valeurs
palette/unique, la représentation de différentes bandes avec différentes couleurs dans une image multispectrale, ou la
création d’un effet d’'ombrage automatique (utile uniquement avec les fichiers matriciels DEM).

7.2.7 Références

Le jeu de données SRTM a été obtenu depuis http://srtm.csi.cgiar.org/

7.2.8 What’s Next?

Maintenant que nous pouvons voir nos données correctement affichées, étudions comment nous pouvons davantage
les analyser.

7.3 Lesson: Analyse de terrain

Certains types de raster vous permettent de gagner plus de perspicacité dans le terrain que ce qu’ils représentent. Les
Modeles Numériques d’Elévation (MNE) sont particulierement utiles dans ce sens. Dans cette legon, vous utiliserez
les outils d’analyse de terrain pour en savoir plus sur la zone d’étude pour le développement résidentiel proposé plus
tot.

Objectif de cette lecon : Ultiliser les outils d’analyse de terrain pour avoir plus d’information sur le terrain.

7.3.1 Follow Along: Calcul d’'un Ombrage
Nous allons utiliser la méme couche DEM que dans la lecon précédente. Si vous commencez ce chapitre a partir de
z€ro, utilisez le panneau navigateur et chargez le fichier raster/SRTM/srtm_41_19.tif.

La couche DEM vous montre 1’élévation du terrain, mais elle peut parfois sembler un peu abstraite. Elle contient
toutes les informations 3D sur le terrain dont vous avez besoin, mais elle ne ressemble pas a un objet 3D. Pour avoir
une meilleure impression du terrain, il est possible de calculer un ombrage, qui est un raster qui cartographie le terrain
en utilisant la lumiere et les ombres pour créer une image d’aspect 3D.

Nous allons utiliser des algorithmes du menu Raster » Analyse de terrain.
1. Cliquez sur le menu Ombrage

2. L’algorithme vous permet de spécifier la position de la source lumineuse : Azimuth a des valeurs de 0 (Nord) a
90 (Est), 180 (Sud) et 270 (Ouest), tandis que Angle vertical définit la hauteur de la source lumineuse (0 a 90
degrés).

3. Nous utiliserons les valeurs suivantes :
e Facteur Zde 1.0
o Azimuth (angle horizontal) a 300 .0°

* angle vertical de 40.0°
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vertical

300g

angle

4. Enregistrez le fichier dans un nouveau dossier exercise_data/raster_analysis/ avec le nom
hillshade.

5. Pour finir, cliquez sur Exécuter

Vous aurez maintenant une nouvelle couche appelée hillshade qui ressemble a cela :
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Le résultat semble sympathique et en 3D. Mais pouvons-nous 'améliorer ? L’ombrage semble un peut en platre.
Pouvons-nous le combiner avec nos autres rasters plus colorés ? C’est effectivement possible en utilisant 'ombrage
en tant que couverture.

7.3.2 Follow Along: Utilisation d’'un ombrage comme une couverture

Un ombrage peut fournir des informations tres utiles sur la lumiere du soleil 2 un moment donné de la journée. Mais
il peut aussi étre utilisé a des fins esthétiques, pour donner a la carte une meilleure apparence. La clé pour cela est de
configurer 'ombrage pour qu’il soit presque complétement transparent.

1. Changer la symbologie de la couche srm_41_19 originale pour utiliser le schéma Pseudo-couleur comme dans
I'exercice précédent

2. Cacher toutes les couches sauf les couches srmm_41_19 et ombrage
3. Cliquez et faites glisser le srrm_41_19 pour qu’il se trouve sous la couche ombrage dans le panneau Couches

4. Réglez la couche ombrage pour qu’elle soit transparente en cliquant sur 'onglet Transparence dans les propriétés
de la couche

5. Définissez 1” Opacité globale 2 50%.

Vous obtiendrez le résultat suivant :

6. Désactivez et réactivez la couche ombrage dans le panneau Couches pour voir la différence que cela fait.

En utilisant un ombrage de cette facon, il est possible d’améliorer la topographie du paysage. Si I'effet ne vous semble
pas suffisamment fort, vous pouvez changer la transparence de la couche hillshade ; mais bien siir que plus 'ombrage
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devient brillant, plus les couleurs derriere lui seront sombres. Vous devrez trouver un équilibre qui fonctionne pour
vous.

N’oubliez pas de sauvegarder le projet lorsque vous avez terminé.

7.3.3 Follow Along: Trouver les meilleures zones

Revenons au probleme de 'agent immobilier, que nous avons abordé pour la derniere fois dans la lecon Analyse
vecteur. Imaginons que les acheteurs souhaitent maintenant acheter un batiment et construire un petit chalet sur la
propriété. Dans '’hémisphere sud, nous savons qu’'une parcelle idéale pour le développement doit comporter des zones
qui :

* sont orientés vers le nord
 dont la pente est inférieure a 5 degrés
» Mais si la pente est inférieure a 2 degrés, I'aspect n’a pas d’'importance.

Trouvons les meilleures zones pour eux.

7.3.4 Follow Along: Calcul d’'une Pente
La pente informe sur le degré d’inclinaison du terrain. Si, par exemple, vous voulez construire des maisons sur ce
terrain, il vous faut un terrain relativement plat.
Pour calculer la pente, vous devez utiliser I'algorithme pente de traitement » analyse de terrain raster.
1. Ouvrir I'algorithme
2. Choisissez srtm_41_19 comme Couche d’élévation.
3. Gardez le Facteur Za 1.0.
4. Enregistrez la sortie sous la forme d’un fichier portant le nom « pente » dans le méme dossier que le « ombrage ».
5. Cliquez sur Exécuter

Vous voyez maintenant la pente du terrain, chaque pixel contenant la valeur de pente correspondante. Les pixels noirs
indiquent un terrain plat et les pixels blancs un terrain escarpé.
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7.3.5 Try Yourself Calculer 'aspect
Aspect est la direction de la boussole a laquelle fait face la pente du terrain. Un aspect de O signifie que la pente est
orientée vers le nord, 90 vers I'est, 180 vers le sud et 270 vers I'ouest.

Comme cette étude se déroule dans 'hémisphere sud, les propriétés devraient idéalement &tre construites sur une
pente orientée vers le nord afin qu’elles puissent rester a la lumiere du soleil.

Utilisez I'algorithme Aspect de traitement » analyse terrain raster pour obtenir la couche aspect sauvegardée avec
la pente.

Réponse

Set your Aspect dialog up like this:
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(&) Aspect >

Parameters | Log Aspect

Elevation layer
g This algorithm calculates the aspect of the Digital

0" orim_41_19 [EPSG:32733] - .. Terrain Model in input. The final aspect raster layer
contains values from O to 360 that express the
Z factar slope direction: starting from Morth (0% and
continuing dockwise.
1.000000 =
Aspect
QGIS-Training-Data/exerdse_data fraster_analysis/aspect. tif
v | Open output file after running algorithm
0% Cancel
Run as Batch Process... Run | Close Help

Your result:

£ 5 eh

. 3=
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7.3.6 Follow Along: Trouver I'orientation vers le nord
Maintenant, vous avez des rasters vous montrant la pente ainsi que I’'aspect, mais vous n’avez aucun moyen de savoir
ou les conditions idéales sont satisfaites a la fois. Comment cette analyse pourrait-elle étre effectuée ?
La réponse réside dans la Calculatrice Raster.
QGIS dispose de différents calculateurs rasters :
* Raster » Calculatrice Raster
¢ Via le menu Traitement :
— Analyse raster » Calculatrice raster
— GDAL » Raster miscellaneous w calculatrice raster
— SAGA » Raster calculus » calculatrice raster

Chaque outil conduit aux mémes résultats, mais la syntaxe peut étre légeérement différente et la disponibilité des
opérateurs peut varier.

Nous utiliserons analyse rasteer » calculatrice raster dans la boite a outils traitement
1. Ouvrez l'outil en double-cliquant dessus.

¢ La partie supérieure gauche de la boite de dialogue répertorie toutes les couches raster chargées sous la
forme name@N, ol name est le nom de la couche et N est la bande.

* Dans la partie supérieure droite, vous verrez un grand nombre d’opérateurs différents. Arrétez-vous un
instant pour vous rappeler qu’un raster est une image. Vous devriez la voir comme une matrice 2D remplie
de chiffres.

2. Le nord est a 0 (zéro) degré, donc pour que le terrain soit orienté vers le nord, son aspect doit étre supérieur a
270 degrés ou inférieur a 90 degrés. La formule est donc:

[aspect@l <= 90 OR aspect@l >= 270 }

3. Vous devez maintenant configurer les détails du raster, comme la taille de la cellule, I'étendue et le CRS. Cela
peut étre fait manuellement ou automatiquement en choisissant une couche de référence. Choisissez
cette derniere option en cliquant sur le bouton ... & c6té du parametre couche de référence.

4. Dans le dialogue, choisissez la couche aspect, car nous voulons obtenir une couche avec la méme résolution.
5. Sauvegardez la couche sous aspect_north.

Le dialogue devrait ressembler a :
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() Raster Calculator

Parameters Log

Expression

Layers Operators

aspect@] (R | S - SO YO - O A -

hillshade@1

slope@1 ‘ = | | / | | acos | | asin | | In | | CR ‘

srtm_41_19@1
[ s S T | T A |
L=< JL = JI = JlL = J| <= J| »= |
| abs | min || max |

Expression

aspect@1 <= 90 OR aspect@1 »>= 270

Expression is valid

Predefined expressions

|ND\|"[ = | | Add... || save.

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]

| linputs selected | |:|

Cell size (use 0 or empty to set it automatically) [optional]

| 0.000000 a [z
Output extent [optional]

|Not set

Qutput CRS [optional]
Output
|D: fdev fgithub/QGIS-Training-Data/exercise_data/raster_analysis/aspect_north, tif

v | Open output file after running algorithm

Raster calculator

This algorithm allows performing algebraic operations using
raster layers.

The resulting layer will have its values computed according to
an expression, The expression can contain numerical values,
operators and references to any of the layers in the current
project, The following functions are also supported:

-sin{), cos(), tan(), atan2(), InQ), log10()

The extent, cell size, and output CRS can be defined by the
user, If the extent is not specified, the minimum extent that
covers selected reference layer(s) will be used. If the cell size
is not specified, the minimum cell size of selected reference
layer(s) will be used. If the output CRS is not specified, the
CRS of the first reference layer will be used,

The cell size is assumed to be the same in both X and ¥ axes.

Layers are referred by their name as displayed in the laver list
and the number of the band to use (based on 1), using the
pattern layer_name@band number', For instance, the first
band from a layer named DEM will be referred as DEM@1.

‘When using the calculator in the batch interface or from the
console, the files to use have to be spedified. The
corresponding layers are referred using the base name of the
file (without the full path). For instance, if using a layer at
path/tofmy/rasterfile. tif, the first band of that layer will be
referred as rasterfile. if@1.

[ 0%

| Cancel

|Run as Batch Process...

Run J | Close | Help |

6. Pour finir, cliquez sur Exécuter

Votre résultat doit étre cela :
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Les valeurs de sortie sont 0 ou 1. Qu’est-ce que cela signifie ? Pour chaque pixel raster, la formule que nous avons
écrite indique 8’il correspond aux conditions ou non. Le résultat final sera donc Faux (0) et Vrai (1).

7.3.7 Try Yourself Plus de critéres

Maintenant que vous avez fait 'aspect, créez deux nouvelles couches a partir du DEM.
» La premiere identifie les zones ol la pente est inférieure ou égale a 2 degrés
» La seconde est similaire, mais la pente doit étre inférieure ou égale a 5 degrés.

¢ Enregistrez-les sous exercise_data/raster_analysis sous les noms slope_lte2.tif et
slope_lte5.tif.

Réponse
¢ Set your Raster calculator dialog up with:
* the following expression: slope@l <= 2

* the slope layer as the Reference layer(s)
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Q Raster Calculator

Parameters Log

Raster calculator

Expression
This algorithm allows performing algebraic operations using
ter |, 3
s e raster layers.

The resulting layer will have its values computed according to
aspect@1 | + | = || s | sin || log10 | AND | an expression, The expression can contain numerical values,
aspect_north@1 operators and references to any of the layers in the current
hillshade@1 | - | / || acos | asin || n | OR | project. The following functions are also supported:
slope@1 .
srtm_41_19@1 | e | sqrt || tan | atan | ( | ) | sin(), cos(), tan(), atan2(), In{), log10(

‘ < | | > | | - | | = | | <= | | = ‘ The extent, cell size, and output CRS can be defined by the
user, If the extent is not specified, the minimum extent that
‘ b | | N | | | covers selected reference layer(s) will be used. If the cell size
abs min max is not specified, the minimum cell size of selected reference
layer(s) will be used. If the output CRS is not specified, the
Exxpression CRS of the first reference layer will be used,

The cell size is assumed to be the same in both X and ¥ axes.
“slope@1” <=2

Layers are referred by their name as displayed in the laver list

and the number of the band to use (based on 1), using the

pattern layer_name@band number', For instance, the first
band from a layer named DEM will be referred as DEM@1.
Expression is valid When using the calculator in the batch interface or from the
console, the files to use have to be spedified. The
Predefined expressions corresponding layers are referred using the base name of the
= file (without the full path). For instance, if using a layer at
path/tofmy/rasterfile. tif, the first band of that layer will be
MNDVI v || add || save referred as rasterfile, if@1.
Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]
| linputs selected | | . |
Cell size {use 0 or empty to set it automatically) [optional]
| 0.000000 a [z
Output extent [optional]
|Notset | | ..,|
Output CRS [optional]
| - |®
Qutput
|D:fdEvfg\ﬂ']ubIQGIS—Training-DaiBj'exerdse_damfraster_analysisjslupe_ltez.ﬁf & | | ,l
v | Open output file after running algorithm
| 0% | Cancel
| Run s Batch Process.. Run J | Close | Help |

* For the 5 degree version, replace the 2 in the expression and file name with 5.

Your results:

¢ 2 degrees:
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* 5 degrees:
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7.3.8 Follow Along: Combinaison des résultats de I'analyse raster

Vous avez maintenant généré trois couches raster a partir du DEM :
* aspect_north : terrain orienté au nord
* slope_lte2 : pente égale ou inférieure a 2 degrés
e slope_lte5 : pente égale ou inférieure a 5 degrés

Lorsque la condition est remplie, la valeur du pixel est 1. Ailleurs, elle est de 0. Par conséquent, si vous multipliez
les rasters, les pixels qui ont une valeur de 1 pour tous les rasters auront une valeur de 1 (les autres auront 0).

Les conditions a remplir sont les suivantes :
¢ a5 degrés de pente ou moins, le terrain doit étre orienté vers le nord
* a2 degrés de pente ou en dessous, la direction a laquelle le terrain fait face n’a pas d’importance.

Par conséquent, vous devez trouver des zones ol la pente est égale ou inférieure a cinq degrés AND le terrain est
orienté vers le nord, OR la pente est égale ou inférieure a 2 degrés. Un tel terrain serait propice au développement.

Pour calculer les zones qui satisfont ces criteres :
1. Ouvrir a nouveau la Calculatrice raster.

2. Utilisez cette expression dans Expression: :
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[( aspect_north@l = 1 AND slope_lte5@l1 = 1 ) OR slope_lte2@l = 1 ]

3. Définissez le parametre couche reference a aspect_north (peu importe si vous en choisissez un autre - ils
ont tous été calculés a partir de srtm_41_19)

4. Enregistrez le résultat sous exercise_data/raster_analysis/sousall_conditions.tif

5. Cliquez sur Exécuter

Le résultat :

Indication: Les étapes précédentes auraient pu étre simplifiées en utilisant la commande suivante :

[((aspect@T <= 90 OR aspect@l >= 270) AND slope@l <= 5) OR slope@l <= 2 ]
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7.3.9 Follow Along: Simplification du Raster

Comme vous pouvez le voir sur I'image ci-dessus, I'analyse combinée nous a laissé de nombreuses et tres petites
zones ol les conditions sont remplies (en blanc). Mais ces zones ne sont pas vraiment utiles pour notre analyse, car

elles sont trop petites pour qu’on puisse y construire quoi que ce soit. Débarrassons-nous de toutes ces petites zones
inutilisables.

1. Ouvrez l'outil tamis (GDAL » Analyse raster dans la boite a outil traitement)

2. Mettez le fichier Input 2 al11_conditions, etle fichier famisa all_conditions_sieve.tif (sous
exercise_data/raster_analysis/).

3. Réglez le Threshold a 8 (minimum huit pixels contigus), et vérifiez le Use 8-connectedness.

Sieve
Parameters Log
Input layer =
" all_condition [EPSG:32733] =
Threshold
a8

ad b

v Use 8-connectedness

Do not use the default validity mask for the input band
Validity mask [optional]

Sieved
fhome/matteo/exercise_data/exercise_data/raster_analysis/all_conditions_sieve.tif

v | Open output file after running algorithm

GDAL/OGR console call

0%

|&|Help Run as Batch Process... # Close & Run

Une fois le traitement terminé, la nouvelle couche sera chargée.
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_——___

Que se passe-t-il ? La réponse se trouve dans les métadonnées du nouveau fichier raster.

4. Visualisez les métadonnées sous l'onglet Information du dialogue proprietes couche.

STATISTICS_MINIMUM :

@ Information

‘J{g- Source

%" symbology

l,ﬂ Transparency

u Histogram

Q‘/

B Pyramids

Rendering

QGIS Server

Layer Properties - all_conditions_sieve | Information

Mame
Path

CRS
Extent

Unit

‘Width

Height

Data type

GDAL Driver Description
GDAL Driver Metadata
Dataset Description

Compression
Band 1

More information
Dimensions
Origin

Pixel Size

ldentification

[E|Help

Style -

Information from provider

all_conditions_sieve

EPSG:32733 - WGS 84 / UTM zone 335 - Projected

969491 2754000000422520,61%6099.34080000035456476 ¢
1038119.773099999991 2454 62502946 9956000000238419
meters

837

a6l

Float32 - Thirty two bit floating point

GTiff

GeaTllFF
/home/mattec/exercise_data/exercise_data/raster_analysis/
all_conditions_sieve.tif

* STATISTICS_APPROXIMATE=YES
* STATISTICS_MAXIMUM=1
* STATISTICS MEAMN=-266696862.2513
e NSNS =-2147483648
* STATISTICS_STDDEWV=708237202.43956
* AREA_OR_POINT=Area

¥: 837 ¥: 661 Bands: 1

269491,6.2503e+6

81.9934.-81.9934

o Apply @ cancel

____ﬁ

Regardez la valeur
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Ce raster, comme celui dont il est dérivé, ne doit comporter que les valeurs 1 et 0, mais il comporte également
un trés grand nombre de négatif. L’examen des données montre que ce nombre agit comme une valeur nulle.
Puisque nous ne recherchons que les zones qui n’ont pas été filtrées, fixons ces valeurs nulles a zéro.

5. Ouvrez la calculatrice raster, et construire cette expression: :

[(all_conditions_sieve@l <=0) =0 }

Cela permettra de maintenir toutes les valeurs non négatives, et de mettre les nombres négatifs a zéro, laissant
toutes les zones avec la valeur 1 intactes.

6. Enregistrez le résultat sous exercise_data/raster_analysis/ sous le nom de
all_conditions_simple.tif.

Votre sortie ressemble a cela :

C’est ce qui était attendu : une version simplifiée des résultats précédents. Souvenez-vous que si les résultats que vous
obtenez a partir d’un outil ne sont pas ceux que vous attendiez, visualiser les métadonnées (et les attributs vectoriels,
si applicable) peut s’avérer essentiel pour résoudre le probleme.

7.3.10 Follow Along: Reclassification raster
Nous avons utilisé la calculatrice raster pour effectuer des calculs sur des couches raster. Il existe un autre outil
puissant que nous pouvons utiliser pour extraire des informations des couches existantes.

Retour a la couche « aspect ». Nous savons maintenant qu’elle a des valeurs numériques dans une fourchette de 0 a
360. Ce que nous voulons faire, c’est reclasser cette couche en d’autres valeurs discretes (de 1 a 4), selon I'aspect :

« 1 =Nord (de 0245 et de 315 2 360)
« 2 =Est (de 45 2 135)

* 3 =Sud (de 135 2 225)

« 4 =Ouest (de 225 2 315)
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Cette opération peut étre réalisée avec la calculatrice raster, mais la formule deviendrait tres trés grande.

Loutil alternatif est I'outil reclassifier par table dans le menu analyse raster dans la boite outils.

1.
2.
3.

Lancez l'outil
Choisissez aspect comme Couche raster d'entrée.

Cliquez sur le ... de Table de reclassement. Un dialogue semblable a un tableau apparaitra, dans lequel vous
pourrez choisir les valeurs minimales, maximales et les nouvelles valeurs pour chaque classe.

Cliquez sur le bouton Ajouter ligne et ajoutez 5 lignes. Remplissez chaque rangée comme suit et cliquez sur
OK :

Minimum Maximum Value | < OK |
10 45 1 * Cancel
2/315 360 1 Add Row
3|43 135 2 Remove Row(s)
4135 225 3

Remove All

Mo

La méthode utilisée par I'algorithme pour traiter les valeurs seuils de chaque classe est définie par la limite de
gamme.

Enregistrez la couche comme reclassified.tif dans le dossier exercise_data/
raster_analysis/.
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Reclassify by Table .

»
Paramelers | Log RECIESSif}'
Raster layer hy table
=" Aspect [EPSG:32733] - This algorithm
Band number reclassifies a
g raster band by
Band 1 (Gray) - assigning new

class values
based on the
ranges specified
in a fixed table.

Reclassification table

v Advanced parameters

Output no data value

-9999 000000 -
Range boundaries
min < value <= max -

Use no data when no range matches value
Output data type
Float32 -

Reclassified raster

rcise_data/raster_analysis/reclassified.sdat

v Open output File after running algorithm

| 0%

@Help Run as Batch Process... ¥ Close

6. Cliquez sur Exécuter

Si vous comparez la couche native aspect avec celle reclassifiée, il n’y a pas de grandes différences. Mais en regardant
la Iégende, vous pouvez voir que les valeurs vont de 1 a 4.

Donnons a cette couche un meilleur style.
1. Ouvrez le panneau style couches

2. Choisissez Paletted/Unique values, au lieu de Singleband gray.
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3. Cliquez sur le bouton classer pour récupérer automatiquement les valeurs et leur attribuer des couleurs aléatoires

Layer Styling (&
| " reclassified - |
= 5= Paletted/Unique values - | 3
Band 'Band 1 (Gray) - |
Color ramp | Random colors |;|
Value Color Label -
1 . 1
2 2
3 . 3
4 4
| Classify ||| | = || Delete All ] el

Layer Rendering

Blending mode 'Normal - |

||| & V| Live update | W Apply |
| Layer Styling | Processing Toolbox

La sortie doit ressembler a ceci (vous pouvez avoir différentes couleurs étant donné quelles ont été générées de
maniere aléatoire) :
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Griace a cette reclassification et au style palettisé appliqué a la couche, vous pouvez immédiatement différencier les
zones d’aspect.

7.3.11 Follow Along: Interroger raster
Contrairement aux couches vecteur, les couches raster n’ont pas de table d’attributs. Chaque pixel contient une ou
plusieurs valeurs numériques (rasters a bande unique ou multibandes).

Toutes les couches rasters que nous avons utilisées dans cet exercice ne consistent qu'en une seule bande. Selon la
couche, les valeurs des pixels peuvent représenter des valeurs d’élévation, d’aspect ou de pente.

Comment pouvons-nous interroger la couche raster pour obtenir la valeur d’un pixel ? Nous pouvons utiliser le bouton
Q% Identifier des entités !
1. Sélectionnez 'outil dans la barre d’outils Attributs.

2. Cliquez sur un emplacement aléatoire de la couche srim_41_19. identifier résultat apparaitra avec la valeur de
la bande a I'emplacement cliqué :
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Identify Results E]ES)
[ 25 i SIS Biv

Feature Value
* 0 srtm 41 19
srtm 41 19
Band 1 592
b (Derived)

Mode Current layer -

View Tree - Help

3. Vous pouvez changer la sortie du panneau Résultat de lidentification du mode arbre actuel aun mode table
en sélectionnant Table dans le menu Vue en bas du panneau :

Identify Results e
Layer FID Attribute Value

1/srtm_41_19 1 Band 1 592

View Table ~ Help

Cliquer sur chaque pixel pour obtenir la valeur du raster pourrait devenir ennuyeux apres un certain temps. Nous
pouvons utiliser le plugin outil valeur pour résoudre ce probleme.

1. Allez a Extensions » Gérer/Installer des extensions...
2. Dans l'onglet fous, tapez value t dans la zone de recherche

3. Sélectionnez I'extension Value Tool, appuyez sur Installer I'extension et ensuite Fermer la fenétre.
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Plugins | All (539) .

& All A value t &«
Value Tool qk

F ] Installed

bl Qgis plugin to display in table or plot values from raster layers

(or mesh layers, from version 3.0.5) at the current mouse

%% Install from ZIP o
position

.ﬁ SEEEGE Qgis plugin to display in table or plot values from raster layers (or mesh layers, from
version 3.0.5) at the current mouse position

If this plugin is useful for you, please consider to make a donation of any value to the
Maintainer

WIWWWW 84 rating vote(s), 136917 downloads

Tags raster, mesh
More info homepage bug tracker code repository
Author Jorge Almerio (maintainer)

Available version 3.0.6
Install Plugin
@Hel ¥ Close
P C

Le nouveau panneau Value Tool apparaitra.

Astuce: Si vous fermez le panneau, vous pouvez le rouvrir en l'activant dans la section Vue » Panneaux »
Value Tool ou en cliquant sur I'icone dans la barre d’outils.

4. Pour utiliser le plugin, il suffit de cocher la case Activer et de s’assurer que la couche srtm_41_19 est active
(cochée) dans le panneau Couches.

5. Déplacez le curseur sur la carte pour voir la valeur des pixels.

Layers @@
o [l ® T &, -BF & L

HEEEEEEN

== srtm 41 19

Browser Layers
Value Tool [E5]
v| Enable

Table | Graph = Options

Decimals |2 |%

Layer Value
1/srtm_41.19  76.0

Coordinate: (997960.378142, 6216696.900344)
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6. Maisilyaplus. Le plugin Value Tool vous permet d’interroger toutes les couches raster actives dans le panneau
couches. Activez a nouveau les couches aspect et pente et passez la souris sur la carte :

Layers [E]ES]
o [ @ T £ g
b v B slope
b |V ¥ aspect
3 -
b -
3 :.'
3 -
"
3 -
2 -
bV B srtm_41_19

Browser Layers
Value Tool B®E
v Enable

Table | Graph = Options

Decimals |2 |3

Layer Value
1 slope 56.08386993...
2 aspect 173.8803253...

3/stm_41_19  328.0

Coordinate: (1001434.695838, 6227891.924031)

7.3.12 In Conclusion

Vous avez vu comment dériver toutes sortes de produits d’analyse a partir d'un DEM. 11 s’agit notamment des calculs
de la hauteur, de la pente et de I'aspect. Vous avez également vu comment utiliser la calculatrice matricielle pour
analyser et combiner ces résultats. Enfin, vous avez appris comment reclasser une couche et comment interroger les
résultats.

7.3.13 What’s Next?

Maintenant que vous avez deux analyse : I'analyse vectorielle qui vous montre les parcelles susceptibles de convenir,
et 'analyse raster qui vont montre le terrain susceptibles de convenir. Comment peut-on les combiner pour arriver a
un résultat final pour ce probleme ? Cest le sujet de la prochaine lecon, qui commence dans le module suivant.
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Module: Compléter I'analyse

Vous avez maintenant deux moitiés de I'analyse: une partie vecteur et une partie raster. Dans ce module, vous verrez
comment combiner les deux. Vous conclurez I'analyse et présenterez les résultats définitifs.

8.1 Lesson: Conversion Raster vers Vecteur

La conversion entre les formats raster et vecteur vous permet d’utiliser des données raster et vectorielles lors de la
résolution d’un probleme de SIG, aussi bien que I'utilisation des différentes méthodes d’analyse propres a ces deux
formes de données géographiques. Cela augmente la flexibilité que vous avez lors de I'examen des sources de données
et méthodes de traitement pour résoudre un probleme de SIG.

Pour combiner une analyse raster et vectorielle, vous devez convertir un type de données a 'autre. Convertissons le
résultat raster de la précédente lecon en un vecteur.

Objectif de cette lecon : Obtenir le résultat rater dans un vecteur qui peut étre utilisé pour compléter I'analyse.

8.1.1 Follow Along: L’outil Polygoniser
Débutez avec la carte du dernier module, raster_analysis.qgs. Ici, vous devriez avoir le
all_conditions_simple.tif calculé durant les derniers exercices.

* Cliquez sur Raster » Conversion » Polygoniser (Raster a Vecteur). La boite de dialogue de I'outil apparaitra.

 Configurez-la comme ceci :
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Polygonize (Raster to Vector) X

Parameters | Log
Input layer
# all_conditions_simple [EPSG:32733] -
Band number
Band 1 (Gray) -
Name of the field to create
suitable
Use 8-connectedness

v Advanced parameters

Additional command-line parameters [optional]

Vectorized
ease_3.10/exercise_data/residential_development/all_terrain.shp
v! Open output file after running algorithm

GDAL/OGR console call

gdal_polygonize.py /home/hari/Desktop/QGIS-Training-Data- =
release_3.10/exercise_data/raster_analysis/all_conditions_simple.tif
/home/hari/Desktop/QGIS-Training-Data-release_3.10/
exercise_data/residential_development/all_terrain.shp -b 1 -f "ESRI

Shapefile" all terrain suitable -
0%
[ElHelp Run as Batch Process... # Close #Run

* Changez le nom du champ (décrivant les valeurs du raster) en suitable.

* Enregistrez la couche sous exercise_data/residential_development sous all_terrain.
shp.

Vous avez maintenant un fichier vecteur qui contient toutes les valeurs raster, mais les seules zones qui vous intéressent

sont celles qui sont appropriées ; c’est-a-dire les polygones ol la valeur de suitable est « 1 ». Vous pouvez changer le
style de cette couche si vous voulez en avoir une visualisation plus claire.

8.1.2 Try Yourself

Reportez-vous au module sur I'analyse vectorielle.
* Créez un nouveau fichier vecteur qui ne contient que les polygones ou suitable a la valeur de 1.

* Enregistrez le nouveau fichier sous exercise_data/residential_development/ sous
suitable_terrain.shp.

Réponse

1. Ouvrez le Constructeur de requétes en faisant un clic droit sur la couche all_terrain dans le panneau Couches
puis en sélectionnant 'onglet Propriétés » Source.

2. Construisez ensuite la requéte "suitable" = 1.
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3. Cliquez sur OK pour valider et enlever tous les polygones qui ne remplissent pas cette condition. Lorsque
visualisés par-dessus le raster, on constatera que les périmetres se superposent parfaitement :

Polygonize (Raster to Vector) X

Parameters | Log
Input layer
" all_conditions_simple [EPSG:32733] -
Band number
Band 1 (Gray) v
Name of the field to create
suitable
Use 8-connectedness

v Advanced parameters

Additional command-line parameters [optional]

Vectorized
ease_3.10/exercise_data/residential_development/all_terrain.shp
v! Open output file after running algorithm

GDAL/OGR console call

gdal_polygonize.py /home/hari/Desktop/QGIS-Training-Data- =
release_3.10/exercise_data/raster_analysis/all_conditions_simple.tif
/home/hari/Desktop/QGIS-Training-Data-release _3.10/
exercise_data/residential_development/all_terrain.shp -b 1 -f "ESRI
Shapefile" all_terrain suitable -

| 0%
[BHelp Run as Batch Process... # Close #Run

4. Vous pouvez sauvegarder cette couche en faisant un clic droit sur la couche all_terrain dans le panneau Couches
et sélectionnant Enregistrer sous..., puis suivez les instructions.

8.1.3 Follow Along: L’outil Rastériser
Bien qu’inutile pour notre probléme actuel, il est utile de connaitre la conversion inverse de celle effectuée ci-dessus.
Convertissez en raster le fichier vecteur suitable_terrain.shp que vous venez de créer a I'étape précédente.

* Cliquez sur Raster » Conversion » Rastériser (Vecteur a Raster) pour démarrer cet outil, puis configurez-le
comme dans la capture d’écran ci-dessous :
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Rasterize (Vector to Raster) x

Parameters | Log
Input layer
all_terrain [EPSG:32733] || .- |[|®

Field to use for a burn-in value [optional]

123 SUITABLE -
A fixed value to burn [optional]
0.000000 =

Output raster size units
Pixels -

Width/Horizontal resolution

837.000000 =
Height/Vertical resolution
616.000000 -

Output extent (xmin, xmax, ymin, ymax)
54,1037709.8059691756,6196099.3408,6250051.015321028 [EPSG:32733]
Assign a specified nodata value to output bands [optional]

0.000000 =

v Advanced parameters

Additional creation options [optional]

Profile | Default -
Name Value
0%
& Help Run as Batch Process... # Close #Run

* la Couche d’entrée est all_terrain.

* Le nom du champ est suitable.

o L”Unité de la taille du raster en sortie est Pixels.

* largeur et hauteur sont respectivement 837 et 661

* Récupérez 1I”Emprise de la sortie a partir de la couche all_terrain.

e Enregistrez le fichier de sortie Rasterisé sous exercise_data/residential_development/
raster_conversion.tif.

Note: La taille de I'image de sortie est spécifiée ici pour étre la méme que dans le raster d’origine qui a été vectorisé.
Pour voir les dimensions d’'une image, ouvrez ses métadonnées (onglet Métadonnées dans les Propriétés de la couche).

* Cliquez sur OK dans la boite de dialogue pour commencer le processus de conversion.

* Quand le processus est terminé, jugez son résultat en comparant le nouveau raster avec le raster original. IIs
devraient correspondre parfaitement, pixel sur pixel.
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8.1.4 In Conclusion

La conversion entre les formats raster et vecteur vous permet d’accroitre 'applicabilité des données, et ne doit pas
conduire a la dégradation des données.

8.1.5 What’s Next?

Maintenant que nous avons les résultats de I'analyse de terrain disponible dans un format vectoriel, ils peuvent
étre utilisés pour résoudre le probleme de quels batiments nous devons prendre en compte pour le développement
résidentiel.

8.2 Lesson: Combiner les analyses

Utiliser les résultats vectorisés de I'analyse raster vous permettra de sélectionner seulement ces batiments sur un terrain
approprié.

Objectif de cette lecon : Ultiliser les résultats de la vectorisation du terrain pour sélectionner des parcelles
appropriées.

8.2.1 Try Yourself

1. Enregistrez votre carte actuelle (raster_analysis.qggs).

2. Ouvrez la carte que vous avez créée lors de I'analyse vecteur précédente (vous devriez avoir enregistré le fichier
sous le nom analysis.qggs).

3. Dans le panneau: guilabel: Calgues, activez ces calques:
e ombrage,
e solution (ou buildings_over_100)

4. En plus de ces couches, qui devraient déja étre chargées dans la carte lorsque vous avez travaillé dessus
auparavant, ajoutez également I'ensemble de données suitable_terrain.shp.

5. Sl vous manque certaines couches, vous devriez les trouver dans exercise_data/
residential_development/

6. Utilisez loutil Intersection (Vecteur » Outils géoprocessing) pour créer une nouvelle couche vecteur appelée
new_solution. shp qui contient uniquement les batiments qui croisent la couche suitable_terrain.

Vous devriez maintenant avoir une couche qui montre certains batiments comme votre solution, par exemple :
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QGIS_ - analysis
Wy B & B E =0 3

2 5 B W

2

m Browser |

|| Coordinate: 448589,6235620 Scale [1:7,937  |+) || @ Render EPSG:32734 (@) y

8.2.2 Try Yourself Contréler les résultats

Regardez chacun des batiments de votre couche new_solution. Comparez-les avec la couche suitable_terrain en
changeant la symbologie pour la couche new_solution afin qu'elle n’ait que des bordures. Que remarquez-vous a
propos de certains de ces batiments ? Sont-ils tous appropriés juste parce qu’ils croisent la couche suitable_terrain ?
Pourquoi ou pourquoi pas ? Lesquels allez-vous estimer comme non appropriés ?

Réponse

You may notice that some of the buildings in your new_solution layer have been « sliced » by the Intersection
tool. This shows that only part of the building - and therefore only part of the property - lies on suitable terrain. We
can therefore sensibly eliminate those buildings from our dataset.

8.2.3 Try Yourself Affiner I'analyse

Vous pouvez voir dans les résultats que certains batiments qui ont été inclus ne sont pas vraiment appropriés, nous
pouvons donc affiner I'analyse.

Nous voulons nous assurer que notre analyse ne renvoie que les batiments qui se situent entierement dans la couche
suitable_terrain. Comment y parviendrez-vous ? Utilisez un ou plusieurs outils d’analyse vecteur et souvenez-vous
que nos batiments ont tous une superficie supérieure a 100 metres carrés.

Réponse

A Theure actuelle, votre analyse devrait ressembler a ceci :
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0006 QGIS - analysis.
DEBRBOR ODPLAAPLALR & G N bE BEE &0 52 0, BYW
#./BRB/&uxp B SR8 DS B
00 Layers
v & 0 new_solution
> E.'f roads_34s
@[> O o budings.over.100
» @ O suitable_terrain_34s
’ » @ O residential_345
» @ O restaurants_34s
n » & 9 schools_345.
@
@
@
%
Lo
Cd

Browser

448589,6235620 Scale [1:7.937 I+ (] & Render £75G:32734 (@) )

Considérez une zone circulaire, continue sur 100 metres dans toutes les directions.

Si elle est supérieure a 100 metres de rayon, alors soustraire 100 metres de sa taille (de toutes les directions) laissera
une partie au milieu.
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Therefore, you can run an interior buffer of 100 meters on your existing suitable_terrain vector layer. In the output
of the buffer function, whatever remains of the original layer will represent areas where there is suitable terrain for
100 meters beyond.

Pour démontrer :
1. Go to Vector » Geoprocessing Tools » Buffer(s) to open the Buffer(s) dialog.

2. Définissez-le comme ceci:
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8.0.8 Buffer(s)

Input vector layer

'
SN

[ suitable_terrain_345

| | Use only selected features

Segments to approximate |10 |v)

(=) Buffer distance -100
() Buffer distance field
suitable :

[EI Dissolve buffer results

Output shapefile

suitable_terrain_continuous_100m.shp | Browse

[Ef.ﬂ.dd result to canvas

'_ || Close | [ OK |

3. Use the suitable_terrain layer with 10 segments and a buffer distance of —100. (The distance is automatically
in meters because your map is using a projected CRS.)

4. Save the output in exercise_data/residential_development/ as
suitable_terrain_continuous100m. shp.

5. If necessary, move the new layer above your original suitable_terrain layer.

Your results will look like something like this:
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QGIS - analysis
BEOR 0SPLARAPLALRE & & e BE = 32 O BY
BRB|A Lep B v B

Y YY I LY.L

T srowser
Scale (17,037 |+ & (/Render EPSG:32734 @) y

6. Now use the Select by Location tool (Vector » Research Tools » Select by location).
7. Set up like this:

0 6 Select by location

e TR Ry P S A e PR Ny e mm

Select features in:

4k

[ new_solution

that intersect features in:

4 W
—

[ suitable_terrain_continuous_100m

|| Use selected features only

Modify current selection by:

4k

[ creating new selection

™ Add result to canvas

[ | [ Close ] H

8. Select features in new_solution that intersect features in suitable_terrain_continuous100m.shp.

This is the result:
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QGIS - analysis
BELR OBRA BPL AL & & Bt BE =D 50 o BR
Y P EE R )
Layers.

= (7
& @

9 new_solution

/" roads_3as

vyvvy «4vv <O

LRRR_ROQ Q@

H5BBINARS N

e

L

Browser . /
102 feature(s) selected on layer new_solution. ¥ Coordinate: 450222,6235267 Scale (17,937 |+ & ¥ Render EPSG:32734 @

4

The yellow buildings are selected.  Although some of the buildings fall partly outside the new
suitable_terrain_continuous100m layer, they lie well within the original suitable_terrain layer and therefore
meet all of our requirements.

9. Enregistrez le nouveau fichier dans le dossier exercise_data/residential_development/ sous
lenom final_answer.shp.

8.2.4 In Conclusion

Vous avez maintenant répondu a la question originale de recherche, et pouvez donner une opinion (avec raisons,
soutenu par I'analyse) pour une recommandation concernant la propriété a développer.

8.2.5 What’s Next?

Vous présenterez ensuite ces résultats dans le cadre de votre deuxieme travail.

8.3 Mission

A Taide de la mise en page d’impression, créez une nouvelle carte représentant les résultats de votre analyse. Inclure
ces couches:

* places (avec étiquettes)

e ombrage,

e solution (ou nouvelle_solution),
* roads et

* au choix photos_aeriennes ou MNE.
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Rédigez un court paragraphe en guise d’accompagnement. Incluez dans ce texte les criteres qui ont été utilisés
dans la considération d’une maison pour I'achat et le développement ultérieur, aussi bien que I'explication de vos
recommandations pour lesquelles les batiments sont appropriées.

8.4 Lesson: Exercice Supplémentaire

Dans cette lecon, vous serez guidé a travers une analyse complete de SIG dans QGIS.

Note: Lecon €laborée par Linfiniti Consulting (Afrique du Sud) et Siddique Motala (Université de technologie de
la péninsule du Cap)

8.4.1 Enoncé du probléme

Vous étes mandaté pour trouver les aires de la Péninsule du Cap et alentours adaptées a I'accueil d’especes rares
de plante « fynbos ». L’étendue de votre aire d’investigation couvre Cape Town et la péninsule du Cap entre
Melkbosstrand au nord et Strand au sud. Les botanistes vous ont fourni les caractéristiques suivantes adaptées aux
especes en question:

* elle se développe sur les pentes orientées a I'est

* elle se développe sur des pentes d’inclinaison comprises entre 15% et 60%

* elle se développe sur des surfaces qui enregistrent un cumul annuel de pluies >1000mm
* elle devra se situer a au moins 250m de tout aménagement humain

¢ la zone de végétation dans laquelle elle se situera, doit étre d’au moins 6000 m?

En tant qu’étudiant a 'université, vous avez accepté de rechercher la plante dans quatre zones différentes de terrain
approprié. Vous voulez que ces quatre zones soient les plus proches de 'université du Cap ou vous vivez. Utilisez vos
compétences en SIG pour déterminer ol vous devez aller pour chercher.

8.4.2 Apercu de la solution

Les données de cet exercice se trouvent dans le dossier :file’exercise_data/more_analysis".

Vous devez trouver les quatre sites adaptés le plus proche de I'Université de Cape Town.

La solution impliquera :
1. Analyzing a DEM raster layer to find the east facing slopes and the slopes with the correct gradients
2. Analyzing a rainfall raster layer to find the areas with the correct amount of rainfall

3. Analyzing a zoning vector layer to find areas that are away from human settlement and are of the correct size
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8.4.3 Follow Along: Mise en place de la carte

&

1. Cliquez sur le bouton = CRS courant gang Je coin inférieur droit de I'écran. Sous 'onglet CRS du dialogue qui
apparatt, utilisez l'outil « Filtre » pour rechercher « 33S ». Sélectionnez 'entrée WGS 84 / UTM zone 33S (avec
le code EPSG 32733).

2. Cliquez sur OK

() Project Properties — CRS X
Q, | Project Coordinate Reference System {CRS)

Mo CRS {or unknown/non-Earth projection)

_ Fitter | ©L 33s
a WEETAE Recently Used Coordinate Reference Systems
\ etings Coordinate Reference System Authority 1D
WGES 8/ UTM zone 335 EP5G:32733
Transformations
Styles
q 3
Data Sources Predefined Coordinate Reference Systems Hide deprecated CRSs
Relations Coordinate Reference System Authority ID =
Schwarzeck / UTM zone 335 EP5G:29333
AATbE WGS 72/ UTM zone 335 EP5G:32333
WGS 72BE / UTM zone 335 EP5G:32533

'TM zone 335 EP5G:32733

1 2

Macros

QGIS Server WG&S 84 | UTM zone 335 = + ?_‘f\'
ST
Properties v
¢ Temporal
* Units: meters -
_ * Dynamic (relies on a datum which is not plate- s ~

Terrain fixed) I = |

- e an L T b g = J—

| oK Cancel Apply Help

Figure8.1: Setting up the CRS

=] .
3. Save the project file by clicking on the Save Project toolbar button, or use the Project » Save As... menu item.

Enregistrez-le dans un nouveau répertoire appelé Rasterprac, que vous devez créer quelque part sur votre
ordinateur. Vous enregistrerez également les couches que vous aurez créées dans ce répertoire. Enregistrez le
projet sous le nom votre_nom_fynbos.ggs.
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8.4.4 Chargement de données dans la carte

Afin de traiter les données, vous devrez charger les couches nécessaires (noms des rues, zones, précipitations, MNE,
quartiers) dans le canevas de la carte.

Pour les données vectorielles...

10.
11.

12.

. Cliquez sur le bouton | dataSourceManager | Ovvrirle gestionnaire de sources de données - qang 1a harre d'outils du

gestionnaire de sources de données, et activez 'onglet " @ Vecteur dans la boite de dialogue qui apparait, ou

utilisez Layer -> Add Layer -> ‘v; Ajouter un calque vectoriel ...

Assurez-vous que ® ' Fichier est sélectionné
Cliquez sur le bouton ... pour rechercher le(s) jeu(x) de données vecteur

Dans la boite de dialogue qui apparait, ouvrez le répertoire exercise_data/more_analysis/
Streets.

Sélectionnez le fichier St reet_Names_UTM33S.shp
Cliquer sur Quvrir.

Le dialogue se ferme et affiche le dialogue original, avec le chemin d’acces au fichier spécifié dans le champ de
texte a c6té de jeu de donnees Vecteur. Cela vous permet de vous assurer que le bon fichier est sélectionné. 11
est également possible de saisir manuellement le chemin d’acces au fichier dans ce champ, si vous le souhaitez.

Cliquez sur gjouter. La couche vecteur sera chargée dans votre carte. Sa couleur est automatiquement assignée.
Vous la changerez plus tard.

Renommez la couche en St reets.

1. Faites un clic droit dessus dans le panneau couches (par défaut, le panneau situé sur le co6té gauche de
I’écran)

2. Cliquez sur renommer dans le dialogue qui apparait et renommez-le, en appuyant sur la touche entrer
lorsque vous avez terminé

Répétez le processus dajout de vecteurs, mais cette fois, sélectionnez le fichier
Generalised_Zoning_Dissolve_UTM33S. shp dans le répertoire Zoning.

Renommez-le en Zoning.

Chargez également la couche vecteur admin_boundaries/Western_Cape_UTM33S. shp dans votre
carte.

Renommez-laen districts.

Pour les raster...

. Cliquez sur le bouton ‘! ouvrir gestionnaire source donnees e activez I'onglet FD Raster dans le dialogue qui apparait,

ou utilisez I'’élément de menu couche » ajouter couche » FD ajouter couche raster....

Assurez-vous que ® ' Fichier est sélectionné
Naviguez vers le fichier approprié, sélectionnez-le et cliquez sur Quvrir.

Faites-le pour chacun des deux fichiers raster suivants, DEM/SRTM.tif et rainfall/reprojected/
rainfall.tif.

. Renommez la grille SRTM en DEM et la grille des précipitations en Rainfall (avec une majuscule initiale)
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8.4.5 Changement de I'ordre des couches

Cliquez et faites glisser les couches de haut en bas dans le panneau couches pour modifier 'ordre dans lequel elles
apparaissent sur la carte afin que vous puissiez voir autant de couches que possible.

Maintenant que toutes les données sont chargées et correctement visibles, I'analyse peut commencer. Il est préférable
que I'opération de découpage soit effectuée en premier. De cette fagon, aucune puissance de traitement n’est gaspillée

pour calculer des valeurs dans des domaines qui ne seront pas utilisés de toute facon.

8.4.6 Trouver les bons districts

En raison du domaine d’investigation susmentionné, nous devons limiter nos districts aux suivants :
e Bellville
¢ Cape
¢ Goodwood
e Kuils River
e Mitchells Plain
* Simon Town
* Wynberg

1. Cliquez avec le bouton droit de la souris sur la couche Districts dans le panneau Couches.

2. Dans le menu qui apparait, sélectionnez I'’élément de menu Filtrer.... La boite de dialogue Constructeur de

requétes apparait.

Vous allez maintenant construire une requéte pour sélectionner uniquement les districts candidats :

1.

Dans la liste des champs, double-cliquez sur le champ NAME_ 2 pour le faire apparaitre dans le champ

de texte SOQL where clause ci-dessous
2. Cliquez sur le bouton IN pour I'ajouter a la requéte SQL
3. Ouvrez les parentheses

4. Cliquez sur le bouton fous sous la liste (actuellement vide) valeurs.

Apres un court délai, cela remplira la liste valeurs avec les valeurs du champ sélectionné (NAME_ 2).

Ajoutez une virgule et double-cliquez pour ajouter le district Cape

Répétez I'étape précédente pour les autres districts

® =N W

Fermer les parentheses

Figure8.2: Query builder

La derniere requéte doit étre (I'ordre des districts entre parentheses n’a pas d’importance): :

"NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',
'Mitchells Plain', 'Simon Town', 'Wynberg')

Double-cliquez sur la valeur Be11ville dans la liste valeurs pour 'ajouter a la requéte SQL.

Note: Vous pouvez également utiliser I'opérateur OR ; la requéte ressemblerait a ceci: :

"NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR

"NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
"NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
"NAME_2" = 'Wynberg'
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1. Cliquez deux fois sur OK.

Les districts indiqués sur votre carte sont désormais limités a ceux de la liste ci-dessus.

8.4.7 Couper les rasters

Maintenant que vous avez une aire d’intérét, vous pouvez couper les rasters de cette aire.

1.

Ouvrez le dialogue de découpage en sélectionnant I'élément de menu Raster » Extraction » découper le raster
a partir d’'une couche de masque...

2. Dans la liste déroulante couche entree, sélectionnez la couche DEM.
3. Dans la liste déroulante couche masque, sélectionnez la couche Districts.
4. Faites défiler vers le bas et spécifiez un emplacement de sortie dans le champ de texte découpé (masque) en
cliquant sur le bouton ... et en choisissant sauvegarder sous un fichier...
1. Naviguez vers le répertoire Rasterprac.
2. Entrez un nom de fichier - DEM_clipped.tif
3. Sauvegarder
5. Assurez-vous que la case Cif ouvrir le fichier en sortie aprés exécution de l'algorithme est cochée
6. Cliquez sur Exécuter
Une fois 'opération de découpage terminée, laissez la boite de dialogue découper le raster a partir d’une couche
masque ouverte, afin de pouvoir réutiliser la zone de découpage
7. Sélectionnez la couche raster Rainfall dans la liste déroulante Couche d’entrée et enregistrez votre sortie
sous lenom Rainfall_clipped.tif.
8. Ne modifiez pas les autres options. Laissez tout comme avant et cliquez sur executer.
9. Une fois la deuxieéme opération de découpage terminée, vous pouvez fermer la boite de dialogue decouper le
raster a partir d une couche masque
10. Sauvegardez la carte
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Figure8.3: Map view with filtered vector, clipped raster and reordered layers

Aligner les raster

Pour notre analyse, nous avons besoin que les rasters aient le méme CRS et qu’ils soient alignés.
Nous commencons par modifier la résolution de nos données pluviométriques a 30 metres (taille du pixel) :

1. Inthe Layers panel, ensure that Rainfall_clipped is the active layer (i.e., it is highlighted by having been
clicked on)

Click on the Raster » Projections » Warp (Reproject)... menu item to open the Warp (Reproject) dialog
Under Resampling method to use, select Bilinear (2x2 kernel) from the drop down menu

Set Output file resolution in target georeferenced units to 30

wok »e

Scroll down to Reprojected and save the output in your rainfall/reprojected directory as
Rainfall30.tif.

6. Assurez-vous que la case Cif ouvrir le fichier en sortie aprés exécution de l'algorithme est cochée

Figure8.4: Wrap (Reproject) Rainfall_clipped

Ensuite, nous alignons le DEM :

1. Inthe Layers panel, ensure that DEM_ c11ipped is the active layer (i.e., it is highlighted by having been clicked
on)

2. Click on the Raster » Projections » Warp (Reproject)... menu item to open the Warp (Reproject) dialog
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A

8.

Under Target CRS, select Project CRS: EPSG:32733 - WGS 84 / UTM zone 33S from the drop down menu
Under Resampling method to use, select Bilinear (2x2 kernel) from the drop down menu
Set Output file resolution in target georeferenced units to 30

Scroll down to Georeferenced extents of output file to be created. Use the button to the right of the text box to
select Calculate from Layer » Rainfall30.

Scroll down to Reprojected and save the output in your DEM/ reprojected directory as DEM30.tif.

Assurez-vous que la case g ouvrir le fichier en sortie aprés exécution de l'algorithme est cochée

Afin de bien voir ce qu’il se passe, la symbologie des couches doit étre changée.

8.4.8 Changement de la symbologie des couches vectorielles

1.

Dans le panneau Couches, faites un clic droit sur la couche Streets.

. Sélectionnez Propriétés dans le menu qui apparait
. Passez a I'onglet Symbologie dans la boite de dialogue qui apparait

2
3
4,
5
6

Click on the Line entry in the top widget

. Sélectionnez un symbole dans la liste ci-dessous ou fixez-en un nouveau (couleur, transparence, ...)

. Cliquez sur OK pour fermer la boite de dialogue Propriétés couche. Cela va changer le rendu de la couche

Streets.

Suivez un processus similaire pour la couche Zoning et choisissez une couleur appropriée pour celle-ci

8.4.9 Changement de la symbologie des couches raster

La symbologie des couches raster est quelque peu différente.

1.

® N kW

Ouvrez le dialogue Propriétés pour la couche raster Rainfall30

Passez a 'onglet Symbologie. Vous remarquerez que ce dialogue est tres différent de la version utilisée pour les
couches vectorielles.

Développer Paramétres des valeurs min/max

Assurez-vous que le bouton moyenne +/- écart-type est selectionne

Assurez-vous que la valeur dans la case associée est 2. 00.

Pour amelioration du contraste, assurez-vous qu'’il est écrit etirer jusqu'au MinMax.
Pour Color gradient, changez-le en White to Black.

Cliquez sur OK

|
Figure8.5: Raster symbology

Leraster Rainfall30,siil est visible, doit changer de couleur, ce qui vous permet de voir différentes valeurs
de luminosité pour chaque pixel

Répétez ce processus pour la couche DEM30, mais fixez les écarts types utilisés pour I'étirement a 4, 00.
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8.4.10 Nettoyer la carte.

1. Supprimez les couches originales Rainfall et DEM, ainsi que Rainfall_clippedet DEM_clipped
du panneau couches :

« Faites un clic-droit sur ces couches et sélectionnez Supprimer.

Note: Cela ne va pas supprimer les données de votre périphérique de stockage, cela va seulement I'Gter
de votre carte.

2. Sauvegardez la carte

3. Vous pouvez maintenant cacher les couches vecteur en décochant la case a coté d’elles dans le panneau couches.
Cela accélérera le rendu de la carte et vous fera gagner du temps.

8.4.11 Créer 'ombrage

Afin de créer 'ombrage, vous devrez utiliser un algorithme créé dans ce but.

1. Dans le panneau couches, assurez-vous que DEM30 est la couche active (c’est-a-dire qu’elle est mise en évidence
en ayant été cliquée)

2. Cliquez sur le menu Raster » Analyse » Ombrage... pour ouvrir le dialogue ombrage

3. Descendez jusqua Ombrage et enregistrez la sortie dans votre répertoire Rasterprac sous le nom
hillshade.tif.

4. Assurez-vous que la case i ouvrir le fichier en sortie aprés exécution de l'algorithme est cochée
5. Cliquez sur Exécuter

6. Attendez que le processus se termine.

Figure8.6: Raster analysis Hillshade

La nouvelle couche hillshade est apparue dans le panneau Couches.

1. Faites un clic droit sur la couche hillshade dans le panneau Couches” et faites apparaitre la fenétre des
:guilabel: Proprietes

2. Cliquez sur l'onglet Transparence et réglez le curseur Opacité globale sur 20%.
3. Cliquez sur OK

4. Notez I'effet lorsque 'ombre transparente est superposée sur le MNT coupé. Vous devrez peut-&tre changer
I'ordre de vos couches, ou cliquer sur la couche Rainfall30 pour voir 'effet.

8.4.12 Pente

1. Cliquez sur le menu Raster » Analyse » Pente... pour ouvrir le dialogue de I'algorithme Pente

2. Sélectionnez DEM30 comme Couche d’entrée.

3. Check A Pente exprimée en pourcentage au lieu de degrés. La pente peut étre exprimée en différentes unités
(pourcentage ou degrés). Nos criteres suggerent que la plante d’intérét pousse sur des pentes dont la pente est
comprise entre 15 et 60 %. Nous devons donc nous assurer que nos données sur la pente sont exprimées en
pourcentage.

4. Indiquez un nom de fichier et un emplacement appropriés pour votre sortie.
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5. Assurez-vous que la case g ouvrir le fichier en sortie aprés exécution de l'algorithme est cochée

6. Cliquez sur Exécuter

Figure8.7: Raster analysis Slope

L’image de la pente a été calculée et ajoutée a la carte. Comme d’habitude, elle est rendue en niveaux de gris. Changez
la symbologie pour une symbologie plus colorée :

1. Ouvrez la couche Dialogue des propriétés (comme d’habitude, via le menu contextuel de la couche)
2. Cliquez sur I'onglet Symbologie

3. La ou il est écrit Bande grise unique (dans le menu déroulant T'ype de rendu), changez-le en Pseudo-couleur a
bande unique.

4. Choisissez moyenne +/- écart-type x pour parametre valeur Min / Max * avec une valeur de “2.0".
5. Sélectionnez une rampe de couleurs appropriée

6. Cliquez sur Exécuter

8.4.13 Try Yourself Aspect

Utilisez la mé&me approche que pour le calcul de la pente, en choisissant Aspect... dans le menu Raster » analyse.

N’oubliez pas de sauvegarder le projet régulicrement.

8.4.14 Reclassement des rasters

1. Choisissez Raster » calculatrice raster...

2. Indiquez votre répertoire Rasterprac comme emplacement pour la couche Output (cliquez sur le bouton
...), et enregistrez-le sous le nom slopel5_60.tif.

3. Assurez-vous que la case ouvrir le fichier sortie apreés exécution de l'algorithme est sélectionnée.

Dans la liste bandes raster sur la gauche, vous verrez toutes les couches raster dans votre panneau couches.
Si votre couche Pente est appelée slope, elle sera répertoriée comme pente@1. Indication de la bande 1 du
raster de pente.

4. La pente doit étre comprise entre 15 et 60 degrés.

En utilisant les éléments de la liste et les boutons de I'interface, construisez I'expression suivante: :

[(slope@l > 15) AND (slope@l < 60)

5. Configurez le champ Couche de sortie avec un emplacement approprié et un nom de fichier.

6. Cliquez sur Exécuter.

Figure8.8: Raster calculator Slope

Trouvez maintenant I'aspect correct (face est : entre 45 et 135 degrés) en utilisant la méme approche.

1. Construisez 'expression suivante: :
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[(aspect@l > 45) AND (aspect@l < 135) }

Vous saurez que cela a fonctionné lorsque toutes les pentes orientées vers I’est seront blanches dans le raster résulta t
(c’est presque comme si elles étaient éclairées par le soleil du matin).

Trouvez de la méme maniére la bonne pluviométrie (supérieure a 1000 mm). Utilisez I'expression suivante: :

[RainfallSO@l > 1000 }

Maintenant que vous disposez de ces trois criteres, chacun dans une grille distincte, vous devez les combiner pour voir
quelles zones répondent a tous les criteres. Pour ce faire, les rasters seront multipliés les uns par rapport aux autres.
Dans ce cas, tous les pixels qui se chevauchent et qui ont une valeur de 1 conserveront la valeur de 1 (c’est-a-dire
que 'emplacement répond aux criteres), mais si un pixel de I'un des trois rasters a une valeur de 0 (c’est-a-dire que
I'emplacement ne répond pas aux critéres), alors il aura une valeur de 0 dans le résultat. De cette facon, le résultat ne
contiendra que les zones de chevauchement qui répondent a tous les critéres appropriés.

8.4.15 Combiner des rasters

1. Ouvrez la Calculatrice raster (Raster » calculatrice raster...)

2. Construisez 'expression suivante (avec les noms appropriés pour vos couches): :

[[aspect45_135] * [slopel5_60] * [rainfall_1000] }

3. Définissez 'emplacement de sortie dans le répertoire Rasterprac.

4. Nommez le raster en sortie : file:aspect_slope_rainfall.tif.

5. Assurez-vous que la case g ouvrir le fichier aprés exécution de l'algorithme est cochée
6. Cliquez sur Exécuter
Le nouveau raster affiche désormais correctement les zones ou les trois critéres sont satisfaits.

Sauvegardez le projet.

N

Figure8.9: Map view where all three criteria are satisfied

Le prochain critere a remplir est que la zone doit étre éloignée de 250 metres des zones urbaines. Nous satisferons a
cette exigence en nous assurant que les zones que nous calculons se trouvent a I'intérieur de zones rurales et qu'elles
sont a 250 metres ou plus de la limite de la zone. C’est pourquoi nous devons d’abord trouver toutes les zones rurales.

8.4.16 Trouver les zones rurales

1. Cacher toutes les couches dans le panneau couche
2. Masquer la couche vecteur zoning

3. Faites un clic droit dessus et faites apparaitre la boite de dialogue table attribut. Notez les nombreuses facons
différentes dont la terre est zonée ici. Nous voulons isoler les zones rurales. Fermez la table des attributs.

4. Faites un clic droit sur la couche Zoning et sélectionnez filtrer... pour faire apparaitre le dialogue constructeur
de requetes

5. Construisez la requéte suivante: :

["Geanoning" = 'Rural' }
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6.

Si vous étes bloqué, consultez les instructions précédentes.

Cliquez sur OK pour fermer la fenétre du Constructeur de requétes. La requéte devrait retourner une entité.

Query builder Zoning

Vous devriez voir les polygones ruraux de la couche zoning. Vous devrez les sauvegarder.

1.

5.

Dans le menu du clic droit pour Zoning, sélectionnez Exporter » Sauvegarder les entités sous....

. Enregistrez votre couche dans le répertoire Rasterprac.

2
3.
4

Nommez le fichier de sortie : file:rural.shp.

. Cliquez sur OK

Sauvegarder le projet

11 faut maintenant exclure les zones qui se trouvent dans un rayon de 250m de la limite des zones rurales. Pour ce
faire, il faut créer une zone tampon négative, comme expliqué ci-dessous.

8.4.17 Création d’'un tampon négatif

10.

. Cliquez sur I'élément de menu vecteur » outils de geoprocessing » tampon...

Dans le dialogue qui apparait, sélectionnez la couche rural comme couche vectorielle d’entrée (:guilabel :
sélectionner les entités seulement ne doit pas étre coché)

Réglez Distance a —250. La valeur négative signifie que le tampon sera un tampon intérieur. Assurez-vous
que les unités sont des metres dans le menu déroulant.

Check Cif Dissoudre le résultat.

Dans Buffered, placez le fichier de sortie dans le répertoire Rasterprac, et nommez-le rural_buffer.
shp.

Cliquez sur sauver.
Cliquez sur executer et attendez que le traitement soit terminé
Fermez la boite de dialogue Tampon.

Assurez-vous que votre tampon a fonctionné correctement en notant en quoi la couche rural_buffer est
différente de la couche rural. Vous devrez peut-étre changer I'ordre de dessin afin d’observer la différence.

Supprimer la couche rural

Sauvegarder le projet
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Figure8.10: Map view with rural buffer

Maintenant, vous devez combiner votre couche vecteur rural buffer avec le raster
aspect_slope_rainfall. Pour les combiner, nous devrons modifier le format des données de I'une
des couches. Dans ce cas, vous vectoriserez le raster, car les couches vecteur sont plus pratiques lorsque nous voulons
calculer des surfaces.

8.4.18 Vectoriser le raster

1. Cliquez sur I'élément de menu Raster » Conversion » Polygoniser (Raster to Vector)...
Sélectionnez le raster aspect_slope_rainfall comme Couche d'entrée.

Définissez Nom du champ a créer’a “suitable’ (le nom du champ par défaut est DN - Digital number data)

T

Sauvegardez le résultat. Sous vectorisé, sélectionnez sauvegarder fichier sous. Définissez I'emplacement a
Rasterprac et nommez le fichier aspect_slope_rainfall_all.shp.

Assurez-vous que la case i ouvrir le fichier aprés exécution de l'algorithme est cochée

e

6. Cliquez sur Exécuter

7. Fermer le dialogue lorsque le traitement est terminé
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! Polygonize (Raster to Vector)

Parameters Log
Input layer
" aspect_slope_rainfall [EP5G:32733]
Band number
Band 1 (Gray)
Mame of the field to create
suitable

Use 8-connectedness

w Advanced Parameters

Additional command-ine parameters [optional]

Vectorized
D: KARTOZARasterprac/aspect_slope_rainfall_all.shp

v | Open output file after running algorithm
GDAL fOGR. console call

aspect_slope_rainfall_all.shp aspect_slope_rainfall_all suitable

0%

Advanced * | |Run as Batch Process...

gdal_polygonize.bat D: WARTOZA\Rasterpracaspect_slope_rainfall. tiff -b 1 -f "ESRI Shapefile” D: KARTOZA Rasterprac/

™
)

Run Close Help

Figure8.11: Raster to Vector

Toutes les zones raster ont été vectorisées, vous devez donc sélectionner uniquement les zones qui ont une valeur de

1 dans le champ suitable. (Nombre numérique).

1. Ouvrez le dialogue constructeur requete (clic droit - Filtre...) pour la nouvelle couche vecteur

2. Construisez cette requéte : :

["suitable" =1

3. Cliquez sur OK

4. Apres vous étre assuré que la requéte est complete (et que seules les zones qui répondent aux trois criteres, c’est-
a-dire avec une valeur de 1, sont visibles), créez un nouveau fichier vecteur a partir des résultats, en utilisant la
commande Exporter » Sauvegarder les entités sous... dans le menu contextuel de la couche

. Enregistrez le fichier dans le répertoire Rasterprac.

. Supprimez la couche aspect_slope_rainfall_all de votre carte

5
6. Nommez le fichier aspect_slope_rainfall_1.shp
7
8

. Sauvegardez votre projet

Lorsque nous utilisons un algorithme pour vectoriser raster, 'algorithme produit parfois ce que I'on appelle des
« géométries non valides », c’est-a-dire qu’il y a des polygones vides, ou des polygones comportant des erreurs,
qui seront difficiles a analyser a I'avenir. Nous devons donc utiliser l'outil « reparer géométrie ».
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8.4.19 reparer géométrie

1. Dans la la boite a outil traitement, cherchez « reparer geometries », et ['executer...
2. Pour la Couche d’entrée, sélectionnez aspect_slope_rainfall_1

3. Sous reparer geometries, sélectionnez sauveharder fichier sous, et enregistrez la sortie dans Rasterprac et
nommez le fichier fixed_aspect_slope_rainfall.shp.

4. Assurez-vous que la case g ouvrir le fichier apreés exécution de l'algorithme est cochée
5. Cliquez sur Exécuter
6. Fermer le dialogue lorsque le traitement est terminé

Maintenant que vous avez vectorisé le raster et fixé la géométrie résultante, vous pouvez combiner les criteres d’aspect,
de pente et de précipitations avec la distance par rapport aux criteres d’établissement humain en trouvant I'intersection
de la couche fixed_aspect_slope_rainfall etdelacouche rural_buffer.

8.4.20 Déterminer I'intersection des vecteurs

1. Cliquez sur I'élément de menu vecteur w» outils géoprocessing w Intersection...

Dans le dialogue qui apparait, sélectionnez la couche rural_buffer comme Couche d'entrée
Pour la couche Overlay, sélectionnez la couche fixed_aspect_slope_rainfall.

Dans Intersection, placez le fichier de sortie dans le répertoire Rasterprac.

Nommez le fichier de sortie rural_aspect_slope_rainfall.shp

Cliquez sur sauver.

Cliquez sur executer et attendez que le traitement soit terminé

® Nk w N

Fermez le dialogue Intersection.

Assurez-vous que votre intersection a fonctionné correctement en notant que seules les zones de chevauchement
subsistent.

9. Sauvegarder le projet

Le prochain critére de la liste est que la zone doit étre supérieure 2 6000 m?. Vous allez maintenant calculer les
zones de polygone afin d’identifier les zones qui ont la taille appropriée pour ce projet.

8.4.21 Calcul de l'aire pour chaque polygone

1. Ouvrez le menu contextuel de la nouvelle couche vecteur
2. Sélectionnez ouvrir la table attributs.

3 Cliquez sur le bouton v‘ basculer mode edition * dans le coin supérieur gauche de la table, ou appuyez sur :kbd: Ctrl+e

4. Cliquez sur le bouton ouvrir calculateur de champ jang 13 barre d’outils en haut de la table, ou appuyez sur Ct r1+1i.

5. Dans la boite de dialogue qui apparait, assurez-vous que la case g créer un nouveau champ est cochée, et
définissez le nom du champ en sortie & area Le type de champ de sortie doit &tre un nombre décimal (réel).
Définissez Precision a 1 (une décimale).

6. Dans la zone Expression, tapez: :

[$area
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Cela signifie que le calculateur de terrain va calculer I'aire de chaque polygone dans la couche vectorielle et va
ensuite remplir une nouvelle colonne d’entier (appelée area) avec la valeur calculée.

(Q rural_aspect_slope_rainfall — Field Calculator >

Only update 0 selected features
V| Create a new field Update existing field
Create virtual field
Output field name  |area

Qutput field type 1.2 Dedimal number (real) -

1k

Output field length | 10 + | Precsion |1

Expression Function Editor

s || mka L Se.. Show Help
feature Returns the area of the current feature. The
geometry ) R
i grea calculated by this function respects
both the current project's ellipsoid setting
row_number

and area unit settings. For example, if an
ellipsoid has been set for the project then
the calculated area will be ellipsoidal, and if
no ellipsoid is set then the calculated area
will be planimetric.

+ Aggregates
b Arrays
» Color
+ Conditionals
+ Conversions
» Date and Time
» Fields and Values
+ Files and Paths Sarea
» Fuzzy Matching
+ General
- Geometry
affine_transf...
angle_at_ver...
=+ - A ENA N | apply_dash_...
Sarea
Feature |Rural 5 [ area

®Zarea — 43

azimuth -

Preview: 25755.256042053695

OK. Cancel Help

Figure8.12: Field Calculator

7. Cliquez sur OK

8. Faites la méme chose pour un autre nouveau champ appelé id. Dans Expression de la calculatrice de champ,
tapez: :

(514 ]

Cela garantit que chaque polygone a un identifiant unique a des fins d’identification.

9. Cliquez sur # basculermode &dition 3 hoyyeay, et enregistrez vos modifications si vous y étes invité
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(o} rural_aspect_slope_rainfall — Features Total: 77, Filtered: 7... - O X

/ -~ g LT BE & _i_-' »

Gen_Zoning suitable area id S
1 [Rural 1 25755.3 0
2 |Rural 1 12405.3 1
3 |Rural 1 4452,5 2
4 | Rural 1 10782.0 3
5 |Rural 1 1797.1 4
6 |Rural 1 893.5 5
7 |Rural 1 50871.4 6
8 |Rural 1 893.6 7
9 |Rural 1 5391.3 8
10 |Rural 1 67387.2 9
11 |Rural 1 107821 10
12 |Rural 1 3594.0 1
13 |Rural 1 105537.8 12
14 |Rural 1 2723.2 13
15 |Rural 1 898.5 14

-~ Show All Features _ ¥

Figure8.13: Attribute table with area and id columns

8.4.22 Sélection des aires d’une taille donnée

Maintenant que les aires sont connues :

1. Construisez une requéte (comme d’habitude) pour sélectionner uniquement les polygones qui sont plus grands

que 6000 m?. La requéte est: :

["area" > 6000

2. Enregistrez la sélection dans le répertoire Rasterprac comme une nouvelle couche vecteur appelée

suitable_areas.shp.

Vous disposez maintenant des zones appropriées qui répondent a tous les criteres d’habitat pour la plante rare qu’est
le fynbos, parmi lesquelles vous choisirez les quatre zones les plus proches de I'Université du Cap.

8.4.23 Numériser I’'Université du Cap

. Créer une nouvelle couche vecteur dans le répertoire Rasterprac comme précédemment, mais cette fois,

utiliser Point comme type geometrie et la nommer university.shp.

. Assurez-vous qu’il se trouve dans le CRS correct (Project CRS:EPSG:32733 - WGS 84 / UTM

zone 339)

. Terminez la création de la nouvelle couche (cliquez sur OK)
. Cachez toutes les couches sauf la nouvelle couche university etla couche Streets.

. Ajouter un fond de carte (OSM) :

1. Allez dans le panneau navigateur et naviguez jusqu’a tuiles XYZ w OpenStreetMap.

2. Glissez et déposez 'entrée OpenStreetMap au bas du panneau couches

8.4.
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10.

11.
12.

13.
14.
15.

A Taide de votre navigateur Internet, recherchez I'emplacement de l'université du Cap. Compte tenu de la
topographie unique du Cap, l'université se trouve dans un endroit trés reconnaissable. Avant de retourner a
QGIS, prenez note de I'endroit ol se trouve 'université et de ce qui se trouve a proximité.

Assurez-vous que la couche St reet s a été cliquée et que la couche University est en surbrillance dans
le panneau couches

Allez dans le menu vue » barres outils et assurez-vous que numerisation est sélectionné. Vous devriez alors

voir une icdne de barre d’outils avec un crayon ( basculer mode edition) " (egt le bouton basculer mode edition.

. Cliquez sur le bouton basculer en mode édition pour entrer dans le mode edition. Cela vous permet d’éditer une

couche vecteur

o0 5
Cliquez sur le bouton ® £3 aiouterunpoint " ayi doit se trouver a proximité du bouton # basculer mode edition

Lorsque T'outil Ajouter une entité est activé, cliquez avec le bouton gauche de la souris sur votre meilleure
estimation de 'emplacement de I'université du Cap

Fournir un nombre entier arbitraire lorsqu’on demande 1 “ i d.

Cliquez sur OK

Cliquez sur le bouton B saver modif
Cliquez sur le bouton basculer en mode edition pour arréter votre session d’édition

Sauvegarder le projet

8.4.24 Trouvez les lieux les plus proches de I'Université du Cap

6.
7.

. Allez dans la Boite a outils de traitement, localisez I'algorithme Joindre les attributs par le plus proche (Outils

généraux pour les vecteurs w Joindre les attributs par le plus proche) et exécutez-le
Couche d’entrée devrait €tre university, et Couche d'entrée 2° suitable_areas.
Définir un emplacement et un nom de sortie appropriés (Joined layer)

Réglez le Maximum des plus proches voisins a 4.

Assurez-vous que la case i ouvrir le fichier aprés exécution de l'algorithme est cochée
Laissez les autres parametres avec leurs valeurs par défaut

Cliquez sur Exécuter

La couche de points qui en résultera contiendra quatre entités - elles auront toutes 'emplacement de I'université et ses
attributs, et en plus, les attributs des zones appropriées a proximité (y compris 1”1 d), et la distance a cet emplacement.

1.

Ouvrez la table d’attributs du résultat de la jointure

. Notez 1”1d des quatre zones appropriées les plus proches, puis fermez la table d’attributs

2
3.
4

Ouvrez la table d’attributs de la couche Suitable_areas

. Construire une requéte pour sélectionner les quatre zones appropriées les plus proches de I'université (en les

sélectionnant a 'aide du champ id)

C’est la réponse finale a la question de recherche.

Pour votre soumission, créez une mise en page enticrement étiquetée qui inclut la couche semi-transparente
« hillshade » sur un raster attrayant de votre choix (comme le DEM ou le raster de pente, par exemple). Incluez
également I'université et la couche suitable_areas, avec les quatre zones appropriées les plus proches de
l'université mises en évidence. Suivez toutes les bonnes pratiques en matiere de cartographie pour créer votre carte
de sortie.
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CHAPTER 9

Module: Extensions

Les extensions vous permettent d’étendre les fonctionnalités offertes par QGIS. Dans ce module, nous vous montrerons
comment activer et utiliser les extensions.

9.1 Lesson: Installation et gestions des extensions

Pour débuter I'utilisation des extensions, vous devez savoir comment les télécharger, les installer et les activer. Pour
ce faire, vous allez apprendre a utiliser le Plugin Installer et le Plugin Manager.

Le but de cette lecon : Comprendre le systeéme des extensions de QGIS.
9.1.1 Follow Along: Gestion des extensions

1. Pour ouvrir le Gestionnaire d extensions, cliquez dans le menu Extension w Installer/Gérer les extensions.

2. Dans la fenétre qui s’ouvre, trouvez I'extension Processing :
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() Plugins | All (1081) *
L processing
e - Rt “ This is a core plugin, so you can't uninstall it
E ] Installed & Mascaret |§§§.
= Maxent Model Processin
T MNot installed % Merge Selected Features (Pro g
2 MOJXML Loader - .
= MOPST Spatial data processing framework for QGIS
o LEEEE et Spatial data processing framework for QGIS
o Metworks
2 NTw2 Datum Transformations )
g OrfecToolbox provider Category Analysis
& ORS Tools More info homepage bug tracker code repository
@ PAT - Precision Agriculture Tc Author Victor Olaya

. PCRaster Tools
@ Pelias Geocoding

Installed version 2.12.99

# PostGIS geoprocessing tools
@ Potential Slope Failure for pro

Proc
@ Processing R Provider
* Erocess!ng Saga E.IextG enPre Uparade Al Uninstall Plugin Reinstall Plugin

Close Help

Cliquez dans la case a coté de ce plugin et décochez-le pour le désactiver.
Cliquez sur Fermer.

En regardant le menu, vous remarquerez que le menu Processing est maintenant parti. Cela signifie que de
nombreuses fonctions de traitement que vous utilisiez auparavant ont disparu ! Par exemple, regardez les
menus Vector » et Raster ». C’est parce qu’ils font partie du plugin Processing, qui doit étre activé pour les
utiliser.

Ouvrez a nouveau le Plugin Manager et réactivez le plugin Processing en cliquant dans la case a cocher a coté.

Fermer le dialogue. Le menu et les fonctions de Processing devraient étre a nouveau disponibles.

9.1.2 Follow Along: Installation de nouvelles extensions

La liste des plugins que vous pouvez activer et désactiver s’inspire des plugins que vous avez actuellement installés.
Pour installer de nouveaux plugins :

1. Sélectionnez I'option Not Installed dans le dialogue Plugin Manager. Les plugins que vous pouvez installer

seront listés ici. Cette liste variera en fonction de la configuration de votre systéme existant.
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@ Plugins | Mot installed (1063) X
L processing

@ AGT - Archaeclogical Geophy = Not installed plugins
@ Append Features to Layer

& Arrblerm Here you see the list of all plugins available in the repositories,
i Mot installed % Batch Hillshader but which are not yet installed.
@ BecaGls Click on the name to see details.
Install from ZIP # BoundaryDelineation You can change the sorting via the context menu (right click).
& Buffer Without Overlaps A plugin can be downloaded and installed by clicking on it's
ﬁ Settings # Cartography Tools name, and then click the 'Install plugin' button.

@ Contour plugin

= Coregistration

% Customize ToolBars

= Danish Address Tools

@ Degree to DMS table converty
. Disconnected Islands

@ Dissolve Adjacent Polygons
= DMS to degree table converte
- dzetsaka : Classification tool
@ Easy Processing Tool

@ Equi Processing ~ || Upgrade al Uninstall Plugin Reinstall Plugin

Cloze Help

2. Trouvez des informations sur le plugin en le sélectionnant dans la liste

@ Plugins | Not installed {1069) ES

= CZML Billboard Maker -

= D3 Data Visualzation Data Plotly ]’;

= DA
i Mot installed # Danish Address Tools D3 Plots for QGIS
Data Plothy

2 Install from ZIP # Data-Driven Input Mask Draw D3 plots in QGIS

& DataFxplorer: Data Analysis a X
* Settings # Datafordeler W W 95 rating vote(s), 189842 downloads

(o ]
E ] Instalied

# Dataforsyningen

# DataGrandEst Tags vector, python, d3, plots, graphs,
* DataSud datavis, dataplotly, dataviz

Date/T Terol -
* Uate/Time loals More info homepage bug tracker code

& Datos Espaciales de Referenc repository

& DaumAP

& DB Style Manager . i )

= DBGI Available version (stable) 4.0.2 updated at uto jun 27
09:25:41 2023

Author Matteo Ghetta (Faunalia)

# DDG Street Images

# Deactivate Active Labels

= debugvs 1 L]
# Deepness: Deep Neural Reme _ Upgrade A tnstall Fiugin

Case Help

3. Installez ceux qui vous intéresse(nt) en cliquant sur le bouton Install Plugin situé sous le panneau d’information
des plugins.

Note: si le plugin comporte une erreur, il sera listé dans 'onglet Invalid. Vous pouvez alors contacter le propriétaire
du plugin pour résoudre le probleme.
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9.1.3 Follow Along: Configuration de dépots supplémentaires d’extensions

Les extensions sont disponibles dépendant de quels dépots d’extensions a utiliser sont configurés.

Les plugins QGIS sont stockés en ligne dans des dépdts. Par défaut, seul le dépot officiel est actif, ce qui signifie que
vous ne pouvez accéder qu'aux plugins qui y sont publiés. Compte tenu de la diversité des outils disponibles, ce dépot
devrait répondre a la plupart de vos besoins.

Cependant, il est possible d’essayer plus d’extensions que celles par défaut. Premierement, configurez les dépots
supplémentaires. Pour ce faire :

1. Ouvrez I'onglet Parametres dans le dialogue Plugin Manager.

() Plugins | Settings X
Check for Updates on Startup -

— If this function is enabled, QGIS will inform you whenever a plugin update is available. Otherwise, fetching
F ': Installed repositories will be performed during opening of the Flugin Manager window.

w VvV Show also Experimental Plugins

-

Not installed

Experimental plugins are generally unsuitable for production use. These plugins are in early stages of
Install from ZIP development, and should be considered 'incomplete’ or 'proof of concept’ tools. QGIS does not recommend installing these
plugins unless you intend to use them for testing purposes.

- Show also Deprecated Plugins

Deprecated plugins are generally unsuitable for production use. These plugins are unmaintained, and should be
considered 'obsolete’ tools. QGIS does not recommend installing these plugins unless you still need it and there are no other
alternatives available.

Plugin Repositories

Status Mame URL
@ connected OGIS sluzbeni repozitorij dodataka https://plugins.qgis.org/plugins/plugins.cmi?ggis=3.32

</ Reload Repository | oadd. | Edit. . Delete | [+

Close Help

2. Cliquez sur Ajouter... pour trouver et ajouter un nouveau dépot.

3. Fournissez un nom et une URL pour le nouveau dépdt que vous souhaitez configurer et assurez vous que la
case Activé est cochée.
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Repository details

Name Faunalia

URL https:/fwww.faunalia.eu/ggis/plugins.xml

Parameters

Authentication Clear | Edit
Enabled v

o conce

4. Vous devriez voir maintenant le nouveau dépdt listé dans la liste des dépdts d’extension configurés :

Plugins | Settings

Check for updates on startup

f 0] Installed

3 Not installed

. Invalid w v Show also experimental plugins
%% Install from ZIP Note: Experimental plugins are generally unsuitable for production use. These plugins are in early stages of development,

and should be considered 'incomplete’ or 'proof of concept’ tools. QGIS does not recommend installing these plugins unless
you intend to use them for testing purposes.

v Show also deprecated plugins

Plugin repositories

Status Name URL

@ connected Faunalia https:ffwww.faunalia.eu/qgis/plugins.xml?qgis=3.2
[©] connected QGIS Official Plugin Repository https://plugins.qgis.org/plugins/plugins.xmi?qgis=3.2

Reload all repesitories Add... Delete

Help * Close

5. Vous pouvez également sélectionner I'option pour afficher les extensions expérimentales en cochant la case
Afficher les extensions expérimentales.

6. Sivous revenez maintenant a 'onglet Not Installed, vous verrez que des plugins supplémentaires sont disponibles
pour l'installation.

7. Pour installer un plugin, cliquez sur celui-ci dans la liste et ensuite sur le bouton Install plugin.

9.1. Lesson: Installation et gestions des extensions 317



QGIS Training Manual

9.1.4 In Conclusion

L’installation de plugins dans QGIS devrait étre simple et efficace !

9.1.5 What’s Next?

Nous allons ensuite vous présenter quelques extensions utiles comme exemples.

9.2 Lesson: Extensions utiles de QGIS

Maintenant que vous pouvez installer, activer et désactiver des extensions, regardons comment, dans la pratique, elles
peuvent vous aider au travers de quelques exemples d’extensions utiles.

Le but de cette lecon : Vous familiariser avec I'interface des extensions et vous faire prendre connaissance de certain
les extensions utiles.

9.2.1 Follow Along: L’extension QuickMapServices
The QuickMapServices plugin is a simple and easy to use plugin that adds base maps to your QGIS project. It has
many different options and settings. Let’s start to explore some of its features.

1. Commencez une nouvelle carte et ajoutez la couche roads du Geopackage t raining_data.

2. Installez le plugin QuickMapServices.

3. Click on Web » QuickMapServices. The first menu lists different map providers (OSM, NASA) with available
maps.

4. Click on an entry and you would load the base map into your project.

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh P g Help
0 BE& PP G
AQV. A RED

Layers e®

v e T 3= =)

v roads
~ ¥ ¥ OSM standard AN

Layers | Browser
D y S -
e Coordinate [ 340458° 204273 | & scle[127093 || @ Mogniter[100% |2 Rotaton [00°  [3] (V] Rencer @epscams @

Nice! But one of the main strengths of QMS is to provide access to many data providers. Let’s add them.
1. Click on Web » QuickMapServices » Settings
2. Go to the More services tab.

3. Lisez attentivement le message de cet onglet et si vous étes d’accord, cliquez sur le bouton Get Contributed
pack.
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4. Click Save.

5. Reopen the Web » QuickMapServices menu you will see that more providers are available.

W= Mesh Processing Help

MetaSearch

» QuickMapServices

M AutoNavi 4

I> Bing b

& esrr B

@@ GeoQ -

& Google 4

@ nasA 8
¢ CartoDB »
« BasemapAT »

-4 Stamen b

g usas g

& waze v
9 Yandex »

» O5M 3

€} search QMs

€} Add to Search

€3 set proper scale

@ settings

€ About QMS

6. Choose the one that best fits your needs, and load the data in the project!
It is also possible to search trough the now available data providers

1. Open the plugin’s search tab by clicking on Web » QuickMapServices » Search QMS. This option of the plugin
allows you to filter the available base maps by the current extent of the map canvas or using a search word.

2. Click on the Filter by extent and you should see one service available. If no service is found, zoom out and pan
around the world (or your location) or search with a keyword.

3. Click on the Add button next to a returned dataset to load it.

4. The base map will be loaded and you will have a background for the map.
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Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help
DeBREN O 2LRPPME L
B@QVAwED

Layers a®

«@®T
V| — roads

~ [] # OsM standard

~ v I GLAD LANDSAT MOSAIC :

RatOOR

% b
aas -

Search QMS

land

-

@

‘

Filter by extent| | Al

GLAD Forest Change Landsat 2017

,,
.

WMs details, report a problem

GLAD FOREST LOSS 2000-2021

”,
.

TMS details, report a problem

GLAD FOREST YEAR LOSS 2000-2021

m
.

TMS details, report a problem

‘GLAD LANDSAT MOSAIC 2018
TMS details, report a problem

-
.

GLAD LANDSAT MOSAIC 2019
TMS details, report a problem

.n
55
.

GLAD LANDSAT MOSAIC 2021
TMS details, report a problem

=
.

GLAD Tree Canopy Height 2020

m
.

WMS details, report a problem

N GLAD Water Ice Mask
WMs details, report a problem

=
it

Layers | Browser Download geodatz for your project
Q Type to locate (Ctri+K] Coordinate | 31,788 19814° | scate 11277934 | = | @ wagniter| 100% 2| Rotation [00° 2| V) Rencer Bepsciazzs @

9.2.2 Follow Along: L’extension QuickOSM

Avec une interface incroyablement simple, le plugin QuickOSM vous permet de télécharger des données
OpenStreetMap.

1. Démarrez un nouveau projet vide et ajoutez la couche roads du GeoPackage t raining_data.

2. Installez le plugin QuickOSM. Le plugin ajoute deux nouveaux boutons dans la barre d’outils QGIS et est
accessible dans le menu vecteur » QuickOSM.

3. Ouvrez le dialogue QuickOSM. Le plugin a de nombreux onglets différents : nous utiliserons celui de Quick
Query.

Vous pouvez télécharger des fonctionnalités spécifiques en sélectionnant un couple Key générique ou étre plus
spécifique et choisir un couple Key et Value spécifique.

Astuce: si vous ne connaissez pas le systeme Key et Value, cliquez sur le bouton Help with key/value. Cela
ouvrira une page web avec une description complete de ce concept d’OpenStreetMap.

5. Cherchez railway dans le menu Key et laissez Value vide : nous téléchargeons donc toutes les entités de railway
sans spécifier de valeur.

6. Sélectionnez Layer Extent dans le menu déroulant suivant et choisissez roads.

7. Cliquez sur le bouton Run query.

[@

Freset

e et i iy st Fzbures

4 0 ke the bey Ty’ 0 B s o b e s goes 1 be sovmkded,

Shw ey
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Apres quelques secondes, le plugin téléchargera toutes les entités marquées dans OpenStreetMap comme railway
et les chargera directement dans la carte.

Rien de plus ! Toutes les couches sont chargées dans la légende et apparaissent dans le canevas de la carte.

p— QIS - o X

Edt Vew Loyer Settngs Pugns Vect Raster Datobase e

>
[ APLAIPIA

BQLARED =4 5=

etge a Coninate| 533573 955" | e[ 15095 |~ | @ woonir[100% 2] motabon [00° 3| v Rencer @mscinis @

Avertissement: QuickOSM crée une couche temporaire lors du téléchargement des données. Si vous souhaitez

les enregistrer de maniere permanente, cliquez sur I'icone [::] a coté de la couche et choisissez les options que
vous préférez. Vous pouvez également ouvrir le menu Advanced dans 'OSM rapide et choisir ol enregistrer
les données dans le menu Directory.

9.2.3 Follow Along: Le moteur de recherche QuickOSM

La facon la plus rapide de télécharger des données a partir du plugin QuickOSM est d’utiliser I'onglet Quick query et
de définir quelques petits parametres. Mais si vous avez besoin de données plus spécifiques ?

Si vous €tes un maitre de requétes OpenStreetMap, vous pouvez utiliser le plugin QuickOSM également pour vos
requétes personnelles.

QuickOSM dispose d’un incroyable analyseur de données qui, associé a I'incroyable moteur d’interrogation de
Overpass, vous permet de télécharger des données en fonction de vos besoins spécifiques.

Par exemple : nous voulons télécharger les pics montagneux qui appartiennent a une zone de montagne spécifique
appelée dolomites.

Vous ne pouvez pas accomplir cette tache avec I'onglet Quick query, vous devez étre plus spécifique et écrire votre
propre requéte. Essayons de le faire.

1. Démarrez un nouveau projet.
2. Ouvrez le plugin QuickOSM et cliquez sur I'onglet Query.

3. Copiez et collez le code suivant dans le canevas de requéte: :

p
gl=

This shows all mountains (peaks) in the Dolomites.
You may want to use the "zoom onto data" button. =>
—-—>
<osm-script output="json">
<!-- search the area of the Dolomites ——>
<query type="area">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>
</query>
<print mode="body" order="quadtile"/>

(suite sur la page suivante)
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(suite de la page précédente)
<!-— get all peaks in the area ——>
<query type="node">
<area-query/>
<has-kv k="natural" v="peak"/>

</query>
<print mode="body" order="quadtile"/>
<!-- additionally, show the outline of the area --—>

<query type="relation">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>
</query>
<print mode="body" order="quadtile"/>
<recurse type="down"/>
<print mode="skeleton" order="quadtile"/>
</osm-script>

Note: Cette requéte est écrite dans un langage de type xm1. Si vous étes plus habitué au Overpass 0L,
vous pouvez écrire la requéte dans ce langage.

4. Etcliquez sur Run Query :

) QuickOSM %
n Map preset <l—
. This shows all mountains (peaks) in the Dofdamites,
‘fou may want to use the “zoom onto data” butforn, ==
’ Quick query -

<osm-script oufpui=Tjson™>

<query fype="area
<has4v k="place” v="region”f>
<has+v &="region:type” v="mountain_area"/>
' QSM File <has+v £="name:en” v="Dolomites"™/>
< fquery=

<print mode="body” arder="quadtile”/>

N Parameters <i—geta = =
<query frpe="node">
<area-query/>
* About <has+v &="natural” »="peak’/=
- <fquery =

<print mode="body” order="gquadtil

<guery fype="Trelation™>
<has+v &="place” v="region”/=
<has4v k="region:type” v="mountain_area"f>
<has4v #="name:en” v="Dolomites™/ =

< fquery=

<print mode="body~ order="quadtle™/>

<recurse fype="down”/=

<print moge="skeleton” arder="quadtile”/>

<fosm-script]

Generate query oo » Run query

P Advanced

eO\rerpass Turbo Documentation -

0%

La couche des pics montagneux sera téléchargée et affichée dans QGIS :
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Vous pouvez écrire des requétes complexes en utilisant le langage de requéte Overpass Query. Regardez quelques
exemples et essayez d’explorer le langage d’interrogation.

9.2.4 Follow Along: L’extension DataPlotly
Le plugin DataPlotly vous permet de créer des tracés D3 de données d’attributs vectoriels grace a la bibliotheque
plotly.

1. Démarrer un nouveau projet

2. Chargez la couche sample_points dans le dossier exercise_data/plugins.

3. Installez le plugin en suivant les instructions décrites dans P?J7] Pas ¢ pas : Installer de nouvelles extensions
searching Data Plotly.

4. Ouvrez le plugin en cliquant sur la nouvelle icone dans la barre d’outils ou dans le menu Plugins » Data Plotly

Dans I'exemple suivant, nous créons un simple Scatter Plot de deux champs de la couche sample_points. Dans
le panneau DataPlotly :

1. Choisissez sample_points dans le filtre de couche, cl pour le champ X et mg pour le champ Y :

9.2. Lesson: Extensions utiles de QGIS 323


https://wiki.openstreetmap.org/wiki/Overpass_API/Overpass_QL
https://d3js.org/
https://plotly.com/

QGIS Training Manual

DataPlotly

&f Plottype | i Scatter Plat

w Plot Parameters

Layer " sample_poaints

Use only selected features

Feature subset @,

Use only visible features

X field 124 ~][€]
Y field 1.2 mg ~|[€]
w Properties
Legend title |dl-mg | €
Marker color I | €L vetersze (000 3] €
Stroke color I | €L svokewidh 100 @ |3 €]
Marker type | Paints - |
Paint type '@ - |
Opacity 1000% 2]
Hover tooltip | All values - |

Hover label as text

Type of plot Single Plot

~ ]

!
| % Clean Plot Canvas

| @ Update Plot | |1 create Plot | | Configuration - |

2. Si vous le souhaitez, vous pouvez modifier les couleurs, le type de marqueur, la transparence et bien d’autres
parametres : essayez de modifier certains parametres pour créer le tracé ci-dessous.
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DataPlothy n
¥ ) -z M

& o-mg
o L &
50
- & + + &
E‘ 40 + + +
&
35
+
T e % + @
. *T
Zh + %
20 - +
ap 60 80 100 120 140
d
\‘.;Reload Dynamically update size ;nm qﬂ

3. Une fois que vous avez défini tous les parametres, cliquez sur le bouton Create Plot pour créer le plot

le graphique intéractif : cela signifie que vous pouvez utiliser tous les boutons supérieurs pour redimensionner,
déplacer ou zoomer sur le canevas du graphique. De plus, chaque élément du tracé est interactif : en cliquant ou
en sélectionnant un ou plusieurs points sur le tracé, le ou les points correspondants seront sélectionnés dans le canevas
du tracé.

Vous pouvez enregistrer le graphique en tant qu'image statique png ou en tant que fichier html en cliquant sur le
=
bouton ﬁﬂ ou sur le bouton dans le coin inférieur droit du graphique.
Ce n’est pas tout. Parfois, il peut étre utile d’avoir deux (ou plusieurs) parcelles montrant différents types de graphique
avec différentes variables sur la méme page. Faisons cela !
1. Retournez a I'onglet principal des parametres du graphique en cliquant sur le bouton (3/ dans le coin supérieur
gauche du panneau des plugins
2. Changer le type graphique en graphique boite.
3. Choisissez group comme Grouping Field et ph comme Y Field.

4. Dans la partie inférieure du panneau, changez le Type of Plot de SinglePlot a SubPlots et laissez I'option par
défaut Plot in Rows sélectionnée.
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DataPlothy

& Phttype | [ BoxPlot A
w Plot Parameters

Layer " sample_points - |

Use only selected features Use only visible features

Feature subset @,

Grouping field =
(k] 123 group -] é |
¥ field |1.2ph v | €]

w Properties

Legend title |ph | @.
x| (I - €
Stroke color - Stroke width | 1.00 @& |3

| I - < | | €
Opacity : 1] 100.0 % =

Box orientation |\|'ert'n3| = |

Show statistics |None v |

Qutliers |Nc Cutliers = |
Type of plot |Subplcts - |

() Plotin columns (@) Plotin rows

4 Clean Plot Canvas Update Plot | | ) Create Plot | | Configuration = |
|

5. Une fois terminé, cliquez sur le bouton Create Plot pour dessiner le tracé

DataPlotly

¢

: [ ] g cl-mg
' > + m e
& + + L ] 75
50 ~ s
+ *é
45 +
7
& + *
35 + 6.5
L
? e PR R
L ] 6
25
+ + @
20 L +
5.5
50 100 150 1 2 3
:;Re\oad Dynamically update size ‘§| |£|

Maintenant, le nuage de points et le diagramme en boite sont tous deux affichés sur la méme page. Vous avez encore la
possibilité de cliquer sur chaque élément du diagramme et de sélectionner les entités correspondantes dans le canevas
de la carte.
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Astuce: Chaque graphique a sa propre page de manuel disponible dans . Essayez d’explorer tous les types de
tracés et de voir tous les autres parametres disponibles.

9.2.5 In Conclusion

Il existe de nombreuses extensions disponibles pour QGIS. En utilisant les outils intégrés pour I'installation et la
gestion de ces extensions, vous pouvez trouver de nouvelles extensions et en faire une utilisation optimale.

9.2.6 What’s Next?

Nous allons ensuite voir comment utiliser en temps réel des couches qui sont hébergées sur des serveurs distants.
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Module: Ressources en ligne

Lorsque I'on considere les sources de données pour une carte, il n’y a pas besoin de se restreindre aux données que
vous avez sauvegardées sur votre ordinateur avec lequel vous travaillez. Il y a des sources de données en ligne depuis
lesquelles vous pouvez charger des données et ce tant que vous étes connecté a Internet.

Dans ce module, nous aborderons deux sortes de services SIG basés sur le web : Web Mapping Services (WMS) et
Web Feature Services (WES).

10.1 Lesson: Web Mapping Services

Un Web Mapping Service (WMS, qui signifie Service de cartographie web en anglais) est un service hébergé sur un
serveur distant. Semblable a un site web, vous pouvez y accéder tant que vous avez une connexion au serveur. En
utilisant QIGS, vous pouvez charger un répertoire WMS directement dans votre carte existante.

Vous devez vous souvenir de la le¢on sur les extensions qu’il est possible de charger une nouvelle image raster depuis
Google, par exemple. Cependant, il s’agit d’une transaction ponctuelle : une fois que vous avez téléchargé I'image,
elle ne change pas. Un WMS est différent dans le fait que c’est un service en direct qui actualisera automatiquement
sa vue si vous déplacez ou zoomez sur la carte.

Objectif de cette lecon : Utiliser un WMS et comprendre ses limites.

10.1.1 Follow Along: Chargement d’'une Couche WMS

For this exercise, you can either use the basic map you made at the start of the course, or just start a new map and
load some existing layers into it. For this example, we used a new map and loaded the original places, landuse and
protected_areas layers and adjusted the symbology:
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(@ "Untitled Project — QGIS — [m] x
Project Edit View Layer Settings Plugine Vector Raster Database Web Mesh Progessing Help

DeBRRY O PALHNPP " A - BabLPOR H-8-G-0- QEHFZE-V -0

LAY AT 1R - - I A L L
Layers (=]E3)

v @ ® TV E&-RAL

V| + places

v! [ tanduse

! [ protected_areas

| QA Type tolocate (Crl+) Coordinate | -34,1016° 20,2775° | Scale | 1:00.001 |~ | (@ Magnifier| 100% 12| Rotaton [0,0° |2 V| Render  WEpsciaze @

1. Chargez ces couches dans une nouvelle carte, ou utilisez votre carte d’origine avec seulement ces couches
visibles.

2. Avant de commencer a ajouter la couche WMS, désactivez la projection « a la volée » (Projet » Propriétés...
» SCR, cochez Aucun SCR (ou projection inconnue ou non-terrestre). Cela peut faire en sorte que les couches
ne se chevauchent plus correctement, mais ne vous inquiétez pas : nous corrigerons cela plus tard.

3. Pour ajouter des couches WMS, cliquez sur le bouton ﬂ pour ouvrir la boite de dialogue Gestionnaire source

donnees et activer 'onglet @ WMS/WMTS.
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(2 Data Source Manager | WMS/WMTS - [m] >

o7t Layers Layer Order Tilesets

Raster

Connect Mew Edit Remove Load Save

d jis] Name Title Abstract

Spatialite

Image Encoding

Options
Tile size
Request step size
Maximum number of GetFeatureInfo results 10
Coordinate Reference System EP5G:4326 - WGS 84 s

Use contextual WMS Legend

Layer name

Arct Load as separate layers
Select layer(s)

Metadata Search Close Add Help

Rappelez-vous comment vous vous &tes connecté a une base de données SpatiaLite ou GeoPackage au début
du cours. Les couches landuse, buildings, et roads sont stockées dans une base de données. Pour utiliser ces
couches, vous devez d’abord vous connecter a la base de données. L’utilisation d'un WMS est similaire, a
I'exception du fait que les couches se trouvent sur un serveur distant.

4. Pour créer une nouvelle connexion 2 un WMS, cliquez sur le bouton Nouveau.

Vous aurez besoin d’'une adresse WMS pour continuer. Il existe plusieurs serveurs WMS gratuits sur Internet.
L’un d’entre eux est terrestris, qui utilise 'ensemble de données OpenStreetMap.

5. Pour utiliser ce WMS, configurez-le dans votre boite de dialogue actuelle, comme ceci :
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) Create a New WMS/WMTS Connection
Connection Details

MName |terrestris

Authentication

Configurations Basic

database,

HTTP Headers

Referer
b Advanced

WHMS/WMTS Options

WMS DPI-Mode all

WMTS server-side tile pixel ratio

Ignore reported layer extents

Invert axis orientation

Smooth pixmap transform

OK

URL https: /fows. terrestris. dejosm/service|

Choose or create an authentication configuration

Mo Authentication  ~ LJ.-EJ

Configurations store encrypted credentials in the QGIS authentication

Undefined {nat scaled) -
Ignore GetMap/GetTile/GetlegendGraphic URI reported in capabilities

Ignore GetFeatureInfo URI reported in capabilities

Ignore axis orientation (WMS 1. 3/MMTS)

Cancel Help

* La valeur du champ nom doit étre terrestris.

 La valeur du champ URL doit étre https://ows.terrestris.de/osm/service.

6. Cliquez sur OK. Vous devriez voir le nouveau serveur WMS listé :
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() Data Source Manager | WMSWMTS

Layers | Layer Order Tilesets

| terrestris

| comec [ nen ||

| ‘ Remove |

@

ju] Name: Title

Abstract

Image Encoding
Oradle

tual L

Options

SAP HAMA
*

Tile size |

Request step size |

Maximum number of GetFeatureInfo results
Coordinate Reference System

Use contextual WMS Legend

|10

EP5G:4326 - WGS5 84

Layer name |

Load as separate layers

Select layer(s)

Close |

Add | Hep |

7. Cliquez sur Connecter. Dans la liste d’en-dessous, vous devriez maintenant voir ces nouvelles entrées chargées
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(&) Data Source Manager | WMS/WMTS

8. Click once on the OSM-WMS layer. This will display the default Coordinate Reference System in use and the

— O x
Layers | Layer Order Tilesets
| terrestris = |
| Connect | | New | | Edit Remove | | Load | | Save |
L2 |
Mesh D « Name Title Abstract
* 0 OpenStreetMap WMS
Paint Cloud v 1 OSM-WMS OpenStreetMap WMS - by terrestris
2 default default
3 OSM-WMS-no-abels 0SM WMS wio labels - by terrestris
b4 Q5M-Overlay-WMS O5M Overlay WMS - by terrestris
[} TOPO-WMS Topographic WMS - by terrestris
[} TOPO-0SM-WMS Topographic OSM WMS - by terrestris
10 SRTM30-Hillshade SRTM30 Hillshade - by terrestris
r 11 SRTM30-Colored SRTM30 Colored - by terrestris
b 13 SRTM30-Colored-Hillshade SRTM30 Colored Hillshade - by terrestris
15 SRTM30-Contour SRTM30 Contour Lines - by terrestris
b 16 Dark Dark
Image Encoding
: () pNG (®) JPEG
Virtual Layer
Options
SAP HAMA
Tile size | | | |
Request step size | | | |
Maximum number of GetFeatureInfo results |10 |
Coordinate Reference System EPSG:4326 - WGS 84 -
Use contextual WMS Legend
or Tile Layer name |
ArcGlS REST Server [t EE
Select layer(s)
Metadata Search | Close | Add | Help |

Il y a toutes les couches hébergées par ce serveur WMS.

number of CRSes supported by the dataset:
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() Data Source Manager | WMS/WMTS — O >
g

Layers | Layer Order Tilesets

| terrestris = |
| Connect | | New | | Edit | | Remove | | Load | | Save |
: (@ |
%] "
== " Mesh D « Name Title Abstract
- Point Cloud QOSM-WMS OpenStreetMap WMS - by terrestris
* 2 default default
3 OSM-WMS-no-abels 0SM WMS wio labels - by terrestris
. Delimited Text b4 Q5M-Overlay-WMS O5M Overlay WMS - by terrestris
[} TOPO-WMS Topographic WMS - by terrestris
e [} TOPO-0SM-WMS Topographic OSM WMS - by terrestris
d 10 SRTM30-Hillshade SRTM30 Hillshade - by terrestris
r 11 SRTM30-Colored SRTM30 Colored - by terrestris
[ [——— b 13 SRTM30-Colored-Hillshade SRTM30 Colored Hillshade - by terrestris
+ 15 SRTM30-Contour SRTM30 Contour Lines - by terrestris
b 16 Dark Dark

areS0L

M5 50L 5
Image Encoding
Orade
() PNG (8 JPEG
rtual Layer
Options
SAP HAMA
Tile size | | | |

Request step size | | | |

Maximum number of GetFeatureInfo results |10 |
Coordinate Reference System (25 available) | EPsG:4325 - wes 84 v ||
Use contextual WMS Legend
Layer name |0pen5h'eetMa|:| WMS - by terrestris
Load as separate layers
1 Layer selected
| Close | | Add | | Help |

Since we’re not using EPSG:4326 — WGS 84 for our map, let’s find one that meets our needs.

1. Click the %Sem CRS button. You will see a standard Coordinate Reference System Selector dialog showing
all the CRS the data is published with.
2. We want a projected CRS, so let’s choose WGS 84 / Pseudo-Mercator with EPSG: 3857. You can use

the top C‘L Filter widget.
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() Select CRS

Predefined CRS
Filter | L
Recently Used Coordinate Reference Systems

Coordinate Reference System
WGS 84

Predefined Coordinate Reference Systems

Coordinate Reference System
WGE5 84
~ [ Projected coordinate Systems
v Cassin
DHDN / Soldner Berlin
~ Lambert Azimuthal Equal Area
ETRS89-extended [ LAEA Europe
~  Lambert Conformal Conic
ETRS89 fLCC Germany (E-N)
ETRS89 [ LCC Germany (N-E)
ETR589-extended / LCC Europe
™ Mercator
Google Maps Global Mercator
WGS 84 [ Pseudo-Mercator
o Swins Ml Mercatar
WGS 84 | Pseudo-Mercator
Properties

* Units: meters

* Dynamic (relies on & datum which is
not plate-fixed)

* Celestial body: Earth

* Based on World Geodefic Sysiem
1984 ensembie (EPSG:6326), which

has & limited acruracy of at hest 2

Authority 1D
EPSGi4326

Hide deprecated CRSs
Authority ID .-

EP5G:4326
EP5G:3068
EP5G:3035
EP5G:5243
EP5G:4335

EP5G:3034

EP5G:900313

1. Cliquez sur OK. Le systeme de référence des coordonnées associé a I'entrée a changé.

9. Click Add to load the layer in your project using Layer name" (default is OpenStreetMap WMS - by terrestris).

10. Fermez le dialogue gestionnaire de source de donnees si ce n’est pas fait automatiquement

11. Dans le panneau couche, cliquez et faites-le glisser jusqu’au bas de la liste.

12. Faites un zoom arriere pour obtenir une vue globale des couches. Vous remarquerez que vos couches ne sont
pas situées correctement (pres de 'ouest de I’Afrique). Cela est dii au fait que la projection « a la volée » est

désactivée.
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(@ "Untitled Project — QGIS — [m] x
Project Edit View Layer Settings Plugine Vector Raster Database Web Mesh Progessing Help
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| [ protected_areas
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lArgentinaj
w
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13. Activons a nouveau la reprojection, mais en utilisant la mé€me projection que la couche OpenStreetMap WMS,
qui est WGS 84 / Pseudo Mercator.

1. Ouvrez la Projet » Propriétés... » onglet SCR
2. Décochez Aucun SCR (ou projection inconnue ou non-terrestre).

3. Choisissez WGS 84 / Pseudo Mercator dans la liste.
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() Project Properties — CRS X
Q Project Coordinate Reference System [CRS)

Mo CRS {or unknown/non-Earth projection)

Filter | CL 3857 a |
Recently Used Coordinate Reference Systems

] . Coordinate Reference System Authority ID

Predefined Coordinate Reference Systems Hide deprecated CRSs

Coordinate Reference System Authority ID

= ~ [ Projected Coordinate Systems
~ lambert Conformal Conic

i NAD_1983_HARN_Adi_WI_Marquette_Me . ESRI:103857
~ Mercator

| Pseudo-Mercator

i »
'WGS 84 | Pseudo-Mercator =
Properties
- * Units: meters
L * Dynamic {relies on a datum which |
i nat nlatafivadl b’
o« || concel || oy || rep |

4. Cliquez sur OK.

14. Now right-click on one of your own layers in the Layers panel and click Zoom to layer(s). You should see the
Swellendam area:
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Q. Type tolocate (Cirl+) Coordinate | 2.255.454 4.041.638 |99 Scle 1:168.151  ~ | (@ Magnifier| 100% 12| Rotaton [0,0° |2 V| Render  @ERsmzsT @
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Remarquez comme les rues de la couches WMS et vos propres rues se superposent. C’est bon signe !

La nature et les limtes du WMS

Vous devriez maintenant avoir remarqué que cette couche WMS contient actuellement beaucoup d’entités. Il y a
les rues, rivieres, réserves naturelles, et caetera. Qui plus est, méme si elle ressemble a quelque chose composé de
vecteurs, elle semble €tre un raster, mais vous ne pouvez pas changer sa symbologie. Pourquoi donc ?

C’est comme cela que fonctionne un WMS : c’est une carte, semblable a une carte normale en papier, que vous
recevez comme une image. Ce qui se passe habituellement est que vous avez des couches vectorielles, que QGIS
affiche comme une carte. Mais en utilisant un WMS, ces couches vectorielles sont sur un serveur WMS, qui les
affiche comme une carte et vous envoie cette carte en tant qu'image. QGIS peut afficher cette image, mais ne peut
pas changer sa symbologie, car tout est géré sur le serveur.

Cela a plusieurs avantages, parce que vous n’avez pas besoin de vous inquiétez de la symbologie. Cela est déja réglé,
et devrait étre agréable a voir sur les WMS congus avec compétence.

D’un autre coté, vous ne pouvez pas changer la symbologie si vous ne I'aimez pas, et si des choses sont modifiées
sur le serveur WMS, alors elles changeront également dans votre carte. C’est pourquoi vous voudrez parfois utiliser
un Web Feature Service (WES) a la place, qui vous donne des couches vectorielles séparément, et pas dans le cadre
d’une carte de style WMS.

This will be covered in the next lesson, however. First, let’s add another WMS layer.

10.1.2 Try Yourself

1. Add the eAt 1las WMS server at this URL: https://maps.eatlas.org.au/maps/wns
2. Load a World: Hillshading layer into the map.
3. You might want to set its Encoding to JPEG and its Tile size option to 200 by 200, so that it loads faster.

4. Your map should look like this (you may need to re-order the layers, and apply some transparency):

Layers @®
<& =T = = gl

v ¥ places
v| [ protected_areas
v| [ landuse
~ [V B OpenstreetMap WMS - by terrestris
®  Stadt > 1.000,000 EW
Stadt > 250,000 EW
Stadt > 25,000 EW

Strate
Bundesstralie
Autobahn
Wasserflache
Landflache
wald

Wiiese / Acker

Gebiude

Krankenhaus aEapE Tow “ .
S - ) of B

1 D

Layers | Browser
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Réponse

1. Go to the Data Source Manager, WMS / WMTS tab and create a new connection entry

2. Use the Q text box to filter the list of layers and select the corresponding layer
3. Remember to check/turn its CRS into EPSG:3857 - WGS 84 / Pseudo Mercator as the rest of the map.

™ Data Source Manager | WMS/WMTS v ~ D
h’ Browser Layers Layer Order | Tilesets
= Vector eAtlas -
r Raster Connect New Edit Remove Load Save
i \esh Q. warld: hillshading
g Mesl
. ID ~ Name Title Abstract
Point Cloud
* -0
Delimited Text ~ Imagery Base Maps Earth Cover Imagery Base Maps Earth Cover
ted Texi
L] *World: Bright Earth Basemap (e-Atlas) ‘World: Bright Earth Basemap (e-Atlas)

-ea-be:World_e-Atlas-UCSD_SRTM30-plus_v&_Hillshading ‘World: Hillshading - SRTM30-plus v8.0 (e-Atlas... This layer shows hillshadi...
Bright-Earth_Hillshading Transparent Hillshade

Bright-Earth_Raster Raster A sample style for rasters, ...
ea-be:World_e-Atlas-UCSD_SRTM30-plus_v&_Hillshading-Ir World: Hillshading Low Res - SRTM30-plus v&.... This layer shows hillshadi...
Bright-Earth_Hillshading Transparent Hillshade

Bright-Earth_Raster Raster A sample style for rasters, ...

Image Encoding

- MS SQL Server

m Virtual Layer

PNG PNG8 (@ JPEG GIF TIFF SVG

Options

Tile size 200 200

-+ WFS / OGC API - Features

Reguest step size
_:e-.—; WCs Maximum number of GetFeaturelnfo results 10
* XYZ Coordinate Reference System (6779 available) EPSG:3857 - WGS 84 / Pseudo-Mercator - || @
Use contextual WMS Legend
ArcGIS REST Server
Layer name |World: Hillshading - SRTM30-plus v8.0 (e-Atlas, UCSD)

» GeoNode
Load as separate layers

Metadata Search 1 Layer selected

i Aide + Add @ Fermer

4. After the layer is loaded, you can modify its Opacity value (under the Transparency properties tab)

10.1.3 Try Yourself

Une partie de la difficulté a utiliser le WMS est de trouver un bon serveur (libre).

¢ Trouvez un nouveau WMS sur directory.spatineo.com (ou ailleurs en ligne). Il ne doit pas étre assorti de frais
ou de restrictions, et doit couvrir la zone d’étude Swellendam.

Souvenez-vous que tout ce dont vous avez besoin pour utiliser un WMS est seulement son URL (et de préférence
une sorte de description).

Réponse

Spatineo is one of many places you can search for a OGC data. Type in the text area a name, keyword, location of
your interest to see if you get some working results. For this lesson, you might want to filter the results to include
WMS only.

You may notice that many WMS servers are not always available. Sometimes this is temporary, sometimes
it is permanent. An example of a WMS server that worked at the time of writing is the MapServer
Demonstration Server WMS at https://demo.mapserver.org/cgi-bin/wms?SERVICE=WMS&VERSION=1.3.0&
REQUEST=GetCapabilities. It does not require fees or have access constraints, and it is global. Therefore, it does
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satisfy the requirements. Keep in mind, however, that this is merely an example. There are many other WMS servers
to choose from.

10.1.4 Try Yourself

* Add the bluemarble layer from the MapServer Demonstration Server. Is that a suitable dataset for our study
area?

Réponse

1. Cachez toutes les autres couches WMS pour éviter qu’elles ne s’affichent inutilement en arriere-plan.

2. Use the same approach as before to add the new server and the appropriate layer as hosted on that server:

. Data Source Manager | WMS/ e
B crowser Layers ‘ Layer Order | Tilesets
. g Vector |Mapsarver - |
¢ Raster | Connect | | New | ‘ Edit ‘ | Remove Load ‘ | Save |
:_ Mesh | Qa |
© G e ID ~ Name Title Abstract
oint Clouc
* 0 WMS_server WMS Demo Server for MapServer This demonstration server showcases MapServer (www.map...
Delimited Text 1 bluemarble Blue Marble World Elevation and Bathymetry ...
ted Tex -
» 2continents World continents
GeoPackage v 4 country_bounds World country boundaries
S b Gities World cities
GPs
. SpatialLite
Image Encoding
® PNG () PNGB (U JPEG () TIFF () SVG
Options
Tile size | | ‘ |
Reguest step size | | ‘ |
Maximum number of GetFeaturelnfo results ‘IO |
Coordinate Reference System (4 available) ‘ EPSG:3857 - WGS 84 / Pseudo-Mercator bt ||@|
Vector Tile Use contextual WMS Legend
ArcGIS REST Server
Layer name |Blue Marble World Elevation and Bathymetry Raster
» GeoNode
Load as separate layers
Metadata Search 1 Layer selected
‘ i Aide | + Add H @ Fermer |

3. If you zoom into the Swellendam area, you’ll notice that this dataset has a low resolution:
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Layers a®
|4 ® T 2 3= gt

v ¥ places

v| [ protected_areas

! [ landuse
v [] & OpenstreetMap WMS - by terrestris
b [v| I Blue Marble World Elevation and Baf

Layers | Browser

Therefore, it’s better not to use this data for the current map. The Blue Marble data is more suitable at global
or national scales

10.1.5 In Conclusion

En utilisant un WMS, vous pouvez ajouter des cartes inactives comme toile de fond pour vos données de carte
existantes.

10.1.6 Further Reading

* Répertoire Spatineo

¢ Liste des serveurs WMS OpenStreetMap.org

10.1.7 What’s Next?

Maintenant que vous avez ajouté une carte inactive comme toile de fond, vous serez content d’apprendre qu’il est
également possible d’ajouter des données (comme les autres couches vectorielles que vous avez ajoutées avant). Un
ajout de données depuis les serveurs distants est possible en utilisant un Web Feature Service (WFES). Cest le sujet
de la prochaine lecon.
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10.2 Lesson: Web Feature Services

Un Web Feature Service (WFS) fournit a ses utilisateurs des données SIG dans des formats qui peuvent étre
directement chargés dans QGIS. A la diftérence d'un WMS, qui vous fournit seulement une carte que vous ne pouvez
pas modifier, un WFS vous donne acces aux entités elles-mémes.

Objectif de cette lecon : Utiliser un WES et comprendre en quoi il est différent d'un WMS.

10.2.1 Follow Along: Chargement d’'une couche WFS

1. Ouvrez une nouvelle carte. C’est a des fins de démo et ¢a ne sera pas sauvegardé.

2 Cliquez sur le bouton % Ouvrir le gestionnaire de source de données

3. Activez Ponglet V) WFS /OGC API - Features.
4. Cliquez sur le bouton Nouveau.

5. Dans le dialogue qui apparait, saisir comme Nom : nsidc.orgetcomme URL : https://nsidc.org/
cgi-bin/atlas_south?version=1.1.0.

(=) Create a New WFS Connection *

Connection Details

Mame |nsidc.org
URL https:/fnsidc.org/fcgi-bin fatlas_south?version=1. 1.0
Authentication

Configurations Basic

Choose or create an authentication configuration

Mo Authentication = E'.'l:',':'

Configurations store encrypted credentials in the QGIS
authentication database.

WFS Options

Version Maximum = Detect
Max. number of features
+ | Enable feature paging
Page size
Ignore axis orientation (WFS 1. 1/WFS 2.0)
Invert axis orientation

Use GML2 encoding for transactions

oK Cancel Help

6. Cliquez sur OK, et la nouvelle connexion apparaitra dans votre Serveur de connexions.

7. Cliquez sur Connecter. Une liste de couches disponibles apparaitra.
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() Data Source Manager | WFS / OGC API - Features

Foint Cloud
mited Text
GeoPackage
GPS
” cpatiaLite
PostgreS0L
M5 5QL

Oracle

Virtual Layer

SAP HANA

+
‘E WMS MMTS

WFS [ OGC API -

Features

Server Connections

nsidc.org

Connect New | Edit

Remove

“ MName

Antarctic coastline (indudes ice shelves)
Antarctic continent

Antarctic grounding line (exdudes ice shel...
Antarctic ice core locations

Antarctic ice shelves

Antarctic island coastlines

Antarctic island coastiines

Antarctic islands

Antarctic megadunes

Antarctic permanent research stations
Antarctic Polar Front

Antarctic suface elevation contours
Antarctica border

coastlines (exduding Antarctica)
countries (excuding Antarctica)
glader outlines

glaciers

International Date Line

land {exduding Antarctica)

South Pole of Cold

South Pole of Inaccessibility

South Pole, Geographic

South Pole, Geomagnetic

South Pole, Magnetic

South Poles

Use title for layer name

antarctic_ice_shelves_outline
antarctic_continent
antarctic_coastline
antarctic_ice_cores
antarctic_ice_shelves_fil
antarctic_islands_coastlines
antarctica_islands_coastlines
antarctic_islands
antarctic_megadunes
antarctic_research_stations
antarctic_polar_front
antarctica_elevation_contours
antarctica_country_border
coastlines_exduding_antarctica

country_borders_exduding_antarctica

glacier_outlines

glaciers
international_date_line
land_exduding_antarctica
south_pole_of_cold
south_pole_inaccessibility
south_pole_geographic
south_pole_geomagnetic
south_pole_magnetic
south_poles_wfz

| Only request features overlapping the view extent

Coordinate Reference System

EP

5G:3031

Build query

Load

Abstract

Bohlander, 1. and T. Scambos. 2007. Ant...
Bohlander, J. and T, Scambos, 2007, Ant...
Bohlander, 1. and T. Scambos. 2007, Ant...

Maurer, 1. compiler, 2009, Deep ice core ...

Bohlander, J. and T, Scambos, 2007, Ant...
Bohlander, J. and T. Scambos. 2007, Ant...
Bohlander, J. and T. Scambos. 2007, Ant...
Bohlander, 1. and T. Scambos. 2007. Ant...

Bohlander, J. and T. Scambos, 2005, Qut...

Wikipedia contributors, 24 January 2007, ...

Orsi, A, and Ryan, U. 2001. Locations of ..

Liu, H., K. Jezek, B. Li, and Z. Zhao. 200...
Bohlander, 1. and T. Scambos. 2007, Ant...

Center for International Earth Sdence Inf...
Center for International Earth Sdence Inf...

Armstrong, R., B. Raup, 5.1.5. Khalsa, R ...

Mational Imagery and Mapping Agency (M...

Mational Geographic Society, 1992, Natio...

Center for International Earth Sdence Inf...

Wikipedia contributors. 23 January 2007. ...
Wikipedia contributors. 20 January 2007. ..
Labels the location of the South Pole {90 ...

McClean, 5. 24 January 2007, Geomagne...
McClean, 5. 24 January 2007. Geomagne...

Labels the location of various types of So..

Close Add

Save

Sql

Change...

Help

8. Décochez l'option Ne demander que les entités qui sont dans l'étendue de la vue courante en dessous de la
liste des couches, étant donné que le canevas de votre carte actuelle peut ne pas couvrir notre zone d’intérét :
I’Antarctique.

9. Trouvez la couche antarctica_country_border. Vous pouvez utiliser la boite Filtre en haut.

10. Cliquez sur la couche pour la sélectionner :

11. Trouvez et sélectionnez également la couche south_poles_wfs. Vous devrez peut-&tre maintenir Ctrl.
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() Data Source Manager | WFS / OGC API - Features

Antarctic grounding line (exdudes ice shel...
Antarctic ice core locations
Antarctic ice shelves

Antarctic island coastlines
Antarctic island coastiines
Antarctic islands

Antarctic megadunes

Antarctic permanent research stations
Antarctic Polar Front

Antarctic suface elevation contours
Antarctica border

coastlines (exduding Antarctica)
countries (excuding Antarctica)
glader outlines

glaciers

International Date Line

land {exduding Antarctica)

South Pole of Cold

South Pole of Inaccessibility

South Pole, Geographic

South Pole, Geomagnetic

South Pole, Magnetic

Virtual Layer

SAP HANA

South Poles

WFS [ OGC API -
Features

Use title for layer name

Coordinate Reference System

EPSG:3031

Server Connections
nsidc.org
Connect New | Edit Remove
Q
Title “ Name
Antarctic coastline (indudes ice shelves) antarctic_ice_shelves_outline
Antarctic continent antarctic_continent

antarctic_coastline
antarctic_ice_cores
antarctic_ice_shelves_fil
antarctic_islands_coastlines
antarctica_islands_coastlines
antarctic_islands
antarctic_megadunes
antarctic_research_stations
antarctic_polar_front
antarctica_elevation_contours
antarctica_country_border
coastlines_exduding_antarctica

country_borders_exduding_antarctica

glacier_outlines

glaciers
international_date_line
land_exduding_antarctica
south_pole_of_cold
south_pole_inaccessibility
south_pole_geographic
south_pole_geomagnetic
south_pole_magnetic
south_poles_wfs

Only request features overlapping the view extent

Load Save

Abstract Sql
Bohlander, J. and T. Scambos. 2007, Ant...
Bohlander, J. and T, Scambos, 2007, Ant...
Bohlander, 1. and T. Scambos. 2007, Ant...
Maurer, 1. compiler, 2009, Deep ice core ...
Bohlander, J. and T, Scambos, 2007, Ant...
Bohlander, J. and T. Scambos. 2007, Ant...
Bohlander, J. and T. Scambos. 2007, Ant...
Bohlander, 1. and T. Scambos. 2007. Ant...
Bohlander, J. and T. Scambos, 2005, Qut...
Wikipedia contributors, 24 January 2007, ...
Orsi, A, and Ryan, U. 2001. Locations of ..
Liu, H., K. Jezek, B. Li, and Z. Zhao. 200...
Bohlander, 1. and T. Scambos. 2007. Ant...
Center for International Earth Sdence Inf...
Center for International Earth Sdence Inf...
Armstrong, R., B. Raup, 5.1.5. Khalsa, R ...
Mational Imagery and Mapping Agency (M...
Mational Geographic Society, 1992, Natio...
Center for International Earth Science Inf...
Wikipedia contributors. 23 January 2007. ...
Wikipedia contributors. 20 January 2007. ..
Labels the location of the South Pole {90 ...
McClean, 5. 24 January 2007, Geomagne...
McClean, 5. 24 January 2007. Geomagne...
Labels the location of various types of So...

Change...

Build query Close Help

12. Cliquez sur Ajouter.

Le chargement des couches peut prendre un certain temps. Lorsqu’elles seront chargées, elles apparaitront sur
la carte, montrant les contours de I’Antarctique et quelques points au-dela.
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() *Untitled Project — QGIS [m] ®
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help
DEBRRE UeLLAPPY "R BatlOR H-B8-§-5- GE#IE- -0 -
a2 wmBR . . - = ® 2 H
Layers
@ eT &AL
® south_poles_wfs
[T] antarctica border
| Q Type to locate (cri) Coordinate | -3.320.287 -4.724.303 | scale \.:47.773‘732\v| & Magnifier| 100% 2] Rotation [0,0° [2] ¥ Render @erscon @

Quelle est la différence avec une couche WMS ?

13. Sélectionnez I'une des couches et vous remarquerez que les outils de sélection d’éléments et de table d’attributs
sont activés. Ce sont des couches vecteur.

14. Sélectionnez la couche south_poles_wfs et ouvrez sa table d’attributs. Vous devriez voir ceci :

() south_poles_wfs — Features Total: 1, Filtered: 1, Selected: 0 - O X
= BENGTYERP BE =8
Id NAME -

1IU | Geographic South Pole

S ren T

Comme les points ont des attributs, nous sommes capable de les étiqueter, tout comme de changer leur
symbologie. Voici un exemple :
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(@ *Untitled Project — QGIS - O X

Project Edit View Layer Settings Plugins Vectyr Raster Database Web Mesh Progessing Help

NEERRY OPLLHPP A LD
BV A WMEBD
Layers @®

o il ® T &~ A0

south _poles wfs
| [-] antarctica_country_border

yoe to locate (Ctrl+K) Coordinate | -3.646.519 4.083.415 | ¥ Scae 45,277,572 ~ | @ Maanifier | 100% | Rotation |0,0° 2| ¥Render @ePsciaoz @

Différences avec des couches WMS

Un service de WEFS retourne la couche en elle-méme et pas uniquement une carte rendue avec. Cela vous donne un
acces direct a la donnée et signifie que vous pouvez changer sa symbologie et lancer des fonctions d’analyse dessus.
Néanmoins, cela se fait en transmettant beaucoup plus de données. Cela se révélera particulierement inadapté si les
couches que vous chargez ont des formes complexes, un grand nombre d’attributs ou de nombreuses entités ou encore
si vous chargez un grand nombre de couches. Les couches WES prennent un temps non négligeable a se charger a
cause de tout cela.

10.2.2 Follow Along: Interroger une couche WFS

Bien que cela soit possible d’interroger une couche WFS apres 'avoir chargée, c’est souvent plus efficace de I'interroger
avant de la charger. De cette facon vous n’interrogez que les entités que vous souhaitez, ce qui signifie que vous utilisez
moins de bande passante.

Par exemple, sur le serveur WES que nous avons récemment utilisé, il y a une couche appelée countries (excluding
Antarctica). Supposons que nous voulons savoir ou se trouve I’Afrique du Sud par rapport a la couche south_poles_wfs

2N 2

(et peut-€tre aussi la couche antarctica_country_border) qui a déja été chargée.

Il y a deux manieres de le faire. Vous pouvez charger la couche countries ... entierement, et faire une requéte comme
d’habitude une fois la couche chargée. Cependant, la transmission des données pour tous les pays mondiaux et
n’utiliser uniquement que les données pour I’Afrique du Sud semble étre un peu du gaspillage de bande passante. En
fonction de votre connexion, ce jeu de données peut prendre plusieurs minutes a se charger.

La maniere alternative est de faire une requéte pour filter avant méme de charger la couche du serveur.
1. Activez l'onglet WFS / OGC API Features dans la boite de dialogue Gestionnaire de source de donnees.

2. Connectez-vous au serveur que nous avons utilis€ précédemment et vous devriez voir la liste des couches
disponibles.

3. Trouvez et double-cliquez sur la couche countries (excluant I’Antarctique). Le nom de la couche est
country_borders_excluding_antarctica. Vous pouvez également sélectionner la couche et
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appuyer sur le bouton Construire la requéte au bas de la boite de dialogue :

(3 Data Source Manager — WFS / OGC API - Features

i Browser

; Point Cloud

Delimited Text

Postgr

SAP HANA

+
ﬁ WMSMIMTS

WFS [ OGC API -
Features

Server Connections
nsidc.org
Connect New | Edit
Q
Title i

Antarctic coastline (indudes ice shelves)

Antarctic continent

Antarctic grounding line (exdudes ice shel...

Antarctic ice core locations

Antarctic ice shelves

Antarctic island coastlines

Antarctic island coastlines

Antarctic islands

Antarctic megadunes

Antarctic permanent research stations

Antarctic Polar Front

Antarctic suface elevation contours

Antarctica border

coastlines (exduding Antarctica)
duding Antarctica)

glacier outiines

glaciers

International Date Line

land (exduding Antarctica)

South Pole of Cold

South Pole of Inaccessibility

South Pole, Geographic

South Pole, Geomagnetic

South Pole, Magnetic

South Poles

Use title for layer name

Remove

Name
antarctic_ice_shelves_outline
antarctic_continent
antarctic_coastline
antarctic_ice_cores
antarctic_ice_shelves_fill
antarctic_islands_coastlines
antarctica_islands_coastlines
antarctic_islands
antarctic_megadunes
antarctic_research_stations
antarctic_polar_front
antarctica_elevation_contours
antarctica_country_border

glaciers
international_date_line
land_exduding_antarctica
south_pole_of _cold
south_pole_inaccessibility
south_pole_geographic
south_pole_geomagnetic
south_pole_magnetic
south_poles_wfs

Only request features overlapping the view extent

Coordinate Reference System

Load

Abstract

Bohlander, 1, and T, Scambos, 2007, Antarctic ...
Bohlander, 1. and T. Scambos. 2007, Antarctic ...
Bohlander, 1. and T. Scambos. 2007, Antarctic ...
Maurer, J. compiler. 2003, Deep ice core locatio...
Bohlander, 1. and T. Scambaos. 2007, Antarctic ...
Bohlander, 1. and T, Scambos, 2007, Antarctic ...
Bohlander, 1. and T. Scambos. 2007, Antarctic ...
Bohlander, 1. and T. Scambos. 2007, Antarctic ...
Bohlander, J. and T, Scambos, 2005, Qutlines o...
Wikipedia contributors. 24 January 2007. List of ..
Orsi, A. and Ryan, U. 2001. Locations of the va...
Liu, H., K. Jezek, B. Li, and Z. Zhao. 2001. Rad...
Bohlander, 1. and T. Scambos. 2007, Antarctic ...
Center for International Earth Sdence Informati...

nter for International Earth ce Informa

Armstrong, R., B. Raup, 5.1.5. Khalsa, R. Barry...
National Imagery and Mapping Agency {(NIMA). ...
National Geographic Society. 1992, National Ge...
Center for International Earth Sdence Informati...
Wikipedia contributors. 23 January 2007. Pole o...
Wikipedia contributors. 20 January 2007, South...
Labels the location of the South Pole (90 deg 5, ...
McClean, 5. 24 January 2007, Geomagnetism Fr...
McClean, 5. 24 January 2007, Geomagnetism Fr...
Labels the location of various types of South Pal...

O >
-
Save
Sal

EPSG:3031 Change...
Build query Close Add Help
4. Dans la boite de dialogue qui s’affiche, saisissez la requéte suivante SELECT *  FROM
country_borders_excluding_antarctica WHERE "Countryeng" = 'South Africa'
dans la zone SQL.
(2 SOL Query Composer X
SELECT FROM country borders excluding antarctica WHERE "( =
SQL Statement South Africa |
Columns Data
Columns =
Table(s) |country_borders_excluding_antarctica
Where Countryeng = 'South Africa’
Functions =5
Spatial predicates -
Order by Operators =
Reset oK Cancel Help
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5. Pressez OK.

6. L’expression utilisée apparaitra comme la valeur Sq/ de la couche cible :

(2} Data Source Manager — WFS / OGC AP - Features - m] =
)

= Server Connections

nsidc.org -
Connect New | Edit Remove Load Save
Q,
Title “ Name Abstract Sgl

Point Cloud Antarctic coastine {incudes ice shelves) antarctic_ice_shelves... Bohlander, ...
Antarctic continent antarctic_continent Bohlander, ...

Delimited T Antarctic grounding line (exdudes ice ... antarctic_coastine Bohlander, ...

* Antarctic ice core locations antarctic_ice_cores Maurer, 1. ...
Antarctic ice shelves antarctic_ice_shelves... Bohlander, ...
Antarctic island coastiines antarctic_islands_coa .. Bohlander, ...
Antarctic island coastiines antarctica_islands_co .. Bohlander, ...
Antarctic islands antarctic_islands Bohlander,
Antarctic megadunes antarctic_megadunes  Bohlander,
Antarctic permanent research stations  antarctic_research_s... Wikipediac...
Antarctic Polar Front antarctic_polar_front  Orsi, A. an...
Antarctic suface elevation contours antarctica_elevation_... Liu, H. K. 1.
Antarctica border antarctica_country_b... Bohlander, ...
coastiines (exduding Antarctica) coastiines_exduding
) country_ M country _|

dladier outiines glacier_outlines Armstrong, ..
glaciers dlaciers National Im..
International Date Line international_date_line MNational Ge...
land (exduding Antarctica) land_excluding_antar . Center for ...
South Pole of Cold south_pole_of_cold Wikipedia c.
South Pole of Inaccessibility south_pole_inaccessi... Wikipedia c
South Pole, Geegraphic south_pole_geographic Labels the |..
South Pole, Geomagnetic south_pole_geomagn... McClean, S...
South Pole, Magnetic south_pole_magnetic  McClean, S...
South Poles south_poles_wfs Labels the |..

WFS f OGC API -
Features

Uze title for layer name

Only request features overlapping the view extent

Coordinate Reference System

EPSG:3031 Change..

Build query Close Add Help

7. Cliquez sur Ajouter avec la couche sélectionnée comme ci-dessus. Seul le pays dont la valeur Countryeng
est South Africa serachargé a partir de cette couche :
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() “Untitled Project — QGIS - [m] >
Project Edit View Layer Setfings Plugins Vector Raster Datsbase Web Mesh Processing Help

[ BEE UL, HAPRPPD M A LG - @ BH I EH-¥-6
WOV /2 B EW =4 qa qegqgpgyg @ 4 B

Layers &=
« @& T &-3 80
| [[] country borders excluding antarct

V| » south_poles_wfs
! [--] antarctica_country_border -

7 South Africa

ographic South Pale. » )

)}, Type to locate (Ctrl+K) Coordinate | -1.120.199 -2.473.965 ¥ Scale 1:48.583.784 ~ | @ Magnifier | 100% % | Rotaten |0,0° 2| v/ Render @Epscizozr @

Avez-vous remarqué I'icone E a cOté de la couche country_borders_excluding_antarctica ?
Elle indique que la couche chargée est filtrée et n’affiche pas toutes ses entités dans le projet.

8. Vous n'avez pas a le faire, mais si vous avez testé les deux méthodes, vous remarquerez que cette derniére est
beaucoup plus rapide que le chargement complet des pays avant de les filtrer !

Notes sur la disponibilité des WFS

Il est rare de trouver un WES hébergeant les entités dont vous avez besoin, surtout si votre besoin est trés spécifique.
La raison pour laquelle un WES est relativement rare est a cause des grandes quantités de données qui doivent étre
transmises pour décrire toute une entité. Il n’est donc pas trés rentable d’héberger un WES plutot qu'un WMS, qui
ne transmet que des images.

Le type le plus commun de WES que vous rencontrerez sera probablement sur un réseau local ou méme sur votre
propre ordinateur, plutdt que sur internet.

10.2.3 In Conclusion

Les couches WFS sont préférables aux couches WMS si vous avez besoin d’'un acces direct aux attributs et aux
géométries de ces couches. Cependant, en considérant le volume de données qui ont besoin d’étre téléchargées (ce
qui mene a des problemes de rapidité et aussi au manque de serveurs WFS publics facilement accessibles) ce n’est
pas toujours possible d’utiliser un WES a la place d'un WMS.
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10.2.4 What’s Next?

Dans la prochaine lecon, vous verrez comment utiliser QGIS pour fournir des services OGC.
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cHAPTER 11

Module: QGIS Server

Ce module est une contribution de Tudor Bérascu.
Dans ce module, nous allons voir comment installer et utiliser QGIS Server.

Pour en savoir plus sur QGIS Server, lisez le QGIS-Server-manual.

11.1 Lesson: Installer QGIS Server

Le but de cette lecon: Apprendre comment installer QGIS Server sur Debian Stretch. Avec des variations
négligeables, vous pouvez également le suivre pour toute distribution basée sur Debian comme Ubuntu et ses dérivés.

Note:  Dans Ubuntu, vous pouvez utiliser votre utilisateur le plus couramment utilisé, en ajoutant sudo
aux commandes nécessitant des autorisations administrateur. Dans Debian, vous pouvez travailler en tant
quadministrateur (root), sans utiliser sudo.

11.1.1 Installer Follow Along: depuis les packages

Dans cette lecon, nous allons seulement faire I'installation a partir de paquets comme indiqué ici .

Installez QGIS Server avec:

apt install ggis-server --no-install-recommends --no-install-suggests

# 1f you want to install server plugins, also:
apt install python3-ggis

QGIS Server doit étre utilisé en production sans que QGIS Desktop (avec le serveur X qui 'accompagne) soit installé
sur la méme machine.
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11.1.2 Follow Along: Exécutable QGIS Server

L’exécutable QGIS Server est qgis—-mapserv.fcgi. Vous pouvez vérifier a quel endroit il a été installé au moyen
delacommande: find / —-name 'ggis_mapserv.fcgi' quidevraitrenvoyer quelque chose comme /usr/
lib/cgi-bin/ggis_mapserv.fcgi.

Optionnellement, si vous voulez faire un test en ligne de commande a ce moment-la, vous pouvez lancer la commande
/usr/lib/cgi-bin/ggis_mapserv.fcgi —--version qui devrait produire quelque chose comme :

QGIS 3.21.0-Master 'Master' (1c70953fle)

QGIS code revision 1c70953fle

Qt version 5.15.2

Python version 3.9.5

GDAL/OGR version 3.2.2

PROJ version 7.2.1

EPSG Registry database version v10.008 (2020-12-16)
GEOS version 3.9.0-CAPI-1.16.2

SQLite version 3.34.1

0S Ubuntu 21.04

Nous verrons plus loin comment faire des requétes WMS.

11.1.3 Configuration HTTP du Serveur

Pour accéder au serveur QGIS depuis un navigateur internet, il faut mettre en place un serveur HTTP. L’installation
du serveur HTTP Apache est décrite dans la section httpserver.

Note: Si vous avez installé QGIS Server sans serveur X (inclus avec Linux Desktop) et si vous voulez aussi utiliser
la commande GetPrint alors il faut installer un serveur X factice et dire a QGIS Server de I'utiliser. Pour ce faire,
consultez le processus d’installation de Xvfb.

11.1.4 Follow Along: Créer un autre virtual host

Créons un autre virtual host Apache pointant sur QGIS Server. Vous pouvez choisir n'importe quel nom vous faisant
plaisir (coco.bango, super.duper.training, example.com, etc.) mais pour faire simple nous allons
choisir myhost.

* Configurons le nom myhost pour qu’il pointe vers I'IP localhost en ajoutant 127.0.0.1 x au /etc/
hosts avec la commande suivante : sh —-c¢ "echo '127.0.0.1 myhost' >> /etc/hosts" ou
en éditant manuellement le fichier avec gedit /etc/hosts.

* Nous pouvons vérifier que myhost pointe sur le localhost en exécutant dans le terminal la commande ping
myhost qui devrait afficher :

ggis@ggis:~$ ping myhost

PING myhost (127.0.0.1) 56(84) bytes of data.

64 bytes from localhost (127.0.0.1): icmp_seg=1 ttl=64 time=0.024 ms
64 bytes from localhost (127.0.0.1): icmp_seg=2 ttl=64 time=0.029 ms

* Voyons si nous pouvons accéder a QGIS Server depuis le site myhost en exécutant : curl http://
myhost/cgi-bin/ggis_mapserv.fcgi ou en accédant a 'URL depuis le navigateur de votre box
Debian. Vous obtiendrez probablement :

<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>
<h1>Not Found</hl>
(suite sur la page suivante)
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(suite de la page précédente)

<p>The requested URL /cgi-bin/qggis_mapserv.fcgi was not found on this server.</p>
<hr>

<address>Apache/2.4.25 (Debian) Server at myhost Port 80</address>

</body></html>

* Apache ne sait pas qu’il est censé répondre a des requétes pointant vers le serveur nommé myhost. Pour
configurer I'héte virtuel, le plus simple serait de créer un fichier monhéte.conf dans le répertoire /
etc/apache2/sites—-available qui aurait le méme contenu que le fichier qgis.demo.conf sauf
pour la ligne ServerName qui devrait étre ServerName myhost. Vous pouvez également changer
I’emplacement des logs, sinon les logs des deux hotes virtuels seront partagés, mais ceci est optionnel.

¢ Activons maintenant I'hote virtuel avec a2ensite myhost . conf etrechargeons ensuite le service Apache
avec service apache2 reload.

* Si vous essayez de nouveau d’accéder a http://myhost/cgi-bin/qgis_mapserv.fcgi vous verrez que tout
fonctionne maintenant !

11.1.5 In Conclusion

Vous avez appris comment installer les différents versions de QGIS Server depuis les paquets, comment configurer
Apache avec QGIS Server, sur Debian basé sur Linux.

11.1.6 What’s Next?

Maintenant que vous avez installé QGIS server et qu’il est accessible via le protocole HTTP, nous devons apprendre a
accéder a certains des services qu’il peut offrir. Le sujet de la prochaine lecon est d’apprendre comment accéder aux
services WMS de QGIS Server.

11.2 Lesson: Serving WMS

Les données utilisées pour cet exercice sont disponibles dans le sous-répertoire ggis-server—tutorial-data
du répertoire training data que vous avez téléchargé. Pour des raisons de commodité et pour éviter d’éventuels
problemes de permissions, nous supposerons que ces fichiers sont stockés dans le répertoire /home/qgis/
projets. Par conséquent, adaptez les instructions suivantes a votre chemin d’acces.

Le jeu de donnée contient un projet QGIS world. ggs, préparé pour étre servi par QGIS Server. Si vous souhaitez
utiliser votre propre projet ou apprendre comment préparer un projet, allez voir la section Creatingwmsfromproject.

Note: Ce module présente les URL afin que le public puisse facilement distinguer les parametres et les valeurs des
parametres. Alors que le format normal est:

[...&fieldlzvaluel&fiele:value2&fieldB:valueB

ce tutoriel utilise :

sfieldl=valuel
&field2=value?2
sfield3=value3

Les coller dans Mozilla Firefox fonctionne parfaitement mais d’autres navigateurs internet comme Chrome peuvent
ajouter des espaces indésirables entre les paires field:parameter. Ainsi, si vous rencontrez ce probleme vous
pouvez soit utiliser Firefox ou modifier les URL afin qu’il soit en format de ligne simple.

Faisons une requéte WMS GetCapabilities dans le navigateur web ou avec curl :
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http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs

Dans la configuration Apache de la lecon précédente, la variable QGIS_PROJECT_F ILE définit le projet par défaut
a: file: /home/qgis/projects/world.qgs. Cependant, dans la demande ci-dessus, nous avons utilisé le parametre map
pour étre explicite et pour montrer qu’il peut étre utilisé pour pointer n’importe quel projet. Si vous supprimez le
parametre map de la demande ci-dessus, QGIS Server affichera la méme réponse.

En interrogeant I'URL GetCapabilities avec un client WMS, celui-ci récupere en réponse un document XML
contenant des métadonnées sur le serveur (quelles couches il contient, son emprise, les formats, la version WMS,
etc.).

Comme QGIS est également un ogc-wms, vous pouvez créer une nouvelle connexion au serveur WMS a I'aide de I'url
GetCapabilities ci-dessus. Voir la section Lecon : Web Mapping Services (WMS) ou ogc-wms-servers sur la facon de
le faire.

En ajoutant la couche WMS countries a votre projet QGIS, vous devriez obtenir une image comme celle ci-
dessous :
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Figurel1.1: QGIS Desktop consommant le service WMS de la couche pays QGIS Server

Note: QGIS server dessert les couches qui sont définies dans le projet world.ggs. En ouvrant le projet avec
QGIS, vous pouvez voir qu’il existe plusieurs styles pour la couche des pays. QGIS server en est également conscient
et vous pouvez choisir le style que vous souhaitez dans votre demande. Le style classé par populationa
été choisi dans I'image ci-dessus.
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11.2.1 Journal

Lorsque vous installez un serveur, les journaux sont toujours importants car ils vous montrent ce qui se passe. Nous
avons mis en place dans le fichier * . conf les journaux suivants :

¢ les fichiers journaux de QGIS Server a /logs/ggisserver.log
* ggisplatform.demo Apache access log at ggisplatform.demo.access.log
* ggisplatform.demo Journal d’erreurs Apache a 'adresse qgisplatform.demo.error.log

Les fichiers journaux sont simplement des fichiers texte, vous pouvez donc utiliser un éditeur de texte pour les
consulter. Vous pouvez également utiliser la commande tail dans un terminal : sudo tail -f /logs/
ggisserver.log.

Le terminal produira ainsi en permanence ce qui est écrit dans ce fichier journal. Vous pouvez également faire ouvrir
trois terminaux pour chacun des fichiers journaux de cette maniere :

qgis@qgis: ~ = o x
File Edit WView Search Terminal Help

:~% sudo tail -f /var/log/apache2/qgisplatform.demo.error.log

:~% sudo tail -f /var/log/apache2/qgisplatform.demo.error.log

qgis@cqgis: ~ “ o x

File Edit Wiew Search Terminal Help

208 11378 "-" "curl/7.52.1"
127.0.0.1 - - [17/Mar/2017:04:09:41 -0480] "GET /cgi-bin/qgis mapserv.fcgi?SERVICE=W
MS&VERSION=1.3.0&REQUEST=GetCapabilities&map=/home/qgis/projects/world.qgs HTTP/1.1"
200 11378 "-" "curl/7.52.1"

127.0.6.1 - - [17/Mar/2017:04:09:42 -04008] "GET /cgi-bin/qgis mapserv.fcgi?SERVICE=W
MS&VERSION=1.3.0&REQUEST=GetCapabilities&map=/home/qgis/projects/world.qgs HTTR/1.1"
208 11378 "-" "curl/7.52.1" I

qgis@qgis: ~ = o x
File Edit View Search Terminal Help

[1732][04:09:42] Sent 1 blocks of 11205 bytes
[1732][04:09:42] Request finished in 3 ms
°C

] qgis:~$ sudo tail -f /logs/qgisserver.log
E1?32][04:89:42] MAP: /home/qgis/projects/world.qgs
11732][04:09:42] REQUEST:GetCapabilities
[1732][04:09:42] SERVICE:WMS
[1732][04:09:42] VERSION:1.3.0
[1732][04:09:42] Found capabilities document in cache
[1732][04:09:42] Checking byte array is ok to set...
[1732]1[04:09:42] Byte array looks good, setting response...
[1732]1[04:09:42] Sending HTTP response
[1732][04:09:42] Sent 1 blocks of 11205 bytes
[1732][04:09:42] Request finished in 3 ms

Figure11.2: Utilisation de la commande tail pour visualiser la sortie des journaux de QGIS server

Lorsque vous utilisez QGIS Desktop pour consommer les services WMS QGIS server, vous verrez toutes les
demandes que QGIS envoie au serveur dans le journal d’acces, les erreurs QGIS server dans le journal QGIS Server,
etc.
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Note:

* Si vous regardez les journaux dans les sections suivantes, vous devriez avoir une meilleure compréhension de
ce qui se passe.

¢ Enredémarrant Apache tout en regardant dans le journal QGIS server, vous pouvez trouver quelques pointeurs
supplémentaires sur la facon dont les choses fonctionnent.

11.2.2 Requétes GetMap

Afin d’afficher la couche count ries, QGIS Desktop, comme tout autre client WMS, utilise les requétes GetMap.

Une simple requéte ressemble a:

http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?MAP=/home/ggis/projects/world.qgs

& SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetMap
&BBOX=-432786,4372992, 3358959, 7513746
&SRS=EPSG:3857

&WIDTH=665

&HEIGHT=551

&LAYERS=countries

&FORMAT=1image/jpeg

Avec la requéte précédente, vous obtiendrez le résultat suivant :

Figure : simple requéte GetMap QGIS server
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Figurel1.3: Réponse de Qgis server apres une simple demande GetMap

11.2.3 Try Yourself Modifier les parameétres d’image et de couches

Sur la base de la demande ci-dessus, remplacons la couche countries par une autre.

Afin de voir quelles autres couches sont disponibles, vous pouvez ouvrir le projet wor1d . ggs dans QGIS et regarder
son contenu. Gardez cependant a I'esprit que les clients WMS n’ont pas acces au projet QGIS, ils se contentent
d’examiner le contenu des documents relatifs aux capacités.

11 existe également une option de configuration qui permet a certaines couches du projet QGIS d’étre ignorées par le
QGIS lorsqu’il dessert le service WMS.

Ainsi, vous pouvez regarder la liste des couches lorsque vous pointez QGIS Desktop vers I'URL
GetCapabilities ou vous pouvez essayer de trouver d’autres noms de couches dans la réponse XML
GetCapabilities.

Un des noms de couches que vous pourriez trouver et qui fonctionne est countries_shapeburst. Vous pouvez
en trouver d’autres mais gardez a 'esprit que certains ne sont pas visibles a une si petite échelle et que vous pourriez
donc obtenir une image vierge comme réponse.

Vous pouvez également jouer avec d’autres parametres, comme par exemple changer le type d’'image retournée en
image/png.
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11.2.4 Follow Along: Utiliser les paramétres Filtre, Opacites et Styles

Faisons une autre requéte ajoutant une autre couche, quelques parametres basiques, FILTER et OPACITIES, mais
aussi le parametre standard STYLES.

http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?MAP=/home/qggis/projects/world.qgs

& SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetMap
&§BBOX=-432786,4372992,3358959, 7513746
&SRS=EPSG:3857

&WIDTH=665

&HEIGHT=551

&FORMAT=1image/jpeg

&LAYERS=countries, countries_shapeburst
&STYLES=classified_by_name, blue

&OPACITIES=255, 30

&FILTER=countries:"name" IN ( 'Germany' , 'Italy' )

Avec la requéte précédente, vous obtiendrez le résultat suivant :

Figure11.4: Réponse a une demande GetMap avec les parametres FILTER et OPACITIES

Comme vous pouvez le voir sur I'image ci-dessus, entre autres choses, nous avons demandé a QGIS Server de ne
rendre que Germany et Italy dans la couche des pays.
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11.2.5 Follow Along: Utiliser le redimensionnement

Lancons une autre requéte GetMap utilisant la fonctionnalité redlining et le parametre SELECTION détaillé dans
la section WMS :

http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?MAP=/home/qggis/projects/world.qgs

& SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetMap

&§BBOX=-432786,4372992,3358959, 7513746

&SRS=EPSG:3857

&WIDTH=665

&HEIGHT=551

&LAYERS=countries, countries_shapeburst

&FORMAT=image/jpeg

&HIGHLIGHT_GEOM=POLYGON ( (590000 6900000, 590000 7363000, 2500000 7363000, 2500000.
—6900000, 590000 6900000))

&HIGHLIGHT SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
—<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter.
—name="stroke">%233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</
—SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
—LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_ LABELSTRING=QGIS Tutorial

&HIGHLIGHT_LABELSIZE=30

&HIGHLIGHT_LABELCOLOR=%23000000

&HIGHLIGHT_ LABELBUFFERCOLOR=%23FFFFFF

&HIGHLIGHT LABELBUFFERSIZE=3

&SELECTION=countries:171, 65

Avec la requéte précédente dans un navigateur web, vous obtiendrez le résultat suivant :
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France

Figure11.5: Réponse a une demande avec la fonction REDLINING et le parametre SELECTION

Vous pouvez voir sur I'image ci-dessus que les pays avec les ids 171 et 65 ont été mis en évidence en jaune (Roumanie
et France) en utilisant le parametre SELECTION et nous avons utilisé la fonction REDLINING pour superposer
un rectangle avec le label QGIS Tutorial.

11.2.6 Demandes GetPrint

Une fonctionnalité géniale de QGIS Server est qu’il utilise les mises en page de QGIS Desktop. Vous pourrez en
apprendre plus dans la section wms_getprint.

Si vous ouvrez le projet wor1d. ggs avec QGIS Desktop, vous trouverez une mise en page nommée Population
distribution. Une requéte simplifiée Get Print qui illustre cette fonctionnalité étonnante est :

http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?map=/home/qggis/projects/world.qgs
&SERVICE=WMS

&VERSION=1.3.0&

REQUEST=GetPrint

§FORMAT=pdf

&TRANSPARENT=true

&SRS=EPSG:3857

&DPI=300

&TEMPLATE=Population distribution
&map0:extent=-432786,4372992,3358959, 7513746
&LAYERS=countries
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Figurel1.6: Montre le pdf résultant de la demande GetPrint ci-dessus

Naturellement, il est difficile d’écrire vos demandes GetMap, GetPrint, etc.

QGIS Web Client ou QWC est un projet de client Web qui peut fonctionner avec QGIS Server afin que vous puissiez
publier vos projets sur le Web ou vous aider a créer des requétes QGIS Server pour une meilleure compréhension des
possibilités.

Vous pouvez l'installer comme ceci :

En tant qu’utilisateur ggis, allez dans le répertoire home avec cd /home/ggis.
Téléchargez le projet QWC depuis ici et dézippez-le.

Faites un lien symbolique vers le répertoire /var/www/html car c’est le DocumentRoot que nous avons
mis en place dans la configuration de I'hote virtuel. Si vous avez décompressé I'archive sous /home /qgis/
Downloads/QGIS-Web-Client-master, nous pouvons le faire avec sudo 1n -s /home/ggis/
Downloads/QGIS-Web-Client-master /var/www/html/.

N

Accédez a http://qgisplatform.demo/QGIS-Web- Client-master/site/qgiswebclient.html?map=/home/qgis/
projects/world.qgs a partir de votre navigateur Web.

Vous devriez maintenant étre en mesure de voir la carte comme dans la figure suivante :
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Figurel1.7: Le client Web QGIS consomme le projet world.qgs

Si vous cliquez sur le bouton Imprimer dans QWC, vous pouvez créer interactivement des demandes GetPrint.
Vous pouvez également cliquer sur I'icne ? dans le QWC pour accéder a I'aide disponible afin de mieux découvrir
les possibilités du QWC.

11.2.7 In Conclusion

Vous avez appris comment utiliser QGIS server pour fournir des services WMS.
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11.2.8 What’s Next?

Ensuite, vous verrez comment utiliser QGIS comme frontal pour le célebre SIG GRASS.
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Module: GRASS

GRASS (Geographic Resources Analysis Support System) est un logiciel libre de SIG bien connu qui dispose d’une
large gamme de fonctions SIG. Il a été publié pour la premiere fois en 1984 et il a subit de nombreuses améliorations
au fil du temps. QGIS vous permet d’utiliser les performants outils SIG de GRASS directement.

12.1 Lesson: Configuration de GRASS

Lutilisation de GRASS dans QGIS vous oblige a penser I'interface d’'une maniere 1égerement différente. Rappelez-
vous que vous ne travaillez pas directement dans QGIS, mais que vous travaillez dans GRASS via QGIS. Par
conséquent, assurez-vous que vous avez installé QGIS Desktop avec le support de Grass.

£7 Pour ouvrir une session QGIS avec GRASS disponible sur Windows, vous devez cliquer sur I'icone « Bureau QGIS
avec GRASS ».

Le but de cette lecon : commencer un projet GRASS dans QGIS.

12.1.1 Follow Along: Start a New GRASS Session

Pour lancer GRASS a partir de QGIS, vous devez I'activer comme pour tout autre extension :
1. Tout d’abord, ouvrir un nouveau projet QGIS.

2. Dans le Gestionnaire d’extension, activez GRASS dans la liste :
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Plugins | Installed (9)

‘ﬁ; Installed v| [§ DB Manager This is a core plugin, so you can't uninstall it
i Geometry Checker
GRASS 8 *
’
%3 mnstall fromzip i & GRASS GIS provider
v @ MetaSearch Catalog Client
# Settings ky# OfflineEditing
&b OrfeoToolbox provider

9 Not installed

GRASS 8 (Geographic Resources Analysis Support System)

Category Plugins

Installed version Version 2.0
v| % Processing

I Topology Checker

I Aide b @ Fermer

La barre d’outils GRASS et le panneau GRASS apparaitront :
Figure12.1: GRASS toolbar

qﬁ GRASS Tools 3]

Mo mapset is open. You can open a GRASS mapset from the browser using the
mapset item's context menu action Open mapset.

Figure12.2: GRASS Panel

Le panneau GRASS n’est pas actif car, avant de pouvoir utiliser GRASS, vous devez créer un « MapSet ». GRASS
fonctionne toujours dans un environnement de base de données, ce qui signifie que vous devez importer toutes les
données que vous voulez utiliser dans une base de données GRASS.

La base de données GRASS a une structure simple, méme si a premiere vue elle semble trés compliquée. La chose
la plus importante que vous devez savoir est que le niveau supérieur de la base de données est la « localisation ».
Chaque « Localisation » peut contenir différents « Mapset » : dans tous les « Mapset », vous trouverez le « Mapset
PERMANENT » car il est créé par défaut par GRASS. Chaque « Mapset » contient les données (raster, vecteur, etc)
d’une structure particuliere, mais ne vous inquiétez pas, GRASS s’en chargera pour vous.

Rappelez-vous simplement : Locat ion contient Mapset qui contient les données. Pour plus d’informations, visitez
le site web de GRASS.
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Database Location Mapset Maps
grassdata nc_spm PERMANENT
new_highway raster elevation
landcover
vector streets
buildings
3D raster soils
temporal landsat
wake_county
usa_albers

world_lat_lon

Figure12.3: Structure de la base de données GRASS (a partir des documents GRASS)

12.1.2 Follow Along: Démarrer un nouveau projet GRASS

1. Cliquez sur le menu Plugins » GRASS » Nouveau jeu de carte :

*Untitled Project - QGIS [tm] = o x
Project Edit View Layer Settings [l Vector Raster Database Web Processing Help
BELDE (O & 4% Manage and Install Plugins... G N E# =9 0
y 7 @ . Python Console Cul+Al+P | a- m =
(o] M t
Layers 18 Lpen Mapse S Tools (=)
. Plugin Reloader
- « @l ® T &, B AL ‘mapset is open. You can open a GRASS mapset from the browser using the
] set item's context menu action Open mapset.
W % Open GRASS Tools
o g
”u ¥
- A GRASS Options
Layers Browser
Q Type to locate (Ctrl+K) Ready Coordinate| -0.405,1.194 |$§ Scale|1:1692146 - | @ Magnifier | 100% | Rotation |0.0* <! W/ Render @ EpsGi4326 @

11 vous sera demandé de choisir 'emplacement de la base de données GRASS.

2. Définissez le dossier qui sera utilisé par GRASS pour y placer sa base de donnée :
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New Mapset

GRASS Database

Database directory |/home/delazj/exercise_data

GRASS data are stored in tree directory structure. The GRASS database is the top-level
directory in this tree structure.

Suivant = Annuler

3. Cliquez sur Suivant

GRASS doit créer une « Localisation », qui décrit 'étendue maximale de la zone géographique dans laquelle vous
travaillerez, aussi appelée « Région ».

Note: la Région est extrémement importante pour GRASS car elle décrit 1a zone dans laquelle toutes les couches
seront prises en compte pour GRASS. Tout ce qui est a 'extérieur ne sera pas pris en compte. Ne vous inquiétez pas,
vous pouvez toujours modifier I'étendue de la Région GRASS apres la création du Secteur

1. Appelez le nouveau lieu « Afrique du Sud » :

New Mapset

GRASS Location

® Create new location |SouthAfrica

The GRASS location is a collection of maps for a particular territory or project.

< Précédent Annuler

2. Cliquez sur Suivant

3. Nous allons travailler avec « TPS 84 », alors cherchez et sélectionnez ce CRS :
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New Mapset

Projection

Mot defined
# Projection
Filter |

Recently Used Coordinate Reference Systems

Coordinate Reference System Authority ID

- EPS x
IAU_2015:200005200 - 52 Europa (2015) - ... IAU_2015:200005200 o

Predefined Coordinate Reference Systems Hide deprecated CRSs

Coordinate Reference System

Authority ID =

WGS 72BE EPS5G:4324

WGS 84 EP5G:4326

WG5S B4 (CR584) OGC:CR584

WGS 84 (G150 FPSG:8055 %
L 3
WGS 84 =
Properties

# Geographic (uses latitude and
longitude for coordinates)
® [ynamic (relies on a datum

< Précédent Annuler

4. Cliquez sur Suivant

5. Maintenant, sélectionnez la région Afrique du Sud depuis la liste déroulante et cliquez sur Définir :
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New Mapset

Default GRASS Region

North |-21.270000000
West |13.680000000 East (33.980000000

South (-35.900000000

Calculate from | Layer ~||Layout Map - ||Bookmark -
Map Canvas Extent Draw on Canvas
Preset regions | South Africa - Set

The GRASS region defines a workspace for raster modules. The default region is valid
for one location. It is possible to set a different region in each mapset. It is possible to
change the default location region later.

< Précédent | | Suivant = Annuler

6. Cliquez sur Suivant

7. Créez un jeu de donnée, qui est le fichier sur lequel vous allez travailler.

New Mapset

Mapset

Mew mapset

| grass_maps ed

The GRASS mapset is a collection of maps used by one user. A user can read maps from
all mapsets in the location but he can open for writing only his mapset (owned by user).

< Précédent | | Suivant = Annuler

Une fois que vous avez terminé, vous verrez un dialogue vous demandant un résumé de toutes les informations
saisies.
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New Mapset

Create New Mapset

Database : fhome/delazj/exercise_data
Location : SouthAfrica

Mapset : grass_mapset

v| Open new mapset

< Précédent|| Terminer Annuler

8. Cliquez sur Terminer.
9. Cliquez sur OK dans la fenétre de succes.

Vous verrez que le panneau GRASS deviendra actif et que vous pourrez commencer a utiliser tous les outils GRASS.

12.1.3 Follow Along: Chargement des données vecteur dans GRASS

Vous avez maintenant une carte vierge et avant de pouvoir commencer a utiliser tous les outils GRASS, vous devez
charger les données dans la base de données GRASS, plus précisément dans le « MapSet ». Vous ne pouvez pas
utiliser les outils GRASS avec des couches qui ne sont pas chargées dans un « MapSet » GRASS.

11 existe de nombreuses fagons différentes de charger des données dans la base de données GRASS. Commengons
par la premiere.

Follow Along: Load data using the QGIS Browser

Dans la section [27] The Browser Panel nous avons vu que la fagon la plus simple et la plus rapide de charger les
données dans le QGIS est le panneau Browser.

Les données GRASS sont reconnues par le navigateur QGIS comme des données GRASS réelles et vous pouvez le

[
i P
remarquer car vous verrez I'icone GRASS a c6té du jeu de cartes GRASS. De plus, vous verrez I'icone @ a coté du
Mapset qui est ouvert.
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Browser (&) (]
e THO
- Favorites 5
= B9 training manual
v B forms

~ B grass

~ B9 grassdata
v [ SouthAfrica
* & SouthaAfrica
& grass_mapset
b PERMANENT
v [ postgis
v [ processing
v [ projected data
v [ ggis-server-tutorial-data

Note: Vous verrez une réplique de 'emplacement GRASS comme un dossier normal : Les données « MapSet » de

GRASS sont celles qui se trouvent dans le dossier ¥/

Vous pouvez facilement glisser et déposer des couches d’un dossier vers le GRASS Mapset.
Essayons d’importer la couche roads dans le jeu de cartes grass_mapset de la localisation SouthAfrica.

Allez dans le navigateur, et faites simplement glisser la couche roads du fichier training_data.gpkg
GeoPackage dans le jeu de cartes grass_mapset.
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Browser (&) (]
LT ™O
Y |
* [ exercise data 1=
5 forms
v 5 grass

v [ grassdata
» 5 SouthAfrica
* 4 SouthAfrica

» ¢ grass_mapset
(= reclass_aspect.txt
(~ reclass_g_dem.kxt
network_analysis
plugins
poskgis
processing
projected data
qgis-server-tutorial-data
raster
school_property _photos
shapefile
styles
symbols
world

() example
» =l landuse.sqlite
* = training_data.gpkg

- buildings
= restaurankts

. roads = |

b . . . . . . .

FAR AR AR AR AR AW AN AW AN AW AN

v v

1 b

C’est tout ! Si vous développez le Mapset, vous verrez la couche roads importée. Vous pouvez maintenant charger
dans QGIS la couche importée comme toutes les autres couches.

Astuce: Vous pouvez également charger des couches du panneau Légende des couches vers le jeu de cartes dans le
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panneau Navigateur. Cela accélérera incroyablement votre flux de travail !

Follow Along: Load data using the GRASS Panel

Nous allons maintenant utiliser la méthode long pour charger la couche rivers. shp dans le méme Mapset.

1. Chargez les données dans le QGIS comme d’habitude. Utilisez 'ensemble de données rivers. shp (qui se
trouve dans le dossier exercise_data/shapefile/)

2. Des qu'il est chargé, cliquez sur la case Filtre du panneau GRASS et trouvez I'outil d'importation de vecteurs
en entrant le terme v.in.ogr.ggis :

Avertissement: [l existe deux outils similaires : « v.in.ogr.qgis » et « v.in.ogr.qgis.loc ». Nous recherchons
le premier.

GRASS Tools: SouthAfrica/grass_mapset (e
Modules Region [@close mapset
1| Filter |win. a
* GRASS MODULES =

~ Create new GRASS location and transfer data into it
~ Create new GRASS location from vector data
/ P> < . win.ogrggis.loc
‘X’ Import loaded vector and create a fitted loc...
~ File management
= Import into GRASS
= Import vector into GRASS
=»> . vin.ogrqgis
T W Import loaded vector
) . win.ogr
W 1m port OGR vector
) i win.ogrloc
% Import OGR vector and create a fitted lo...

.
P

NN\ N

=
=
= win.ogr.all

Import OGR vectors in a given data sour.. |~

\ 4

Reload tree | | Run debug | | Close debug

Le v signifie vecteur, in signifie une fonction pour importer des données dans la base de données GRASS, ogr
est la bibliotheque logicielle utilisée pour lire les données vectorielles, et ggis signifie que I'outil va chercher
un vecteur parmi les vecteurs déja chargés dans QGIS.

3. Une fois que vous avez trouvé cet outil, cliquez dessus pour faire apparaitre 'outil lui-méme. Choisissez la
couche rivers dans la case Charger couche et tapez et nommez le g_rivers pour éviter toute confusion :
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7.

GRASS Tools: SouthAfrica/grass_mapset E3]

Modules Region ¥ [@close mapset

Module: viin.ogrqgis

Options | Qutput | Manual

Loaded layer

rivers -

Password

Nom de la couche vectorielle en sortie

g_rivers

Show advanced options >>

Run Close

Note: Notez les options supplémentaires d’import fournies dans Options avancées. Cela inclut la possibilité
d’ajouter une clause WHERE pour la requéte SQL utilisée lors de I'import de donnée.

Cliquez sur Exécuter pour commencer I'import.
Une fois fait, cliquez sur le bouton Voir le résultat pour voir la nouvelle couche GRASS importée dans la carte.

Fermez d’abord l'outil d’import (cliquez sur le bouton Fermer juste a droite de Voir le résultat), puis fermez la
fenétre Outils GRASS.

Supprimez la couche originale rivers.

Vous ne disposez désormais plus que de la couche GRASS affichée dans la carte QGIS.

12.1.4 Follow Along: Chargement des données Raster dans GRASS

Vous pouvez importer une couche raster de la méme maniere que nous avons importé des couches vectorielles.

Nous allons importer dans le jeu de cartes GRASS la couche srtm_41_19_4326.tif.

Note: la couche raster est déja dans le bon CRS, « TPS 84 ». Si vous avez des couches dans des CRS différents,
vous devez les reprojeter dans le méme CRS du jeu de cartes GRASS

A

Charger la couche srtm_41_19_4326.tif dans QGIS

Ouvrez a nouveau les Outils GRASS.

Cliquez sur I'onglet Liste des modules.

Recherchez « r.in.gdal.qgis » et double-cliquez sur I'outil pour ouvrir la boite de dialogue de l'outil.

Configurez-le de sorte que la couche d’entrée soit srtm_41_19_4326.tif etla sortie soit g_dem.
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GRASS Tools: SouthAfrica/grass_mapset E3]

Modules Region b ¥ [@close mapset

Module: rin.gdal.qgis

Options | Qutput | Manual

Loaded layer

srtm_41_19_4326 -

Password

Nom de la couche matricielle en sortie

g_dem

Show advanced options >>

Run Close

6. Cliquez sur Exécuter.

7. Une fois I'opération réussie, cliquez sur Voir le résultat.

8. Vous pouvez Fermer I'onglet actuel puis cliquez dans la boite de dialogue suivante sur Fermer.

e

"R R e R L W L

-
=
=]
.

9. Vous pouvez maintenant supprimer la couche srtm_41_19_4326.t1if originale.
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12.1.5 Try Yourself Add Layers to Mapset

Essayez d’'importer dans le jeu de cartes GRASS les couches vecteur water.shp et places.shp du dossier
exercise_data/shapefile/. Comme nous l'avons fait pour rivers, renommez la couche importée en
g_water et g_places pour éviter toute confusion

Réponse

Vous pouvez ajouter des couches (raster et vecteur) dans le Mapset de GRASS via glisser-déposer a partir de
I'explorateur (voir [Z[2[7] Pas a pas : Charger des données via Uexplorateur de QGIS) ou en utilisant les commandes
v.in.gdal.qggis pour les couches vectorielles et r.in.gdal.ggis pour les rasters.

12.1.6 Open an existing GRASS Mapset

Si vous avez un jeu de cartes GRASS existant, vous pouvez facilement le rouvrir dans une autre session de QGIS.
Vous avez plusieurs méthodes pour ouvrir une carte GRASS, nous allons en explorer quelques-unes.

Fermons le Mapset en cliquant sur le bouton Close Mapset de la fenétre GRASS Tools.

Follow Along: Using the GRASS plugin

1. Cliquez sur le menu Extensions » GRASS » Ouvrir Jeu de carte a c6té du menu Extensions » GRASS » Nouveau
Jeu de carte que nous avons vu dans la section précédente.

2. Naviguez vers le dossier de la base de données GRASS : soyez prudent ! Vous devez choisir le dossier parent,
et non celui de GRASS Mapset. En effet, GRASS lira toutes les « Locations » de la base de données et tous
les « Mapset » de chaque « Localisation » :

Select GRASS Mapset

Gisdbase |/home/delazjrexercise_data Browse...
Location | SouthAfrica -
Mapset | grass_mapset -

v Ok & Annuler

3. Choisissez le « Lieu » (guilabel:SouthAfrica) et le « Mapset » (guilabel:”grass_mapset”) que nous avons créés
auparavant.

C’est tout ! Le panneau GRASS devient actif, ce qui signifie que le mapset a été correctement ouvert.

Follow Along: Using the QGIS Browser

L’ouverture d’'un « mapset » a I'aide du navigateur QGIS est encore plus rapide et plus facile :
1. Fermez le Mapset (s’il est ouvert) en cliquant sur le bouton Close Mapset de la fenétre GRASS Tools.
2. Dans le navigateur QGIS, naviguez jusqu’au dossier de la base de données GRASS.
3. Cliquez avec le bouton droit de la souris sur le mapset (rappelez-vous que le jeu de cartes comporte I'icone

GRASS W 2 coté). Vous verrez quelques options.
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4. Cliquez sur Open mapset :

Browser &
LETHO
- Favorites
- training manual
v [ forms
~ B8 grass

v grassdata
v [ SouthAfrica
~ % SouthAfrica

qraEE (et Rl et o

b} & PERMA Add as a Favorite
v B postgis Properties...
» & meEE'E'i”g Hide from Browser
* O prcluected_data Fast Scan this Directory
v [ ggis-server-tutor
b E raster GRASS Options
8 scropopery T
* @ shapefiles Mew Point Layer
v [l styles _
v Bl symbals MNew Line Layer
v [ world Mew Polygon Layer
() example il
» [ Home
» &/
v & GeoPackage
£ SpatiaLite
@ rostcis
P mssqL

Le Mapset est maintenant ouvert et prét a étre utilisé !

Astuce: Un clic droit sur un jeu de cartes GRASS vous offre de nombreux parametres différents. Essayez de les
explorer et de voir toutes les options utiles.
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12.1.7 In Conclusion

La méthode de travail de GRASS pour la gestion des données est quelque peu différente de celle de QGIS car GRASS
les charge dans une base de donnée a structure spatiale. Toutefois, en utilisant QGIS comme interface, vous pouvez
rendre plus facile la création d’un jeu de donnée GRASS grice aux couches QGIS comme sources de données pour
GRASS.

12.1.8 What’s Next?

Maintenant que les données sont importées dans GRASS, nous pouvons nous intéresser aux opérations d’analyses
plus évoluées que nous permet GRASS.

12.2 Lesson: Outils GRASS

Dans cette lecon, nous vous présenterons une sélection d’outils afin de vous donner une idée des potentialités de
GRASS.

12.2.1 Follow Along: Créer une carte d’aspect

1. Ouvrez 'onglet outils GRASS
2. Chargez la couche matricielle g_dem depuis le jeu de cartes grass_mapset
3. Recherchez le module r.aspect en le cherchant dans le champ Filtre de 'onglet liste des modules.

4. Ouvrez loutil et configurez-le comme suit, puis cliquez sur le bouton Run :
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GRASS Tools: SouthAfrica/grass_mapset

Modules  Region e A

Module: r.aspect
Options | Qutput = Manual

Name of input elevation raster map

(= (]

@Clﬂse mapset

g_dem * ||
Mame for output aspect raster map
g_aspect |
Run Close

5. Lorsque le processus est terminé, cliquez sur voir le résultat pour charger la couche résultante dans le canevas :
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wvtinied Fespeat - a0 o] . o=

1 gt v, e Colaas MO XLEND B WS LI 5§ Mgl WA T Bl B0 Do R $IRLEE &

La couche g_aspect est stockée dans le Mapset grass_mapset afin que vous puissiez retirer la couche du canevas
et la recharger quand vous le souhaitez.

12.2.2 Follow Along: Obtenir des statistiques de base sur la couche raster

Nous voulons connaitre quelques statistiques de base de la couche raster g_dem.
1. Ouvrez l'onglet outils GRASS
2. Chargez la couche matricielle g_dem depuis le jeu de cartes grass_mapset
3. Recherchez le module r.info en le cherchant dans le champ Filtre de 'onglet liste modules.

4. Configurez I'outil comme ceci et cliquez sur Run :
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GRASS Tools: SouthAfrica/grass_mapset

Modules Region i O

Module: r.info

Options | OQutput = Manual

Name of raster map

(& )

[G]close mapset

g_dem | - I jm|
Print raster history instead of info
Print extended metadata information in shell script style

Run Close

5. Dans I'onglet Sortie, vous verrez s'imprimer certaines informations raster, comme le chemin d’acces au fichier,

le nombre de lignes et de colonnes et d’autres informations utiles :
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GRASS Tools: SouthAfricafgrass_mapset @ )
Modules Region i O [@]close mapset

Module: r.info

Options | Output | Manual

r.info map=g_dem@grass_mapset

| Map: g_dem@grass_mapset Date: Mon Aug 6 10:48:55 2018 |
| Mapset: grass _mapset Login of Creator: matteo |
| Location: SouthAfrica |
| DataBase: fhome/matteo/exercise datafgrass/grassdata |
| Title: g_dem |
| Timestamp: none |

Type of Map: raster Number of Categories: @
Data Type: FCELL

Rows : 619

Columns: 919

I I
I I
I I
I I
I I
| Total Cells: 568861 |
| Projection: Latitude-Longitude |
| M: 33:45:02.7900255 S: 34:16:12.8387725 Res: 0:80:03.01978 |
| E: 20:50:22.030235E W: 20:04:06.845095E Res: 0:88:03.01978 |
| Range of data: min = @ max = 1699 |
I I
| Data Description: |
| generated by r.in.gdal |
I I
I I
I I
I I
I I
I I

Comments:

r.in.gdal input="/home/matteo/lavori/miei/grant tm/0GIS-Training-Dath,
a/training manual data/raster/SRTM/srtm 41 19 4326.tif" output="g de\
m" memory=300 offset=0 num_digits=0

Successfully finished

s

12.2.3 Follow Along: L’outil de recyclage

La reclassification d’une couche raster est une tiche tres utile. Nous venons de créer la couche g_aspect a partir
de la couche g_dem one. La plage de valeurs va de 0 (Nord) a 360 (Nord a nouveau) en passant par 90 (Est), 180
(Sud), 270 (Ouest) et enfin 360 (Nord a nouveau). Nous pouvons reclassifier la couche g_aspect pour n’avoir que
4 catégories suivant des régles spécifiques (Nord = 1, Est = 2, Sud = 3 et Ouest = 4).

L’outil de reclassification Grass accepte un fichier « txt » avec les regles définies. L’écriture des régles est tres simple
et le manuel GRASS contient une trés bonne description.

Astuce: Chaque outil GRASS a son propre onglet Manuel. Prenez le temps de lire la description de I'outil que vous
utilisez pour ne pas manquer quelques parametres utiles

1. Chargez la couche g_aspect ou, si vous ne I'avez pas encore créée, retournez a la section 777 Follow Along:
Create an aspect map.
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2. Recherchez le module r.reclass en le cherchant dans le champ Filtre de 'onglet liste modules.

3. Ouvrez l'outil et configurez-le comme sur 'image suivante. Le fichier contenant les regles se trouve dans le
dossier exercise_data/grass/,nommé reclass_aspect.txt.

4. Cliquez sur Executer et attendez que le processus soit terminé :

GRASS Tools: SouthAfrica/grass_mapset &
Modules  Region 4 1 [G]close mapset

Module: r.reclass

Options | Qutput =~ Manual

Name of raster map to be reclassified

g_aspect -1
File containing reclass rules
fhome/matteo/exercise_data/grass/reclass_aspect.txt
Name for output raster map
|g_reclassified
Run Close

5. Cliquez sur visualiser résultats pour charger le raster reclassée dans le canevas

La nouvelle couche est composée de seulement 4 valeurs (1, 2, 3 et 4) et elle est plus facile a gérer et a traiter.
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Astuce: Ouvrez le fichier reclass_aspect . txt avec un éditeur de texte pour voir les régles et commencer a
vous y habituer. De plus, regardez attentivement le manuel GRASS : de nombreux exemples différents sont présentés.

12.2.4 Try Yourself Reclassifier avec vos regles

Essayez de reclasser la couche g_dem en 3 nouvelles catégories :
¢ de 0 a 1000, nouvelle valeur = 1
e de 1000 a 1400, nouvelle valeur = 2

¢ de 1400 a la valeur maximale du raster, nouvelle valeur = 3

Réponse

Pour trouver la valeur maximale du raster, exécutez 'outil r.info : dans la console vous verrez que la valeur
maximale est de 1699. Vous étes maintenant prét a écrire les regles.

1. Ouvrez un éditeur de texte et saisissez les régles suivantes

0 thru 1000 = 1
1000 thru 1400 = 2
1400 thru 1699 = 3

2. Enregistrez le fichier sous ~~my_rules.txt et fermez I'éditeur de texte.

3. Exécutez l'outil r . reclass : choisissez la couche g . dem et chargez le fichier contenant les régles que vous
venez de créer.

4. Cliquez sur on Exécuter puis sur Visualiser la sortie. Vous pouvez modifier les couleurs afin que le résultat final
ressemble quelque peu a I'image suivante :
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12.2.5 Follow Along: Outil Mapcalc

L’outil Mapcalc est similaire a la calculatrice raster de QGIS. Vous pouvez effectuer des opérations mathématiques
sur une ou plusieurs couches raster et le résultat final sera une nouvelle couche avec les valeurs calculées.

Le but du prochain exercice est d’extraire les valeurs supérieures a 1000 de la couche raster g_dem.
1. Recherchez le module r.mapcalc en le cherchant dans le champ Filtre de 'onglet Modules List.
2. Lancez l'outil.

Le dialogue Mapcalc vous permet de construire une séquence d’analyses a effectuer sur un raster, ou une
collection de rasters. Vous utiliserez ces outils pour ce faire :

- S S N

d @

Dans l'ordre:

* Ajouter une carte : Ajoutez un fichier raster de votre jeu de cartes GRASS actuel.
o Ajouter une valeur constante : Ajoute une valeur constante a utiliser dans les fonctions, 1000 dans ce cas

o Ajouter un opérateur ou une fonction : Ajoutez un opérateur ou une fonction a connecter aux entrées et
sorties, nous utiliserons 'opérateur « plus égal que ».

* ajouter connection : Connecter des éléments. A I'aide de cet outil, cliquez et glissez du point rouge sur un
élément vers le point rouge sur un autre élément. Les points qui sont correctement connectés a une ligne

de connexion deviennent gris. Si la ligne ou le point est rouge, c’est qu’il n’est pas correctement connecté
!

e Selectionner item : Sélectionnez un élément et déplacez les éléments sélectionnés.

* Supprimer l'élément sélectionné : Supprime I'élément sélectionné de la feuille mapcalc actuelle, mais pas
du jeu de cartes (s’il s’agit d’unraster existant)
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* ouvrir : Ouvrir un fichier existant avec 'opération définie

* Sauvegarder : Sauvegarder toute I'opération dans un fichier

e Sauvegarder sous : Enregistrez toutes les opérations dans un nouveau fichier sur le disque.

3. A Taide de ces outils, construisez I'algorithme suivant :

GRASS Tools: SouthAfrica/grass_mapset

Modules ] Region ‘ E I

[E]close mapset

Module: r.mapcalc

Options [ Output [ Manual l

B saHOoEa0a

Output [g_dem 1000

Run

] |‘Jiew c—utpl..t| [

Close

]

4. Cliquez sur Executer et ensuite sur voir resultats pour voir la sortie affichée dans votre carte :
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Cela montre toutes les zones ou le terrain est plus haut que 1000 metres.

Astuce: Vous pouvez également sauvegarder la formule que vous avez créée et la charger dans un autre projet QGIS
en cliquant sur le dernier bouton de la barre d’outils GRASS Mapcalc.

12.2.6 In Conclusion

Dans cette lecon, nous avons abordé seulement quelques-uns des outils que GRASS propose. Pour explorer les
fonctionnalités de GRASS par vous-méme, ouvrez la boite de dialogue Outils GRASS et déroulez la Liste des Modules.
Pour une approche plus structurée, consultez 'onglet Arbre des Modules qui organise les outils par type.
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Module: Evaluation

Utilisez vos propres données dans cette section. Vous aurez besoin de:

un jeu de données vectorielles de points représentant des points d’intérét, avec le nom des points et des
catégories multiples

un jeu de données vectorielles de lignes représentant des routes
un jeu de données vectorielles de polygones représentant I'utilisation du sol (utilisant les propriétés de contour)
une image de spectre visuel (une photographie aérienne par exemple)

un Modele Numérique de Terrain (té€léchargeable depuis le CGIAR-CSI si vous n’en disposez pas d’un)

13.1 Créer une carte de base

Avant de faire une analyse de données, vous aurez besoin d’une carte de base, qui fournira le résultat de votre analyse
du contexte.

13.1.1 Ajout de la couche de points

Ajoutez la couche de points. Selon le niveau de cours que vous avez suivi, faites seulement ce qui est listé dans
la section appropriée ci-dessous :

Etiquetez les points selon un attribut unique, comme les noms de lieux par exemple. Utilisez une petite police
et gardez des étiquettes discretes. L’information doit étre disponible, mais ne doit pas étre une entité principale
de la carte.

Classez les points entre eux avec différentes couleurs basées sur une catégorie. Par exemple, des catégories
peuvent représenter « destination touristique », « poste de police », et « centre-ville ».
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Faites la méme chose que dans la section .

Classez la taille des points par importance : plus une entité est importante, plus son point sera grand. Cependant,
ne dépassez pas une taille de point de 2. 00.

Pour les entités qui ne sont pas localisées en un point unique (par exemple, les noms des provinces/régions, ou
les noms des villes a grande échelle), ne leur affectez aucun point du tout.

N-utilisez pas les symboles en point pour symboliser la couche. A la place, utilisez les étiquettes centrées sur
les points ; les symboles en point ne doivent avoir aucune taille.

Utilisez la :guilabel:Source de définition des parametres pour styliser les étiquettes en des catégories
significatives.

Ajoutez des colonnes appropriées aux données attributaires si nécessaire. Quand vous faites cela, ne créez pas
de données fictives - utilisez plutdt la Calculatrice de champ pour remplir les nouvelles colonnes, qui se base
sur des valeurs existantes appropriées du jeu de données.

13.1.2 Ajout de la couche de lignes

Ajoutez la couche des routes et ensuite changez sa symbologie. N’étiquetez pas les routes.

Changez la symbologie des routes pour obtenir une couleur claire avec une large ligne. Ajoutez un peu de
transparence a cela.

Créez un symbole avec plusieurs couches de symbole. Le symbole final devrait ressemble a une véritable route.
Vous pouvez utiliser un symbole simple pour cela ; par exemple, une ligne noire avec une fine ligne continue
blanche qui passe en son centre. Il peut étre élaboré ainsi, mais la carte finale ne doit pas paraitre trop chargée.

Si votre jeu de données a une grande densité de routes a I'échelle a laquelle vous voulez montrer la carte, vous
pouvez avoir deux couches de routes : celle avec le symbole ressemblant a une route, et celle avec un symbole
plus simple pour une échelle plus petite. (Utilisez la visibilité selon ’échelle pour faire le changement entre les
deux couches aux échelles appropriées.)

Tous les symboles devraient avoir des couches multiples de symbole. Utilisez des symboles pour les afficher
correctement.

Faites la méme chose que dans la section d’en haut.

En outre, les routes doivent étre classées. En utilisant les symboles ressemblant a une route, chaque type de
route devrait avoir son propre symbole ; par exemple, une autoroute devrait apparaitre avec deux voies dans
chaque direction.
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13.1.3 Ajout de la couche de polygones

* Ajoutez la couche de I'utilisation du sol et changez sa symbologie.

¢ Classez la couche selon I'utilisation du sol. Utilisez des couleurs continues.

¢ Classez la couche selon I'utilisation du sol. Ou c’est approprié, incorporez des couches de symbole, différents
types de symbole, etc. Gardez cependant des résultats qui semblent modérés et uniformes. Gardez en téte que
cela fera partie d’'une toile de fond !

 Utilisez une classification basée sur un ensemble de regles pour classer I'utilisation du sol en catégories
générales, telles que « urbain », « rural », « réserve naturelle », etc.

13.1.4 Création de la toile de fond raster

¢ Créez un ombrage a partir du MNE, et utilisez-le comme un revétement pour une version classifiée du MNE
lui-mé&me. Vous pourriez aussi utiliser I'extension Relief (comme montré dans la lecon sur les extensions).

13.1.5 Finalisation de la carte de base

 En utilisant les ressources ci-dessous, créez une carte de base en utilisant quelques unes ou toutes les couches.
Cette carte devrait inclure toutes les informations de base nécessaire pour orienter l'utilisateur, ainsi qu’étre
visuellement unifiée / « simple ».

13.2 Analyse de données

* Vous recherchez une propriété qui satisfasse certains criteres.
* Vous pouvez décider de vos propres criteres, que vous devez documenter.
¢ Ily a des lignes directrices pour ces criteres :
— la propriété-cible doit étre d’un certain(s) type(s) d’utilisation du sol
— elle doit étre a une distance donnée des routes, ou croiser une route

— elle doit étre a une distance donnée des différentes catégories de points, comme un hopital par exemple.
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13.2.1 /

¢ Ajouter une analyse raster a vos résultats. Considérez au moins une propriété dérivée du rater, comme son
aspect ou sa pente.

13.3 Carte finale

o Utiliser Imprimer la Mise en page pour créer une carte finale qui contiendra les résultats de vos analyses.

¢ Insérez cette carte dans un document avec vos criteres documentés. Si la carte est devenue visuellement trop
chargée en raison de la(des) couche(s) ajoutée(s), désélectionnez les couches que vous jugez le moins nécessaire.

 Votre carte doit inclure un titre et une légende.
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cHAPTER 14

Module: Application forestiere

Dans les modules 1 a 13, vous avez déja appris beaucoup a propos de QGIS et comment travailler avec. Si vous
&tes intéressé a en apprendre sur certaines applications forestieres de base des SIG, suivre ce module vous donnera la
possibilité d’appliquer ce que vous avez appris et vous montrera quelques nouveaux outils utiles.

European Union
European Regional Development Fund
European Social Fund

Le développement de ce module a été sponsorisé par 'Union Européenne.

14.1 Lesson: Présentation du module forestier

Suivre ce module sur une application forestieére requiere la connaissance que vous avez acquise a travers les modules
1 a 11 de ce manuel d’entrainement. Les exercices dans les lecons suivantes supposent que vous étes déja capable de
faire beaucoup d’opérations basiques dans QGIS et seuls les outils qui n’ont pas été utilisés avant sont présentés en
détail.

Néanmoins, le module suit un niveau basique tout au long des lecons de telle sorte que si vous avez une expérience
précédente avec QGIS, vous pouvez probablement suivre les instructions sans problémes.

Notez que vous avez besoin de télécharger un paquet de données supplémentaire pour ce module.
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14.1.1 Echantillon de données forestiéres

Note: Le jeu de données utilisé dans ce module fait partie des données du manuel d’entrainement et est disponible
dans le dossier exercise_data\forestry\.

L’échantillon de données relatives a la foresterie (carte forestiere, données forestieres) a été fourni par EVO-HAMK
forestry school. Les jeux de données ont été adaptés pour les besoins des lecons.

Les données générales de I'échantillon (images aériennes, données LiDAR, cartes de base) ont été obtenues
aupres du service de données ouvertes de la National Land Survey of Finland et adaptées aux fins des
exercices. Le service de téléchargement de fichiers de données ouvertes est accessible en anglais ici
<https:/ftiedostopalvelu.maanmittauslaitos. fi/tp/kartta ?lang=en> _.

Avertissement: Comme pour le reste de ce manuel d’exercices, ce cours comprend des instructions sur ’ajout, la
suppression et la modification des jeux de données SIG. Nous avons fourni des ensembles de données de formation
a cet effet. Avant d’utiliser les techniques décrites ici sur vos propres données, assurez vous toujours de disposer
des sauvegardes appropriées !

14.2 Lesson: Géoréférencement d’une carte

Une tiche forestiere commune serait la mise a jour des informations relatives a une zone forestiere. Il est possible que
les informations précédentes pour cette zone datent de plusieurs années et aient été collectées de maniere analogique
(c’est-a-dire sur papier) ou peut-étre qu’elles aient été numérisées mais qu’il ne vous reste que la version papier de ces
données d’inventaire.

11 est fort probable que vous souhaitiez utiliser ces informations dans votre SIG pour, par exemple, les comparer plus
tard avec des inventaires ultérieurs. Cela signifie que vous devrez numériser les informations dont vous disposez a
l'aide de votre logiciel SIG. Mais avant de pouvoir commencer la numérisation, il y a une premiere étape importante
a franchir, a savoir la numérisation et le géoréférencement de votre carte papier.

Le but de cette lecon: Apprendre a utiliser I'outil Georeferencer dans QGIS.

14.2.1 Scanner la carte

La premiere tiche que vous aurez a faire est de scanner votre carte. Si votre carte est trop grande, vous pouvez
la numériser en plusieurs parties, mais n’oubliez pas que vous devrez répéter les taches de prétraitement et de
géoréférencement pour chaque partie. Donc, si possible, scannez la carte en un nombre de parties aussi réduit que
possible.

Si vous devez utiliser une carte différente de celle fournie avec ce manuel, utilisez votre propre scanner pour scanner
la carte sous forme de fichier image, une résolution de 300 DPI fera 'affaire. Si votre carte comporte des couleurs,
scannez I'image en couleur afin de pouvoir utiliser ces couleurs plus tard pour séparer les informations de votre carte
en différentes couches (par exemple, les peuplements forestiers, les courbes de niveau, les routes...).

Pour cet exercice, vous allez utiliser une carte qui aura été scanné préalablement, que vous pouvez trouver sous le
nom rautjarvi_map.tif dans le dossier de données exercise_data/forestry.
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14.2.2 Follow Along: Géoréférencement de la carte scannée

1. Ouvrez QGIS et définissez le SCR du projet comme EPSG:3067 — ETRS89 / TM35FIN(E,N) dans
Projet » Propriétés » SCR, qui est le SCR actuellement utilisé en Finlande.

Project Properties — CRS X

Q

Project Coordinate Reference System (CRS)

S

%, General No CRS (or unknown/non-Earth projection)
! Metadata Filter | <
e R Recently Used Coordinate Reference Systems
Coordinate Reference System Authority ID
‘@ CRS ETRS89 / TM35FIN(E,N) EPSG:3067
. KKJ /Finland zone 2 EPSG:2392
€2 Transformations NAD27 [ Alaska Albers EPSG:2964
% Default Styles
BB Data Sources : -
EE Relations Predefined Coordinate Reference Systems Hide deprecated CRSs
N— Coordinate Reference System Authority ID =
ariasies ETRS89 / TM26 EPSG:3038
@ M ETRS89 / TM27 EPSG:3039
acros
= ETRS89 / TM35FIN(E,N) EPSG:3067
=% QGIS Server ETRS89 / TM35FIN(N,E) EPSG:3902 =
2 . ) ) .
G‘ Temporal ETRS89 / TM35FIN(E,N) =
Properties <
* Uniks: meters

* Static (relies on a datum which is plate-fixed) by
* Method: Universal Transverse Mercator il i

@Help @apply || @cancel

2. Enregistrez le projet QGIS sous map_digitizing.qggs.

Vous allez utiliser I'outil de géoréférencement de QGIS nommé Géoréférencer. Pour géoréférencer la carte :

1. Ouvrez l'outil de géoréférencement, Couche » j:-t Géoréférencer....

14.2. Lesson: Géoréférencement d’une carte 397



QGIS Training Manual

Georeferencer - o &

File Edit View Settings

B> [ 3 M@ PP

GCP table B

Rotation | 0.0 ® % | Transform: Mot set 639,1 EPSG:

2. Ajoutez le fichier image de la carte, raut jarvi_map.tif, en tant quimage a géoréférencer, Fichier »
Ouvrir un raster....

3. Cliquez sur OK.
Ensuite, vous devez définir les parametres de transformation pour le géoréférencement de la carte :
1. Ouvrez Parameétres w Parameétres de transformation.
2. Définissez le Type de transformation en Linéaire et la Méthode de ré-échantillonnage en P1us proche
voisin.
3. Cliquez sur le bouton =i Sélectionnerle SCR 5 ¢4t¢ de I'option SCR cible et sélectionnez le SCR EPSG:2392 -
KKJ / Finland zone 2 ;c’estle SCR qui était utilisé en Finlande en 1994, quand cette carte a été créée.

4. Cliquez sur I'icone a coté de la boite Raster de sortie, allez dans le dossier, créez le dossier exercise_data\
forestry\digitizing et nommez le fichier raut jarvi_georef.tif.

5. Cochez la case . Charger dans QGIS lorsque terminé

6. Laissez le reste des parametres a leur valeur par défaut.
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Transformation Settings X

Transformation Parameters

Transformation type | Linear

Resampling method | Nearest neighbour -

Target SRS

Output Settings

Output raster
Compression None

Save GCP points

EPSG:2392 - KKJ / Finland zone 2 v ||

afForestry/digitizing/rautjarvi_georef.tif

Create world file only (linear transforms)

Use 0 for transparency when needed

Set target resolution

Reports

Generate PDF map

Generate PDF report

¥| Load in QGIS when done
©Help

7. Cliquez sur OK.

Ocancel | G0k |

La carte contient plusieurs croix marquant les coordonnées dans la carte, nous les utiliserons pour géoréférencer cette
image. Vous pouvez utiliser les outils de zoom et de panoramique comme vous le faites habituellement dans QGIS

pour inspecter I'image dans la fenétre géoréférencer.

1. Zoomez sur le coin en bas a gauche de la carte et remarquez qu’il s’y trouve une croix avec une paire de
coordonnées X et Y qui sont, comme mentionné précédemment, dans le SCR KKJ / Finland zone 2.
Vous utiliserez ce point en tant que premier point de contréle pour géoréférencer la carte.

2. Sélectionnez l'outil Ajouter point et cliquez dans I'intersection du réticule (pan et zoom si nécessaire).

3. Dans le dialogue Entrer les coordonnées de la carte, saisissez les coordonnées qui apparaissent sur la carte (X :
2557000 et Y : 6786000) et leur SCR (EPSG:2392 — KKJ / Finland zone 2)

Enter Map Coordinates X

Enter X and Y coordinates (DMS (dd mm ss.ss), DD (dd.dd) or projected coordinates (mmmm.mm))
which correspond with the selected point on the image. Alternatively, click the button with icon of a
pencil and then click a corresponding point on map canvas of QGIS to Fill in coordinates of that point.

X /East 2557000
Y / North 6786000
EPSG:2392 - KKJ / Finland zone 2

v| Automatically hide georeferencer window

4. Cliquez sur OK.

# From Map Canvas | | @Cancel QoK

14.2. Lesson: Géoréférencement d’une carte
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La premiere coordonnée pour le géoréférencement est maintenant préte.

5. Recherchez d’autres croix de calage noires dans I'image, elles sont séparées de 1000 metres dans les directions
nord et est. Vous devriez pouvoir calculer les coordonnées de ces points en relation avec le premier point.

6. Dézoomez I'image et déplacez-vous vers la droite ou le haut jusqu’a trouver une autre croix de calage, et estimez
de combien de kilometres vous vous étes déplacé. Essayez d’obtenir des points de contrdle les plus éloignés
possible les uns des autres.

7. Numérisez au moins trois points de controle supplémentaires de la méme facon que pour le premier point.
Vous devriez obtenir quelque chose similaire a ceci :

P

] |- eS|

OFP - -

..'-'ﬁ Georeferencer - rautjarvi_map.tif

File Edit WView Settings

> L

Help
*a 5 @ T %G

5
GCP table
onfoff id srck src dst¥ dsty d¥ [pixels] dY [pixels]

™ 0 473.10| -4352.93 | 2557000.00 |6786000.00 7.65 4.95
»® 1 | 2838.78| -3185.77 | 2555000.00 6787000.00 5.58 -7.35
»® 5 | 2848.87| -825.55|2558000.00 |5783000.00 -5.51 -6.06
™ 3 488.49| -811.03|2557000.00 -7.73 8.45
(4] | an

| Translation (2.5565%e+06, 6.7922e+06) Scale (0.846165, 1.28642) Rotation: 0 Mez Ja7a,-5025 |E| y
'

Quand vous aurez numérisé trois points de controle, vous pourrez visualiser les erreurs de géoréférencement par une
ligne rouge partant des points. L’erreur en pixels peut aussi étre vue dans le Tableau des points de contréle, dans les
colonnes dX[pixels] et dY[pixels]. L’erreur en pixels ne doit pas dépasser 10 pixels. Si c’est le cas, vous devez revoir
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les points que vous avez numérisés et les coordonnées que vous avez entrées pour trouver ou est le probleme. Vous
pouvez utiliser I'image au-dessus pour vous guider.

Une fois que vous étes satisfait de vos points de controle, vous pouvez les conserver pour une utilisation ultérieure :
1. Allez sur Fichier » Enregistrer les points de contrdle sous....

2. Dans le dossier exercise_data\forestry\digitizing, nommez le fichier raut jarvi_map.
tif.points.

Pour terminer, géoréférencez votre carte :
1. Allez sur Fichier » Débuter le géoréférencement.

2. Notez que vous avez déja nommé le fichier raut jarvi_georef.tif quand vous avez modifié les
parametres de géoréférencement.

A présent, vous pouvez voir la carte en tant que raster géoréférencé dans le projet QGIS. Notez que le raster
parait légerement de travers, mais c’est simplement di au fait que les données sont en KKJ / Finland
zone 2 et votre projet esten ETRS89 / TM35FIN(E,N).

3. Pour Vérifier que vos données sont correctement géoréférencées, vous pouvez

1. Ouvrir limagerie aérienne dans le dossier exercise_data\forestry, nommée
rautjarvi_aerial.tif.

2. Votre carte et 'image doivent plut6t bien correspondre : mettez la transparence de la carte a 50 % et
comparez avec 'image aérienne.
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4. Enregistrez les modifications apportées a votre projet QGIS, vous continuerez a partir de ce point pour la

prochaine legon.
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14.2.3 In Conclusion

Vous avez maintenant géoréférencé une carte papier, ce qui permet de I'utiliser comme couche cartographique dans
QGIS.

14.2.4 What’s Next?

Dans la prochaine lecon, vous numériserez les peuplements forestiers de votre carte sous forme de polygones et y
ajouterez les données d’inventaire.

14.3 Lesson: Numériser les massifs forestiers

A moins que vous n’utilisiez votre carte géoréférencée comme une simple image de fond, la prochaine étape naturelle
consiste a en numériser les éléments. Vous I'avez déja fait dans les exercices sur la création de données vectorielles
dans Lecon : Création d’un nouveau jeu de données vectorielles, lorsque vous avez numérisé les champs de 1’école.
Dans cette lecon, vous allez numériser les limites des peuplements forestiers qui apparaissent sur la carte sous forme
de lignes vertes, mais au lieu de le faire a I'aide d’une image aérienne, vous utiliserez votre carte géoréférencée.

Objectif de cette lecon : Apprendre une technique d’aide a la tache de numérisation, en numérisant des massifs
forestiers et en leur ajoutant finalement les données d’inventaire.

14.3.1 Follow Along: Extraction des bordures des massifs forestiers

Ouvrez dans QGIS le projet map_digitizing.qggs que vous aviez sauvegardé dans la lecon précédente.

Une fois que vous avez scanné et géoréférencé votre carte, vous pouvez directement commencer la numérisation en
regardant I'image comme un guide. Cela sera probablement la facon avec laquelle vous procéderez si 'image que
vous avez numérisé est, par exemple, une photographie aérienne.

Si ce que vous utilisez pour numériser est une bonne carte, comme dans notre cas, il est probable que les informations
soient clairement affichées sous forme de lignes de couleurs différentes pour chaque type d’élément. Ces couleurs
peuvent étre extraites relativement facilement sous forme d’images individuelles a 'aide d’un logiciel de traitement
d’images comme GIMP. Ces images séparées peuvent étre utilisées pour faciliter la numérisation, comme vous le
verrez ci-dessous.

La premiere étape sera d’utiliser GIMP pour obtenir une image qui ne contienne que les massifs forestiers, c’est-a-dire
toutes ces lignes verdatres que vous pouvez voir sur la carte scannée d’origine :

1. Ouvrez GIMP (si vous ne I'avez pas déja installé, téléchargez-le depuis internet ou demandez a votre professeur).

2. Open the original map image, File » Open, raut jarvi_map.tif intheexercise_data/forestry
folder. Note that the forest stands are represented as green lines (with the number of the stand also in green
inside each polygon).
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3. Vous pouvez maintenant sélectionner les pixels dans I'image qui coincident avec les bordures des massifs
forestiers (les pixels verdatres):

1. Ouvrez l'outil Sélection » Par couleur.

2. With the tool active, zoom into the image (Ctrl + mouse wheel) so that a forest stand line is close
enough to differentiate the pixels forming the line. See the left image below.

3. Cliquez et faites glisser le curseur de la souris au milieu de la ligne afin que 'outil collecte plusieurs valeurs
de couleur de pixels.

4. Relachez le clic de la souris et attendez quelques secondes. Les pixels aux couleurs récupérées par I'outil
seront sélectionnés a travers toute I'image.

5. Dézoomez pour voir comment les pixels verdatres ont été sélectionnés sur toute I'image.
6. Si vous n’étes pas content du résultat, répétez 'opération de cliquer et glisser la souris.

7. Votre sélection de pixels devrait ressembler a ce qu’on voit dans I'image de droite ci-dessous.
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4. Une fois que vous en avez terminé avec la sélection, vous devez copier cette sélection comme nouvelle couche
et ensuite la sauvegarder séparément comme fichier image :

1. Copy (Ctr1+C or Edit » Copy) the selected pixels.

2. And paste the pixels directly as a new layer (Edit » Paste as » New Layer). GIMP will display the pasted
pixels as a new layer (Pasted Layer) in the Layers panel.

3. Cliquez sur I'icone « oeil » a coté de la couche de I'image d’origine pour la désactiver, afin que seule la
Couche collée soit visible :

[ X X ] *[rautjarvi_map] (imported)-6.0 (RGB color 8-bit gamma integer, GIMP built-in sRGB, 2 layers) 3507x4960 - GIMP

2. Hardness 050 (51 x 51)
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s BN M ox C©

I1T!N=l=|. Channels xl‘-‘a\‘n‘s‘ =]
lMude Normal v] 5 v
o e
Lock: f o [

B rautand_mp

@l % - [x ] 1505 [ |Pasted Layer (434.8 ) Fl oA v @

>l
[
X

14.3. Lesson: Numériser les massifs forestiers 405



QGIS Training Manual

5. Finally, select File » Export As..., set Select File Type (By Extension) as a TIFF image, select the digitizing
folder and name it raut jarvi_map_green.tif. Select no compression when asked.

Vous pouvez faire le méme processus avec d’autres éléments de 'image, par exemple extraire les lignes noires
représentant les routes, ou les brunes qui représentent les lignes de contour du terrain. Mais pour nous, les massifs
forestiers sont suffisants.

14.3.2 Try Yourself Géoréférencer I'image de pixels verts
Comme vous I'avez fait dans la lecon précédente, vous devez géoréférencer cette nouvelle image pour pouvoir l'utiliser
avec le reste de vos données.

Note that you don’t need to digitize the ground control points anymore because this image is basically the same image
as the original map image, as far as the Georeferencer tool is concerned. Here are some things you should remember:

¢ This image is also, of course, in KKJ / Finland zone 2 CRS.

* Vous devriez utiliser les points de contrdle que vous avez sauvegardé, Fichier » Charger des points de controle
(GCP).

» Souvenez-vous de modifier les Préférences de transformation.
¢ Name the output raster as raut jarvi_green_georef.tif inthe digitizing folder.

Vérifiez que le nouveau raster se superpose parfaitement avec la carte d’origine.

14.3.3 Follow Along: Création de points d’appui pour la numérisation

Si vous avez en-téte les outils de numérisation de QGIS, vous pouvez penser qu’il serait utile de s’accrocher a ces
pixels verts lors de la numérisation. C’est précisément ce que nous allons faire en créant des points a partir de ces
pixels pour les utiliser plus tard pour nous aider a suivre les bordures des foréts lors de la numérisation en utilisant les
outils d’accrochage disponible dans QGIS.

1. Utilisez l'outil Raster » Conversion w Polygoniser (Raster a Vecteur) pour vectoriser vos lignes vertes en
polygones. Si vous ne vous souvenez plus comment faire, vous pouvez le revoir dans Lecon : Conversion
Raster vers Vecteur.

2. Save as raut jarvi_green_polygon. shp inside the digitizing folder.

3. Zoomez et voyez a quoi ressemblent les polygones. Vous obtiendrez quelque chose comme ¢a :
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4. Next option to get points out of those polygons is to get their centroids:
1. Open Vector » Geometry Tools » Centroids....

2. Set Input Layer to = rautjarvi_green_polygon (the polygon layer you have just created)

3. Set Centroids output to green_centroids. shp file within the folder digitizing

4. Cochez oA Ouvrir le fichier aprés exécution de l'algorithme

5. Press Run. This will calculate the centroids for the polygons as a new layer and add it to the project.
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5. Now you can remove the L~ raut jarvi_green_polygon layer from the TOC.

6. Change the symbology of the centroids layer as follows:
[

1. Open the Layer Properties for = green_centroids.
2. Aller a l'onglet Symbologie.
3. Set Size to 1. 00 and choose Map Units

Il n’est pas nécessaire de différencier les points les uns des autres, vous avez seulement besoin de les avoir pour que
les outils d’accrochage puissent les utiliser. Vous pouvez maintenant utiliser ces points pour suivre les lignes d’origine
plus facilement que sans eux.
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14.3.4 Follow Along: Numériser les massifs forestiers

Maintenant, vous €tes prét a lancer le travail de numérisation. Créez un fichier vecteur du type polygone mais pour
cet exercice, il existe déja un fichier Shape sur les emprises d’intérét. Il vous reste a terminer la numérisation de la
moitié des foréts qui restent entre les routes principales (lignes roses larges) et le lac:

Hiémeenlinnaan

1. Go to the digitizing folder using your file manager browser.
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2. Drag and drop the forest_stands. shp vector file to your map.
3. Change the new layer’s symbology so that it will be easier to see the polygons that have already been digitized.
1. Set Fill color to green - and change the Opacity to 50%.
2. Select Simple Fill and set Stroke widthto 1 .00 mm.
Maintenant, si vous vous souvenez des modules passés, nous devons définir et activer les options d’accrochage :

1. Go to Project » Snapping options...

Press @ Enable Snapping and select Advanced Configuration
Check the green_centroids and forest_stands layers
Set Type for each layer to Vertex

Set Tolerance for each layer to 10

A T

Set Units for each layer to pixels
7. Check g Avoid Overlap for the forest_stands layer
8. Press | Topological editing

9. Choose @ Follow Advanced Configuration
10. Close the pop-up

Project Snapping Settings

| ‘% Advanced Configuration |[2 Disabled _  Topological Editing | ‘¥ Allow Overlap || Snapping on Intersection « Self-snapping
Layer Type Tolerance Units Avoid Overlap Min Scale Max Scale

vl ® green_centroids Vertex 10 pixels

v! [l forest_stands Vertex 10 pixels v

L Filter layers

With these snapping settings, whenever you are digitizing and get close enough to one of the points in the
centroids layer or any vertex of your digitized polygons, a pink square will appear on the point that will be
snapped to.

11. Finally, turn off the visibility of all the layers except forest_stands and rautjarvi_georef. Make sure that the
map image has not transparency any more.

A few important things to note before you start digitizing:
* N’essayez pas d’étre trop précis avec la numérisation des bordures.

* Si une bordure est une ligne droite, numérisez-la avec seulement deux noeuds. En général, la numérisation
utilise aussi peu de noeuds que possible.

e Zoomez pour fermer les plages seulement si vous pensez que vous devez étre précis, par exemple, a un coin ou
lorsque vous voulez connecter un polygone avec un autre polygone a un certain noeud.

» Utilisez le bouton du milieu de la souris pour zoomer/dézoomer et vous déplacer lors de la numérisation.

¢ Numérisez seulement un polygone a la fois.

¢ Apres avoir numérisé un polygone, écrivez I'id du massif forestier que vous pouvez voir sur la carte.
Vous pouvez maintenant commencer la numérisation :

1. Locate the forest stand number 357 in the map window.
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2. Select the forest_stands layer.
3. Click the f}? Toggle Editing ytton to enable editing

(& ]
4. Select Lo Add Polygon Feature tool.

5. Start digitizing the stand 357 by connecting some of the dots. Note the pink crosses indicating the snapping.

When you are done:
1. Right click to end digitizing that polygon.
2. Enter the forest stand ID within the form (in this case 357).
3. Cliquez sur OK.

If a form did not appear when you finished digitizing the polygon, go to Settings » Options » Digitizing and make
sure that the Suppress attribute form pop-up after feature creation is not checked.
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Votre polygone numérisé ressemblera a cela :

; e = A

-
—

Now for the second polygon, pick up the stand number 358. Make sure that i Avoid Overlap is checked for the
forest_stands layer (as shown above). This option ensures polygons do not overlap. So, if you digitize over an existing
polygon, the new polygon will be trimmed to meet the border of the existing polygons. You can use this option to
automatically obtain a common border.

1. Commencez a numériser le massif 358 a un des angles communs avec le massif 357.
2. Continue normally until you get to the other common corner for both stands.

3. Finalement, numérisez quelques points dans le polygone 357 en s’assurant que la bordure commune n’est pas
intersectée. Observez I'image de gauche ci-dessous.

4. Faites un clic-droit pour terminer la modification du massif forestier 358.
5. Enter the ID as 358.

6. Click OK. Your new polygon should have a common border with the stand 357 as you can see in the image
below.
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The part of the polygon that was overlapping the existing polygon has been automatically trimmed and you are left
with a common border - as you intended it to be.

14.3.5 Try Yourself Finir la numérisation des massifs forestiers

Vous avez maintenant deux plages de foréts prétes. Et une bonne idée de comment procéder. Continuez & numériser
de vous-méme jusqu'a ce que vous ayez numérisé toutes les plages de forét qui sont limitées par la route principale
et le lac.

Cela peut sembler étre beaucoup de travail, mais vous serez bient6t habitué a la numérisation des massifs forestiers.
Cela devrait vous prendre environ 15 minutes.

Lors de la numérisation, vous pourriez avoir besoin de modifier ou de supprimer des nceuds, de séparer ou de fusionner
des polygones. Vous avez appris les outils nécessaires a cela dans Lecon : Topologie des données, c’est probablement
un bon moment pour relire a nouveau ce chapitre.

Souvenez-vous qu’en ayant coché Activer l'édition topologique, cela vous permet de déplacer des noeuds communs a
deux polygones afin que la bordure commune soit modifiée en méme temps pour les deux polygones.

Votre résultat devra ressembler a cela :
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14.3.6 Follow Along: Jointure des données du massif forestier

11 est possible que les données d’inventaire des foréts que vous avez pour votre carte soit aussi écrites sur papier.
Dans ce cas, vous devrez tout d’abord écrire ces données dans un fichier texte ou un tableur. Pour cet exercice, les
informations de I'inventaire de 1994 (le méme inventaire que la carte) sont prétes dans un fichier texte séparé par des
virgule (fichier csv).

1. Openthe rautjarvi_1994.csv file from the exercise_data\forestry directory in a text editor
and note that the inventory data file has an attribute called ID that has the numbers of the forest stands. Those
numbers are the same as the forest stands ids you have entered for your polygons and can be used to link
the data from the text file to your vector file. You can see the metadata for this inventory data in the file
rautjarvi_1994_legend.txt in the same folder.
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2. Now add this file into the project:

1. Use the ,ﬂ Add Delimited Text Layer o] This is accessed via Layer » Add Layer » Add Delimited Text
Layer....

2. Set details in the dialog as follows:

Data Source Manager — Delimited Text

File name |/media/TRAVAIL/dev/github/QGIS-Training-Data/exercise_data/forestry/rautjarvi_1994.csv

. 4 Vector Layer name rautjarvi_1994 Encoding | UTF-8

& Raster v File Format

A7 Mest
szg Mesh © CSV (comma separated values)

« Point Cloud

Regular expression delimiter

9, Delimited Text
Custom delimiters.

“4 GeoPackage

~ Record and Fields Options

% GPS
i':_ SpatialLite Number of header lines to discard 0 = Decimal separator is comma
4 PostgreSQL V! First record has field names Trim fields
'+ MS SQL Server v Detect field types Discard empty fields
WA virtual Layer Custom boolean literals
&2 wusmwmTs True False
4 WFS/OGC API - Features
v Geometry Definition
& wes 3/
* XYZ Point coordinates
Vector Tile ‘Well known text (WKT)
ArcGIS REST Server ® No geometry (attribute only table)
[IEChELD » Layer Settings
Metadata Search Sample Data
D Hab Devl Age BA Vol MainSp MainPerc 3
123 ]nteger (32 bit) ~ | ** Integer (32 bit) ~ | *<Text (string) - | 122 Integer (32 bit) ~ | *-2 Decimal (double) ~ |12*Integer (32 bit) ~ | 2*Integer (32 bit) ~ | 122 Integer (32 bit) ~
1 /376 4 0 0 0 0 0
2 334 4 Y1 15 74 54 1 100
3 1336 4 S0 0 0 0 1 0 -
B Aide v Add | @ Fermer

3. Press Add to load the formatted csv file in the project.
3. To link the data from the . csv file with the digitized polygons, create a join between the two layers:
1. Open the Layer Properties for the forest_stands layer.

2. Rendez-vous a 'onglet Jointure.

Click 71 Addnew join on the bottom of the dialog box.
Select rautjarvi_1994.csv as the Join layer

Set the Join field to ID

Set the Target field to ID

NS AW

Cliquez sur OK deux fois.
The data from the text file should be now linked to your vector file. To see what has happened, select the

forest_stands layer and use |== Open Autribute Table -y, can see that all the attributes from the inventory data
file are now linked to your digitized vector layer.

You will see that the field names are prefixed with raut jarvi_1994_. To change this:
1. Open the Layer Properties for the forest_stands layer.
2. Rendez-vous a l'onglet Jointure.

3. Select Join Layer rautjarvi_1994

4. Click the ¢/ Bditselected join byion 1o enable editing
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5. Under i Custom field name prefix remove the prefix name

Add Vector Join

Join layer rautjarvi_1994 -
Join field 123 1D =
Target field abc ID -

v Cache join layer in memory
e ; FIou
Dynamic form

> Editable join layer
[ loined fields

w v Customn field name prefix
& Aide " Ok | & Annuler

The data from the . csv file is just linked to your vector file. To make this link permanent, so that the data is actually
recorded to the vector file you need to save the forest_stands layer as a new vector file. To do this:

1. Right click on forest_stands layer
2. Choose Export » Save Features As...

3. Set Format to ESRI Shapefile
4

. Set file name to forest_stands_1994. shp under the forestry folder

5. To include the new file as a layer in the project, check oA Add saved file to map
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Save Vector Layer as...

Format ESRI Shapefile =
File name GIS-Training-Data/exercise_data/forestry/forest_stands_1994.shp &
Layer name

CRS EPSG:3047 - ETRS89 / UTM zone 35N (N-E) ik -

v Select fields to export and their export options

Name Export name Type Replace with displayed values
v/ 1D ID String
v/ Hab Hab integer Use Range
v| Devl Devl text
v Age Age integer Use Range
v/ BA BA double
v/ Vol Vol inteaer Use Ranae X
Select All Deselect All

Use aliases for exported name

Replace all selected raw field values by displayed values

¥| Persist layer metadata
» Geometry

» v Extent (current: layer)
» Layer Options

>

Custom Options

H Aide v Add saved file to map ~ Ok © Annuler

14.3.7 Try Yourself Adding Area and Perimeter

To finish gathering the information related to these forest stands, you might calculate the area and the perimeter of
the stands. You calculated areas for polygons in Lecon : Exercice Supplémentaire. Go back to that lesson if you need
to and calculate the areas for the forest stands. Name the new attribute Area and make sure that the values calculated
are in hectares. You could also do the same for the perimeter.

Now your forest_stands_1994 layer is ready and packed with all the available information.

Save your project to keep the current map layers in case you need to come back later to it.
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14.3.8 In Conclusion

Cela a pris plusieurs clics de souris mais vous avez désormais vos anciennes données d’inventaire dans un format
numérique et prétes a étre utilisées dans QGIS.

14.3.9 What’s Next?

Vous pouvez lancer d’autres analyses sur votre nouveau jeu de données mais il est plus intéressant de les faire sur un
jeu de données plus récentes. Le sujet de la prochaine lecon concerne la création des massifs forestiers en utilisant
les dernieres photos aériennes et I'ajout d’information plus précises a votre jeu de données.

14.4 Lesson: Mise a jour des massifs forestiers

Now that you have digitized the information from the old inventory maps and added the corresponding information
to the forest stands, the next step is to create the inventory of the current state of the forest.

You will digitize new forest stands using an aerial photo. As with the previous lesson, you will use an aerial Color
Infrared (CIR) photograph. This type of imagery, where the infrared light is recorded instead of the blue light, is
widely used to study vegetated areas.

Apres la numérisation des massifs de forét, vous ajouterez des informations telles que les nouvelles contraintes données
par les réglementations de conservation.

The goal for this lesson: To digitize a new set of forest stands from CIR aerial photographs and add information
from other datasets.

14.4.1 Comparaison des anciens massifs de forét avec des photographies
aériennes actuelles

The National Land Survey of Finland has an open data policy that allows you downloading a variety of geographical
data like aerial imagery, traditional topographic maps, DEM, LiDAR data, etc. The service can be accessed in English
here. The aerial image used in this exercise has been created from two orthorectified CIR images downloaded from
that service (M4134F_21062012 and M4143E_21062012).

1. Open QGIS and set the project’s CRS to ETRSS89 / ETRS-TM35FIN in Project » Properties... » CRS
2. Add the CIR image raut jarvi_aerial.tif to the project:

1. Gotothe exercise_data\forestry\ folder using your file manager browser

2. Drag and drop the file raut jarvi_aerial.tif onto your project
3. Save the QGIS project as digitizing_2012.ggs

Les images CIR sont de 2012. Vous pouvez comparer les massifs qui ont été créés en 1994 avec la situation d’il y a
environ 20 ans.

1. Add the forest_stands_1994. shp layer created in the previous lesson:
1. Gotothe exercise_data\forestry)\ folder using your file manager browser
2. Drag and drop the file forest_stands_1994 . shp onto your project
2. Set the symbology for the layer so that you can see through your polygons:
1. Right click forest_stands_1994
2. Select Properties

3. Go to the (\‘/ Symbology tab
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4. Set Fill color to transparent fill
5. Set Stroke color to purple
6. Set Stroke widthto 0.50 mm

3. Etudiez comment les anciens massifs de forét suivent (ou non) ce que vous pouvez visuellement interpréter
comme de la forét homogene.

4. Zoomez et bouger autour de la zone. Vous remarquerez probablement que certains des anciens massifs de forét
pourraient correspondre a I'image alors que d’autres non.

This is a normal situation, as some 20 years have passed and different forest operations have been carried
out (harvesting, thinning...). It is also possible that the forest stands looked homogeneous back in 1992 to
the person who digitized them but as time has passed some forest has developed in different ways. It is also
possible that that forest inventory priorities back then were different from those of today.

Ensuite, vous créerez de nouveaux massifs de forét pour cette image sans utiliser les anciens. Plus tard, vous pourrez
les comparer pour voir les différences.

14.4.2 Interprétation de I'image CIR

Numérisons la méme zone qui était couverte par 'ancien inventaire, limitée par les routes et par le lac. Vous n’avez
pas besoin de numériser I'entier de la zone, comme dans I'exercice précédent, vous pouvez commencer avec un fichier
vectoriel qui contient déja la plupart des massifs de forét.

1. Remove the layer '.. . forest_stands_1994
2. Add the file exercise_data\forestry\forest_stands_2012. shp to the project
3. Set the styling of this layer so that the polygons have no fill and the borders are visible

1. Open Properties dialog of the forest_stands_2012 layer

2. Go to the <* Symbology tab
3. Set Fill color to transparent fill
4. Set Stroke color to green
5

. Set Stroke width to 0.50 mm
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You can see that the northern section of the inventory area is still missing. Your task is to digitize the missing forest
stands.

Before you start, spend some time reviewing the forest stands already digitized and the corresponding forest in the
image. Try to get an idea about how the stands borders are decided, it helps if you have some forestry knowledge.

Some points to consider:

* Which forests have deciduous species (in Finland these are mostly birch forests) and which ones have conifers
(in this area these are pine or spruce)? In CIR images, deciduous species usually show up as a bright red color
whereas conifers show as a dark green color.
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* How old is the forest? The size of the tree crowns can be identified in the imagery.

e How dense are the different forest stands? A forest stand where a thinning operation has recently been done
would show spaces between the tree crowns and should be easy to differentiate from other forest stands around
it.

 Des zones bleutées indiquent des terrains stériles, routes et zones urbaines, les cultures qui ne sont pas ouvertes
a croitre, etc.

* Don’t use zooms too close to the image when trying to identify forest stands. A scale between 1:3 000 and 1:5
000 should be enough for this imagery. See the image below (1:4000 scale):

14.4.3 Try Yourself Numérisation des massifs de foréts depuis I'imagerie CIR

When digitizing the forest stands, you should try to get forest areas that are as homogeneous as possible in terms of
tree species, forest age, stand density... Don’t be too detailed though, or you will end up making hundreds of small
forest stands - and that would not be useful at all. You should try to get stands that are meaningful in the context of
forestry, not too small (at least 0.5 ha) but not too big either (no more than 3 ha).

With these points in mind, you can now digitize the missing forest stands.
1. Set up the snapping and topology options:

1. Go to Project » Snapping options...

2. Press Q) Enable Smapping and select Advanced Configuration

3. Check the ® forest_stands_2012 layer
1. Set Type to Vertex
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2. Set Tolerance to 10
3. Set Units to pixels
4. Check the box under Avoid Overlap

5. Press | Topological editing

6. Choose ‘g Follow Advanced Configuration
7. Close the pop-up

Project Snapping Settings

¥ % Advanced Configuration | [3 Disabled | Topological Editing | % Follow Advanced Configuration || Snapping on Intersection | :*Self-snapping
Layer Type Tolerance Units Avoid Overlap Min Scale Max Scale
v|[] forest_stands_2012 Vertex 10 pixels v

L Filter layers.

2. Select the forest_stands_2012 layer on the Layers list

A

3. Click the ¢ TeegleEditing hyytton to enable editing

4. Start digitizing using the same techniques as in the previous lesson. The only difference is that you don’t have
any point layer that you are snapping to. For this area you should get around 14 new forest stands. While
digitizing, fill in the St andID field with numbers starting at 901.

5. Quand vous avez terminé, votre couche devrait ressembler a quelque chose comme ¢a :
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Now you have a new set of polygons showing the different forest stands in 2012 - as interpreted from the CIR images.
However, you are missing the forest inventory data. For that you will need to visit the forest and get some sample
data that you will use to estimate the forest attributes for each of the forest stands. You will see how to do that in the
next lesson.

You can add some extra information about conservation regulations that need to be taken into account for this area.

14.4.4 Follow Along: Mise a jour des massifs de forét avec I'information de
conservation

For the area you are working in, there are some conservation regulations that must be taken into account when doing
the forest planning:

e Deux emplacements d’une espece protégée d’écureuil volant de Sibérie (Pteromys volans) ont été identifiés.
Selon le reglement, une zone de 15 metres autours des lieux devrait restée intacte.

* A riparian forest of special interest that is growing along a stream in the area must be protected. In a visit to
the field, it was found that 20 meters to both sides of the stream must be protected.

You have a vector file containing the information about the squirrel locations and another containing the digitized
stream running from the North area towards the lake.

1. Fromthe exercise_data\forestry)\ folder, add the squirrel.shpand stream. shp files to the
project.
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2. Use the ==/ Open Attribute Table 4,5] 16 view the squirrel layer

Vous pouvez voir qu’il y a deux emplacements qui sont définis comme écureuil volant de Sibérie, et que la zone
a protéger est indiquée par une distance de 15 metres des emplacements.

Let’s more accurately delimitate that area to protect. We will create a buffer around the point locations, using the
protection distance.

1. Ouvrez Vecteur » QOutils de géotraitement » Tampon.

[
B

2. Set Input layer to = squirrel
3. Set Distance to 15 meters

4. Set Buffered to exercise_data\forestry\squirrel_15m.shp

5. Check i Open output file afer running algorithm
6. Cliquez sur Exécuter

7. Once the process is completed, click Close

L
Parameters | Log Buffer
Input layer This algorithm computes a buffer
+* squirrel [EPSG:25835] - B Xy ..|| |areafor all the features in an
input layer, using a fixed or
Selected features only dynamic distance.
Distance

The segments parameter

15,000000 * 'meters - | 4, | |controls the number of line
segments to use to approximate

Segments a quarter circle when creating

5 2|| |rounded offsets.

End cap style The end cap style parameter

Round . controls how line endings are
handled in the buffer.

Join style

The join style parameter specifies
Round || |whether round, miter or beveled
joins should be used when
offsetting cornersin a line.

Miter limit

2,000000 =

The miter limit parameter is only

applicable for miter join styles,

Buffered and controls the maximum
distance from the offset curve to

<[ |use when creating a mitered join.

Dissolve result

ning-Data/exercise_data/forestry/squirrel_15m.shp

v Open output file after running algorithm

0% Cance

i Aide Advanced -|| Run as Batch Process... ~ Run @ Fermer
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If you zoom in to the location in the northern part of the area, you will notice that the buffer area extends over two
neighbouring stands. This means that whenever a forest operation takes place in that stand, the protected location
should also be taken into account.

For the protection of the squirrels locations, you are going to add a new attribute (column) to your new forest stands that
will contain information about locations that have to be protected. This information will then be available whenever
a forest operation is planned, and the field team will be able to mark the area that has to be left untouched before the
work starts.

To join the information about the squirrels to your forest stands, you can use the Join attributes by location algorithm:

1. Ouvrez Vecteur » Outils de gestion de données » Joindre les attributs par localisation.

. Set Join to features in to ':-:‘:' forest_stands_2012

\S]

3. In Geometric predicate, check o intersect
Set By comparing to to (= squirrel_15m
Set Join type as Take attributes of the first matching feature only (one-to-one)

Leave unchecked Discard records which could not be joined

N o A

. Set Joined layer to exercise_data\forestry\stands_squirrel.shp

. Check Cif Open output file afer running algorithm

oo

9. Cliquez sur Exécuter

10. Once the process is completed, you can Close the dialog.
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Join Attributes by Location

Parameters | Log Join attributes by
Join to features in “ location
= forest_stands_2012 [EPSG:25835] -] @ X |..)| | |his algorithm takes an input

Selected features only vector layer and creates a new
g vector layer that is an extended
version of the input one, with

v intersect overlap additional attributes in its
attribute table.

Features they (geometric predicate)

contain are within
The additional attributes and

equal Cross their values are taken from a
second vector layer. A spatial

touch e .
criteria is applied to select the
By comparing to values from the second layer that
9 squirrel_15m [EPSG:25835] -| @) Xy |..[| | |areaddedtoeach feature from
— the first layer in the resulting
Selected features only one.
Fields to add (leave empty to use all fields) [optional]
||:jil fields selected || |
Join type
|Take attributes of the first matching feature only (one-to-one) =

Discard records which could not be joined

Joined field prefix [optional]

Joined layer [optional]

leGIS—Training—Data;’exercise_data!forestrylstands_squirrel.shp a || _|

v Open output file after running algorithm

\ 0% || cancel

| H Aide | | Advanced | | Run as Batch Process... ~ Ok | |9Eermer

Now you have a new forest stands layer, stands_squirrel. shp showing the protection information for the
Siberian flying squirrel.

1. Open the attribute table of the stands_squirrel layer

2. Sort the table by clicking on point_pr field in the table header.
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stands_squirrel — Features Total: 74, Filtered: 74, Selected: 0

/ € a7V ES P 2E = &E
idcalc StandID point_id point_pr * point_dist =
1 69 970 2 liito-orava 15
2 70 971 2 liito-orava 15
3 13 914 1 liito orava 15
4 15 916 1 liito orava 15
5 0 901 NULL|NULL NULL
6 1 902 NULL| NULL NULL
7 2 903 NULL|NULL NULL
8 5 904 NULL| NULL NULL
9 4 905 NULL|NULL NULL

~ Show All Features _

You can see that there are some forest stands that have the information about the protection locations. The
information in the forest stands data will indicate to the forest manager that there are protection considerations
to be taken into account. Then he or she can get the location from the squirrel dataset, and visit the area to
mark the corresponding buffer around the location so that the operators in the field can avoid disturbing the
squirrels environment.

14.4.5 Try Yourself Mise a jour des massifs de forét avec la distance au cours
d’eau

Following the same approach as for the protected squirrel locations you can now update your forest stands with
protection information related to the stream. A few points:
* Remember the buffer is 20 meters around the stream

* You want to have all the protection information in the same vector file, so use stands_squirrel.shp as
the base layer

* Name your output as forest_stands_2012_protect.shp

Once the process is completed, open the attribute table of the output layer and confirm that you have all the protection
information for the riparian forest stands 